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1 About the L-BOSS application

Logivision  is a corporation specialized in the development of software for the retail industry
with a particular focus on operation systems for front-end terminals. Innovative and always at
the forefront of new technological developments, Logivision  is committed to improving the
service and products we provide to our customers.

Please take some time to read through the help manual to gain insight into how L-BOSS can
be tailored to run in a wide variety of retail applications.  Logivision's documentation and
manuals are subject to change as new software versions become available. Please ask your
Logivision dealer about manual updates.
This manual covers changes to L-BOSS version 4.1.3.

Logivision has attempted to make this document accurate. Logivision is not responsible for
any direct, incidental, or consequential damages resulting from this documentation or
inaccuracies within. Specifications are subject to change.

Printed in Canada.

Overview

The Back Office System Software is designed as the back office controller for L-POS front
end terminals. Together, they represent the most recent Logivision store management tools.
L-BOSS is the core application for back office control, acting as the centralized data storage,
programming interface, communication center, event scheduler, and office application
launcher. As the core of the store system, L-BOSS is designed to run continuously on at
least one station in the network. This allows it to execute scheduled events, for example
sending item prices to all front end databases.

L-BOSS can also be used in a multi-store system. The L-BOSS Central version was
designed to allow centralized database modifications and reporting. The L-BOSS Regional
version exists for companies that need regional consolidation or database maintenance. The
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stores use L-BOSS. In a chain store environment each store's program data is received from
a regional office if it is used.

Data Storage

L-BOSS uses a relational database system to maintain all system information. Conventional
databases often use single records that contain all information about a specific data type in a
set number of fields. This limits the amount of information that can be kept for a data type. If
new information is required, fields must be added. For example, if you keep customer
information, a conventional database record might have two (2) possible telephone number
fields. If a third telephone number field becomes necessary, the entire database must be
changed to accept the new information.

Relational databases use table sets to link information, allowing for far greater flexibility. As
with any database, each data type must have a unique identifier to distinguish it from other
data items of the same type. By combining two or more unique identifiers, it is possible to
keep multiple values for a single data type. For example, if you sell items at different price
levels, you need to keep many prices for the same item. Instead of adding price fields, the
relational system allows you to have a price level table with as many levels as required. By
combining the unique item code and the price level, it is possible to create a new unique
record for each price for the item in the price table.

Security

As with any critical data system, security is always an issue. L-BOSS offers configurable
security "levels" so that users can only access functions that are available to their assigned
security level. For example, you probably want the store manager to be allowed to add /
remove items, but cashiers should not be allowed. When a user logs into the system, they
can only activate or use options that their security level allows them.

To remain compliant with the PCI mandated security settings L-BOSS uses a complex
password system to manage program access. To reduce risk of exposure the L-BOSS
system has 8 security levels numbered from 0 to 7. Only users with levels 4 and above can
access back office functionality included with L-BOSS.

1.1 License agreement

COPYRIGHT AND TITLE
All intellectual property rights in the SOFTWARE and user documentation are owned by
Logivision or its suppliers and are protected by Canadian and International copyright laws,
other applicable copyright laws and international treaty provisions.  Logivision and its
suppliers retain all rights not expressly granted. Pursuant to this Agreement, you may: (a) use
the programs on the quantity of computers the license was granted for; (b) copy the
programs into any computer in readable or printed form for back-up purposes in support of
your use of the programs. Your software may have been pre-loaded and diskettes may not
have been included.  If you are provided with diskettes, you may not use the diskettes on
another computer or loan, rent, or lease them to another user. You may not use, copy,
modify, disassemble or transfer the programs or any copy, modification or merged portion, in
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whole or in part, except as expressly provided for in this agreement. If you transfer
possession of any copy, modification or merged portion of the programs to another party the
license is automatically terminated. 

TERM
The license is effective unless rejected or until terminated.  You may reject or terminate it at
any time by destroying the programs together with all copies, modifications and merged
portions in any form.  It will also terminate upon conditions set forth elsewhere in this
Agreement or if you fail to comply with any term or condition of this Agreement.  You agree
upon such termination to destroy the programs together with all copies in any form.

LIMITED WARRANTIES AND REMEDIES
Logivision warrants the media on which the programs are furnished to be free from defects in
materials and workmanship under normal use for a period of 90 days from the date of
delivery to you as evidenced by a copy of your receipt. This warranty is limited to the original
purchaser and is not transferable. During the 90-day warranty period, Logivision will replace
any media not meeting the foregoing warranty and which is returned to Logivision or an
Authorized Logivision Reseller ("Authorized Reseller") with a copy of your receipt. The
foregoing warranty does not extend to any media that has been damaged as a result of
accident, abuse, misuse, or as a result of service or modification by anyone other than
Logivision or an Authorized Reseller. Except as expressly set forth above, no other
warranties, either express or implied, are made with respect to the programs, including, but
not limited to the implied warranties of merchantability and fitness for a particular purpose,
and Logivision and its suppliers expressly disclaim all warranties not stated herein. You
accept the entire risk as to the quality and performance of the programs. Logivision and its
suppliers do not warrant that the functions contained in the programs will meet your
requirements or that the operation of the programs will be uninterrupted or error-free. You
assume responsibility for the selection of the programs and hardware to achieve your
intended results; and for the installation, use and results obtained from the programs. Should
the programs prove defective, you-and not Logivision or its suppliers-assume the entire cost
of necessary servicing, repair, or correction. Some jurisdictions do not allow the exclusion of
implied warranties so the above exclusion may not apply to you. This warranty gives you
specific legal rights and you may have other rights that vary from place to place. Your sole
remedies and the entire liability of Logivision and its suppliers are set forth above. In no event
will Logivision, its suppliers, or its Authorized Resellers be liable to you or any other person
for any damages, including any incidental or consequential damages, expenses or lost
profits, lost savings, or other damages arising out of the use of or inability to use the
programs. Some jurisdictions do not allow the limitation or exclusion of incidental or
consequential damages, so the above limitations may not apply to you.

LICENSE KEYS (lost or stolen)
Lost or stolen keys will not be replaced for free by Logivision. A replacement key and the
license for all your options must be purchased at the normal price. Logivision is not
responsible for lost or stolen keys. Please take care to protect your investment.

GENERAL
You may not sublicense, assign, or transfer the license or the programs.  Any attempt to
sublicense, assign, or transfer any of the rights, duties, or obligations hereunder is null and
void. If you have any questions concerning this Agreement, including warranty service, you
should contact Logivision, 210 Sir Wilfrid Laurier, Beloeil, QC, Canada, J3G 4G7. The laws of
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the province of Quebec govern this Agreement.

The simple fact that you have installed and / or used this software means you acknowledge
that you have read this agreement and that you agree to be bound by its terms and
conditions; you further agree it is the complete and exclusive statement of the agreement
between us which supercedes any proposal or prior agreement, oral or written and any other
communications between us relating to the subject matter of this agreement. Manufacturer is
Logivision, 210 Sir Wilfrid Laurier, Beloeil, QC, Canada, J3G 4G7. 

1.2 Privacy policy agreement

LogiLicence Privacy Policy Agreement

This policy describes the ways we collect, store, use and protect information about your
store. You accept this policy when you use our software products (collectively the “Logivision
software"). We may amend this policy at any time by posting a revised version on our
website. The revised version will be effective at the time we post it. In addition, if the revised
version includes a substantial change, we will provide you with 30 days’ prior notice by
posting notice of the change on the "Policy Updates" page of our website.
How we collect information about you
When you use the Logilicence Service, we may collect the following types of information:

Store information - your store name, number and contact information as recorded in the
software configuration menu.
Hardware information - the motherboard and other hardware component ID information
attached to the computer on which the service is activated.

We may also collect information from or about you if you contact our customer support team.
How we record and protect store information
We use the term "store information" to describe information that can be associated with a
specific store using our products and that can be used to identify that store. We record and
process your store information on our computers in Canada, and we protect it by maintaining
physical, electronic and procedural safeguards. We use computer safeguards such as
firewalls and data encryption, we enforce physical access controls to our files, and we
authorize access to store information only for those employees who require it to fulfill their job
responsibilities. 
How we use the store information we collect
Our primary purpose in collecting store information is to validate that the software is licensed
for use at that store location. We may use your store information to:

enforce our User Agreement;

deliver service update notices.
Marketing
We don't sell or rent your store information to third parties.
How you can contact us about privacy questions
If you have questions or concerns regarding this policy, you should contact us by writing to us
at Logivision, Attn: Privacy Department, 204-370 Sir Wilfrid Laurier, Mont-St-Hilaire, QC,
Canada, J3H 5V3.
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1.3 Navigation

Navigating the L-BOSS Application

Using the mouse

Throughout the L-BOSS application you will find drop down menus and main screen icon
groups to navigate through the program or launch utilities. The most commonly used drop
down menu options have been included as buttons on the L-BOSS desktop to facilitate
access. In other words, some drop down menu options lead to the same location as clicking
that option's icon counterpart. 

Not all options have buttons, and must be launched from the drop down menu. Options that
are not often required, or single use setup tools (used to configure the system at installation
time) do not have main screen buttons. If an option does not appear to have an button, use
the drop down menus to locate and launch that option.

Using the keyboard

As with most Windows style applications, the drop down menu titles and options are also
accessible using the keyboard. This can actually be faster than navigating with the mouse,
after you've memorized the keystrokes involved for a specific task. The keystrokes
associated with menu titles and options are underlined. For example, the "File" menu has an
underscore under the "F":

Hold down the [Alt] key on the keyboard.

Simultaneously, press the [F] key.

The File menu opens. 

The options in the drop down menus also have underscored letters. Once a drop down menu
is open, you can press the letter that is associated with the option you wish to launch. You
can also use the [up] or [down] arrow keys to select the menu option, then press [Enter] to
launch the option.

Within applications or utilities, the [Tab] key will move the cursor from one box, window or
editable field to the next, in a pre-set order. Holding down the [Shift] key and pressing the
[Tab] key will reverse the pre-set order. Once the cursor is on an option, press the [Enter] key
to launch the option.

1.4 Printing Help as a Manual

Printing help pages as a paper document

Logivision 's L-BOSS help pages can be printed from the Windows style help viewer.
However, when you print the entire help from the help viewer, the resulting pages will not be
indexed (no page numbers or table of contents). If you wish to print the entire help, you should
run the "L-BOSS.pdf" file that is placed in the L-BOSS folder at installation time. The L-
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BOSS.pdf document is the manual in a printable format, with a table of contents, index and
page numbers. To view / print the L-BOSS.pdf document requires Adobe Acrobat Reader.
You can download the reader from the Adobe website free of charge at http://www.adobe.
com/products/acrobat/readstep2.html

The Install help can also be downloaded from the Logivision  website in all existing formats.
Several smaller manuals are available on individual subjects such as A/R, Preferred shopper,
Labels, Inventory, etc. You can download the help files from the user documentation section
at http://www.logivision.com.

To print a single page from the help viewer

Select the page you wish to print.

Click the "print" button at the top of the help viewer.

A panel will open asking if you wish to print all the topics.

If not already selected, choose "...this topic only".

Print the page

To print the entire paper manual

Make sure you have the Adobe Acrobat Reader installed.

Use Windows explorer to locate the L-BOSS folder.

Select the "L-BOSS.pdf" file, it will open the Acrobat Reader.

You can view the manual on screen, or use the Reader's print utility.

1.5 Folder structure

L-BOSS uses different folders for the files that are needed to operate and for the data that is
created by the user.

Operatin
g system

P
r
o
g
r
a
m
f
i
l
e
s

Program Data

Windows
XP pro
32-bit

C:\Program
files\Logivision\L-
BOSS\*.*

C:\Documents and
settings\All
Users\Logivision\Office001
\*.*
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C:\Documents and
settings\All
Users\Logivision\OfficeSyst
em001\*.*

Windows
7 pro 32-
bit

C:\Program
files\Logivision\L-
BOSS\*.*

C:\Program
Data\Logivision\Office001\*.
*
C:\Program
Data\Logivision\OfficeSyste
m001\*.*

Windows
7 pro 64-
bit

C:\Program files
(x86)
\Logivision\L-
BOSS\*.*

C:\Program
Data\Logivision\Office001\*.
*
C:\Program
Data\Logivision\OfficeSyste
m001\*.*

1.6 Understanding Communications

Polling Process

"Polling" is the act of collecting information from POS stations. In most cases, one back end
station collects the sales and other information from the front end stations, storing the
information in the database. In some systems, polling takes place once at the end of each
sales period (often day end). In these types of systems, there is normally a "request" from the
back end, forcing the POS stations to communicate the sales information.

How Polling Works

The L-BOSS back and front end POS machines are in constant communication, so the
polling process is constantly running. The back end machine that has been designated to
retrieve sales information is constantly checking each POS station's "outbox" at a set interval,
collecting any information that the POS stations are producing. The front end stations
produce sales information files (eg. EJ) after every transaction. After "finalizing" a sale, the
information is immediately placed in a file in the POS's "outbox". The POS station then sends
a message to the L-BOSS station telling it that there is mail to come and get. Even if the back
end does not receive messages from a POS, it checks that stations "outbox" for information
regardless.

Secure Information

This method of collecting sales information adds to the system's data integrity. If the back
end L-BOSS station "crashes", (or the network communication is halted at any time),
individual POS stations can continue to finalize sales. The sales information collects in each
station's outbox, so when normal network communication resumes, the back end L-BOSS
station collects the information as usual, "catching up". If a front end L-POS terminal goes
down, information continues to be deployed to its "inbox", so when the terminal re-starts, all
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new information is absorbed.

During a communication failure, each POS relies on its own data base for item prices and
other item information so the store can continue normal sales operations. Several factors are
involved if the front end uses "floating cashiers" or customer accounts. 

While the network is "down" and L-BOSS cannot communicate with the front end:

No new item prices can be obtained, but the L-POS front end stations work from their
local item database. Local "price override" can be used to modify prices if required.
Floating cashier balance reports cannot be generated until the system returns to
normal operation. 
No customer account balances will be available at the POS terminals until the system
returns to normal. The L-POS front end station will prompt the cashier with a "server
not available - continue anyway?" error message. At this point it is up to the store
manager to allow or not allow account charges during a network outage.
If the HOLD in Server system is used the hold transaction or special order function
cannot be used.
Rental transactions cannot be used.

The gift card server may not be available with gift card balances.

If the POS do not have access to the internet the credit/debit processing may not be
available.

1.7 Data Maintenance

Controlling Database Size

Except for the POS hardware configurations such as printer and scanner settings, L-BOSS
keeps all data in database tables. The original size and growth in size of the database tables
depends on the number of items and other factors such as the amount of transactions per
day. Daily transactions which include PLU sales information are probably the biggest factor,
taking up large amounts of space. Large amounts of data can also slow down the processing
times for database operations. Data cleanup tasks are automated with the Task Manager,
and are included in a default L-BOSS installation.

Instead of keeping all daily data, L-BOSS provides automated utilities that consolidate sales
information into weekly, monthly and yearly totals. The consolidation process is also
automated by the Task Manager, and greatly reduces the amount of space the information
occupies in the database report tables. 

Daily Maintenance Process

As the front end L-POS terminals perform transactions, they place the resulting information in
their local Electronic Journals and SIL backup folders as well as in their own "Outbox". The L-
BOSS 901 controller station picks up this sales data and posts it to the report tables in the



L-BOSS User Manual 4.1.320

© 2001-2014 ... Logivision

database. This creates many daily records that occupy large amounts of space in the
database. The daily maintenance process consolidates the information from all L-POS lanes
into one daily total per store, eliminating many of the records. For example: during a daily
period, a front end lane has sold 300 different PLUs and the same 300 PLUs were sold on
lane 2. Each different PLU sold results in a new a record in the sales file. By default, every 14
days the Daily Maintenance process will combine the 300 records from lane 1 with the 300
records from lane 2, saving database space.

Monthly Maintenance Process

As time passes in an operational situation, data continues to grow. Each month, L-BOSS
runs another maintenance operation to control database size. The Monthly maintenance
process further reduces the database size by eliminating daily data from the past. In most
situations, daily data is not required after about 90 days. With the exception of daily financial
data, the monthly process eliminates daily data, keeping weekly, monthly and yearly totals.
Every month when the process runs, it leaves the most recent 90 days of daily data
untouched, but removes daily data from before the 90 day period.

NOTE: By default, L-BOSS keeps the daily financial data for 365 days. The cleanup
period can be defined in the configuration settings. We recommend you consult your
reseller before modifying the values.

1.8 Protecting Your Data

Backups Are Important!

Is your sales information important? Is your database important? Is your hardware setup
important? The answer is always YES! What happens if the system crashes? How can I
protect my information? Like any "mission critical" information, your L-BOSS installation
should be archived on a regular basis. Normally, your Logivision  dealer will suggest ways to
protect your information, based on the type of installation you have, and how much space
your data actually takes up. In most situations, you'll want to backup every night, (or other
time when the system is not busy).

L-BOSS Data Backup

L-BOSS provides a backup utility that can be programmed to automatically archive all data
from the central database, but it does not provide physical backups that store the data on
removable media. The L-BOSS utility can extract all data from the tables and store the
information in text type "SIL" (Standard Interchange Language) files. The backup files contain
information about each table, and the data to re-populate the tables. It can completely re-build
the database from these files. When set as an automated task, the backup utility works as a
"cyclical" backup; it creates a series of folders named for each day of the week. After the first
week, the process replaces each day's existing backup from the week before. There is
always at least one week of data, going back day by day.

This type of backup is used to reconstruct database tables that for some reason have
become corrupt, or have incorrect data. However, once archived, these files should be stored
using a disk backup type utility, in case of a major physical system failure, such as hard disk
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crash.

The L-BOSS backup mentioned above does not make a complete backup. The process only
extracts data from the SQL-Server database and saves the records within the L-BOSS folder
so you can make a physical back-up that contains all data required to restore the L-BOSS in
case of failure.

Physical Backup

You should definitely consider some kind of physical backup. These "total" backups can be
very complete, replicating the entire drive if necessary, or re-building portions that have been
lost. L-BOSS does not control these types of backup; you should consult your backup
program help to configure your backup / archiving software. It should include a total backup of
everything in the \L-BOSS folder, including all sub-folders. This way the setup can be easily
restored.

Restoring from L-BOSS Archives

The restoration process is somewhat technical and requires that you understand the table
names, and what should be restored. If for some reason the information contained in the data
tables has become corrupt and you need to restore tables, we suggest that you consult your
Logivision  dealer. For more on how to restore using the L-BOSS file maintenance utility, see
the File Maintenance Utility help page in this manual.

1.9 PCI compliancy

PCI Security concerns

System access
Logivision recommends that access to PCs, servers and databases with payment
applications should be restricted by the use of a unique username and complex password
combination.
Data retention
Logivision took steps to elimintae the storage and display of card data so as to minimize the
possibility of that data being lost or compromised. Card account data is truncated on
receipts, in electronic journal and in log files.  The data retention policies cannot be modified
by system integrators or by end users.
Remote Access
Remote access is the ability to connect and interact with a remote network or computer as if
you were directly connected of that remote network or computer. Full remote access implies
that this access is available at will (on demand), and some level of network communication is
allowed to or through a firewall. PCI PA-DSS recommendations are to use two-factor
authentication for remote access login.

The industry recognizes that implementing two-factor authentication can be difficult and
costly.  If a merchant cannot justify the expense of implementing a two-factor authentication
solution for remote access, there are other options available by providing connectivity needed
to support customers without creating a "full" remote access solution.  When considering
these alternative solutions, the following principles must be addressed to ensure that the
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solution provides needed controls without enabling "full" remote access:
· Ensure that remote connectivity can be traced to a specific service request (this

would allow identification the customer support representative and the user requesting
support). 

· Ensure that the solution does not allow "on demand" or "always on" access.
· Ensure the solution uses robust (at least 128 bit) encryption for all communications.
· Ensure that the solution does not allow for the exchange of credentials.
· Mandate that the customer environment must be monitored while access is enabled.
· Ensure that the connection is enabled by an outbound connection that does not

require firewall port enablement.

Here are some examples of this type of solution that can be implemented to meet these
requirements include:
· Go To Assist (full usage tracking with unique session tokens created by customer
support rep)  http://www.gotoassist.com/ 
· LogMeIn Rescue (full usage tracking with unique session tokens created by
customer support rep)  https://secure.logmeinrescue.com/HelpDesk/Home.aspx 
· Techinline Remote Desktop (full usage tracking with unique session tokens created
by customer support rep)  http://www.techinline.com/ 
· iRemotePC Remote Support Service (full usage tracking with unique session
tokens created by customer support rep)  https://www.iremotepc.com/ 
· Go To Meeting (tracking of meeting IDs used and persons involved need to be
tracked in support tickets)  https://www.gotomeeting.com/
· LiveMeeting (tracking of meeting IDs used and persons involved need to be tracked
in support tickets)  
http://office.microsoft.com/en-us/livemeeting/default.aspx 
· UltraVNC (configure to require customer to initiate access and to connect to a
specific IP address or range  for support connectivity, and persons involved need to be
tracked in support tickets)  http://www.uvnc.com/ 

Encryption
Logivision does not use data encryption for sensitive card-holder because it is not needed
within our application. The credit interfaces we provide do not control pin-pads or card data
communication. No sensitive card data is stored in the L-BOSS, L-POS or other Logivision
applications. 

Nonetheless it is important to know that Logivision has chosen software partners that are
PCI-CISP approved. These partners have been validated to ensure that data is not stored that
can lead to any type of compromise. 

For detailed information on requirements to meet PCI compliancy you should review the PCI
Implementation guide for L-POS v1.01.Pdf document delivered with this application and
other recommendations made by the PCI Council. Visit https://www.pcisecuritystandards.
org/ for more information.
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2 L-BOSS Menus

The Main Menu

The L-BOSS main menu is the gateway to all back-store applications. The L-BOSS can be
configured as a store controller, a regional controller or a central controller.
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This example shows the L-BOSS "Desktop" for the Central version.

Click the L-BOSS icon at the left of the main menu to select whether L-BOSS will run as a
service from the system-tray or normally as an application from the button-bar.You will be
prompted once to start L-BOSS every time from the system tray. When this option is
selected the EXIT shortcut changes dynamically to a CLOSE shortcut button.
This is useful in situations where L-BOSS is being used as a store controller and thereby
eliminating unnecessay shutdown.
To return to running the system from the button-bar repeat the operation selecting start L-
BOS from button bar.

Note: You may see a money-bag flashing to the lower left hand corner of the L-BOSS screen.
This is a warning that cashier drawer limits have been exceeded. Double-click the icon to get
a list of the s currently on-line. You can also generate a report that shows cashiers with in-
drawer amounts different than 0.00.

2.1 File Menu

File Menu Options

With the exception of the Login, Logout and Viewer options, the File menu option accesses
system set-up options that areconfigured at installation time and normally remain static after
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that.

Login: Allows system operators to gain access to system applications.

Logout: Security feature that allows the communications to continue while protecting
access.

Language: Change the application's display language to one of the available selections.

View Internal Process: Displays internal communication process between L-BOSS and
other applications.

View Polling Status: Displays the terminal list and their exchange status (online of error
state.)

Execute Command File: Opens a browser to select an sql command to execute. The sql
commands used most frequently would normally be set up as a task under the task menu.

Deploy Individual File: Opens a list of files that can be sent from L-BOSS to update another
terminals database.

Configuration Panel: Gives access to company information, network and database
configuration, security system.

Send urgent messages to L-POS: This option is to show whether or not the system was
configured to forward a copy of the urgent messages received in L-BOSS to a POS terminal.
When grayed-out the option was not activated.

Date Conversion: A calendar and date conversion utility.
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Messages: Send messages over the network to other stations.

Show Tips: Helpful hints at startup?

Exit: Close the L-BOSS application, stopping all communications.

2.1.1 Login

Logging into the System

As with any critical data system, security is always an issue. L-BOSS offers configurable
security "levels" so that users can only access functions that are available to their assigned
security level. For example, you probably want the store manager to be allowed to add /
remove items, but cashiers should not be allowed. When a user logs into the system, they
can only activate or use options that their security level allows them.

When L-BOSS is first launched, the application runs at the "no user" level. This means that
launching most options or applications will open the login panel. By default, the user "7" is
given the programmer security level, meaning access to all functions and options.

Login:  Use this option to sign onto the system with your user name (and password). 

Open the File menu.

Selecting the "Login" option opens the "Enter login" panel.

Enter the user number from the keyboard*. (see note below about user numbers)

Press [Enter].

*You can also double click the data entry area to open an on-screen numeric keypad, useful
for touch screen situations.

NOTE: L-BOSS uses numbers for users; you cannot use alpha characters for users. The
users, their assigned levels, and the security level configuration are accessed in the 
Maintenance application.

NOTE 2: L-BOSS restricts the use of level 7 operator for select entries. It is not permitted to
use an operator assigned level 7 security for continuous operation of L-BOSS. L-BOSS
warns against the usage of level 7 security settings and aborts processing whenever you
sign on with an operator  using level 7 security.

NOTE 3: L-BOSS is often started by means of a shortcut placed in the appropriate start-up
folder. This can cause a problem when the software is running on a machine that is also
acting as a database server running an application such as MSDE or MSSQL. To ensure
that the operating system and database server have adequate time to load all the required
services, you can add an argument, or switch, to the shortcut that starts L-BOSS. 

/Delay:20  will force L-BOSS to count a 20 second delay before loading. Set the delay
required on your system.
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2.1.2 Logout

Logging off the system

To maintain data security, and to prevent unwanted access to the system, it is important to
"logout" or "log off" the system when you are not working with it. 

Logout:  Use this option to sign off the system, leaving the application on the "no user"
security level.

NOTE: L-BOSS will still execute any scheduled operations, including polling or other
communications, even if no user is logged.

2.1.3 Language

Setting the Language

It is possible to change the language displayed in the L-BOSS application. At this time there
are two possible languages, English or French. 

Changing the language does not affect the way that functions or options behave.

You do not have to re-start the application.

It is also possible to configure L-BOSS to display a specific language based on user
preferences. When a user (operator) logs in to the system, the application switches
immediately to that user's preferred language. Click here to go to the Operator Table help
page now.

Language:  Use this option to change the current language displayed in the L-BOSS
application. After selecting the language menu option:

A "Select Language" panel opens, displaying a list of the available languages.

Click the language to change to,

Press the "OK" button to accept the language change, or

Press the "Cancel" button (or top right hand window "X") to cancel the language
change.

2.1.4 View Internal Process

What's Happening "behind the scenes"
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To understand how the L-POS / L-BOSS communications work, refer to the "Understanding
Communications" help page in this manual.

View internal process

When running, L-BOSS is constantly performing transactions, exchanging information and
processing commands. The "View Internal Process" option launches the "Viewer", a utility
that monitors the internal exchange system as it functions, tracking activity. This option can
be used to view what the L-BOSS mail exchange program is doing internally. 

The viewer should be used to trouble-shoot; it is very useful in determining communication
problems between the back-end controller and the POS lanes.

NOTE: The options and controls available in the viewer utility control the viewer only, not the
actual internal system processes. In other words, you cannot stop or freeze the actual
internal processing system from the internal process viewer.

The Viewer Display

Once the viewer window is open, the utility begins to track the internal process, displaying a
line for every activity being tracked. Each line consists of:

10:12:07.680 Mailslot received: 00190611ACT,SUPPORT3:
- the precise time that the process began, including milliseconds

10:12:07.680 Mailslot received: 00190611ACT,SUPPORT3:
- a short description of the process

10:12:07.680 Mailslot received: 00190611ACT,SUPPORT3:
- the three digit store number

10:12:07.680 Mailslot received: 00190611ACT,SUPPORT3:
- the three digit terminal number

10:12:07.680 Mailslot received: 00190611ACT,SUPPORT3:
- the two digit internal Mailslot line number (internal id)

10:12:07.680 Mailslot received: 00190611ACT,SUPPORT3:
- the terminal's status, ACT means "active"

10:12:07.680 Mailslot received: 00190611ACT,SUPPORT3:
- the terminal's machine network name

The viewer has both a top bar main menu and buttons to control how the viewer behaves,
and to allow you to determine what exchanges are being traced. The help pages below this
topic explain the functions and controls for the "View Internal Process" viewer utility.
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2.1.4.1 Process Viewer Buttons

Controlling the Viewer

This example shows the Internal Process viewer.

Status bar and control buttons

The options and controls available in the viewer utility control the viewer only, not the actual
internal system processes. In other words, you cannot stop or freeze the actual internal
processing system from the internal process viewer.

Status Bar

The status bar is the area at the bottom right of the viewer window, and displays current
system information, such as the "average merge time", the transaction number and more.
Hold the mouse cursor above the status information to find out what the information
represents.

Buttons

OK: The OK button closes the viewer, and is identical to the "Files" menu's "close" option.

FREEZE:  This option "freezes" the viewer at it's current display line. It behaves as a "toggle",
in other words, clicking the first time freezes the display; clicking the second time "unfreezes"
the display, which then continues to display lines. Although similar to the "Files" menu's "stop"
option, no lines are skipped; the viewer continues displaying all activity from the point at which
it was frozen. The "stop" option is explained in the "Process Viewer Menus" help page above.
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READ KEY: This option checks the hardware copy protection key and tests it's current
communication status. Only one machine in the system hosts the key, and runs a program
that "broadcasts" the key info. Use this option to determine if the key is functioning properly.
The viewer does not show the content or value the key returns, only that the communication
was successful. For example:

11:08:27.300 Send Key MailSlot
11:08:27.520 Mailslot received: Key info

2.1.4.2 Process Viewer Menus

Controlling the Viewer

Internal process viewer menus

The options and controls available in the viewer utility control the viewer only, not the actual
internal system processes. In other words, you cannot stop or freeze the actual internal
processing system from the internal process viewer.

Files Menu

Stop: This option stops the viewer at it's current display line and behaves as a "toggle". In
other words, clicking the first time stops the viewer from displaying more lines and puts a
check mark beside the menu option. Clicking the second time restarts the viewer, removes
the check mark and continues to display lines. All internal processes continue as usual; this 
does not stop actual internal processing. Although similar to the "Freeze" button, the "stop"
option skips all process lines or activity between the time it was stopped and when it is
restarted. The activity or processes that occurred during the time the viewer was stopped will
not be displayed.

Freeze: The same as the button found at the bottom of the viewer, this option "freezes" the
viewer at it's current display line. It behaves as a "toggle", in other words, clicking the first
time freezes the display; clicking the second time "unfreezes" the display, which then
continues to display lines. Although similar to the "Files" menu's "stop" option, no lines are
skipped; the viewer continues displaying all activity from the point at which it was frozen.
When unfrozen, the viewer displays all activity lines since frozen.

Reset transaction counter: This option resets the internal process line count for the viewer
only, not the actual internal process number. It is a counter used by the viewer to keep
track of which line is being displayed. The current process line count is displayed at the
bottom right of the viewer's status bar (bottom of viewer window).

Close: The "Close" option closes the viewer, and is identical to the "OK" button at the bottom
left of the viewer.
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View menu

The viewer allows you to control which types of internal processes you wish to track.
Checked items in the list will be tracked and displayed as transaction lines. The option acts
as a "toggle"; click to select or unselect the items to be tracked. In some cases (searching for
a specific type of internal process) it may be easier to follow only one type of process to
determine communication problems.

MailSlot: Information requests to and from the back office, hardware copy protection key
information etc.
EJ: "Electronic Journal"; actual POS transactions, as sent to the back end after a tender key
finalizes a transaction.
Mime: Other information communicated to and from the POS (such as images, search
results).
Import: Information files received from external sources, such as PLU files from another
store or head office.
Export: Information files sent to external destinations, such as PLU files sent to another store
or head office.
Misc: Other types of files, messages.
Errors: Error messages communicated through the system after an error occurs, normal,
urgent etc.
Commands: Polling requests and other command type files. 

2.1.5 View Polling Status

View Polling Process  

This "File" menu option opens a two pane viewer that displays the files being retrieved from,
and sent to, the POS terminals, along with a list of the stations (or POS terminals) involved in
the polling process. The viewer is not actually part of L-BOSS, but a separate utility or
application. When the polling software is running (in the background), it's icon shows in
Window's "System tray" (bottom right corner of the Windows desktop tool bar). 

The Polling process can only be displayed on the L-BOSS terminal that is set as the 
Controller during the initial set-up of the system. This setting is normally made for terminal
901. If the Polling Process can not be viewed it is probably because another backoffice
terminal is set as the Controller.

NOTE: The polling viewer uses Window's regional settings to determine language. This
means that the language specified in L-BOSS does not control the language displayed in the
viewer. To change languages, you must change the settings in the Window's Control Panel -
Regional Settings utility.
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This example shows the Polling Process viewer.

Menu Options

File Menu: The "File" menu has two options:

Close: Closes the viewer, leaving the polling software running, it's icon visible in the
Window's System tray.

Quit polling: Closes the viewer and also stops the communication process. You should
only use this option if you are certain that you want to stop communications all together.
Once the polling utility is stopped, you must exit and re-launch the L-BOSS application to re-
start it.

NOTE: You can also launch the polling viewer by double clicking the system tray icon, or
right clicking it and selecting the "View status" option. The context menu (right click) also has
both the "Close" and "Quit Polling" options explained above.

Viewer Display windows

Top window (Status information): Each line displayed in the polling viewer includes the
exact time to the millisecond, as well as the store and terminal number. If the server cannot
reach a POS station for sales information, the viewer displays the error.
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Example top window line: 13:58:18.130 Polling 001 024 

Bottom window (Terminal transfer list): The polling viewer's bottom window shows all the
terminals presently configured in the L-BOSS station's "terminal list", their store and terminal
number, current status, and machine network name. Selecting a terminal from the list will
display that terminal's location information in the status line at the window's bottom bar.

It is also possible to stop or force the polling process for one or all terminals from the View
polling bottom window. After selecting a terminal from the terminal list, clicking the right
mouse button opens a menu allowing you to:

Pause: Use this to stop one terminal from communicating.
Communicate now: Forces that terminal to begin polling immediately.
Stop All: Stops all terminals in the terminal list from communicating.
Start All: Forces all terminals to poll immediately.

NOTE: L-BOSS controls the Polling cycle internally. In a normal situation data is retrieved
immediately after each sales transaction is complete. L-BOSS also "cycles" through the
terminal list every 2 minutes to ensure the on-line status of each terminal. When L-BOSS
detects that a terminal is not on-line, it records an error internally. From that point  L-BOSS
will only attempt to poll that terminal every 15 minutes. If no communication is available on
the next polling attempt an error will be reported to advise store personnel that the terminal is
off-line.

2.1.6 Execute Command File

Forcing Commands

Command files contain instructions for L-BOSS and SQL (Standard Query Language)
commands that when executed bring information into the system database tables. Most
internal commands required for normal operation are executed automatically based on the L-
BOSS scheduler. 

There are some situations that may require you to execute these commands manually. For
example, internal commands that either failed, or could not be executed automatically at the
scheduled time, such as in the case of a network "down". These commands should be
launched from the "Events / Tasks" (the scheduler) utility. For help on forcing scheduled
tasks manually, please see the "Events / Tasks" help pages.

Other Tasks

There are other internal commands that are not programmed to execute automatically, and
are not setup in the "Events / Tasks" list. For example, commands that re-program front end
machines, or other utilities that maintain the database tables. Use this option to execute a
command file manually.

!Warning!: You should only use this option if you are certain that you are executing the
correct command. By running an internal command file you can inadvertently or even 
severely damage the data contained in the system database tables. If you are unsure, you
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should consult the system administrator or your L-BOSS dealer for technical support.

Execute command file:  This menu option opens a Windows Explorer style window (file
browser) to allow you to select an internal command file for execution. The L-BOSS internal
command files have a common .sql file extension. The file browser's "Files of type" setting
(bottom of window) is set to find .sql files found under the default \L-BOSS\Office folder. To
execute one command file:

Browse the Office folder to locate the command to execute.

Select the file and press "open" (or double click the file).

A confirm execute panel opens.

Press "Yes" to accept, "no" or "Cancel" to abort the process.

Custom command files: In some situations it may be necessary to customize command
files delivered with L-BOSS. We recommend you follow this protocol when modifying
commands delivered with L-BOSS. Create a copy of the existing file using the same file
name from the original command file with "_CUST" in the main part of the filename. For
example, if you want to customize the command that sends all changes to the POS please
copy the file Deploy_POS_chg.sql to Deploy_POS_chg_CUST.sql. Then make your changes
inside the Deploy_POS_chg_CUST file.

Now you do not need to change any of the events that execute the Deploy all changes
command. L-BOSS will search for the custom version of any command file it is asked to
execute. If thee custom version is found it will be used. 

Take care when updates are performed to compare the changes in your custom file with the
contents of the original file. When new tables are added to the system some internal
commands are modified to send changes in those tables to the POS terminals or to other
stores. If you have a custom command file you need to add the same changes to it that were
done in the original file sent with the update version.

2.1.7 Deploy Individual File

Sending Information From One Database Table

L-BOSS keeps all data in database "tables", with one table for each specific data type. For
example, system operator information is kept in an operator table within the database. In
normal circumstances, daily routine involves modifications to data within these tables. An
automated task is provided that searches all database tables for modified data and sends all
changes to the front end, set to execute daily. However, in certain situations it may be quicker
to select a single table containing the modified data and send it immediately, without
searching all the tables for modifications.

This option allows you to send a single type of information or configuration file to the POS
stations. Sending modifications may interrupt the front end operations, except for item,
operator and customer tables.
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NOTE: It is important to understand the "Replace" option before using the deploy individual
file utility. When the "Replace" option is used, the receiving terminal's table must be "locked"
to avoid multiple table access during the transfer. It is important to note that the receiving
POS terminals cannot operate during the replace operation.

NOTE 2: If the border of the Deploy individual file window is blue, the current operator's
security settings will not allow him to select the replace file option.
 

This example shows the "Deploy one file" table selection tool.

Deploy individual file:  This menu option opens a list of all the data tables and .ini
(configuration) files that can sent to the register. When the Events/Tasks are executed,
several tables are usually verified before data is sent to the L-POS terminals. If you know the
specific data table or configuration file you need to send, use this option for quick results. 

Select the Deploy individual file from the L-BOSS "File" menu.

A list window opens, showing all available data tables and configuration files.

From the list, select the file to deploy.

If you need to overwrite the data on the POS terminal with the data from the back-end
database, select replace. (see note above)

Click the "Deploy" button.

A window opens displaying a list of available terminals and terminal groups (targets).

Select the destination terminal or group.

Press the "OK" button to send now, "Cancel" to abort.
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2.1.8 Bypass file processing security order

This option is usually hidden from view when the system is operating properly.

It is possible that corrupted data is sent to L-BOSS. For example after a network failure or
when importing from 3rd party systems. If this occurs L-BOSS will interrupt operation until the
problem is resolved. Here is the first message displayed on the L-BOSS:

Whenever this occurs you should normally close L-BOSS and all workstations. This frees up
any database issues.Then re-open L-BOSS and try to reprocess the file that caused the
error. When you open L-BOSS the same red screen will appear. Press OK and the L-BOSS
will show a flashing UNPROCESSED icon. L-BOSS may also display an error message.
Close the error window and click the Unprocessed icon.
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When you click UNPROCESSED this form will appear:
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This form shows a list of the mail folders for each terminal. The name of the file that did not
process will show under the Local terminal Unprocessed folder. Right-click on the file name
and select the reprocess option. If the red error screen saying a file has been moved to the
unprocessed folder occurs again there is a more serious issue with the data in the
unprocessed file.

When L-BOSS cannot process a file you need to correct the error in the data file or remove it
from the unprocessed folder. You cannot remove the file using an L-BOSS function. If the
program must be moved use Windows explorer. The Unprocessed folder is located at:
In Windows XP: Users\Logivision\OfficeXXX\Unprocessed\ where XXX is your store number
In Windows Vista / Windows 7:  C:\ProgramData\Logivision\OfficeXXX\Unprocessed\ where
XXX is your store number.

 If you make the decision to remove this file manually from the unprocessed folder L-BOSS
adds a new menu entry to the File menu:

The Bypass file processing order security option is the only way you can return L-BOSS
to its normal processing activity. This option prompts you to confirm the file delete is voluntary
by typing the word ACCEPT, pressing OK then entering your name. Once these conditions
are satisfied the processing will restart.

2.1.9 Call me

This menu option does not appear on all systems. If you are using the LRemote system to
communicate with stores AND you activated the L-BOSS heartbeat this option is available at
the head office.
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This option is used to send a request to each store to initiate immediate communications with
the head office. If you enabled the L-BOSS heartbeat during L-Remote setup the L-BOSS >
File menu includes a "Call me" option.

Use this option to send the request for immediate store initiated communications to each L-
Remote client.

2.1.10 Configuration Panel

Basic L-BOSS Set Up Information

!!WARNING!! Most of the options available in the Configuration panel control how L-
BOSS behaves. Tampering with these settings can cause serious system failure.
Please consult your Logivision  dealer before changing any settings.

L-BOSS uses a basic configuration file to keep track of global application information for the
installation. 

2.1.10.1 Company

Company Tab Settings



L-BOSS Menus 41

© 2001-2014 ... Logivision

The "Company information" is normally entered the first time you launch the L-BOSS
application. This information is used throughout the application. For example, when report
pages are generated, L-BOSS uses the company name and address to personalize the
printed and on screen result.

Enter your company information in the appropriate spaces.

Allow multi-store selection: This option is used to determine if this L-BOSS installation will
control multiple stores for pricing, inventory, etc. When selected, this option will affect certain
utilities throughout the L-BOSS application where multi-store information is required. 

NOTE: If you are not in a multi-store control situation, selecting this option is not suggested.
Although it will not harm the installation, it will cause the system to prompt you to select a
target store for many everyday operations, adding unnecessary steps to the operations.

The Configure format button opens a window where you can set the telephone number
formatting. 

Example: 
If you enter 450.###.####, L-BOSS will replace any 7 digit entry with a preceeding 450
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and place decimals as the digit group separators.
If you enter ###.###.####, L-BOSS will not replace any digits, but will place decimals as
the digit group separators.

The E-Comm button opens the configuration menu for the L-BOSS interface to it's
ecommerce application.

The LvReceipt button opens the configuration panel for the receipts hosting system option.
This option allows you to send customer transaction receipts to a web site where the
customers can go online to view their purchases. This manual does not include the
instructions on setting up the LvReceipt option. Please refer to your Logivision reseller for
help with this option.

The Advanced button opens a list of options that control the behavior of the system.

The software compiled date is displayed for convenience. The Updates until date is shown as
a warning so that you do not update with a newer version that the license does not permit you
to operate with. For example, if the "Updates until" field shows 10/31/2007, you can install an
update for any version that is compiled on or before that date. 
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2.1.10.2 Email

Use this form to enter the email set-up information required to send emails from L-BOSS.
The L-BOSS licence permits sending up to 50 emails per month for all users whose software
is covered by the annual updates subscription. Users that require additional emailing capacity
can subscribe to subscription upgrades that allow sending additional emails. Please contact
your L-BOSS installer for more information. Please note that L-BOSS emails are sent via an
email server that should prevent emails from being perceived as spam. Emails are placed in
a queue for sending and may not be released from the queue immediately. Emails may at
some point take up to an hour to be dispatched to avoid being perceived as spam messages
by destianation email servers.To verify your update subscription status open the LogiLicence
Viewer by clicking once on the icon in the system tray or from the Windows Start menu, All
programs, Logivision, Logilicence Service, LogiLicence Viewer. The following form will
appear:
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Name: By default L-BOSS will use the information from the store details table to identify the
sender. Set up the store details in Maintenance under the register>store information menu
option. Overwrite: Use this to modify the store name used when sending emails.
Email: Enter the sending email account. By default L-BOSS will use the information from the
store details table to identify the sender. Set up the store details in Maintenance under the
register>store information menu option. Overwrite: Use this to modify the sender's email
address when sending emails.
Error Email: Enter the email account that will receive any error reports generated by the L-
BOSS and that are set to be sent by email.
Reply address: Enter the reply-to address to be used in the message.

To schedule a task that will Email a report:
Reports can be emailed automatically or manually from the L-BOSS Task scheduler.
Create an event for each different report you need to email automatically. Refer to the help
section on tasks for assistance on what the fields mean. The event command line syntax is
shown here:

@EXEC(LRP=financial,@DATE1=@DSSC-30,@DATE2=@DSSF,EMAIL=STORE:027)
LRP=ReportName to use
@DATE1=Start date (refer to DATEFMT.TXT file in L-BOSS program folder)
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@DATE2=End date
EMAIL=Destination

Where destinations are:
STORE:XXX where XXX=3 digit store number whose store manager will receive the report.
VENDOR:XXX where XXXis the Vendor number whose email will receive the report.
OPER:XXX where XXX is the Operator number whose email account will receive the report
ACC:XXX-YY where XXX is the account number and where -YYY is the contact number
whose account will receive the report. If you do not supply the -YYY contact number the email
will be sent to the main account contact 0.

Examples:
    ACC:1       To account 1 contact 0
    ACC:1-3     To account 1 contact 3
    ACC:1;ACC:3 To account 1, contact 0 and account 3, contact 0
    OPER:x      To operator x (F1126)
    VENDOR:x    To vendor x (F27)
    STORE:x     To store manager of store x (F1156)
    OPER:7;ACC:3-4      To operator 7 and account 3 contact 4

To schedule a task to send an Email:
You can create an event in L-BOSS to send a message via email. Here is the syntax:

@EMAIL(TO=email@server.com,TEXT='Hello there')
There my be several TO and several TEXT arguments.

The TO may have different syntaxes.

To send to a contact you know the email account for:
TO=salesteam@logivision.com

To send a message to a vendor's email account:
TO=VENDOR:VendorNumber

To send a message to a customer's email account:
TO=ACC:accountNumber
TO=ACC:AccountNumber-ContactNumber

To send a message to an operator's email account:
TO=OPER:OperatorNumber

To send a message to another store's email account:
TO=STORE:103

Examples:
    ACC:1       To account 1 contact 0
    ACC:1-3     To account 1 contact 3
    ACC:1;ACC:3 To account 1, contact 0 and account 3, contact 0
    OPER:x      To operator x (F1126)
    VENDOR:x    To vendor x (F27)
    STORE:x     To store manager of store x (F1156)
    OPER:7;ACC:3-4      To operator 7 and account 3 contact 4
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You may include attachments: (You may remove the TEXT command)
ATTACH=MyFile1
ATTACH=myfile2

You may use a file instead of typing the message with TEXT (You may remove the TEXT
command)

FILE=MyFile
If you wish to send in HTML format instead of PLAIN format, use the command:

HTML
You may enter a subject:

SUBJECT=My Subject (If no subject is entered, the default is 'Info from L-
BOSS')
You may overwrite the FROM address with:

FROMNAME=My Company
FROM=company@server.com

PS: If there is no TO, FROM or if the server is not defined, there will be no error generated.

If you are not connected to the internet, you may get an urgent message.

You can view the email sending results under the View Logs menu option.

Notes:
The EMAIL system is now auto configured and uses a server defined by Logivision. This
ensures that  sending multiple emails (like statements) in rapid succession will not be
detected as spam mail. This will have no effect on your current ISP.

The settings are transferred from Logivision to the L-BOSS system using LogiLicence. 

If the system becomes in-operational, Logivision will elect a different server. When this
happens a request will be made using to get new settings from Logivision. This will be done
automatically whenever L-BOSS detects a SMTP error:

When the email system detects constant errors for more than 30 minutes, the icon EMAIL
ERROR is turned on and a request is made to LogiLicence to connect to the host.
5 minutes later, L-BOSS will retry sending emails (The icon will be turned off).

if it fails again, no more action is taken and the EMAIL ERROR ICON will be displayed.

If it succeeds, then it resets the fact that it already asked Logilicence to update the settings

in case later on the same problem raises.  But this is done a maximum of 10 times per
session. Beyond that you must restart L-BOSS to reset the count.

PS: The EMAIL ERROR ICON will appear whenever the system reaches the maximum
emails allowed per month . The system will not call to get a new licence from host in this
case. The licence for the user account must be updated to allow more emails to be sent. The
email count runs from the first day to the last day of each month.

By default L-BOSS will use the information from the store details table to identify the sender.
Set up the store details in Maintenance under the register>store information menu option.
Overwrite: Use this to modify the store name used when sending emails.

View Logs
Use the log viewer to check email outbox and email status.
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The title bar of the View log forms includes icons that display the status of Emails and other
messages generated through the system.

This view displays a list of the unsuccessful transfers that occurred since the unsuccessful
log was deleted. 

2.1.10.3 System

System Tab Settings

Information in the system tab is critical to L-BOSS operation, and should be fully understood
before making modifications. Settings depend largely on the type of station being installed,
such as server or secondary office station. 



L-BOSS User Manual 4.1.348

© 2001-2014 ... Logivision

This example shows the Configuration panel's "System" tab.

Server PC Name: This field will display the local PC name. When you are installing an L-
BOSS Server this is the correct name.For an L-BOSS workstation you need to enter the
PC name of the L-BOSS server. In our example the Server PC name is PB7.

Database server: Enter the name of the SQL Server 2008 Express R2 database server.
The default name is ComputerName\LOGI2008 where PcName is the computer
identification. In our example the PC name is PB7.

User.  Enter the User account created for the SQL Server 2008 Express R2 program during
the SQL installation process. The default value was LogiU. PCI compliancy prohibits use of
the SA account.

Password.  Enter the password you created during the SQL Server 2008 Express R2
installation. PCI compliancy requires that you assign a complex password to  each user and
to the SA account.

Create Database Use this button if you want to create new database to use with L-BOSS.
Normally you will use the LogiDB database that was created during the SQL Server 2008
Express R2 installation. You must enter the password to connect to the database server to
create a new database,
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Database name: Enter the name of the database to be used for L-BOSS table data. The
default name is LogiDB. If you have not entered the Database Server and a valid password
the list of databases attached to the Database server will not be available.

Use internal stored procedures: Select this option unless instructed otherwise by
technical support.

System date. L-BOSS allows two types of date rollover. 

In a normal environment, the fact the date changes at midnight is the ideal situation. All
sales made between store opening at 7:00AM, for example, and up to store close at
10:00PM, for example, belong to the same day and to the same balancing period. In this
type of environment the default selection (change at midnight) for system date is correct.

In a 24 hour store, or in a store where the balancing period may not correspond to the
sales made within a specific calendar date, the system date should be set to change
manually .This is the case for a 24 hour store. Imagine a 24 hour store that wants to
close the daily balancing period at around 11:00 PM. But never exactly at the same time.
L-BOSS allows you to define that the time-stamp made to a transaction does not have to
be the exact date of the operating system. If the cashier working the last shift is ready to
close at 11:07PM, a command can be issued to force a date rollover at that point. This
way the data used to balance will correspond up to and including the last transaction
made by the cashier. L-BOSS and L-POS also realizes that any other cashiers still
signed on while the date rollover command is executed are actually still working on the
previous day's totals until they log out and log in again. The command to execute the date
rollover can be a back-end event executed manually or automatically or it can be a front-
end operator function that sends a request to the back-end to force the date change.
This same option (change manually) allows a non 24-hour operation to balance their
cashiers at 3:00PM if they wish, or to allow sales made up to 1:00AM to be included in the
previous day's sales and not included in the calendar day in which they are made.

Force date change. This flag is used to force the date to change at the appropriate time
even though an operator may be logged on the system.

Last day of the week: Select the day of week that is used to define the end of each weekly
period for the data stored by L-BOSS. Normally this will be either a Saturday for stores that
work from Sunday to Saturday, or it will be Sunday if you report from Monday to Sunday as
the weekly period.

Compression. The sales data is stored in multiple files for file redundancy, reporting, and for
search and review (electronic journal.) The compression of data is handled differently for front
end and backend terminals. This flag setting refers to the number of days that transactional
data in database format remains available on the individual POS terminals. The maximum
entry is 31 days. We suggest leaving the default value of 31.

Leading "0".   The L-BOSS database can be configured to automatically pad (or fill in) the
leading zeroes in the UPC or product code. In some environments this is a desired behavior.
Other environments may not want leading zeros in their product code. If you enter 14, the
numbers entered will all be at least 14 digits, with zeros filling in any positions before the PLU
number you create if it is less than 14 digits long.    
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Note: If your system requires alpha-numeric PLU numbers, leave this field blank and the
number you enter will be the PLU number. 

Store. L-BOSS was conceived to operate as part of a multi-store retail chain. The number
entered here will be a part of the data files generated for each transaction. Take care to use a
unique number for each separate location the L-BOSS is used in within the same retail chain.

Terminal. Each back-office terminal must have a unique number. A numbering system has
been determined whereby terminals 001 to 799 are cash registers. Terminals 800 to 899 are
back-end tools such as portable devices, label stations, etc, that may need to be targeted
with program data. Terminals 900 to 999 are all office terminals running the L-BOSS
application. Start the L-BOSS terminal numbering at 901 on the first back-end terminal, use
902 on the next back-end terminal in the same store, terminal 903 on the next one, etc.

Controller. When L-BOSS is installed on multiple back-end terminals, one of the back-end
terminals will be used to manage the exchange of data with the L-POS sales terminals. This
terminal number is set to 901 on all systems.

Messages  Although terminal 901 acts as the store controller, you may wish to direct all the
messages processed by the system to another back-end terminal. This could be the case in
a larger store that uses more than one back-end terminal and that also has many POS
terminals. If the operator responsible for monitoring the error messages works at the 902
station, messages would be set to 902. By default the message terminal is set to 901. 

Ad: Use the Ad button to the right of the messages field to set advanced properties of the
error messaging system. This window is used to select a message and define an action to
change the default behavior of L-BOSS when this message is generated. For example, you
may reeceive "Scanner event received when disabled" message now and again. This is due
to the scanner model not recognizing the programmed diable code, or not having a disable
command. If you prefer to display the message only if it occurs 3 times every 7 days you
would select:
Active when it occurs 3 times per 7 days. The same definition can be made to email the
message. It will be sent to the error email account defined in the Email tab of the L-BOSS
configuration menu. 

Email all urgent messages: Select this option to send a warning email every time an
urgent message is received by the L-BOSS. The message will be sent to the destination
defined in the email configuration tab.
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Messages 2: Use this setting to send a copy of urgent messages received by the Main
message center to another terminal in a store. The message is sent using the internal email
program that allows inter-terminal messages to be sent. This second message center is
sometimes required in stores where the main message center is left unattended. You would
still want to send a copy of each message to the front of the store where someone is working
on a terminal. It is possible to turn on or to turn off the second message center from the L-
BOSS file menu.

Polling local: This setting is used by headquarter application with many stores or lanes to
poll and who want to run the polling from a different terminal.

2.1.10.3.1  IP List set-up

The system can use what we refer to as an IP list. This is a list of fixed IP adresses that
different internal applications use to exchange messages. Here is what you need to do to
implement the IPList system which will direct the mailslots to a specific IP instead of being
broadcast over the network. This means that terminals can be in different sub-nets, in
different workgroups, etc.

1 - Create a text file called "IPList.ini" (anywhere on the PC)

2 - Create the following sections in the IPLIST.INI file for every component of the system: 
[LPOS], [L-BOSS], [Keyreader], [Monitor], [PUMP] (plus one called [LRFMON] if you are using
a Worthington unit)

3 - In each section add the terminal #'s along with the IP's for those terminals. Add the
[monitor] section for each of the POS terminals you are going to monitor.
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[L-BOSS]
001901=192.168.0.106
001902=192.168.0.107

[LPOS]
001001=192.168.0.107
001002=192.168.0.108
001003=192.168.0.109

[LRFMON]
001400=192.168.0.106

[KeyReader]
KeyReader=192.168.0.106

[Monitor]
1=192.168.0.106  (this is IP of the first  machine listening to the registers)
2=192.168.0.107 ((this is IP of the second  machine listening to the registers)

[PUMP]
001600=192.168.0.46  (pump server for store 001)
001690=192.168.0.82  (backup pump server for store 001)

[LRCLIENT]
001901=192.168.0.106

[LRSERVER] 
001901=192.168.0.106

Note: For version 4 the [KeyReader] section defines where Logilicence is running. Use
KeyReader to define the IP address running the LogiLicence service.

4 - Copy this file to all terminals (the workstations, the server, the lanes, etc...) into the L-
BOSS folder for the L-BOSS machines and Poswin folder for the L-POS machines.

5 - Reboot all the PC's.

2.1.10.4 Misc

Misc tabMisc Tab Settings

The "Misc" tab provides several optional settings for the system.
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This example shows the Configuration panel's "Misc" tab.

Gift certificate section: Gift cert.valid for is used to determine the expired date that will be
printed on gift certificates issued by L-POS. Next number is the number that L-BOSS will
assign to the next gift certificate issued by the POS when the POS button is configured to
issue the gift certificate number at the time of sale, rather than using pre-programmed
numbers.

Gift certificate expiration:  
1. If there is no date in the EXPIRATION field in the gift certificate maintenance, AND
there is no setting in L-BOSS for number of days for gift certificate expiration, the gift
certificate will never expire.
2. If the number of days for gift certificate (in the miscellaneous tab of the configuration of
L-
BOSS) is set to 0, the expiration of the gift card (if any) will not be modified when it is
sold. If there is a number in that field L-POS will set the expiration date to the date the
certificate is sold plus the number of days in the configuration field for gift card expiration
days.
3. There is a new flag in the advance set-up (System): "Gift certificate never expires".
This option takes precedence over option 1 and 2.

Printer: The Preview Maximized option is set to on by default, and is used to determine the
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Report application's default Report Viewer window size. When selected, reports open "Full
Screen". When not selected, reports will open without using the entire screen area. Re-Init
Printer: Some printer drivers do not re-initialize the printer between print jobs. For example,
this means that if a previous print job was printed in "Landscape", the next job will also print
that way unless the printer is reset. Select this option to force the printer driver to re-initialize
to default settings for every print job it receives from L-BOSS. The Default selection is used
to define that reports will be directed to the default windows printer. If you prefer using a
different printer for reports press the Select button and choose the printer. Note that you can
set a specific printer for any report that will override the settings you make here. Refer to the
report properties set-up for information on how to set a different printer for a specific report.

Time Clock
Enabled: Select this to use the Time Clock system.
Configuration: This calls the Time Clock Settings application.

Cost / Price Calculation: 
This option determines how the Maintenance application will calculate prices from the cost.
Selecting  Markup / % of cost uses the number indicated in the Price tab's price calculation
field as the percentage of the cost to add on top of the cost to obtain a retail price. The 
Margin / % Profit setting uses the number indicated in the Price tab's price calculation field
as the target profit margin, which is the profit per sale divided by the total sale. 

For example: An item costs $1.00, and the item sells for $1.50.
The Markup is $0.50 or 50% of the cost.
The Margin is the profit ($0.50) expressed as a percentage of the total sale, or 33% of the
selling price. 

NOTE: It is important to remember that if you change this setting, you must close the
Maintenance application before the changes will take effect.

Allow duplicate alias: Set this flag if you want to call up several different items in a list by
typing in one PLU number. For example, you sell single muffins and six packs of muffins. In a
situation where the single is taxable but the 6-pack is non-taxable the duplicate alias will work
well for you. You would create the single muffin and the 6 pack muffins as 2 different
products. Assign a common Alias code to each item. When the common Alias code is
entered on the POS terminal a list will appear with the 2 muffin choices.

Process returns as payments: L-BOSS uses this flag to process a negative charge as a
payment. Allowing this behaviour means a customer who bought something two months ago
would not be charged any interest if he returned something this period. Do not select this flag
and L-BOSS will process the return as a negative charge in the period where it was entered.
That way you will still collect the interest on the oldest outstanding invoices when the interest
calculation is performed again.

Auto Declare: The Auto declare option should be set to on if cashiers or other management
personnel do not declare drawer amounts manually. When set to on, the system will force
the declared amounts to be the same as the in drawer amounts collected by the system.
This way, reports will balance by showing the in drawer amounts as the actual declared
amounts, leaving no Over / Short. When the Auto declare is not set to on, reports will show
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Over / Short amounts, and the report will not balance until the manual declaration of in drawer
amounts is performed from within the Entry module's Pickup and Loan option. Please see
the Entry module's help section in this manual for more about using pickups, loans and
manual declarations

Restore hints: Use this button to reload the hints provided for the L-BOSS system.

2.1.10.5 Comm

Comm Tab Settings

Head office data communications

In some situations it is necessary to transfer files from the POS system in a store to a central
location for further processing. The L-BOSS communication method and set-up is defined
under the Comm tab. By default no communication is defined. Refer to the L-Remote section
of this guide for further help on remote communications.

The Comm tab includes a flag related to Multi-store account balance. It is important that this
flag be set properly to reflect how you want to handle charge account balances. Most
customers should use this flag. 

Multi-store account balance
Multi-store account balance
flag IS selected

Multi-store account balance
flag is NOT selected

Can I make account
adjustments at Head office
using L-BOSS Maintenance

YES NO

Can I make account
adjustments at Stores using L-
BOSS Maintenance

NO YES

Can I print statements at Head
office

YES NO

Can I print statements at store NO Yes
Is my account balance
identical at Head office and all
stores

YES NO

Can I pay off my account
balance for all stores at any
store

YES NO

NOTE: It is important to make the correct setting for the account balances to flow properly.
When you decide NOT to select multi-store account balances only the charges made at a
local store will appear on the statements printed at that store. The head office system cannot
contain different balances for each store in its database. So if you choose not to use the
Multi-store account balance flag you must print statements at each individual store and ignore
the account balance at the head office. It cannot be used.
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2.1.10.6 Cleanup

Cleanup Tab Settings

As the L-BOSS / L-POS system functions, it is constantly adding data to the report tables,
and creating log files. After months of use, these tables become quite full, and some of the
information within may not be essential to keep. Cleaning up the tables and log files promotes
system efficiency, and should be carried out on a regular basis.

L-BOSS is usually set to "cleanup" data automatically based on scheduled events in the
Events / Tasks list, and pre-set times declared in this tab. Most of the options are set by
default to reasonable values for a normal installation.

This example shows the Configuration panel's "Cleanup" tab.

Number of days to keep individual terminal
This is the number of days to keep individual terminal item sales. Past this number of days,
the data from all lanes is consolidated into lane 001 (This process is done daily)

Number of days to keep successful log
This is the number of days to keep successful communication log (LO). Please note that the
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LOG files MUST be kept small. (This process is done daily and affects the log_tab.)

Number of days to keep all log
This is the number of days to keep all communication log (LO). Please note that the LOG
files MUST be kept small. ((This process is done daily and affects the log_tab.)

Number of days to keep processed files: This is the number of days to keep the
processed files and the journal files. Past this number of days, the processed files @Office
\Processed\Sales are zipped to the @Office\Archived directory, and the journal files @Office
\Journal to the journal directory. Archived journal files can be viewed with the EJ program
without any restriction. This does not affect any table. 

Number of days to keep daily sales information: This is the number of days to keep the
DAILY sales information. Past this number of days the daily information is deleted from
RPT_ITM_D, RPT_CLK, RPT_HOU, RPT_SUB and RPT_DPT. This cleanup is executed as
part of the Monthly_Maintenance.sql command. Monthly maintenance executes once every
month. This means a setting of 60 days will retain up to 91 days of data before the cleanup is
run.

NOTE1: The weekly, monthly and yearly sales information is never deleted.
NOTE2: The larger the files are, the slower the system will be.

Number of days to keep financial daily sales information
This is the same as above, except this is related to the FINANCIAL daily data only. (This
process is done Monthly)

Number of days to keep PLU items per customer
This is the number of days to keep the PLU movement per customer. To use this option you
must purchase the preferred shopper option and select the check box beside Active. Past
this date the data is stored in weekly , monthly and yearly totals.

Keep log of all exports in the processed directory
This option is used to keep a copy of each file exported from the L-BOSS system to the
targets, such as price changes, account data, and all other data sent from the L-BOSS.

2.1.10.7 Load Files

Load Files Tab Settings

During the first time set-up of L-BOSS a basic screen / keyboard profile was selected to use
the software. The database tables with screen layout, function lists, etc. were all created in
the system. If you need to load a second profile or reload the original set-up, select the Load
files tab.
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This example shows the Configuration panel's "Load Files" tab.

The screen is split in two. The choices on the bottom refer to the default screen layout and
function files that the L-POS terminals can be loaded with and some sample product files.
Select the profile that you want to load and then press the Load selected files button to
execute the load.

Once the required load files have been loaded, they will show up on the top part of the
window in the Load file tab. The top area of the window only displays a list of the files that
have been loaded into the system. If you need to reload a set of files, you need to select it
again by clicking on that file in the bottomof the window. No action can be executed on a file
on the top list, it is only there as an audit trail of what has been loaded.

The program will begin importing the load files you chose and building the database once you
press the OK button. When it is time to create the front-end function lists, you will be
prompted for the target register group. Unless you are installing both touch screen and
keyboard in the same store, you should accept the default PAL target. If you need to install
the 2 different register set-up files, enter a target group for the keyboard version (P01) and
when you are prompted enter a different target group for the touch screen set-up files (P02).
You will need to create the registers and the target group once the system is installed. This is
explained in the installation help. After you have designated the correct target for the screen
and function load, the remaining files will be imported and the program will be ready to
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operate. 

NOTE: You should not use the Load files option unless you want to reload the initial set-up
files and destroy all the data entry (sample files) and screen modifications (Keyboard
800X600, Touch 800X600). If you think you need to use these files in a live installation
please back up your data first because it will be overwritten.

2.1.10.7.1  Load 2 different screen groups from sample data

You may want to load the sample screen for touch and also the sample screen for keyboard
into the same system. Follow these steps.

Create the KEB and TOU targets on the terminal list and set the Program flag. Refer to the 
Register > terminals section for more help. 
Associate the POS terminals to KEB and TOU targets.
Your target list will look something like this, our example has 2 POS terminals.

If you have existing screen data that you want to keep:

Open PosSetup from the L-BOSS>Modules menu.
Open the Groups menu.
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You need to associate the functions data to KEB and TOU targets.
1. In the right had window select the KEB target. No file types will be selected.
2. Place a check mark beside Functions. You will be prompted to select source data. If your

existing data is the keyboard set-up select PAL. This action will copy all existing data
from the PAL target to the KEB target. If your existing data is the touchscreen set-up
select NONE because you do not want to copy the touch data to the keyboard target.

3. In the right had window select the TOU target. No file types will be selected.
4. Place a check mark beside Functions. You will be prompted to select source data. If your

existing data is the touch screen set-up select PAL. This action will copy all existing data
from the PAL target to the TOU target. If your existing data is the keyboard set-up select
NONE because you do not want to copy the keyboard data to the touch target.

5. Select the PAL target in the right hand window pane.
6. Remove the Check from Functions. This will remove the PAL records from the screen

related files.

Now you have a system with data for EITHER touch OR keyboard. You still need to import
the data for the other file type.

1. From L-BOSS configuration menu select Load files.
2. From the lower window select either the Keyboard or Touch screen layout you want to

use.
3. When you press the Load selected file the system will prompt you for a screen target. If
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you are importing the keyboard data enter KEB. 

4. If you are importing touch data enter TOU.

Use the Deploy screens task to send the screen data to the terminals. To send the keyboard
data to the terminals in the KEB target select KEB.  To send the touch data to the terminals in
the TOU target select TOU.

If you have existing screen data that you want to delete:
1. Create the KEB and TOU targets as explained above.
2. Open the L-BOSS>File>Execute command file window.
3. Execute the Erasescreen.sql command. Now you have no screen related data.
4. From L-BOSS configuration menu select Load files.
5. From the lower window select either the Keyboard layout you want to use..
6. When you press the Load selected file the system will prompt you for a screen target.

Enter KEB. 

 
7. From L-BOSS configuration menu select Load files.
8. From the lower window select either the Touch screen layout you want to use..
9.    When you press the Load selected file the system will prompt you for a screen target.
Enter TOU. 
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Use the Deploy screens task to send the screen data to the terminals. Select KEB to send
keyboard setup or TOU to send Touch data.

2.1.10.8 Security

Security Tab Settings

Security System Overview

The Back Office System Software offers a security level system to restrict access to most
functions, database tables and configuration type information. In some situations, such as a
single owner-manager L-POS / L-BOSS setup, or if the PC that runs the back office is in a
locked room, you may not need to use the security system. In most cases however, the PC
station that runs L-BOSS (or networked L-BOSS stations) is accessible to any passer-by.
This means that your data and system configuration is open to possible damage. 

The security system is based on access levels that are assigned to users. There are eight
(8) levels, starting with level 0, called "no user", up to level seven (7), called "programmer".
Assigning the "no user" level to an option or utility means that anybody can access it. Once a
security level is assigned to a function, option or data table, the system verifies the logged in
user to make sure that they have access rights. If the user does not have access rights, the
system opens a login panel.

Below is an example of how the security levels might be set.

Level 0: No User - locked,  the default security level when L-BOSS is launched
Level 1: New User - able to access certain tables only, for example items, departments etc. 
Level 2: Cashier - access to items, departments and other functions that a cashier would
require
Level 3: Clerk - receive, modify, view certain reports 
Level 4: Assistant Manager - access and modify items, departments. Access to reports
Level 5: Manager - Access, Modify, Add / Delete, no access to network and programming
features
Level 6: Owner - Access, Modify, Add / Delete all except programming features
Level 7: Programmer - complete access

Essentially, there are two steps to follow to implement the security system:

First: Establish the minimum security level required to access each of the system
functions, options, data tables, and configuration files listed in the Security Tab of the
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Configuration Panel. 
Second: Associate each operator in the operator table with a security level.

Remember that this is the MINIMUM level required. A user with a higher access level has
access to all levels below.

Establishing access levels

The System tab displays a list of data tables, utilities and setup information. The list has four
(4) columns:

column 1 - the name or description of the option to protect.
column 2 - "Access" - the minimum security level required to access the option.
column 3 - "Modify" - the minimum security level required to change data or settings.
column 4 - "Add / Delete" - the minimum security level required to add or remove data.

This example shows the Configuration panel's "Security" tab.

To assign security levels:

Start by assigning security levels in the "Access" column. 

Select an option or table from the "Access" column by clicking on it.



L-BOSS User Manual 4.1.364

© 2001-2014 ... Logivision

Right click or double click to open a list of security levels.

Choose the minimum security level required to access the selected option.

Once a security level is associated with accessing an option, continue by associating
minimum security levels to the "Modify" and "Add / Delete" columns of the option. For
example, you may want to allow a cashier to have access to view items, but not modify, add
or delete them from the system. Once the required access level to items is set to "Cashier",
assign the security level required to "Modify" items, then the level required to "Add / Delete".

If an option requires a high security level to access it you may not have to bother assigning
security levels to the "Modify" or "Add / Delete" columns, since a user must have access to
an option before they can modify, add or delete it.

Once the required security levels have been assigned to options or data tables, the last step
is to associate a security level to each operator in the system. For help on assigning security
levels to operators, click here to go to the Operator Table help page now.

NOTE: If you are using the security system, be sure to use the "logout" option to sign off the
system when leaving the work station, leaving the application on the "no user" security level.
L-BOSS will still execute any scheduled operations, including polling or other
communications, even if no user is logged.

Time of inactivity before auto log off should be set if your store personnel forget to log off
the system and different users have security levels that need to be monitored. Leaving the
setting at 00:00 means that no auto log off will be executed.

2.1.11 Send urgent message to L-POS

Send urgent message to L-POS: Use this setting to send a copy of urgent messages
received by the Main message center to the terminal defined as the second message center.
Selecting this menu option acts as a toggle to activate the second message server (when the
check bar is set) or to turn it off, when the check box does not appear.

2.1.12 Date Conversion

Calendar and Date Conversion Utility

It is important to note that if you open the Windows Date utility by double clicking the System
date / time icon (usually at the bottom right of the windows desktop) and change the month
displayed, Windows changes the system date even if you haven't pressed "OK" or "Apply". If
L-BOSS is running, it immediately displays a warning message, then closes. This is because
L-BOSS is constantly checking the system date / time to see if any "Events" or "Tasks"
should be performed. If the application did not close, it would want to execute events for the
new date / time, possibly adversely affecting the data.

The L-BOSS "File" menu provides a calendar utility called "Date Conversion", useful for
verifying past or future dates when working within L-BOSS. The utility also provides a date
format converter, used to verify dates in less common formats. The date formats described
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below are commonly used by programs internally, because they simplify mathematical date
calculations, making it possible to subtract one date from another. 

This example shows the L-BOSS "File" menu's "Date Conversion" utility.

Julian Date

Some systems use alternate date formats. The Julian date shows the year, followed by the
number of days since the beginning of the year. This format is used in SIL data files, so L-
BOSS needs to recognize this format. You probably won't need to use this format.

Unix Date

This is the date format used internally by PC's. It is the number of days since December
31st, 1899.

2.1.13 Messages

The Messages Utility

Logivision 's Back Office System Software and POS softwares are designed for network use.
In some cases, such as larger installations, there may be several L-BOSS stations, such as
a reception area, price control station, and manager's station. The message utility provides a
quick online messaging method between L-BOSS stations and L-POS stations, convenient
for communicating from the front to back end of a store.
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This example shows the L-BOSS "File" menu's "Messages" utility.

Using the Messages Utility

To send a message to another L-BOSS station or L-POS station, select the "Messages"
option from the "File" menu. The Messages utility window opens, with options buttons across
the bottom of the display. The main window area is for viewing messages only. To send a
message:

Click the "Send" button to open the message edit line.

After entering a message, press the "OK" button to proceed.

A new panel appears, waiting for the destination for the message.

In the destination panel, enter the station number to send the message to. (L-BOSS station
numbers are a three digit numbers, usually starting with 901 as the main back-end station.
L-POS lanes are usually numbered starting at 001.)
You can also enter "ALL" to "broadcast" the message to all stations that are currently
online.

The "Reply" button is normally "grayed out", except when the station receives a message
from another station. Use the reply button to return an answer to the sending station.

The Previous / Next buttons are used to review messages that have been collected and
stored in the system.
The Delete button is used to remove messages that you do not want to keep for future
reference.

2.1.14 Show Tips

Show Tips - L-BOSS File menu Option

Show tips is used to display helpful tidbits of information that we expect will make your usage
of L-BOSS more enjoyable. Selecting this option opens a Windows style "hints" window.
Once open, you can browse through the hints, or configure the hints panel to open every time
you launch the L-BOSS application, handy for new users.
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2.1.15 Exit

Exit the L-BOSS Application

The Exit menu option closes the L-BOSS application. On closing, the application opens a
warning message to let you know that if you close the application, the back office will not
be available for communications or scheduled events. Only shut down the application if
you are sure that this will not affect the normal store operations.

Exit: Use this option to close the L-BOSS application. Other programs such as Maintenance,
polling, and other sub-applications will also be terminated. Whenever you choose the Exit
button, L-BOSS warns you that closing the application will terminate the communication with
the registers. This is a normal warning but several issues should be considered before
terminating the L-BOSS program.

When L-BOSS is not operating, the sales data from the POS terminals is not
processed. The data does continue to accumulate on each lane. When L-BOSS is re-
started, the data is transferred to the back-office and the report system is brought
back up to date without user intervention.
Customer account balances cannot be retrieved when L-BOSS is not operating.
Charge sales can be posted and the account data will be transferred and posted
when the L-BOSS system is restarted. No store credit limit, etc. is verified.
No reports can be requested on the front end terminals if L-BOSS is not operating.

Floating cashiers have totals that are retrieved from the L-BOSS machine whenever a
floating cashier logs on. The floating cashier balances are not available when the L-
BOSS Controller is unavailable.
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2.2 Modules Menu

Modules Menu Options

The Modules menu option is used to open other applications available from L-BOSS. These
include:

Pickup This choice will open the pickup screen. Pickups are also available directly from the
Entry main menu.

Safe balancing This choice will open the safe (or office) balancing application.

GL Export This option opens the general ledger export program.

Maintenance: This is the database information editor / viewer. It is used to maintain
database tables; items, operators and other system information.

Reports: L-BOSS includes tools to generate, view and print reports, lists, labels etc. It also
includes access to the report configuration settings.
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PosSetup: Common configuration of front end stations; screens, peripherals etc. Use the L-
POS help file link to access help on the Pos Setup application. The Poshlp.chm file can also
be opened individually from the L-BOSS folder or from the lane's Poswin folder. A printable
(pdf) is also available.

Entry Module: Receive / Order merchandise, fix inventory quantities etc.

Events Tasks: The Event / Task launcher, scheduler. Help on Events/Tasks.

View Logs: View system events, system in / out boxes contents, etc.

Monitor: This utility allows L-BOSS to view L-POS transactions as they occur, used to
monitor cashiers. Help with Monitoring

Journal (or Tracker): Displays the actual sales information from the front end L-POS
stations in sales journal format. The EJ also includes poweful search and review functions.

Time Clock manager: This opens the Time Clock manager panel used for making
adjustments.

L-BOSS Desktop Icon shortcuts

Several of these menu options have corresponding icons on the L-BOSS desktop. You can
limit access to these applications or utilities using the security access. For help on
configuring the security system see the Security help page.

NOTE: Although the modules appear and are launched under this menu, their help pages are
not necessarily described under this heading, but are listed in the root of this help manual.

2.2.1 Cashier Pickups & Loans

The back-end pickup option is fed by transactions done on the POS or on the back office menu. The
Pickup module allows you to record loans, pickups and post declared amounts for specific cashiers. The
safe balancing program is useful to track changes to the funds contained within the office safe. It carries
an opening balance, allows withdrawals and deposits and monitors the loans and pickups made to
cashiers. The end-of-period declaration produces an over-short variance that is visible on store financial
reports.

Installing the option
The back-end pickup module is included with the Entry module. The default L-BOSS installation creates
the menu options to use the Pickup module and the Safe balancing option. This manual explains how to
use the pickup function on both the back-end or on the POS. Entering a pickup or loan on the POS
terminal may require changes to your POS keyboard or to the touch screen layout. It is not the purpose
of this manual to explain how to create the pickup or loan buttons on the POS. Refer to the Pos Set-up
help guide for that type of information or consult your dealer. 

License required
This option requires activation on the license key. Verify with your dealer to know if you have purchased
this option. The option called pickup also allows access to the safe balancing program.
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Security settings
Security is set through the L-BOSS configuration menu, from the security tab. There are separate
security settings for pickup and safe balancing.

Set the user level required to use the program.

2.2.1.1 Balancing type

Several balancing types are available: cashier balancing, terminal balancing or drawer balancing. The
system cannot use more than one balancing method in the same store. So you need to evaluate the
set-up options to make the correct choice for your installation.

Cashier balancing
L-POS will track the drawer related information by cashier. Cashier balancing is the default method so
no set-up changes are required.

Terminal balancing
Use this option to track drawer related totals by terminal. This means that the loans, pickups, declares,
in drawer and over/short information will be tracked for each terminal but not for individual cashiers. 

Selecting the terminal balancing option
The Terminal balancing option is selected from PosSetup | System | General tab | Balancing by field.
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This is a one-time set-up that MUST be executed at the POS station. The information is recorded into a
file stored locally on the POS terminal. Although PosSetup can be executed from the back-office menu
the required settings will not be sent to the POS terminal.

1- Select Terminal from the pull-down list in the Balancing by field.
2- The system already shows the Store number, terminal number and may or may not display a

Lane #. You must set the Lane #  to match the virtual cashier number you created in operator
maintenance.

3- This change MUST be made directly on the POS terminal. The setting is not available from the
back-end.

Once you have completed the changes and sent the virtual cashier records to the POS you are ready to
begin balancing by terminal. Sign on using the normal method by entering the operator number and
password for the operator working on the terminal. 

If you see the error "Balancing terminal/drawer number not found" it means the number you entered in
the Lane # field does not match with any of the virtual cashier records, or the virtual cashier records
were not sent to the POS terminals (use the task "Deploy all changes".)

If you see the error "Balancing terminal/drawer number must have a level of 0" it means the number you
entered in the Lane # field is not using security level 0. Modify the level number field for each of the
virtual cashier records you created and deploy the changes to the POS terminals.

Create virtual cashiers for terminal balancing
When you select balancing by terminal you will need to create several virtual cashiers. L-POS uses
these virtual cashiers to record the balancing totals for all transactions done on the particular terminal.
The cashiers are added to the system under the L-BOSS | Maintenance | Register | Operators menu:
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1. Use the  icon from the tool-bar. You must create one virtual cashier record per terminal. So
if you have 4 terminals you will need to create 4 extra cashier records. We recommend using
operator numbers 1111, 2222, 3333 etc. This is not compulsory. These numbers cannot be
used as cashier id numbers for other operators.

2. Do not set any password for these operator records.
3. The print name and first name should say Terminal 1 for L-POS lane 1. 
4. You must set the Level field to 0 (zero.)  
5. The other fields are not used so they do not need to be entered.

Drawer balancing
Use this option to track drawer related totals by drawer. This means that the loans, pickups, declares, in
drawer and over/short information will be tracked for each drawer but not for individual cashiers. This
option is sometimes required when cashiers need to be balanced more than once per day with separate
totals, as in the case of split shifts. Drawer balancing is not related to using a dual cash drawer system.
The dual cash drawer system is used with the normal cashier balancing system. The drawer balancing
option will prompt the operator who signs on to enter a drawer number. This number is assigned to the
physical tray the operator was given for the current shift. These drawer numbers need to be created in L-
BOSS operator maintenance.

Selecting the drawer balancing option
The Drawer balancing option is selected from PosSetup | System | General tab | Balancing by field. This
is a one-time set-up that MUST be executed at the POS station. The information is recorded into a file
stored locally on the POS terminal. Although PosSetup can be executed from the back-office menu the
required settings will not be sent to the POS terminal.
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1- Select Drawer from the pull-down list in the Balancing by field.
2- This change MUST be made directly on the POS terminal. The setting is not available from the

back-end.

Once you have completed the changes and sent the virtual cashier records to the POS you are ready to
begin balancing by drawer. Sign on using the normal method by entering the operator number and
password for the operator working on the terminal. Now you will be prompted to enter the “drawer”
number the cashier is using. This is the number you have assigned to the cash drawer insert tray given
to the operator for the current shift.

If you see the error “Balancing terminal/drawer number not found” it means the “drawer number” you
entered does not match with any of the virtual cashier records, or the virtual cashier records were not
sent to the POS terminals (use the task “Deploy all changes”.)

If you see the error “Balancing terminal/drawer number must have a level of 0” it means the drawer
number you entered is not using security level 0. Modify the level number field for each of the virtual
cashier records you created and deploy the changes to the POS terminals.

Note: The interface to the TEC Electronic Cash Registers only supports Cashier balancing.

Create virtual cashiers for drawer balancing
When you select balancing by drawer you will need to create several virtual cashiers. L-POS uses
these virtual cashiers to record the balancing totals for all transactions done with the particular drawer
(or cash drawer tray insert.) The cashiers are added to the system under the L-BOSS | Maintenance |
Register | Operators menu:
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6. Use the  icon from the tool-bar. You must create one virtual cashier record per cash drawer
tray insert. So if you have 20 tray inserts you will need to create 20 extra cashier records. We
recommend using operator numbers that fall outside the normal range of operators. This is not
compulsory. These numbers cannot be used as cashier id numbers for other operators.

7. Do not set any password for these operator records.
8. The print name and first name should say Tray 9901 if you have labeled the tray 9901.
9. You must set the Level field to 0 (zero.)  
10. The other fields are not used so they do not need to be entered.

2.2.1.2 Pickup forms for POS

Creating pickup buttons and forms for detailed receipt print

L-POS version 3.0.1.0 and greater allow you to set up the pickup function to print a detailed pickup slip.
This slip can contain the information for the quantity of each coin and paper bill denomination to make it
easier to balance the cashier's deposits. This is not the only way to set up the system, you can define
many different screens to accomplish the POS pickups .

Why are you doing this?

The cashier presses the Pickup button to start the pickup. This will load a PICKUP form with the
different tender types you want to pick up. This pickup form will NOT have the cash tender function. It will
have a LOAD FORM function that loads another form to enter the CASH PICKUP. In our example form
23 is the PICKUP TENDERS screen and form 20 is the PICKUP CASH screen.
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So the entries for all tenders except CASH are made on one form (23) and all Cash entries are made
from form (20).

The TENDER PICKUP form 23 has a button called BEGIN CASH PICKUP. The button uses the Cash
function to advise L-POS we are entering CASH PICKUP mode. The settings for the BEGIN CASH
PICKUP are explained below. When the CASH entries are terminated the operator presses the BACK
button which returns to the PICKUP form 23 and exits the CASH PICKUP mode. The BACK button also
produces a printed subtotal for all the cash picked up.

Creating a Cash pickup form 
We have programmed our pickup button to execute the pick-up function 8053 and set the SWAP
function to +23 to load FORM 23. Form 23 is the first pickup screen in our example. It allows pickup
entries for all tender types except cash. Of course our example may not have all of your payment keys,
they would need to be added by a qualified reseller.

The buttons in the PICKUP TENDERS form are normal tender buttons. The only special button is the
BEGIN CASH PICKUP button.
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The [Begin Cash Pickup] button is used to enter CASH PICKUP mode. Press this button to load the
form with the cash denomination buttons. In our example the POS loads form 20-PICKUP CASH. In the
advanced view of function properties this is entered as /FRM=20. 
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Create buttons for each denomination of coins, bills and rolls
You need to create buttons to pickup each denomination or coin and bill in the drawers. You can also
create buttons for the different coin rolls that need to be picked up. The description from the button key-
top is what will be printed on the pick-up slip. If you want to use an image on the key-top you still need
to assign the text that will print on the receipt. For example, create a button called 5¢ to pick up the 5
cent coins. Create a button called 40 * 5¢ to pickup the rolls of 5 cents, etc. Of course these buttons will
use the Cash function. Set the calculation field of this Cash function to .05. To allow multiplication of the
entries to the 5¢ button you need to insert the multiply function before the Cash function.

Here is how to set up the 5¢ button:
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The multiply function has no special parameter settings.
The CASH function has these parameters set:
/CLC=.05 (this is .05 in the Calculation field.)

Create the buttons for each coin and bill denomination you can pick up. Then you need to create the
button that will end the CASH pickup and return to the normal Pickup tender screen where you can
continue or finalize the pickup transaction.
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The button is called BACK in our example because it goes “back” to the main pickup form number 23.
This button uses the CASH function 101. Set the parameter "Pickup form" to the form you created for
the CASH type pickups. In our example this is form 20. This will terminate the cash portion of the pickup
and print a subtotal line for the cash picked up.

From there you can continue the pickup of other tenders or press Pickup to terminate. On the Pickup
Tenders form 23 you need to place a PICKUP function to exit from the pickup. In our example this button
is called Pickup End.
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The Pickup End button uses the PICKUP function 8053. In the Pickup end button we set the SWAP
parameter to +11 to reload the normal department screen (form 11 in our working example.)

Transaction sample

[PICKUP]
Amount [Tender 1]
Amount [Tender 2]
 [Begin Cash Pickup]
12 [ 1¢ ]
15 [ 5¢ ]
6 [ ROLL 10¢ ]
[BACK]
[END PICKUP]

Receipt sample

              L-POS
 POS SOFTWARE THAT UNDERSTANDS YOU...
    ...FROM PEOPLE WHO UNDERSTAND POS
17/03/2008 3:03:14 PM              Carol

Pick up                                 
Debit card                    $59.99    
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Credit card                  $147.88    
Food stamp                    $25.00    
Cash                                    
122 X 1¢                       $1.22    
15 X 5¢                        $0.75    
47 X 10¢                       $4.70    
23 X 25¢                       $5.75    
3 X ROLL 1¢                    $1.50    
12 X $1                       $12.00    
3 X ROLL 5¢                    $6.00    
2 X ROLL 10¢                  $10.00    
2 X ROLL 25¢                  $20.00    
ROLL $1                       $25.00    
2 X $50                      $100.00    
Cash SUB TOTAL               $186.92    
----------------------------------------
Pick up                      $419.79    
Trans:34464    Terminal:030001002-003001

You can become a Preferred Shopper today!
     Please ask for information at
          our courtesy booth.

         THANK YOU & COME BACK

2.2.1.3 Backend transactions

Entering back-end pickups, loans & declares

Use this option to perform pickups and loans from the "back end", that is to say from an L-BOSS
station. Entries made here are used to compile the financial information used and viewed in the reports,
such as end of day, financial and cashier reports.
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Select "Pick up" from the Entry application's "Module" menu to access the Pickup module. The pickup,
loan and declare screen will appear. A sample screen shot is displayed above. The screen has several
tabs. The default View tab displays information that has already been entered. These amounts cannot
be edited by the user. The Loan, Pickup, and Declare tabs are where the operator makes new entries.

2.2.1.3.1  Loans

Loans
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Use “loan” to give money to an operator. This is often the “float” amount the cashier is given to have
enough change at the start of her shift. Some stores do not use the Loan function. They prefer to
always consider the float as a constant; it is neither entered into the system nor considered when the
cashier's money is counted at the end of day. Loans can be made on the POS terminals or on an L-
BOSS workstation.

1- From the Pickup screen select the cashier who will receive the loan.
2- Select the transaction date.
3- Select the Loan tab.
4- Enter the loan amount in the New entry column on the row that corresponds to the tender type.
5- Press the [Post] button.

Note: To correct an entry you have made you need to make a new entry using the negative sign. You
cannot delete an entry that has been posted.

2.2.1.3.2  Pickups

Pickups
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Use pickups to collect money from the operator. Pickups can be made on the POS terminals or on an L-
BOSS workstation.

1- Select the cashier to collect money from.
2- Select the transaction date.
3- Select the Pickup tab.
4- Enter the loan amount in the New entry column on the row that corresponds to the tender type.
5- Press the [Post] button.

Note: To correct an entry you have made you need to make a new entry using the negative sign. You
cannot delete an entry that has been posted.

2.2.1.3.3  Declares

Declare
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Use Declare to enter a final drawer amount. This is basically the same as doing another pickup. If there
is nothing to declare you need to enter 0 (zero) into any of the tender totals to produce the over short.

1- Select the cashier to declare the drawer amounts for.
2- Select the transaction date.
3- Select the Declare tab.
4- Enter the amount for each tender type in the New entry column.
5- Press the Post button.

Note: To correct an entry you have made you need to make a new entry using the negative sign. You
cannot delete an entry that has been posted.

Note 2:  All entries made to the pickup system are cumulative. A new entry does not replace a previous
entry, it adds to it. You are allowed to use the negative sign if required.

2.2.1.4 POS pickups and loans

Loans & Pickups on the POS

Loans
1- Press the [LOAN] button on your POS to begin LOAN mode on the POS. 
2- Enter the amount of the first tender type to be loaned.  If you have $150 of cash you can enter

15000 [CASH].
3- Enter the amount of the next tender type to loan. Press the [Tender key].
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4- Press [LOAN] to terminate.

Multiplication entry
You can enter a [QTY]. 
For example if you want to compute 44 times $5.00 enter 44 [QTY] 500 [CASH].

Total for several media entries
You can make many entries for each tender type in the same LOAN transaction. Press the tender key
after the last entry to print a total for that tender type in the transaction.

Pickups
1- Press the [PICKUP] button on your POS to begin PICKUP mode on the POS. 
2- Enter the amount of the first tender type to be picked up.  If you have $450 of cash you can

enter 45000 [CASH].
3- Enter the amount of the next tender type to pick up. Press the [Tender key].
4- Press [PICKUP] to terminate.

Multiplication entry
You can enter a [QTY]. 
For example if you want to compute 44 times $5.00 enter 44 [QTY] 500 [CASH].

Total for several media entries
You can make many entries for each tender type in the same pickup transaction. Press the tender key
after the last entry to print a total for that tender type in the transaction.

2.2.1.5 Cashier balancing reports

Cashier Reports
Several reports are available to help with cashier balancing.

From the L-BOSS menu select the reports menu and open the Cashiers folder. The Cashier sales report
and the Cashier over-short report both contain the information required to view the cashier's payment
data.

Cashier sales
This report lists all information collected for the cashier. It includes the balancing information in a list
where each information type is displayed for each payment type. It shows the amounts received for
sales, the Loans made to the cashier, the pickups received from the cashier, the in drawer amounts, the
declared amounts, and the over-short amounts.

Cashier over – short
The cashier over-short report is a quick view of the balancing information only for each cashier.

2.2.2 Safe balancing

Safe balancing
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Sample screen

2.2.2.1 Set-up the module

A few settings for the Safe balancing option need to be made by editing the C:\L-
BOSS\Office\Shared\SafeBalSetup.ini file. Use a text editor such as Notepad to modify the
file. Modifying the program with a real word processor like Microsoft Word will corrupt the file
contents and make it unusable by L-BOSS. 

You can return to the system default values by deleting the SafeBalSetup.ini file. The system
will reinitialize that file to the default distributed with the software.

You will have a few general system settings to define

You need to define which tender functions are displayed in the safe balancing module.

You need to define the accounts that you can pay amounts to (expenditures) or accounts
that you can receive money from (revenues).
You need to define which tender functions can be used for miscellaneous expenditures

You need to define which tender functions can be used for miscellaneous revenues.

You may need to correct the report formulas on some totalizers if you have updated from
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an old version of L-BOSS.

2.2.2.1.1  General settings

Edit the C:\L-BOSS\Office\SHARED\SafeBalSetup.ini file 

[General]
IsWorkstation=0
ButtonWidth=125
ButtonRows=4

IsWorkstation=0 means Safebal is running on the L-BOSS server. Set this value to 1 to run on a work-
station.

ButtonWidth=125 is the default setting for the width of the buttons on the miscellaneous revenues and
expenses tables. This key may not be present in the file because the system will use a hidden default
value of 125. To change the button width, add the key in the General section and specify the width you
want for your buttons.

The ButtonRows value is used to specify the number of rows the system will use on the miscellaneous
expense and revenue tabs.

2.2.2.1.2  Tender totals

You must assign special values to the tender totalizers to use them in the safe balancing program. You
are responsible to modify the totalizers you will track in the safe. In the first safe balancing screen Cash,
Check, and Foreign currency as show as tender types that can be deposited, paid out, etc. This section
explains how to add the totals you need to the list.
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Access the L-BOSS, Maintenance, Register, Totalizer tab. Locate the tender totalizer you wish to
modify. The tender totalizers are in the range of 101 to 198. A special value must be entered in the
Report formula field. 

1- You need to add SB(1) to the existing data in the report formula field.
2- Repeat this operation for each tender totalizer that you want to use with the safe balancing

module.

2.2.2.1.3  Create Miscellaneous totalizers

Miscellaneous totalizers for revenues and expenditures

You must enter special values on the totals you will use to track miscellaneous revenues or
miscellaneous expenses. For example, if you receive money into the safe from a supplier because if a
rebate deal you would create a total to track that rebate money. An example is shown below.

Open the Maintenance > Register > Totalizer menu option.
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1- Select an existing totalizer not required for your normal operations or create a new totalizer. 
2- In the Files field assign the value FIN.
3- If you are outputting data to an accounting system you must enter the Debit / Credit value (D or

C) and a general ledger account number in the General ledger field.
4- Assign the report section to 3000.
5- You need to add SB(1) to the existing data in the report formula field.
6- Repeat this operation for each miscellaneous amounts received (totalizers 3701-3799) or

miscellaneous amount expenditures (totalizers 3801-3899) that you want to use with the safe
balancing module.

2.2.2.1.4  Adding totals to revenues tab

Miscellaneous revenues form

By default no buttons will appear on the Revenue tab when it is accessed. You can place as many
buttons as required to affect specific GL accounts and payment types.
Edit the C:\L-BOSS\Office\SHARED\SafeBalSetup.ini file. 

And find the [RAButton] section header. You need to define the number of buttons and define each
totalizer you want to use. Here is a simple entry that will display 3 buttons that use totals 3701, 3702
and 3703.
[RAButton]
ButtonCount=3
Tlz1=3701
Tlz2=3702
Tlz3=3703

ButtonCount=x is the number of buttons that will appear on the Revenues form.
Tlz1 is the total to use for button 1.
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Tlz2 is the total to use for button 2. Etc.
N.B. If you set the system to use 14 buttons, but you only define Tlz1 to Tlz5, the system will repeat the
Tlz5=xx value for all the Tlz values you did not assign.

You also need to define which payment functions can be used with the miscellaneous revenues. This is
done by editing the section called:
[RAButtonTender]
ButtonCount=5
Tlz1=101
Tlz2=102
Tlz3=103
Tlz4=104
Tlz5=105

ButtonCount=x is the number of buttons that will appear on the Revenues form.
Tlz1 is the total to use for button 1.
Tlz2 is the total to use for button 2. Etc.
N.B. If you set the system to use 14 buttons, but you only define Tlz1 to Tlz5, the system will repeat the
Tlz5=xx value for all the Tlz values you did not assign.

2.2.2.1.5  Adding totals to expense tab

Miscellaneous expenses form

By default no buttons will appear on the Expense tab when it is accessed. You can place as many
buttons as required to affect specific GL accounts and payment types.
Edit the C:\L-BOSS\Office\SHARED\SafeBalSetup.ini file. 

And find the [POButton] section header. You need to define the number of buttons and define each
totalizer you want to use. Here is a simple entry that will display 3 buttons that use totals 3701, 3702
and 3703.
[POButton]
ButtonCount=3
Tlz1=3701
Tlz2=3702
Tlz3=3703

ButtonCount=x is the number of buttons that will appear on the Expenses form.
Tlz1 is the total to use for button 1.
Tlz2 is the total to use for button 2. Etc.
N.B. If you set the system to use 14 buttons, but you only define Tlz1 to Tlz5, the system will repeat the
Tlz5=xx value for all the Tlz values you did not assign.

You also need to define which payment functions can be used with the miscellaneous expenses. This is
done by editing the section called:
[POButtonTender]
ButtonCount=5
Tlz1=101
Tlz2=102
Tlz3=103
Tlz4=104
Tlz5=105
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ButtonCount=x is the number of buttons that will appear on the Expenses form.
Tlz1 is the total to use for button 1.
Tlz2 is the total to use for button 2. Etc.
N.B. If you set the system to use 14 buttons, but you only define Tlz1 to Tlz5, the system will repeat the
Tlz5=xx value for all the Tlz values you did not assign.

2.2.2.1.6  Safe balancing totalizers

Safe totalizers
The L-BOSS includes a range of totalizers related to safe balancing. These are totalizers 2001-2599. In
older versions of L-BOSS the safe balancing totalizers did not have the report formulas or groups defined.
If you have updated from an older version of L-BOSS to version 2.2.1.0 or greater it is possible that the
totalizer formulas do not exist. You will need to edit the totalizer table manually to insert the totalizer
formula and group settings. Follow this pattern for each of the totalizers you use on your safe balancing
system:

Safe open totalizers
Each total in the 2001-2098 range should be set up as follows, where the Report formula shows
GROUP(2099, F65) and the Report section shows 2000.

Safe receive totalizers
Each total in the 2101-2198 range should be set up as follows, where the Report formula shows
GROUP(2199, F65) and the Report section shows 2100:
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Safe deposit totalizers
Each total in the 2201-2298 range should be set up as follows, where the Report formula shows
GROUP(2299, F65) and the Report section shows 2200:

Safe close totalizers
Each total in the 2301-2398 range should be set up as follows, where the Report formula shows
GROUP(2399, F65) and the Report section shows 2300:
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Safe declare totalizers
Each total in the 2401-2498 range should be set up as follows, where the Report formula shows
GROUP(2299, F65) and the Report section shows 2400:

Safe over/short totalizers
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Each total in the 2501-2598 range should be set up as follows, where the Report formula shows
GROUP(2599, F65) and the Report section shows 2500:

2.2.2.2 Safe transaction entries

The term safe and office may both be used in this document as reference to the safe totals. The office
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transactions include:

Use the Recv (+) tab to add into safe balance (without affecting a specific GL account for the revenue)
Use the Dep(-) tab to remove from safe balance (without declaring a specific reason such as a bank
deposit.)
Revenues adds to safe balance for the revenue account you chose, such as a rebate payment from a
supplier.
Expenses will remove from safe balance for the expense account you select, such as returning found
money to a customer who claims it.
Declare is used to input actual counts against the calculated safe balance.
Safe Close will terminate the safe balancing period and move the closing safe amount to the next period
opening balance.

Computed safe balance
The View screen shows a Balance column. The system computes a safe balance as follows:

Open Balance + Receives + Miscellaneous Receives + Pickups + POS Declares – Loans -
Deposits - Miscellaneous Deposits = Closing balance (or Calculated safe balance)

Safe over/short

When the SAFE DECLARE operation is used:

+ Declared safe balance
-  System Calculated close balance
= Over / Short.

Open balance

The amount in Balance is used as open for next period when the SAFE CLOSE function is executed.
Restrictions: Once the SAFE CLOSE function is executed you can not make any more entries to the
current date or to any previous periods. It is never possible to work on a future date.

Set the Open balance on a new system: 
Select a previous date and use the Declare tab to enter the amount you have in the safe for each tender
type. Do this before any loans or pickups are made for the current date. Then use the SAFE CLOSE
button to set those amounts over to the start of the current period. 

2.2.2.2.1  Making safe transactions

Operations
Open the Safe Balancing program by selecting L-BOSS > Special Menu > Safe balancing.
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Safe balancing form

For each entry you will:

1- Select the date.
2- Press [View] to refresh screen with system data for the date selected.
3- Select transaction type by clicking the required tab.
4- Make data entry.
5- Press the [Post] button to save the entry.
6- Press [View] to view the updated data.

2.2.2.2.2  Receive monies to safe

Receive into the safe
You will need to receive into safe whenever you add money to the safe. Note that money can be added
to the safe using Revenue. tab as well.
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1. Select the Recv(+) tab from the safe balancing main form.
2. The form shows all receives that have been made since the last Safe close.
3. Enter the amount in the New Receive column for each tender type you are adding into the safe.
4. You must press enter to save the amount in the entry field.
5. Press [Post] to record the transaction entry.
6. Press [Refresh] to view the updated data.

2.2.2.2.3  Deposits from safe

Deposit from the safe
Deposit from the safe whenever you remove money from the safe to send to bank. You can also use the
Expenses tab to decrease the amounts in the safe.



L-BOSS Menus 99

© 2001-2014 ... Logivision

1. Select the Dep(-) tab from the safe balancing main form.
2. The form shows all deposits that have been made since the last Safe close.
3. Enter the amount in the New deposit column for each tender type you are removing from the

safe.
4. You must press enter to save the amount in the entry field.
5. Press [Post] to record the transaction entry.
6. Press [View] to view the updated data.

2.2.2.2.4  Miscellaneous revenues

Miscellaneous Revenues received into the safe

You may need to receive into safe for miscellaneous revenue. The miscellaneous revenues allow you to
select a specific revenue type, normally associated with a specific G/L account number. This may be
the case if someone gave you an NSF check, then came to pay it back with some type of transaction
fee. Your system could be configured to receive $300 in cash to the GL account against Bad debt
collection and $15 to a GL account for bad check fees.
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1. Select the Revenues tab from the safe balancing main form.
2. Enter the amount you are putting into the safe.
3. Select the revenue type from the buttons in the middle.
4. Select the payment type you are adding to the safe.
5. Press [Post] to record the transaction entry.
6. Press [View] to view the updated data.

2.2.2.2.5  Miscellaneous expenses paid

Miscellaneous Expenses from the safe
You may need to remove funds from the safe for miscellaneous expenses. The miscellaneous expenses
allow you to select a specific expense type, normally associated with a specific GL account number.
This may be the case if you want to pay someone to sponsor an event, or any other reason.
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1. Select the Expenses tab from the safe balancing main form.
2. Enter the amount you are removing from the safe.
3. Select the expense reason from the buttons in the middle.
4. Select the payment type you are removing from the safe.
5. Press [Post] to record the transaction entry.
6. Press [View] to view the updated data.

2.2.2.2.6  Declare safe balance

Declare
The declare function is used to enter the actual amounts in the safe after a safe count. Enter the amount
on hand into each tender type you control with the safe balancing module.
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1. Select the Declare tab from the safe balancing main form. The system displays the current
balance stored in the totals.

2. Enter the amount you have counted for each tender stored in the safe. 
3. Press [Post] to record the transaction entry.
4. A message will appear confirming the data entry.
5. The Over/short will be the difference between the declared amount and the calculated balance.

The declared amount will replace the amount in the balance column on the View tab as soon as
the data is posted.

Note 1: You may use the declare function as often as required in the period. Each new declared
amount replaces the current “Balance” amount. 
Note 2: The system ignores amounts posted as zeroes. If the safe balance displays an amount that
is wrong it can be corrected by entering the correct balance in the declare column. But when the
balance shows 25.00 and it should be zero you need to make a correction in another column to
correct it. A zero declare is ignored. When the safe balance shows a positive number that should be
zero use the DEPOSIT column or a miscellaneous expense entry to correct it. When the safe
balance shows a negative number that should be zero use the RECEIVE column or a miscellaneous
revenue entry to correct it. 

2.2.2.2.7  Sale close

Safe close
The Safe close function is used to terminate the period and create the opening balance for the
subsequent balancing period.
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1. From the view tab press the Safe close button.
2. You will be prompted to confirm the Safe Close action.

N.B. Once the safe has been closed no further transactions are permitted in the current period. 

Open balance
When the SAFE CLOSE function is executed the Balance is used as open amount for next period
(next day).

2.2.2.2.8  Review ing transactions

Reviewing transactions

Transactions made on the safe balancing terminal can be reviewed and printed using the Electronic
journal or L-Tracker programs.

Reports
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The safe balancing information can be viewed or printed by using the Safe balancing report from the
Financial reports folder.

2.2.3 GL Export

Please take some time to read through the help manual to gain insight into how the GL Export
program works. Logivision's documentation and manuals are subject to change as new
software versions become available. Please ask your Logivision dealer about manual
updates.

Logivision has attempted to make this document accurate. Logivision is not responsible for
any direct, incidental, or consequential damages resulting from this documentation or
inaccuracies within. Specifications are subject to change.

L-BOSS export to GL is designed to take summarized transaction data and send the totals to
an accounting system. The export does not transfer each transaction separately. It is an
execution that reads the financial totals from L-BOSS and sends summary data for the
specified totals.

2.2.3.1 Getting started

The GL export program is installed during the installation of the L-BOSS program. This guide
explains how to set up and use the GL export program. It does not explain how to set up a
chart of accounts in your accounting application or notions like debits and credits. It does not
explain all the totals in L-BOSS that need to be posted to have an interface that will balance.
That information should be available from an accountant familiar with your business
operation.

Steps to follow to be able to use the Export to General Ledger module:

Make sure the software option is licensed for use. This should be done by a qualified
agent.
Set the GL account numbers on Totalizers and subdepartments

Set the Export to GL interface type and export location for your accounting software 

Create an event if you need to run the program automatically

2.2.3.2 Setting up the relation to GL accounts inside L-BOSS

You must enter a GL account number on each total that affects the general ledger system.
You will need a list of the chart of accounts from your accounting system. You will also need
to know which totals can be input from the POS system. This would normally be something
your accountant can help you with.

Open the L-BOSS Maintenance application and access the Register menu. Select Totalizers.
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Assign the associated GL account number to each totalizer that affects the GL. Select
whether the amount should be posted as a debit or a credit. Logivision can not tell you which
totalizers need to have a GL account number assigned, nor whether the account is a debit or
credit.

For example, a sales tax amount you collect needs to be posted to a Sales Tax payable
account in the GL system. Locate the account number in the GL system. Enter this number
in the field called General Ledger for that Tax totalizer in L-BOSS. Since this is a Credit
account enter a C in the (Debit/credit) field.

You will need to find each of the totalizers in L-BOSS that can affect your accounting system
and enter the correct general ledger account number and balancing sign, debit or credit.
Totalizers that have a GL account number but no Debit or credit sign are processed as
debits.

If you want to distribute revenues to different accounts you need to assign those revenue
account numbers in L-BOSS. It is done through the sub-department programming screen.
Open the subdepartment file programming menu.
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You need to enter a GL account and the debit or credit value for the sub-department. Most
sub-departments will be entered as C for credit. You may enter the same GL account on as
many subdepartments as you want. If you want to post one single sales total enter the GL
account for revenue on Totalizer 3 (Net sales) and leave the sub-departments blank.

General ledger: Enter the associated general ledger account number. This must be a
number that exists in your accounting system. If you enter a 7 digit GL number in the totalizer
table but your Chart of accounts does not have a 7 digit account number the data transfer will
not balance properly, or will be rejected by your accounting software.

D or C (Debit / Credit): Is this a debit or a credit entry to the GL system? Payments such as
CASH in DRAWER are normally entered as D for debit.

2.2.3.2.1  QuickBooks cross reference f ile

The QuickBooks interface is a little different from others. QuickBooks uses GL account
names, no numbers. Since you cannot enter the general ledger account name in the L-BOSS
totalizer you need to edit a file called QBcrossRef.ini to set reference between the GL
account number entered in L-BOSS and the GL account name.

A sample file is included with the installation:
L-BOSS\Office\GLExport\QBCrossref.ini 
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Here is a sample section of the file:

[GLACCNT]
1000=CASH
9999=CASH:CASH ON HAND
9999=CASH:UNION PLANTERS CHECKING
9999=CASH:UNION PLANTERS CHECKING:CREDIT  CARDS
9999=CASH:PETTY CASH FUND
9999=ACCOUNTS RECEIVABLE CUSTOMER
9999=ACCOUNTS RECEIVABLE CUSTOMER:L-BOSS
9999=A/R
9999=ACCOUNT RECEIVABLE-EMPLOYEE
9999=ACCOUNT RECEIVABLE-EMPLOYEE:PEDRO VAZQUEZ
9999=ACCOUNT RECEIVABLE-EMPLOYEE:J. TORREZ DEDUCTION
9999=ACCOUNT RECEIVABLE-EMPLOYEE:R. NORTHINGTON DEDUCTION
9999=ACCOUNT RECEIVABLE-EMPLOYEE:CRYSTAL SANDERS - DEDUCTION
9999=ACCOUNT RECEIVABLE-EMPLOYEE:DAVID CROWE-DEDUCTION

You need a file that contains a header section:
[GLACCNT]

Then each row of the file will have the GL Account number entered on an L-BOSS totalizer
and the account name as entered in QuickBooks. We recommend that you print the chart of
accounts to make the cross reference file easier to create.

2.2.3.3 Setting an event to run automatically

Open the L-BOSS events menu.

Add a new event.

Call the event Export to G/L.

Create an event using the L-BOSS>Task>Edit button.

Command line:
@EXEC(RUN=@L-BOSS\GLExport.exe /B /D1=0 /D2=0 /STORE=001)

Command line switches:
/B means run in unattended batch mode.
/D1 is beginning date. 0 is today. -1 is one day offset to yesterday, etc.
/D2 is ending date. 0 is today. -1 is one day offset to yesterday, etc
/STORE is the store number to select the data for. 

Select Allow manual to allow manual execution of the program. Note that it will export data
for the store and dates in the batch file. For normal manual execution of the GL export use the
L-BOSS>MOdules menu option.

Select Allow scheduled to allow automatic execution at the pre-programmed time/date.
If you have selected the Allow scheduled flag you need to set a repeating cycle. The event will
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repeat at this frequency.

NOTE: When run in batch (automatic event scheduling) mode the GL export will not export
data for a date that has already been exported.

2.2.3.4 Configuring the accounting interface

Open the GLExport program.

From the file menu select the "Configuration" option.
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Accounting software: Select the type of software from the pull-down list. Standard CSV will
export the 4 fields that are displayed on the GL interface export screen. The other interfaces
should meet the format requirements of the selected accounting system.

Export path \ filename: Enter the path and filename that L-BOSS will use to save the
exported data for the accounting software. 

The GLExport allows you to include system variables in the exported file's name. For
example, if you need to add the store number within the file's name you can use the @Store
argument.

This is a list of custom fields to use inside the file name:

@Store (uses the store number)
@Term (uses the terminal number)
@Seq (inserts a sequential number)
@Date (inserts the date)

Here are some examples. The (#), (##), (###), etc. represent the number of characters to
use for the variable.
 
--------Store--------  --------Terminal--------
@Store(#)           Result for example 1 @Term(#)           Result for example 1
@Store(##)          Result for example 01 @Term(##)         Result for example 01
@Store(###)        Result for example 201 @Term(###)       Result for example 901
@Store(####)      Result for example 0201 @Term(####)     Result for example
0901

...

--------Sequential Number--------One "@Seq" can be inserted
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@Seq(#)           Result for example 0 - 9
@Seq(##)           Result for example 00 - 99
@Seq(###)         Result for example 000 - 999
@Seq(####)       Result for example 0000 - 9999

...
--------Date--------
There are multiples ways to configure your date variable. This function uses the same format
as your Windows Date Format. Make your date separator can be used inside a normal
filename.

1-  @Date(yyyy-mm-dd)
2-  @Date(yyyy_mm,FromTo)
3 - @Date( Your date format , Offset ( as expressed in days, months or years), Type Y=Year,
M=Month, D=Day)

A few examples where the date is 2009-02-27

When separator character: -
@Date(yyyy-mm-dd) Result 2009-02-27
@Date(dd-mm-yyyy) Result 27-02-2009

When separator character: _
@Date(yyyy_mmmm_dddd_dd)  Result 2009_February_Friday_27      
@Date(yymmdd,FromTo) Result 090227_to_090227
@Date(yyyymmdd,FromTo)  Result 20090227_to_20090227

Using the OFFSET with separator -
@Date(d-m-y,-2,M) Result  27-12-08 (2 months before the current date 2009.02.27)
@Date(dddd-m-y,1,Y) Result  Friday-2-10
@Date(ddd-m-y,1,D) Result Sat-2-09

Remember that the date variable will add the selected date format to the output filename. If
your accounting system interface does not need a date do not use the variable. Most
accounting systems use a default name. Choose the Use default name flag and you should
be set to go.

Use default file name: Select this option to use the default file name. If you modify the
default file the check-mark will disappear. Place a check mark in this field to accpet the
default filename for your accounting interface.

Server machine name: Enter the network ID (computer name) of the L-BOSS server 901.

Zero skip: Set this option to skip GL accounts that are at zero total for the period selected.

NOTE: For the export type AVANTAGE the store number field is read from the L-BOSS
internal store number. Set this value in L-BOSS>Maintenance>Register>Store information
programming screen by entering the accounting store number into the Internal number field.
This store number is inserted on each row of data in the exported file.
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2.2.3.5 Running the Export to G/L

The GL export creates a file that is imported into the accounting system. The data file you
create will contain totals for the stores or targets you choose. You can also select a single
date or range of dates. You need to make sure that the date ranges you choose have not
been cleaned up from the detailed report database.

If you try to export data for a previously exported date the system will warn you but will not
stop you from proceeding. It is up to you to remove records from the accounting system if
you have posted data more than once.

Open the GL Export program from the L-BOSS>Modules menu.
1-Select the store or target group you want to export for.
2-Select the start and end date.
3-Press the Preview button. A grid will appear that shows the amounts computed for each
totalizer assigned to a GL account. The grid can be edited if changes are required before
posting the numbers to your accounting system. Click in the field that you need to modify. If
you need to add data to the file press the Add Row button and enter the totalizer and amount
to post. If you have already exported data for the date selected you will be prompted to
overwrite the existing data. When you select a date that was previously exported the GL
Export program reloads the original data that was computed by L-BOSS. It will not save any
and edits, additions or suppressions you made in the previous GL export session. Those
changes were saved only in the file that was created with the export button.
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4. When you are ready to create the export data press the Export button. You cannot Export
a file that does not balance total debit against total credit. So if the totals are red you need to
find the amount that does not allow you to balance and make the correction. This is normally
due to errors in configuration of the GL account inside L-BOSS totalizers.

5. You can print the data in the export table to your Defaul system printer as defined in
Windows by pressing the Print button.

There is another selection available for the interface type called F1000/Acomba. The system
allows to export either Financial data for the General Ledger or account data for the Accounts
receivable system. Select the export file type required by your system as shown in the
following image:
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Please consult your user guide or accountant to learn about importing the data into your
accounting system.

2.2.4 Maintenance Application

L-BOSS Maintenance Application Overview

The Maintenance application is used to control all data that is used on front-end L-POS
terminals. The Maintenance menus provide access to all data tables required for store
operations. The data tables are divided into categories such as item information (PLU),
customer account information, and front end system information, such as operators. The
Maintenance application menus are divided into these categories as well, to simplify user
access. 

Like the L-BOSS desktop, the Maintenance application's title bar displays the application's
name and logged user name. The Maintenance menu provides access to all system options.
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The main toolbar allows you to access the most commonly used options. In other words, you
can access options either by clicking the button, or opening the menu and selecting the
option from that menu's option list.

The Maintenance application menus are dynamic, and change depending on the category of
data that you are accessing. For example, when no data tables are open for editing, the
maintenance "File" menu allows login, logout, bubble-help on / off toggle and execution of an
SQL command line. Launching a data table editor (PLU for example) causes the "File" menu
to change content to include options specific to PLU maintenance.

The Maintenance application provides a common set of editing tools, even though the table
editor changes content according to the data table being edited.

NOTE: If you leave the Maintenance application open but inactive (not being used) for more
than 10 minutes, it will automatically close. This is because the Maintenance application
accesses data tables, locking them to prevent simultaneous access. If there are data tables
open and modified, the changes will be saved. 
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This example shows the Maintenance application's "Desktop".

2.2.4.1 Maintenance Main Menus

Maintenance Menus and Icons Overview

The Maintenance application's help pages describe each menu's options in detail by menu
name.

File: The File menu is dynamic and either displays options for the Maintenance application
when no tables are open, or data type utilities, depending on the data tables that are open for
editing.

Edit: This option is not visible until a data table is open for editing and contains editing options
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that correspond to the edit tools available on the toolbar.

PLU: The PLU menu provides access to all item related data types, such as department,
sub-department, bottle links, mix&match, etc.

Account: Accesses all customer account related tables, such as customer information,
client shopper levels, risk levels and discount table set-up.

Register: Provides access to all front end specific information, for example Operators,
functions, totalizers etc.

Windows: Because the Maintenance application is a "multi-window" environment, this menu
provides controls such as tiling or cascading views.

Help: Launch this help document or view the About for version number and contact
information.

Several buttons that give direct access to frequently used menu choices have been placed
on an icon bar below the menu choices in the Maintenance application. Right-click anywhere
on the Icon bar to add or remove a menu option. For example, to add the Gift certificate option
to a direct access button, right click anywhere on the icons area and place a checkmark
beside Gift Certificate. To remove an option from the icons area, right click anywhere and
remove the checkmark from the option to be removed.

2.2.4.2 Common Data Edit Toolbars

Common Data Table Toolbar 

Regardless of which data table you edit, the Maintenance application provides a common set
of tools on a toolbar at the top of the data table editor. The Maintenance main menus change
as well, depending on the table you are programming. The toolbar is common to all tables
you edit.

NOTE: If you have the "Bubble help" set to on, you can hold the mouse cursor over a tool to
see a short description of that tool's function. To set the help on or off, close all data tables,
then open the "File" menu. The help bubble option acts as a "toggle", displaying a check
mark when set to on.

Top Bar Tools

The  tool allows you to post the changes to the record within the table being accessed.

The  tool is used to add a new blank record to the table you are working with. To copy an
existing item to a new item, or to replace an existing item with a new number, enter the
number directly into the item number field. You will then be prompted for the action you want
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to take. 

The  tool is used to delete an existing record from the table you are working with.

The  tool is used to undo changes that appear on the screen but that have not yet been
posted. It will not undo changes that have been posted.

The  tool is used to go back  to the previous record in the table you are working with.

The  tool is used to go forward  to the next record in the table you are working with.

The  tool is used to send the modification made to the current record to the POS terminals
immediately. This icon changes color to green when a modification has been made to a
record. When the record is deployed the icon will return to the normal color displayed here.

NOTE: Changing records in a store to send to the host system:
The Send to host option of the "File" menu options is only available when the Host active
option is selected to return data to a headquarter system. The "send to host" option will
allow output of the changes made on the local L-BOSS machine back to a host system.
This means that changes to prices, accounts and other files can be made at a store and
sent back up to the host system. Select this option for the tables that may be edited locally
in a store.  Please consider as well that changes sent back up to the headquarter system
will be deployed to all terminals that are part of the same target group for that file type. This
means that if a price is changed at store 3 and all stores share the information on that
product, the change will make it to the other stores in the next communication cycle. To
force a change to make its way back up to the head office you must press the Satellite from
the menu for that record. Using the deploy all changes option will not return any information
to the host system. It is an item by item decision that can only be activated one item at a
time with the satellite icon.

The  tool is used to approve all changes and close the tables you are working with. 

The  tool only appears on the PLU item screen. It allows you to set a filter on the PLU file
in order to view and modify only the filtered items. 

Pressing the  icon toggles it to  view mode and displays the tools used for setting filters
and performing global modifications on the PLU file. 

These icons appear to the right of the   and are explained in the
"Filters" section of this help file.

2.2.4.3 Displaying Data Lists

Viewing Data Table Contents

L-BOSS uses tables to store data. In some cases the information stored in a table has been
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indexed so that a rapid search can be performed to locate data you require. As you are
navigating through the fields of different tables you will notice that sometimes a "?" (question
mark) appears beside the cursor. This means that the selected field is indexed so that its
contents are viewable as a searchable list. Double clicking the selected field will open a
viewable list of the table's contents. 

The sequential order that the contents will appear depends on which field you have selected
for the drop down list. For example, if you are editing operators and double click in the
operator number field, the list is in numerical order according to the operator numbers.
Double clicking the operator name field opens the same information, but listed alphabetically
according to the operator names. The data list's left column will contain the data from the field
selected.

The L-BOSS program has 2 different styles of search windows. The first is fixed and the data
and fileds included in the window cannot be changed. Here is a sample of a simple search
window:

Once this type of list is open, you can search several ways. You can use the scroll bar to
search manually, or you can enter the first few letters (or numbers if the field is numeric) of
the data you are searching for in the "Locate" box. The search is left-justified; which means
that when you begin typing a description in the search table, the cursor will move to the
record in the table that meets the search criteria. For example, searching for the description 
bread in the PLU database "descriptor" field will move to the section of the file beginning by b.
Next it will attempt to move ahead to br. If it finds br, it will attempt to move to bre. As soon as
it cannot find the full description you searched for, the cursor will stop moving and display the
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first record it finds with as much as possible of the descriptor you requested.

To begin a new search you must clear out the search data you entered the first time. Once
you find the data item you are searching for you may want to leave the search window and
navigate up or down the list being displayed. You can do this by clicking with the mouse
anywhere on the list. You can also press Enter to move from the Search box to the current
list and move up or down the list to select the record you were searching for.

The second type of search window allows advanced users to define their own search criteria
and result columns. Here is a sampleof the advanced search window available in many of the
database fields related to products:

Once this type of list is open, you can have many more search options. Clicking at the top of
any column will use that column to sort the data. From the example shown above, if you click
on the column header description the list will sort in alphabetical order. If you click again in the
same column the list will sort again in alphabetical order starting from the opposite end of the
alphabet. Click in the PLU number header and the same list will sort numerically. Re-click the
PLU number and the list will sort from the last PLU to the first,etc. You can also use the
locate entry window to type data. If you have sorted the column by clicking in the PLU number
field, the locate tool will search the PLU number field (F01 in the database.) If you have sorted
the column by clicking in the description field, the locate tool will search the item description
field (F29 in the database.)

You can also use this type of search window to perform a wildcard search (the field you are
searching contains the data in a continuous  string.) For example you want to search for all
products that include the word berry anywhere in the description. Type the word berry into the
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locate window. The system will display the first product it locates beginning with the word
berry. Press the Enh. Search button. The system will display every product that includes the
word berry. So the first list may show no results unless there are products that start with
Berry. But the second list would show strawberry, blueberry, raspberry, etc.

The File menu option in the search window allows you to send the data from the search list
to an export file or to a printer. This is a simple way to print a very specific list: set a filter to
find your items. The Apply button will produce this type of search list which can then be
printed (or exported to a csv file.)

The next major advantage to this type of list is that a customized query can be defined if you
understand the L-BOSS database structure and you have a minimum knowlegde of sql
commands. Access the options menu and select custom query. The system will open up
an sql editor window. Add the commands you need to select the data you want to list. If you
are unsure how to do this it is recommended that you inquire with your ealer on how to add
custom queries.

Note:The first type of list displays a record count (the number in brackets at the top of the
list.) The second list type that allows enhanced search does not display the record count at
the top of the window. You must open the options menu and choose record count.

search several ways. You can use the scroll bar to search manually, or you can enter the first
few letters (or numbers if the field is numeric) of the data you are searching for in the "Locate"
box. The search is left-justified; which means that when you begin typing a description in the
search table, the cursor will move to the record in the table that meets the search criteria. For
example, searching for the description bread in the PLU database "descriptor" field will move
to the section of the file beginning by b. Next it will attempt to move ahead to br. If it finds br, it
will attempt to move to bre. As soon as it cannot find the full description you searched for, the
cursor will stop moving and display the first record it finds with as much as possible of the
descriptor you requested.

To begin a new search you must clear out the search data you entered the first time. Once
you find the data item you are searching for you may want to leave the search window and
navigate up or down the list being displayed. You can do this by clicking with the mouse
anywhere on the list. You can also press Enter to move from the Search box to the current
list and move up or down the list to select the record you were searching for.

2.2.4.4 Transfer Menu

Sending Information After Editing

The "Transfer" menu is only visible if there are tables open to edit. After editing information in
a table, you can send the modifications either by using the satellite dish button on the edit
table toolbar, or from the "Transfer" drop down menu. The "Transfer" menu allows you to
send the currently selected record or the entire file. In most cases sending the entire file is
not suggested or required, but doesn't really cause any problem.

NOTE: When editing the Item table, the "Send complete File" option is "greyed out". This is
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because the item file is usually quite large, and could take a considerable amount of time to
send. If you need to send the entire file, you should use the "Deploy Individual file" option
from the L-BOSS "File" menu.

2.2.4.5 File Menu

File Menu Overview

The Maintenance application's "File" menu contains common options such as login / logout,
language setting etc., but is also dynamic. Depending on the table being edited, the options in
the "File" menu change to include utilities designed to test or verify system integrity for the
selected data type. For example, it is important to verify that all items have links to sub-
departments. When the item table editor is open, the "File" menu changes to include an
option to check for PLU links. Not all tables have utilities or additional options in the "File"
menu.

The Send to host option of the "File" menu options is only available when the Host active
option is selected to return data to a headquarter system. The "send to host" option will output
the changes made on the local L-BOSS machine back to a host system. This means that
changes to prices, accounts and other files can be made at a store and sent back up to the
host system. Select this option for the tables that may be edited locally in a store. When this
option is selected for any item in a table it means that any change made to any record in that
table will be returned to host. For example, you cannot send item 1 to host but not send item
2. If Send to host is selected when you are editing PLU's, all PLU changes will return to host.
Please consider as well that changes sent back up to the headquarter system will be
deployed to all terminals that are part of the same target group for that file type. This means
that if a price is changed at store 3 and all stores share the information on that product, the
change will make it to the other stores in the next communication cycle.

NOTE: As with most Windows style programs, the Maintenance application's desktop
supports "Multi-Windowing", meaning there may be several tables (windows) open at the
same time. The dynamic "File" menu always displays the options for the currently "selected"
or "in focus" table. The selected table will always be on top of the others, its top bar will be
different than other "not selected" tables. The table top bar colors are based on the colors that
you have selected for your Windows desktop.

File Menu Options

Login, Logout and Language are identical to the same options in the L-BOSS main
application, described in the L-BOSS Main Menus help section in this manual.

Bubble help: When toggled on, the Maintenance application will show short help when the
mouse hovers over an area that has hints.
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SQL Command

!Warning!: This option should only be accessible to programmers! You should only use
this option if you are certain that you understand SQL and are executing the correct
command. By running an SQL command you can inadvertently or even severely damage
the data contained in the system database tables. If you are unsure, you should not use this
option, or consult the system administrator or your L-BOSS dealer for technical support.

This example shows the Maintenance application's "File" menu, "SQL command" option.

This option allows a programmer to either select an existing SQL command from the drop
down list at the top of the window or manually enter a new SQL command and execute it. It is
also possible to enter new commands, then save them to have them added to the existing
list.

2.2.4.5.1  Item Options

Item Maintenance Utilities

The "PLU" desktop icon and the "PLU" menu's "Item" option both open the Item table
programming utility. Once open, the Maintenance application's "File" menu adapts to include
options and utilities that apply specifically to item table. The options and utilities are designed
to work with item data entry and programming integrity.

Item Table File Menu Options

Tests: This option includes item tests that help control item data integrity, such as sub-
department links, items with no price and other tests, including:

PLU at zero price in level 1: Items should have a price on level 1! This tests the item
tables for any items that do not have a price on price level 1, and opens a list box. If there
are no items without a price, the list is empty. If there are items without a price, you can
double click an item to edit it right away. You can then either edit or delete the item in
question. Repeat the process until all items have been dealt with.
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NOTE: Items can exist without a price. The Maintenance application will not stop you
from creating an item, then leaving the item table without entering a price.

No sub-department: Items in the database should all be linked to a sub-department.
Sub-departments allow for selective reporting and item group programming. For more
about sub-departments, see the Sub-department help in this manual. Use this test to find
any items that are not linked to a sub-department. Selling items that are not linked to
sub-departments will lead to discrepancies in the item, sub-department and department
sales reports. As with the item test, a list appears allowing you to select the item for
immediate editing.

Unreferenced sub-department: Although the Maintenance application has drop down
lists to allow you to select the correct sub-department for an item, you can also enter the
sub-department manually. This makes it possible to enter a non-existent sub-department
as a link. The system will emit a warning, but does not stop you from continuing. Use this
test to find any items that are programmed with a sub-department number that does not
exist in the sub-department table. If there are un-referenced sub-departments, the items
will appear in a list. You can then either correct the entry, or create a new sub-
department table record.

Unreferenced bottle link: Similar to un-referenced sub-departments, it is possible to
assign a non-existent bottle link to an item that sells with a bottle. Run the test to find any
items that have been incorrectly linked. From the ensuing list, you can either fix the bottle
link number, or open the bottle link table to add a new record. 

Unreferenced tare link: Run this test to discover items in the database that reference
a tare table record that does not exist. If any items appear in the list, double click to edit
immediately, correcting the problem in the item, or programming the tare table to include
the unreferenced record.

PLU price over 100.00: This test looks for items that have prices over $100.00. The
system does not limit item pricing; this utility is included to find items that have probably
been incorrectly programmed, often an undetected "typo". This is handy if your store
does not have any items with prices in the 100.00 range.

Show POS targets: L-BOSS makes use of "target groups" to know which terminals are
to receive programming. When selected, an information list opens, displaying a list of all
POS targets for the selected item. Normally, all terminals receiving programming will be
in the PAL target. ("Programming ALL"). For more about the terminal groups, see the
"Register menu", "Terminal table" help pages in this manual.

Show Price targets: The same as the "Show POS targets" utility above, this opens a
list of the Price targets programmed for the selected item.

Auto Update from Batch: If you are using the "Batch" mode utility, it is possible to
automatically update item programming from a batch, even though the batch has not been
deployed. When this option is selected, L-BOSS will display the best promotional price in the
"sales price" column (extracted from the active batches). This option does not affect the way
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that batches behave. For more about Batch programming, see the batch programming help
pages in this manual.

Scanner: The Maintenance application offers a utility to enter item codes from a scanner.
This can make it easy to quickly locate items in the database for programming. The scanner
must be programmed to function properly with the Maintenance application.

Use scanner: If a scanner will be used to enter item codes for programming, select the
"Use scanner" option.

Configure scanner: This utility is used to program the Maintenance application for using
a scanner. The utility provides a list of pre-set configurations based on popular
manufacturers' models. If your scanner does not appear in the list, it can be added,
programmed and saved. This is usually done by the dealer / programmer or system
administrator at installation time.  If you are unsure about how to setup the table, please
consult your Logivision  dealer.

This example shows the Maintenance application's Scanner Setup panel.

Definition table: Scanners can be programmed to read different bar code types, and
the way that they are read. The Maintenance application uses the scanner "definition"
table when accepting codes from the device. Use this utility to setup the definition table.
This is usually done by the dealer / programmer or system administrator at installation
time. If you are unsure about how to setup the table, please consult your Logivision 
dealer.
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This example shows the Maintenance application's Scanner Definition Table.

Set quick page: This option can be used to personalize the home (quick) page of the PLU
editing screens. When the quick page editor is activated, a yellow banner is displayed as a
warning. Select a field from another tab in the PLU maintenance screen by right-clicking on
that field. Return to the quick page and click on the form to place the selected field. Several
fields are only displaying results that have been calculated. For example, the unit cost is a
calculation derived by dividing the base cost by the case pack size. You cannot place a
calculated field by right-clicking it. You must select this type of field from the drop-down list
located in the yellow banner area when the quick page editor is selected. You may also set
your preferred tabbing order for navigation on the quick page.
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Send to host: The Send to host option of the "File" menu options is only available when the
Host active option is selected to return data to a headquarter system. The "send to host"
option will allow output of the changes made on the local L-BOSS machine back to a host
system. This means that changes to prices, accounts and other files can be made at a store
and sent back up to the host system. Select this option for the tables that may be edited
locally in a store.  Please consider as well that changes sent back up to the headquarter
system will be deployed to all terminals that are part of the same target group for that file type.
This means that if a price is changed at store 3 and all stores share the information on that
product, the change will make it to the other stores in the next communication cycle. To force
a change to make its way back up to the head office you must press the Satellite from the
menu for that record. Using the deploy all changes option will not return any information to the
host system. It is an item by item decision that can only be activated one item at a time with
the satellite icon.

2.2.4.5.2  Other File Options

Other Dynamic File Menu Options

Not all tables have utilities or additional options in the "File" menu. If there are no tests or other
options for a table, the File menu usually only contains the "Close" option to close the table,
saving all modifications.
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Sub-departments: When the sub-department table is open for editing, the Maintenance
application's "File" menu changes to include an option to test the sub-departments

Unreferenced Departments: Although the Maintenance application has drop down lists
to allow you to select the correct department for a sub-department, you can also enter
the department record number manually. This makes it possible to enter a non-existent
department as a link. The system will emit a warning, but does not stop you from
continuing. Use this test to find any sub-departments that are programmed with a
department number that does not exist in the department table. If there are un-
referenced departments, the sub-department will appear in a list. You can then either
correct the entry, or create a new department table record.

2.2.4.6 Edit Menu

Edit Menu Overview

The "Edit" menu is not always visible, and only appears when there are open tables to edit.
Like the "File" menu, the Maintenance application's "Edit" menu is dynamic, its options
changing depending on the utility used, or the table being edited. This is because the utilities
and tables do not have all the same options. Some of the "Edit" menu options are alternate
links to the same options as the common table edit toolbar, such as tools to "Add", "Delete"
or "Post" records.

2.2.4.6.1  Item Options

Edit Menu Item Options

Once the item table is open on the desktop, the "Edit" menu changes to include options that
are specific to the item table. If an option on the menu has an associated "hot key" (quick
keyboard access), it is indicated after the menu option description.

Expand UPC-E (F12): Use this option so that when entering codes manually in their "E"
format (6 digit short format), the application will automatically convert the UPC-E to a UPC-A.
This is convenient if you are searching for the code in the item table, but only have the short
(E) format of the code.

Vendor Code (F5): Use this option to search for one item in the database using the vendor
code for the item, rather than the UPC.

Search Vendor code (Shift-F5): If you are unsure of the vendor code for an item, this option
opens a list of all the items in order by their vendor code.
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Custom queries: L-BOSS allows you to list data records in certain fields such as the item
description. The search is initiated when you double click in the field to be used as the search
key. It is possible that the search criteria you want to use is not available in the standard
search lists. You can modify the sql request made to the database engine and display the
results in the search window. Certain database knowledge is required and changing the
standard requests may inhibit the normal searches you perform. Here is an example of how
to add a custom search to the system.

Access the Custom query menu option and select Add.
At the prompt enter a short description that will be used to identify this query. (MM#1is our
example which will produce a list of the items atached to mix match group 1.)
In the query window enter the sql command to be executed.  Example: SELECT  F01,F29,
F32 FROM OBJ_TAB O LEFT OUTER JOIN PRICE_TAB P ON (O.F01=P.F01) 
WHERE F32=1
You can also set the number of visible columns to be displayed.
Once you press [OK] the query is saved and a new button will appear on the item screen.
Press this button to execute the custom query.

Delete POS Target: Items are linked to several types of "targets". POS targets are the front
end terminals that require the programming in the POS table, including descriptor, status etc.
Often there is only one POS target for items, (all terminals) except in multi-store situations,
for example where some stores are under different state taxation laws. You can delete POS
targets from an item if they are no longer sent to the target to delete. Items must have at least
one (1) valid POS target.

Delete PRICE Target: The PRICE targets are the terminals that the price is sent to. Once
again, in most situations there is only one Price target, all the terminals. In multi-store
conditions, some store will not have the same pricing. It is possible to remove unwanted price
targets. Items must have at least one (1) valid PRICE target.

Item List Per POS(also PRICE, COST) Target: In situations where there are separate
targets for pricing or POS information, you can list the items that are in a specific target, for
PRICE, COST, or POS targets.

Previous, Next, Add, Delete Record: These options are the same as their toolbar
counterparts.

Calculate Price: Before using this option, items must have a cost, and a value in the
"Projected" field. You must also decide which method L-BOSS will use to calculate the item
price based on cost, Margin or Markup. For more about Margin and Markup, please read the 
Price tab help page below. To read about how to set L-BOSS to use the type of calculation
you would like to use, please see the L-BOSS, "File" menu, "Configuration" utility's "Misc" tab
help.

To have L-BOSS set ALL item prices from their costs based on the type of calculation
selected:

With the Item tables open on the Maintenance application's desktop, 

Open the "Edit" menu and hold the mouse over the "Calculate Price", opening a sub-menu
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From the "Calculate price" sub menu, select "All items".

You will be warned and before the calculate process runs.

To calculate prices on a specific group of items only, you must select the items using a filter,
apply the filter, then from the Maintenance application's "Edit" menu, "Calculate prices" option
you will be able to select the "All filtered items". It is important to note that if you use price
levels, you should be sure that there is a target value for all price levels. This is because if
you ask L-BOSS to calculate prices based on the target value, the prices FOR ALL PRICE
LEVELS are calculated.

Ignore Un-posted changes: This is an Undo option that removes changes made BEFORE
posting the changes. Note that if you modify an item and move on to the next item, the
changes are POSTED (not to be confused with DEPLOYING). You cannot undo
modifications after posting using this option.

Delete All Filtered Records: This option allows you to select items from the database using
a filter and deleting them as a group.

Move Filtered items to Batch: This option allows you to select items from the database
using a filter, and have the selected items sent to an existing batch.

Add this Item to Batch: Send the selected item to an existing batch.

2.2.4.6.2  Other Edit Options

Other Dynamic Edit Menu Options

For most other tables, the edit menu contains the same options and utilities as the toolbar.

Post Record: is the same as the  tool.

Previous Record: is the same as the  tool.

Next Record: is the same as the  tool.

Add New Record: is the same as the  tool.

Delete Record: is the same as the  tool.

Ignore Unposted Changes: This is an Undo option that removes changes made BEFORE
posting the changes. Note that if you modify a record and move on to the next, the changes
are POSTED (not to be confused with DEPLOYING). You cannot undo modifications after
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posting using this option.

2.2.4.7 PLU Menu

PLU Menu Options

The PLU menu provides access to all item related data types. Selecting an option from the
PLU menu opens the corresponding data table. For quick access to the Item table, use the
PLU icon found on the Maintenance application's desktop. Most other item related tables are
rarely accessed after the original configuration and do not have desktop icons.

Item: Probably the most used option, it opens the PLU (or Item) table that contains the PLU's
main information.

Sub-Department: PLUs MUST be linked to a sub-department. Use this option to program
the sub-department table.

Department: Sub-Departments MUST be linked to Departments. This option opens the
Department table.

Bottle Link: Opens the Bottle Link table to configure bottle values to link to bottled PLUs that
must collect a deposit.

Tare: Opens the tare table for editing scale related packaging weights.

Price Level: The price level table contains a record for every price level PLUs will link to.

Category: Items can be linked to "categories" for reporting purposes.

Mix & Match: This option opens the Mix & Match table to configure records for PLUs to link
to.

Batch: Used when prices must be modified at future dates, such as short or long term
promotional pricing.

Vendor: Use this option to add / modify records in the vendor table so that PLUs can be
linked with suppliers.

Scale: Opens the scalable items programming interface for electronic scales.

Statistics: A utility to verify item programming and links to other item tables.

Transaction completion deal: This menu allows you to set up the transaction deals
exectued by L-POS.
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2.2.4.7.1  Item Tables

Item Table Tabs and Fields

The item related tables are separated into "tabs" containing PLU information. Each tab
displays different aspects of PLU programming. The help pages under the "Item Table" topic
explain the PLU fields in order of the tabs. The item maintenance screens are divided into
tabs to make viewing simpler. The top portion of the screen is consistent to all tabs. This
includes the item number, the main item description, the active price and the next price. The 
Quick tab is a shortcut to fields that are also found on other tabs in the PLU set-up screen.

The relational nature of the L-BOSS database is easy to understand when you are working in
the PLU maintenance. You may create item 1 as Oreo cookies, attached to sub-department
10 and with a price of 2.39 as in the example below.  You have therefore added a record to
the object table (item 0000000000001), but you have also added a record to the POS table
(the sub-department link, tax status, and register flags), and you have added a price record to
the Price table. You now have one record in each of the 3 tables. When you want to add a
second price level for Oreo cookies you do not create a new item, you only add a new price
on level 2. So you will have 2 price records but only one object record and only one POS
record. The same would be true in the cost table if you have more than one supplier for
product 1. Multiple cost records can be associated with the item. The PLU information
centres on the object table. It is the the table that contains the unique identifier for each
product in the system.
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This example shows the Item table editor.
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2.2.4.7.1.1  Item maintenance screen

The top section of the Item maintenance screen is common to all the tabs and displays the
following fields:
 
Item number : 0000000000001 (this is really part of the OBJECT tab.)
Main description (normally used on reports):  Oreo Cookies  (this is really part of the
OBJECT tab.)
Active Price: 2.29  (this is really part of the PRICE tab.)
Next price and start date / time:  1.99  8/1/2013  0000  (this is really part of the Price tab.)

Item image: .  (this is really part of the OBJECT tab.)

If no image has been assigned to the product the display will show: . To
select an image for the product or change the existing image click the picture associated or
the No picture

Custom buttons (On hand, Order, Over $50, Parent, Promo)
These buttons are programmable to execute an SQL query to list data in the Maintenance
search window.

L-BOSS allows you to list data records in certain fields such as the item description. The
search is initiated when you double click in the field to be used as the search key. It is
possible that the search criteria you want to use is not available in the standard search
lists. You can modify the sql request made to the database engine and display the results
in the search window. Certain database knowledge is required and changing the standard
requests may inhibit the normal searches you perform. Here is an example of how to add
a custom search to the system.
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Access the Custom query menu option and select Add.
At the prompt enter a short description that will be used to identify this query. (MM#1is our
example which will produce a list of the items attached to mix match group 1.)
In the query window enter the sql command to be executed.  Example: SELECT  F01,
F29,F32 FROM OBJ_TAB O LEFT OUTER JOIN PRICE_TAB P ON (O.F01=P.F01) 
WHERE F32=1
You can also set the number of visible columns to be displayed.
Once you press [OK] the query is saved and a new button will appear on the item screen.
Press this button to execute the custom query.

Note: The Active price and Next Price will be filled automatically from the price table. these
fields are used to show you what should be the current active POS price and the next price
with date and time it will be activated.

Note 2: To select a new image for a product click the image. Browse to the image.

2.2.4.7.1.2  Quick Tab

Item (PLU) Maintenance: Quick Tab

The PLU (price-look-up) screen contains all the relevant information and parameter flags
required to program an item for use on a front end POS system. The screen is divided into
several sub-screens that can be selected by clicking on the Tab for that sub-screen. By
default, L-BOSS displays the Quick tab. This view shows a combination of fields from other
tabs. These fields were selected to make day to day operations easier. The quick tab would
be easier to explain last, but since it shows first... we will continue on.

The Quick tab is actually a repetition of fields available on other tabs in PLU maintenance.
The Quick screen allows you to access the basic information that changes most frequently
for a product. The example below includes the base price field and the package price field
from the price table. If you access the Price tab you see that many of the price table fields are
not visible on the Quick tab. It is possible that your Quick tab may not resemble the image
shown below. In an effort to improve your productivity your dealer may have selected other
fields on your Quick tab.
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This example shows the Item table's "Quick" tab.

The Quick page fields are explained in the help section for the individual tab they originate on.

2.2.4.7.1.3  Editing the Quick Tab

Editing the Quick Tab

The quick tab fields can be edited to optimize operations in a given store. Business that only
use one tax rate may want to remove the second tax rate that appears on the quick page in
PLU programming. Other businesses may require additional tax rates, or other fields not set
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on the quick page by default. To satisfy the varying requirements, L-BOSS includes a
powerful quick page editor. It is used to capture fields from the other Tabs in the PLU editing
screen and place them on the quick page. Although this operation is not very complicated, we
suggest that users not comfortable with the operation should contact their reseller to have the
changes made.

You must open PLU maintenance to edit the Quick Tab settings. When item maintenance is
active, select Set quick page from the File menu. The system will display a warning message
that explains the basic steps to adding a new field to the quick tab.

Moving existing fields within the quick page
To move a field already on the quick page, click in that field to select it. Then drag it to where
you would prefer it to be. To move several fields at the same time click on the first field. While
pressing the [Shift] button on your keyboard click on the next field to be relocated on the quick
page. When several fields are selected at the same time, the frame outline turns grey to
show that more than one field has been selected. Continue selecting the fields to be moved
the same way. When all fields are selected, drag them to the area or the quick page that you
want to use them in.

When fields are moved they use a built-in grid and cannot always be moved to the exact
position you want to leave them. To move a field you can also select the field and press Shift-
Arrow to move it. Fields can be streched or shinked the same way by selecting the field and
using the Ctrl-Arrow combination.

Adding fields to the quick page
Open the tab that contains the field to be added. Right click in the field. Return to the quick
page and click on the quick tab in the area that you want to locate the new field.

Other data can be placed on the quick screen by using the pull-down window that displays "
select the field to add". If you decide to show more than one price level, you need to select
price level n, then assign the field on the page. When this is done, right-click that new field
and adjust the level to the one you want to view. Only the base price and base price quantity
can be shown for levels 2 and greater.

You can also set a tabbing sequence for the fields placed on the quick page. Press the Set
tab order button and then click in each field in the order you prefer to work in. The greyed
fields only display information, they cannot be edited.

NOTE: If you are not sure of yourself on this we recommend that you contact your dealer for
assistance.

2.2.4.7.1.4  Object Tab

Item (PLU) Maintenance: Object Tab

The Object table contains additional information for each PLU. When combined with the
PLU's item code and descriptor the Object table information provides a detailed identification
for each item in the system.
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NOTE: Remember that some of the settings on the Object tab are also available from the
"Quick Tab". Modifying data on the object tab modifies the same data field if it is located on
the quick tab.

This example shows the Item table's "Object" tab.

Kit: Leave this field blank for normal items. Set this field to create a kit only. A kit is used in
some businesses to track multiple inventory items when the kit product is sold. Note that
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when the Kit field is selected, the Cost tab becomes a kit tab to allow you to enter the content
items that make up the kit.

Category is not compulsory. It can be used to link items for reporting purposes only. This
can be used to associate items that are not in the same sub-department (or have no other
association in the system) to get a special report on item sales. Categories are user defined
; you must program the Category table before assigning items to categories. This field is 
numeric, up to 6 digits. 

Family: Like the Category, the Family field is not compulsory, but allows you to link similar
products for comparison reporting. For example, if all soft drinks are in one sub-department,
you may want a report comparing sales of different colas, or perhaps the most popular size.
The Family field is user defined; enter the numeric Family code, up to 6 digits.

Commodity: This field is used to track the product commodity number. This is required for
some loyalty programs or with Fleet card systems.
Report Code: This field is numeric, up to 6 digits. The Report code is another non
compulsory, user defined field that allows you to build specific report groups for certain
PLUs.

Item Detail box contains item specific information about

Brand: This is the item manufacturer's brand name. User defined, not compulsory,
up to 15 characters. 

Unit of Measure: If this item is scalable, enter the measure used to calculate sale by
weight. User defined, not compulsory, up to 4 characters.

Size Description: For scalable items, the actual weight in terms of the Unit of
Measure. For other items, the packaging size. User defined, not compulsory, up to
9 characters.

The Comment field allows you to further describe the item particulars. This is not
compulsory, and user defined. Enter up to 40 characters.

The object tab also provides access to the Alias table links. The alias links are used as
alternate search codes for the PLU on the L-POS system. Add or delete an alias link by using
the toolbar located below the Alias window. 

The allow duplicate alias setting in L-BOSS configuration allows another behavior. Set this
flag if you want to call up several different items in a list by typing in one PLU number. For
example, you sell single muffins and six packs of muffins. In a situation where the single is
taxable but the 6-pack is non-taxable the duplicate alias will work well for you. You would
create the single muffin and the 6 pack muffins as 2 different products. Assign a common
Alias code to each item. When the common Alias code is entered on the POS terminal a list
will appear with the 2 muffin choices.

Note that the alias item links are not available with an ECR front end terminal. 



L-BOSS Menus 139

© 2001-2014 ... Logivision

2.2.4.7.1.5  POS Tab

Item (PLU) Maintenance: POS Tab

NOTE: Throughout L-BOSS records from different tables have check-boxes to activate the
option. When a field appears to be "grayed out" it is not active. This is true whether the
check-mark is selected or not. A check-box with a grayed-out check-mark is the same as a
blank check-box. This is a peculiar default behavior of the database system used with L-
BOSS.
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This example shows the Item table's "POS" tab.

Description 1 and Description 2
These fields allow a 30 character description to identify the product on the POS receipt. It is
possible to use 2 byte code such as Chinese characters in the main item description
(OBJ_TAB.F29), in the main POS description (POS_TAB.F02) and in the alternate language
POS description (POS_TAB.F2095). If you need to print labels with 2 byte code in the
description fields you will need to modify the fonts used by the label template. Your dealer can
help with this change.

There is a PosSetup option to allow printing both POS descriptions on the customer receipt.
Open PosSetup, System, Language tab.

POS Target: This field is used in multi-store environments when the status flags for the
items are not the same in all stores. To understand the Terminal table programming, go to
the Terminal table help page. The default target for items is PAL. To change the target for an
item, double click the Target field of the POS table and select the new target from the drop
down list. Targets are only available if they have been programmed as an Item target in the
Maintenance application's "Register" menu "Terminals" option.

Follow Sub-dept: This flag can speed up the item creation process and help reduce
potential errors. Selecting this option sets the item flags to those programmed in the sub-
department table. (see Sub-department table help) For example, if items in the automotive
supplies sub-department are all taxable and non-discountable, you could set those
parameters in the sub-department and set items linked to that sub-department to follow the
programming attributes of the sub-department. Selecting this option will "gray-out" the
descriptor of options set in the sub-department. All flags with grayed descriptors will follow
the sub-department's status. Item's do not have to follow sub-department programming; an
item in the same sub-department as the example above may be non-taxable. In this case you
would not select the follow sub-dept flag. The item's flag settings will override the default
taxable status of its associated sub-department.

Taxable 1: Select this flag if tax rate 1 should be applied when this item is used.
Taxable 2: Select this flag if tax rate 2 should be applied when this item is used.
Taxable 3: Select this flag if tax rate 3 should be applied when this item is used.
Taxable 4: Select this flag if tax rate 4 should be applied when this item is used.

Food Stamp: Select the food stamp flag if this item can be paid for with Food stamps and
you are in a jurisdiction that accepts food stamps.

WIC 1-2: (USA only: Women, Infant, Children) Select the WIC flag if this item can be paid for
by WIC check. Each WIC flag allows tender by a different WIC tender type. The same item
can have more than one WIC flag set.

Prohibit discount: Select this flag to stop the POS operator from applying an item or a type
1 subtotal discount to this item. The item will also be excluded from the running discountable
total or from the account discount subtotal for accounts that use a client level with Discount
type 1 assigned..
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Prohibit Quantity: Select this flag if the POS multiplication function cannot be used with this
item. Operators often use a quantity function for similarly priced items although the products
have different PLU codes. This can falsify the sales and stocking quantities of the related
items.

Quantity Required: Select this flag if a quantity entry is required before the item can be sold.
This is often the case for items sold, for example, at 3/$1.00 and when the cashiers are
unsure whether scanning one item will ring 3 items for $1.00 or 1 item at 34 cents.

Price Required: This item status creates an "open-priced" item. It means that the item will
behave like a sub-department, forcing the cashier to manually enter a price for the item.

Visual Verify: Select this flag when price confirmation is required before an item is accepted.
The programmed price is displayed, prompting the cashier to accept or change the price.
This can be helpful in businesses that often negotiate the price of an item at the time of sale.

Not for Sale: Use this flag to restrict the sale of this item temporarily, as in the case of
seasonal items not available year-round. This allows you to leave the PLU in the Item table,
but not allow POS operators to inadvertently sell the item.

Hash Item: This flag is used to exclude the sales of this product from the store's Net sales.
This is sometimes the case for items or departments used for bottle sales, lottery returns,
etc. The setting "Not in gross" is used on the sub-department table to signify the same thing
as "Hash item" on the PLU record.

Gas PLU: This flag is used to calculate the quantity sold whenever an amount is entered.
The result is computed by dividing the amount entered by the preset price. The gas volume
can be changed from liters to gallons as required.

Remote Printer 1-4: set this flag to send the item description and quantity ordered to a
remote printer such as a kitchen preparation area printer.

FSA: Set the correct status flag for items that can be paid using the FSA card (Flexible
spending account) against an available FSA RX or non RX account balance.. Setting an FSA
flag will disable the food stamp flag for the same item. Non FSA items cannot be paid with an
FSA account. 

Scalable: This flag defines that the product is sold by weight read from the POS scale. This
flag should not be selected for pre-packaged and pre-priced items such as items weighed
and labeled for scanning at the POS.

Manual Weight: Select this flag to allow a manual weight entry for this product.

Override Allowed: Certain situations may require an item price to be changed when it is
being rung through for sale. Select this flag for items that you need to permit price override
on. It is possible to restrict the usage of the price override button by operator level.

No Repeat: Select this flag to prohibit the repeat function with this item.
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No Refund: Select this flag to prohibit refund of this product code. The POS will prevent the
cashier from entering the item's code and pressing the refund function.

No pts redemption: Select this flag to prohibit payment of this item with customer points.
For example, you may not want to allow customers to pay for tobacco products with their
accumulated loyalty points.

Bottle Return: This flag is used to determine that the item is used to refund a bottle deposit
amount. It is compulsory to select the bottle link flag for this flag to function. The bottle return
amount is the value of the bottle link assigned in the bottle link flag. Any price assigned to
the item will be ignored.

Validation Req'd: Set this flag to require a print validation when this item is used.

MPF  - MPF 6: The Multi Purpose Flags (used for varying needs, hence the name multi-
purpose.)

Vendor Coupon: This flag is used to set the price of the item to a negative value and to send
the data to the vendor coupon total on reports.

Store Coupon: This flag is used to set the price of the item to a negative value and to send
the data to the store coupon total on reports.

Prohibit Trans. Dsc: Select this flag to stop the POS from including this item in the
qualifying amount that must accumulate before the transaction discount will be triggered. The
item will also be excluded from the running DISCOUNT total or from the account discount
subtotal for accounts that use a client level with Discount type 2 assigned.

Link to: Use this field to link the sale of another PLU record to this first PLU record. This is
useful for businesses that have normally accounted for bottle sales as department revenue.
By using link PLU L-BOSS will account for bottle revenue in the sub-department the item is
associated with. (Note that the internal advanced flags bottle follows WIC status, bottle follows
FS status, and bottle follows TAX status is only functional with bottle link records from the
bottle link table.)

Divisor: (Scalable items only) Double-click in this option window when you want to use a
different measure than the default pound or kilogram when this product is sold. The POS will
divide the weight by the divisor you select before calculating the price.

Tare Link: This flag is used to define a weight (normally the packaging) to be deducted from
the total weight when the product is sold. To assign a tare value, double-click in the tare link
field and select the correct tare value for the item. The Tare table is programmed using the 
Maintenance application's "PLU" menu "Tare Table" option. If the correct tare value does not
exist, you must open the tare table and add a new record or modify an existing record.

Var Tare: (Variable tare). This flag should be selected whenever the tare value is a
percentage of the total weight of the item. Enter the percentage of the total weight to use for
tare removal.
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Bottle Link: This flag is available to automate the charge for bottle deposit in areas where
deposits are charged on items like soda, beer, etc. Select the link that is programmed with
the appropriate bottle deposit amount. Note that as an alternative to using bottle deposits, you
may enter a link PLU code in the Link to field on the POS_TAB. (Note that the internal
advanced flags bottle follows WIC status, bottle follows FS status, and bottle follows TAX
status is only functional with bottle link records from the bottle link table.

Promo ID: This field contains the identifier for the promotional pricing for the item, based on
the "Promo" tab. When the conditions for the defined promotion are reached, the item sells at
the special price, or an electronic discount is applied based on the promotional programming.
See the ECL_TAB help in this section for more on how in store electronic coupons are
programmed.

The Promo ID is also used to identify items that are part of the "Free item" promotion
system available with the preferred shopper system. The Free items are set up under the
account programming menu. This number is used to associate products to the free item
promotion. The promo ID number is assigned to the product (or products) in PLU
maintenance. 

For example, every 10 purchases of a 10 pound bag of dog food entitles the customer to
the next bag for free. If the purchase is only applicable on one specific item you will assign
a unique Promo ID code to that item. Then you create the Free item record under the
account menu, Free item menu.

If you want to allow different flavors of the dog food to accumulate together you would
enter the same Promo ID code to each of the different flavors of dog food. Then you
create the Free item record under the account menu, Free item menu.

The Promo_ID can also be used to trigger a Transaction completion deals.

Rest code: This is a link to the Restrictor table programmed in the POS Setup module.
Restrictors are used to prohibit the sale of products during a certain time periods or to restrict
items to a maximum quantity. Select the Restrictor required for this item

Client Age: This flag is available to restrict the sale of age-sensitive products such as
tobacco or alcohol. When this flag is set, the first item entered will prompt for customer age.

Oper Age: This flag is available to restrict the sale of age-sensitive products such as
tobacco or alcohol. When this flag is set, the POS will verify the age declared in the set-up of
the operator signed on.

Coupon family: This field is used to validate coupon family for cross reference when
scanning vendor coupons. The coupon family is part of the vendor coupon number. In this
coupon number 51234511102 the bold digits 111 are the coupon family. If vendor
authentication is used, this coupon would be accepted when products with in the leading
sequence of the 10 digit code are scanned. If Coupon family authentication is also used, then
only products beginning with 12345111 would qualify the coupon to be accepted.

RP Order: Use this field o specify a print order for items sent to the kitchen printers. Blanks
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will be sorted alphabetically.

Label: The Print flag is used internally by the system. It is selected when a price is changed
so that a label will be printed for this item the next time you print labels. The Type window
allows you to select a label type that you want to use for this item. Double click to select from
the available labels you have on your system.

2.2.4.7.1.6  Price Tab

Item (PLU) Maintenance: Price Tab

An L-BOSS PLU can have many prices. They can be different price types such as promotion
price, regular price, in store price, sale price, etc. There are also price levels. So you can
have a promotion price for a PLU that is different on price level 1 than on price level 5. Those
levels are typically assigned by customer type. L-BOSS also controls prices by zone. A zone
is required most often for multi-store operators that have different price in different regions.

L-BOSS selects and activates the BEST price from all the price types listed for an item. Of
course this takes into account multiple price levels and multiple price zones. An item with 4
price levels will have a BEST price for each of those levels. The best price of level 2 will be
used for price level 2 on the POS terminals. This is the same for targets, or price zones. The
best price for zone 1 will only be active in price zone 1 stores. 

N.B. Several factors are considered by L-BOSS when it calculates the "BEST" price to
activate:

L-BOSS will not activate a price if the start date has not been reached or passed.

L-BOSS only compares the base price field when comparing among prices. An item
programmed with a split price is compared after the price division is made. Items that
use base and package price are only evaluated by comparing the base price and base
quantity.
When the price type called InStore exists for an item L-BOSS will never activate another
price for that item. This means that InStore price type is protected and will remain active
until it is removed from the system.

Accessing item price fields
PLU pricing is modified in the Item Maintenance program. L-BOSS opens the quick tab when
you access PLU maintenance. You will need to select the Price tab to edit some of the price
tab fields not available on the quick tab.The price tab display includes a window that shows all
the different prices that exist for an item on the selected level and for the selected target. 

The following sample screen shows an item with two price types. The PLU has a REG price
of 2.29 and a BATCH22 price of 1.99.
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This example shows the Item table's "Price" tab.

Method type is a flag used to determine price behaviour. 

Method Type A: this method is not required by L-POS.

Method Type B: this method is used to enter different prices for the same item, such as
selling different vintages of the exact same wine that have the same PLU code. When
type B is selected a grid will appear. Enter the different prices available for this product
and a description for each of those different prices. The column headed Index is filled in
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automaticaly every time you add a new entry. If you select Default, the L-POS will use
that row's price as the default price when the item is sold on the POS. If you do not select
a default price L-POS will open a choice window for the operator to select the proper
price whenever the item is sold. If you select a default price, the Price Modify button can
be used to override the default record and pop up the list to permit POS operator
selection.
Method Type C is ignored by L-POS.

If you set an item to Method Type D, this item cannot be deleted from the order. Type D is
used internally on a special feature called Pick 5. Once a pick 5 item has been triggered,
it cannot be deleted. Only the trigger items can be deleted. Type D should not be used
unless it is needed in a Pick X type deal. N.B.: If you set an item to Type D, this item
cannot be deleted from the order. Method Type D is used internally on a special feature
called Pick 5. Once a pick 5 item has been triggered, it cannot be deleted. Only the
trigger items can be deleted.
Method Type E is used for buy one get one free (BOGO) promo deals. L-POS charges
the first item, does not charge the second item, then prints a Buy one get one free
message. When you select the price method E it will automatically hide the Package
price and LQD Limited Quantity Discount type price. Method E will also hide the Dicount
$$ and Discount % fields.
Price method E will automatically prohibit using a quantity before entering the item. Price
method E will also give the "cheaper" item free in the case of Random weight and open
price items. You must enable an Advanced Flag to use BOGO with items that have
different prices but that also use a common mix match code. For example you want to
allow a free can of soup if they buy 2 cans, but the items are not the same base price.
This flag is set in PosSetup>System>General>AD.
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Method Type F is used to limit free items to "Buy one get only one free". As with items in
Type E the cheapest item will be free if the base prices are different and the items use a
common mix match number. Price method F will automatically prohibit using a quantity
before entering the item. When you select the price method F it will automatically hide the
Package price and LQD Limited Quantity Discount type price. Method F will also hide the
Dicount $$ and Discount % fields.
Method Type G sets the rental price feature.Type G should be used for rental items that
are rented for different periods of time. An example of type G rental item is a VCR or
Nintendo machine that may be rented for a day, a weekend or a week at a time. 
NOTE: Selecting type G rental changes the pricing columns from the normal price
methods. You must also program L-POS lanes using the POS setup for rental items. For
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more on rental item programming, and how to use the "POS Setup", please see the 
"Working with PLUs" section, "Rental Items" help page below.

This example shows the Item table's "Price" tab with "G" type rental is selected.

Choosing method type G for an item will modify the fields available in the price column.
No sale column is available with type G. Price levels are available. When you select a
type G, the pricing column changes to an editable table. You must add records (lines) to
this table to program the prices for the available time periods. 

The first field is the length of the rental period in hours.

The next field is a description of the rental period.

The final field is the price for that period of rental. 

Add as many rental periods as required for the item being added. If you select Default,
the L-POS will use that as the rental period even though multiple periods have been
selected. If you do not select a default period, L-POS will open a choice window for the
operator to select the proper period whenever the item is rented. If you select a default
rental period, the Price Modify button can be used to override the default status and pop
up the list to permit POS operator selection.

Method Type H items use the price exactly the way normal items do.
NOTE: Other information on the rental system is available in the System set-up screen
under the Rent tab.

Method type I is used to calculate, display and print the weight of a price embedded
product. These items are normally set up as "price required." The POS divides the price
amount on the label by the per pound or KG price amount programmed for that item. It
displays the result as the number of pounds or KG.
Method Type J is used to limit the number of items a customer can purchase in a
transaction. Set the LQD quantity field to the maximum quantity of the product that can
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be purchased in a transaction. If you set type J and use a mix and match number, the
LQD quantity will apply to all items in the same mix match group. Note that the package
price is not available with type J price. 

Method type K is used to display an extra decimal of price on the customer receipt and in
back end maintenance. This is required for sites that enter a quantity sold for preset price
items with more than the standard windows decimal settings. 
Method Type L will display an extra decimal of price on the customer receipt and in back
end maintenance and will also use the Gas Descriptor set in PosSetup>System>PLU.
This is required for sites that enter a quantity of liters of fuel rather than entering the price
into a GAS PLU. 
Method Type M sets an item with a zero price. These items can be entered or scanned
on the L-POS as counters only.
Method Type N is used by the ECR interface.

Method Type O is used by the ECR interface.

Method type P is used to program different package sizes of the same UPC code. This is
uselful for convenience stores with singles and six packs, or liquor stores that sell items
by the case, half case and single. Enter the quantity, a package descriptor and the sale
price. If you select Default, the L-POS will use that package size even though multiple
sizes were programmed. If you do not select a default package size, L-POS will open a
choice window for the operator to select the proper size whenever the item is entered. If
you select a default package size, the Price Modify button can be used to override the
default status and pop up the list to permit POS operator selection.
Method Type Q is assigned to attach an item to the loyalty rewards program. Items can
be paid with either the L-BOSS preferred shopper points or with rewards maintained by
some 3rd party loyalty systems. When price type Q is sold L-POS can display a list of
qualified products available at a preferred price in exchange for points. The preferred
price and points required are programmed using PLU items assigned as price method R.
This PLU that uses price Method R is assigned as the PLU link on the POS tab of the
method Q product. Read the next section to see how you create the prices for Method R
products.
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Method Type R is used to set the different redemption levels for the loyalty rewards
system. For example a product normally retails for $3.99 but can be purchased for $2.49
when you redeem 1000 points. And the same item is free with a 1500 points redemption.
For each different reward level you add a row in the grid. Set the quantity of points used
to sell for a price. The price you enter is the price that will be used for the Type Q plu to
which you attached this type R item. The operator will see a form in the POS that
displays all the available reward items and the amount of points it takes to get that item
for the reward price. To redeem Q&R items, you need to use the Loyalty Redeem
function (#8073).

Price type R item sample.

For all items that are NOT selected as B, G, P or R the screen layout of the price tab looks
similar to this sample:
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Method Type S is used to allow the type E + type I. Price method S will automatically
prohibit using a quantity before entering the item. When you select the price method S it will
automatically hide the Package price and LQD Limited Quantity Discount type price.
Method S will also hide the Dicount $$ and Discount % fields. This would be used on
Random weight items that you want to set up as BOGO price type. Take note that you
MUST set the flag to allow different prices in the same mix match group. This flag is set in
PosSetup>System>General>AD.
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Fields on the price tab:

For all items that are NOT selected as B, G, P or R the screen layout of the price tab looks
similar to this sample:
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Active and Next prices

The Active and Next fields are for information only, and are not editable. The "Active" price
shown in the yellow area is the system's current price for the selected item. The "Next" price



L-BOSS User Manual 4.1.3154

© 2001-2014 ... Logivision

is the price due to be deployed to the target POS lanes and is shown in the pink area along
with the date and time that they are to become active. The description below the yellow price
field explains the source of the active price. The description below the pink explains the
source of the next price that will be activated by L-BOSS. In normal situations the Active price
is in use at the POS. But if all lanes are off line because of a communication issue the back
office may display an incorrect active price until the communication is restored. It is the price
that L-BOSS last deployed as the current active price.

Price like code: This field is used to group products with identical pricing formats. For
example, jello or baby food. The different flavors of a single size are all sold for the same
price in most situations. Assign the price for the first item of the many that are the same.
Access the next item that has the same price. Double click in the Like code window and
select the UPC code of the first jello that has been given the correct price. When you select a
like code that does not match the current upc code its like code field will display green. This is
a warning to make you aware that a like code is being used. In the future you can access any
of the PLU items with that like code to change the price of all PLU items sharing that like
code. If you leave this code blank, the system will place the same UPC code into the Like
code. So don't be surprised to see a number in that field even though you did not place it
there.

Price Target: L-BOSS allows you to program different prices for different targets. These
targets are commonkly called zones. In a single store situation, there is normally only one
price target. However, if you are working in a Headquarters L-BOSS system, or the store has
different pricing depending on the terminal, you may need to set different prices for different 
targets. To learn more about Terminal table programming, go to the Terminal table help page.
By default the target for prices is PAL which means that item pricing is shared among all
terminals or targets.  When prices are common to all targets you willnot need to change the
default PAL target. If you do need to change targets, double-click the Price Target field and
select the appropriate target for the price. The targets are created using the Maintenance
application's "Register" menu "Terminal" option. For each target you will be able to enter as
many price types as required.

Level: L-POS and L-BOSS support an unlimited number of prices for each item. Price levels
can be used for customer accounts or "preferred shopper" situations, or for special pricing.
To change the price level for an item, double-click the Level field. If the price level exists, it will
be displayed with the related price information. If the price level does not exist, the system
allows you to create a new level "on the fly". To create a new level, click the small up arrow to
the right of the price level field. If the new level does not exist, a prompt to create the price
level will appear. Select Yes to create the next price level for the item. The down arrow
returns to the previous level.

If an item does not have a price for the level selected, all the pricing fields will be blank. After
selecting the price level, enter the pricing information as you would for the first level.

You can also create price levels by accessing the Maintenance application's "PLU" menu
"Price level" option. Items do not require a price in each price level. For example, if there are
four (4) price levels and you want to assign an item to level 4 but not to level 2 or level 3, you
can enter the level number or select level 4 from the price level table. An item with no price on
level 2 will normally sell for the price of level 1 unless you invoke the special flag to prohibit it.
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This way you need only maintain prices for the levels actually used by the item. All other
items will switch to level 1 when sold.

S.R.P.: The suggested retail price can be used to show the customer the price that the item
normally sells for. The POS can be programmed to calculate and display (or print on the
receipt) the difference, showing a "You Save" type message, based on the Suggested Retail
Price field.

Size: (This information applies to the Label module only) This is the size, weight or volume of
the item that will be displayed on labels created using the Label module. (The field must be
included in the label template)

Factor: (This information applies to the Label module only) The factor determines the pricing
base displayed on the labels printed for the item. For example, the item's "size" (above) may
be 500 grams, but the label shows the price based on 100 gram quantities.

1-Base is used to enter the regular price of an item (usually a quantity of one item for that
price). Base pricing also accepts split priced items (such as lemons priced at 3 for $1.00.
The front-end L-POS terminals will sell an item programmed at 3 for $1.00 by registering the
first item for .34 cents and the remaining 2 at .33 cents each (unless of course they were
entered with the quantity key.) At the POS, split priced items do not need to be sold
sequentially, they can be sold at any time within the same transaction and the correct price
split will still occur. NOTE: Although the system allows items without a base price, items
should always have a Base price, even if there are other pricing Methods programmed for
the item.

2-Package pricing is used for items you offer with a price break based on quantity. Package
priced items will sell for the base price up until they reach the quantity assigned in the
package price field. An example of package pricing is where the base price for one can of a
soft drink is set at .79 cents but a six pack is sold for $3.99. If the operator enters a quantity of
6 and keys or scans the item, the register will ring 6 @ $3.99. If the operator keys or scans
each item separately, the register will ring the first 5 soft drinks at .79 cents for a total of $3.95
and the sixth will ring at .04 cents for a package price of $3.99. NOTE: When an item that is
part of a product is sold in a quantity greater than the package quantity, it reverts back to the
base price until the quantity is reached again. In the example above, the 7th, 8th, 9th, 10th
and 11th products would sell for .79 cents each and the 12th would ring up for .04 cents. 
NOTE 2: When an item is set to use price method E, F or S the package price field cannot
be used.

3-LQD or limited quantity discount is used to limit the number of items that can be
obtained for a certain price. A real world example could be that you want to limit the access to
sale items. Setting the LQD to .79 cents for quantity 3 means that only the first 3 items
purchased qualify for the special LQD price. The register will ring any extra items at the base
price. NOTE: When an item is set to use price method E, F or S the LQD price field cannot
be used.

4-Mix-match table # is used to create associations between similarly priced items. For
example, setting a Jello product to use Base price of 3/$1.00 will allow that item to sell at .34
for the first and .33 cents for the second and third. If you want to offer your customer any 3
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different Jello products for 3/$1.00 you must attach them to the same mix and match group.
That way, instead of ringing each of 3 different Jello flavors at .34 cents, the register will ring
the second and third items at .33 because they are in the same mix-match table. Items can
be set to a mix and match table and use all of the price types shown. Items assigned to the
same mix match group should be using a common price method. If they do not have a
common price method the system will not combine the products with different methods. For
example Item 1 is set to Price method E, buy one get one free and mix match group 101.
Item 2 is set to method F, buy one get ONLY one free and mix match 101. For the BOGO to
work on item 1 you must sell at least 2 items number 1. If both items were set to price type E
the system would mix 1 quantity of each and give a free item. If items with the same mix
match have a different price and they all use method E, or they all use method F or they all
use method S, then the cheapest items will always be triggered as the free items. When you
assign a common mix match number to products with a different price L-POS will generate
an error and will not combine the prices. This behavior can be over-ridden by using a system
flag. You must enable an Advanced Flag :Items in the same package will be accepted even if
their regular price is different. This flag is set in PosSetup>System>General>AD.
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5-Points is used for customer loyalty building. You can enter a value of points that will be
issued when this product is sold. The points system can be defined to issue in either amount
or %. Related programming in the register programming utility (PosSetup, System, PLU.)
The default points setting is to issue the points as an amount, not by percentage. NOTE:
Points can also be issued off the tendering amount to simplify maintenance requirements.
This is set in the Button and form programming of the PosSetup module under the
parameters of the actual tender function.

6-Disc $ is used when the price on file should be discounted by a pre-defined dollar amount.
For price levels 2 or greater, a discount entered here will be removed from that level's price. If
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the price level being used has no price entered, the discount programmed will be removed
from the price of the item on level one. 

7-Disc % is used when the price on file should be discounted by a pre-defined percentage.
For price levels 2 or greater, a discount entered here will be removed from that level's price. If
the price level being used has no price entered, the discount programmed will be removed
from the level one price of the item.

N.B. The account discount table does not over-ride the prohibit discount status of individual
PLU's. If you need to give a discount to customers on some PLU's even when the item is
set to prohibit discount you must add any value in the item discount %  for the specified
price level. Access item maintenance and the price tab. Enter any value in the item %
discount field (Price.F112). This discount will not be given to the customer. The customer
will receive the discount from the related sub-department as programmed in the customer
discount table. The value in F112 only means that the prohibit dicount flag should be
ignored if there is a discount rate in the discount table.

8-Loyalty. Set the number of loyalty units to issue when this product is sold. Loyalty units are
computed and sent to an external program by L-POS. L-POS does not accumulate the
loyalty units in its customer database. Use the points field if you want tracking of points in the
L-POS preferred shopper database.

9-Margin (or Markup)

The title of the cost calculation box and the way the price calculation is performed
depends on the setting selected in the L-BOSS, "File" menu, "Configuration" utility's
"Misc" tab's "Cost / Price Calculation" setting, described in the "Misc" tab's help page. press
the Calculate button to compute the price for the current item.

It is important to understand the difference between a MARKUP and a MARGIN, as the
calculation and results are different. These fields allow you to calculate a price based on
a profit margin, or a percentage markup. To use the Margin fields there must be a cost in the
item's cost field. Each price level has its own target pricing box, and each price level can be
set to different values as the target. It is also important to note that if you use price levels,
you should be sure that there is a target value for all price levels. This is because if you ask L-
BOSS to calculate prices based on the target value, the prices FOR ALL PRICE LEVELS is
calculated.

If you have selected to use MARGIN:
The margin is based on the target profit margin, entered in the "Projected" field. The "Actual"
field shows the true margin after calculation. If the Projected margin calculates evenly, the
Projected and Actual fields will show the same amount. It is also possible to set the "Last
digit" field to force L-BOSS to calculate the margin, then substitute the last digit (for example
all prices end in "9"). L-BOSS just replaces the last price digit. For example, you enter 9 in
the "Last digit" and the item's price calculated by margin is $1.81, L-BOSS will use $1.89. If
the "last digit" is 1 and the price was $1.89, L-BOSS will use $1.81. Often, this makes the
"Projected" and "Actual" margins different. 

The MARGIN calculation decides how much to markup the cost to achieve the target profit
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margin, establishing the selling price. An example of a margin calculation: An item costs
$1.00 and you want to make 30% profit. L-BOSS calculates that to make 30% profit, the
item's sales price must $1.43 (note that this is a MARKUP of 42.9%)

If you have selected to use MARKUP:
The markup is based on the target markup, entered in the "Projected" field. The "Actual"
field shows the true markup after calculation. If the Projected markup calculates evenly, the
Projected and Actual fields will show the same amount. It is also possible to set the "Last
digit" field to force L-BOSS to calculate the markup, then substitute the last digit (for example
all prices end in "9"). L-BOSS just replaces the last price digit. For example, you enter 9 in
the "Last digit" and the item's price calculated by markup is $1.81, L-BOSS will use $1.89, or
if was is $1.89. If the "last digit" is 1 and the price was $1.89, L-BOSS will use $1.81. Often,
this makes the "Projected" and "Actual" markups different. 

The MARKUP calculation takes a percentage of the cost and adds it to the cost to obtain a
selling price. An example of a markup calculation: an item costs $1.00 and you want to
markup the item by 30%. L-BOSS calculates 30% of the cost ($0.30), and adds that to the
cost to obtain a sales price of  $1.30 (note that this is a MARGIN of 23.1%)

Margin vs. Markup Comparison Chart 

Margin Markup Margin Markup Margin Markup

4.8 5.0 22.0 28.3 37.5 60.0

5.0 5.3 23.1 30.0 39.0 63.9

7.0 7.5 24.0 31.6 39.4 65.0

8.0 8.7 25.0 33.3 40.0 66.7

9.0 9.9 25.9 35.0 41.0 69.5

9.1 10.0 26.0 35.1 41.2 70.0

10.0 11.1 27.0 37.0 42.0 72.4

11.0 12.4 28.0 38.9 42.9 75.0

12.0 13.6 28.6 40.0 43.0 75.4

13.0 15.0 29.0 40.8 44.0 78.6

14.0 16.3 30.0 42.9 44.4 80.0

15.0 17.6 31.0 45.0 45.0 81.8

16.0 19.0 32.0 47.1 45.9 85.0

16.7 20.0 33.3 50.0 46.0 85.2

17.0 20.5 34.0 51.5 47.0 88.7

18.0 22.0 35.0 53.8 47.4 90.0

19.0 23.5 35.5 55.0 48.0 92.3

20.0 25.0 36.0 56.3 48.7 95.0

21.0 26.6 37.0 58.7 49.0 96.1

50.0 100.0

NOTE: To apply price calculations to all items, or to filtered items, please see the
Maintenance application's "Edit menu", "Item options" help section.

10-Last digit is used to truncate and then replace the last digit of a computed price when the
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calculation function is used to determine the selling price.

11- From and to are the dates and times in which sale prices are active. Placing the cursor
in this field and clicking will pop up a calendar for date selection. Select the date you want to
have the sale price begin on. The next column is to enter the time if the sale price is time
sensitive.

12- To is the date the sale price will terminate. It is used for sale periods only. After the sale is
over the price will revert to the regular retail price. If you do not enter an ending date, L-BOSS
will automatically assign a date 7 days after the start date. NOTE: If you are using the Batch
module DO NOT enter prices directly into the sale price column because they will be erased
by the system. L-BOSS updates the sale price column automatically from batches. If any
batches exist (even 1 batch), all pricing that is entered directly into the Sale price column of
the PLU maintenance will be erased the next time the system checks to see if all batches are
up to date in the price fields.

13- Prohibit Discount. This field is available on both the POS tab and the Price tab. When
an item is selected as Prohibit discount on the POS tab the field on the price tab is not
considered. When an item is not selected as Prohibit discount on the POS tab it is available
for each price type you create. This means the item may be discountable at REG price type
but can be set as non discoutable when assigned to the instore or another price type.

Price B was designed to allow the same item to be sold for different prices. For example you
sell wine in different vintages. For the same UPC code you can enter several rows to the grid
with a different price for each vintage. The POS operator will select from the grid to sell the
correct vintage. The default check box means the operator will only see the price that is
checked and will be forced to use the price modify key prior to scanning the item to get the
list of different prices. Otherwise the default record will be selected automatically by the POS.

The grid for a bottle of wine with several vintages could look like this:

Controlling Rental Items

L-POS can control rental items by setting the items as rental, and defining the rental
parameters. L-POS rental items could include video films in a c-store, VCR machines,
strollers in a zoo, etc. There are 2 types of rental items in L-POS and they must be defined in
the item maintenance.
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Method type must be set to G or to H for rental items. 

Type G should be used for rental items that are rented for different periods of time. Example
of type G rental item is a VCR or Nintendo machine that may be rented for a day, a weekend
or a week at a time. Type H is used for items that share the same rental period. This would
often be the case for most films in a C-store because they are rented for a fixed 24 hour
period and no other choice is available.
 
Choosing method type G for an item will modify the fields available in the price column. No "
Sale" column is available with type G. Price levels are available. Type H items use the price
exactly the way normal items do.

This example shows the Item table's "Price" tab with "G" type rental is selected.

The first field available in Method type G items is the length of the rental period in hours. The
next field is a description of the rental period. The final field is the price for that period of
rental. Add as many rental periods as required for the item being added. If you select Default,
L-POS will use it as the default rental period, even though multiple periods have been
selected. If you do not select a default period, L-POS will open a choice window for the
operator to select the proper period whenever the item is rented. If you select a default rental
period, the Price Modify button can be used to override the default status an pop up the list
to permit operator selection. 

If you have multiple copies of the same item, you will need to create different PLU codes for
each item. This way L-POS can track all copies of each item and the due time or reservation
date of the product. In cases where you need to monitor return times for different copies of
the same product, it is important to follow some basic rules to be able to track the information
for the multiple copies. Here is a practical example.

You have 3 copies of the film Titanic. Create the first PLU number using 1234561. The PLU
number for the film is really 123456 and the last digit identifies it as the first copy. Then create
the second copy as item 1234562 exactly the same way you set up the first copy. Finally
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create 1234563 as the third copy. Now you will be able to define, as shown below, the
position of the copy identifier within the PLU record. This is especially useful when you use
the price inquiry function on L-POS to query how many items you have in stock.

Other information on the rental system is defined in the Possetup module System set-up
screen under the Rent tab.

Rent tab

Rental items can be controlled by L-POS when the system is used with the L-BOSS backend
system. The rental tab includes general programming that defines how the rental system will
operate. The rental items are set up in the L-BOSS system under PLU programming.

Return time:
L-POS can control return time for rental items two ways. The more popular
application for rental with L-POS is controlling films in a c-store type application. In
this type of environment, the return time is usually determined as being 6:00 pm or
thereabouts. If this is your case, leave the Check box for Based on the period as a
blank. An item rented today at 3PM will be due at the return time tomorrow. Same
thing for an item rented at 11PM tonight, it will be due tomorrow at 6:00PM if a return
time is specified.
When L-BOSS is used for rental that is based on time, you need to place a check
mark next to Based on the period. This would be used in an application where
something is rented for an hour, 2 hours, 8 hrs, etc. An example would be strollers
rented to customers by the hour in an amusement park. When you select this option,
any time that shows in the Return time will be ignored.
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Late fee

Open account: Set this flag to automatically open the customer account who is
returning a film late. There is a related flag in the  PosSetup>System>General>Ad
vanced flags: Bypass customer contact on late return. This flag must be set if you
want to open the account and charge a fee automatically with the Late fee button.

Charge late fee: Select this flag if you want the system to  activate a button when a
film is returned late.

Automatic quantity: Use this flag to send the number of days an item is late to the
Late fee button. An item returned 3 days late will enter 3 QTY end press the Late fee
button.

Use same PLU: Select this flag to use the same item as the late fee. When you
select this flag it is important to set the PLU function 710 as the first function executed
in the late fee button.

Late fee button: By default there is no button programmed as late fee on the default
L-POS set-up. So the button shows [None]. To charge a late fee you need to assign a
button in the rental set-up screen. If you decide to set the flag "Automatic quantity"
and "Use same PLU" assign the PLU button. If you want to charge a different fee you
can program a PLU as late fee charge and assign a Pre-Set PLU as the Late fee
button.

Grace period
To permit an automatic grace period beyond the return time, enter the grace time in
hours (probably as a fractional amount) or in percentage of the rental period. Selecting
a percentage of the rental period (such as 10%) would obviously extend a 30 day
rental by 3 days (such as a pair of crutches in a pharmacy.)

Copy identifier
When several copies of the same item are available it may be necessary to easily
learn if a copy of the item is still in the store. By creating a pattern or mask for the item
numbers of the same film L-POS will be able to respond on film availability.

You can determine which digits represent the copy number within the PLU number
entered to rent the item. The copy identifier digits can be placed at the start or at the
end of the PLU number created in L-BOSS. Choose First x digits = copy to place
the copy identifier digits at the start of the PLU number. Or select Last x digits =
copy to place the copy identifier at the end of the actual PLU number. 
You may also determine that the PLU number itself is a specific length and the
remaining digits are used as the copy number following the same logic as above.
Select First x digits = Item or Last x digits = copy if this is the case.
You can also define how many digits are required to identify the copy. If you never
have more than 9 of the same item, select 1 in the #digits entry. This field
corresponds to the value x referred to in the First x digits = copy field.



L-BOSS User Manual 4.1.3164

© 2001-2014 ... Logivision

If you never have more than 9 copies of a film, one digit will be enough to differentiate
between the films. Take the example of item number 12345 which is the PLU code for
the film Titanic. If you had 4 copies of the film you could number them 123451, 123452
, 123453, 12344. if you were to set the configuration of the copy identifiers to use the
Last x digit, and set 1 in the number of digits field L-POS will understand to search
all 4 items when you request status for item 12345.

Note: When no copy identifier is required the value "# of digits" should be set to zero
to speed up inventory queries on the POS system. This would be the case when you
never have more than one copy of a film, or when you receive pre-coded films that
cannot be fit with the L-POS masking system.

Type H period is used to define the fixed period used by price type H PLU items.
These are rental items that do not have variable rental periods like the price type G
items. This would be most common for items like films in a c-store that are always
rented for the same time period.

Price P was designed to allow the same item to be sold for in different sizes For example you
sell beer in different packages. For the same UPC code you can enter several rows to the
grid with a different package quantity  and price for each size. The POS operator will select
from the grid to sell the correct package. The default check box means the operator will only
see the prompt list of the press a Price modify key prior to scanning the item Otherwise the
default record will be selected automatically by the POS. To get the prompt do not select a
default.

The grid for a soft drink with several package sizes could look like this:

Method Type Q is assigned to attach an item to the loyalty rewards program. Items can
be paid with either the L-BOSS preferred shopper points or with rewards maintained by
some 3rd party loyalty systems. When price type Q is sold L-POS can display a list of
qualified products available at a preferred price in exchange for points. The preferred
price and points required are programmed using PLU items assigned as price method R.
This PLU that uses price Method R is assigned as the PLU link on the POS tab of the
method Q product. Read the next section to see how you create the prices for Method R
products.
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Method Type R is used to set the different redemption levels for the loyalty rewards
system. For example a product normally retails for $3.99 but can be purchased for $2.49
when you redeem 1000 points. And the same item is free with a 1500 points redemption.
For each different reward level you add a row in the grid. Set the quantity of points used
to sell for a price. The price you enter is the price that will be used for the Type Q plu to
which you attached this type R item. The operator will see a form in the POS that
displays all the available reward items and the amount of points it takes to get that item
for the reward price.
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Price type R item sample.

NOTE: To use the reward, you need function 8073 (Loyalty Redeem) programmed on
POS

Adding prices to items

L-BOSS can be purchased with or without the Batch included in the program license. If you
do not own the batch license you are limited to creating price types REG and SALE. You can
have one REG price and one SALE price at any given time. But you cannot create more than
one sale price for an item without the batch option.

Users that purchase the batch option can create as many price types as they want. For
example they can create the REG price, enter information for many future promotions and
also create an instore price for any items.

Set a SALE price for an item:
Each PLU you create will automatically create a REG price type for that item.  You can also
set a SALE type price for each item. Click the F11 - Add button. You must enter a start and
end date for the SALE item.

Adding other price types
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If your system includes the license for the BATCH module you can additional price types.
Press the F11-Add button. At the prompt select SALE, INSTORE or enter a description for
any Other price type you want to create. When you select SALE or Other you need to enter a
start and end date or the price type will be invalid. The INSTORE price will override all other
prices for that item that are on the same level and in the same target zone.

Refer to the batch help menu to add items through a price batch.

2.2.4.7.1.7  Cost Tab

Item (PLU) Maintenance: Cost Tab

Each PLU can be assigned a cost for each vendor from whom it can be purchased. There is
no real limit as to how many vendors and costs an item can have, but items must have a
"Default" vendor. To assign vendors and costs to items, select the Cost tab from the PLU
maintenance option. The F7 function key can be used as a shortcut to access the Cost table
immediately. The information in the cost table, such as Case / Cost will define the way this
item behaves in the Entry module, when dealing with orders, receiving and adjusting
inventory.

Note: The cost information is also used to keep track of the actual (or real) cost of the item
when it sells at the POS. This means that any changes made to item costs MUST be
"deployed" to the front end to keep accurate cost information for items.
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This example shows the Item table's "Cost" tab.

Cost Target: The target allows you to create different cost records for the same item based
on different regions. The target applies to both the Regular cost and Cost break sections. In
most situations, the default "PAL" target does not need to be modified, since the item has
only one cost per vendor. However, in multi-store situations costs may vary from store to
store, even from the same vendor, often because of regional differences. The Cost target
determines which store or cost group the cost applies to. Click on the cost target you want to
change. The window contains up to 10 of the available cost targets, when more than 10 cost
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targets exist a horizontal scroll bar allows you to view the additional targets.

L-BOSS automatically tries to select the target called PAL which is the default target. The
window displays other targets in bold or in italic characters. If PAL target is not set the system
will select the first target it finds. The Cost target window has different fonts for different
targets. The target name will be in bold font if a cost was entered for that target. The target
name will be in italic font if no cost was entered for that target. The target you are currently
viewing is selected in Blue.

Working in the cost tab: The Cost tab is divided into two (2) sections, Regular cost and
Cost break. The Regular cost section deals with the normal cost for this item, when
purchased in the usual quantities. The Cost break section deals with purchasing options from
the selected vendor. Each vendor for an item can have multiple Cost break setups.

Note: To work with each section, use the tool bars at the top of that section, not the toolbar
across the top of the PLU maintenance screen.

Regular Cost Section

To add a cost and vendor for an item, double click in the Vendor # field to select from a list
of vendors. You will be prompted to accept the selection. 
To add additional vendors and costs for the same item, use the "+" button within the
Regular cost section, or hold down the [Ctrl] key and press [A]. 

If there is more than one vendor for an item, use the black left and right arrow buttons at the
top of the Regular Cost section to move to the next or previous vendor. 
To remove a vendor from an item, select the vendor, then press the scissor button at the
top of the Regular Cost section, and accept the prompt that appears asking if the vendor
should be removed from this item.

Vendor #: This is the number that has been assigned to identify a vendor in the system.
Once the Vendor table has been configured with the list of vendors, you can double click to
select from the list of vendors that exist in the system. For more on how to program vendors
in the system, see the Vendor Table programming section below in this manual. 

Item Code: Most vendors use their own codes for items, different from the UPC or PLU
code. If you have assigned a vendor's item code for the item, it can be used to retrieve items
from the PLU maintenance by pressing the [F5] button, and entering the vendor's item code.
You can also search the vendor code list by pressing [Shift] and [F5]. A vendor code
selection list opens, displaying a list of all vendor item codes in the system.

Case / Cost: This is the case quantity for the item, followed by the case base cost. If the item
is purchased by unit from the vendor, enter 1 as the quantity per case, along with the unit
cost. After entering the cost for the default vendor, be sure to enter the cost for any other
vendor that supplies this item. The Case / Cost information will be available in the Entry
module when ordering or receiving from the assigned vendor.

Remark: Is used to enter a short, meaningful note for the item, up to 30 characters. Often
this is to remind users of some important fact about purchasing the item from the linked
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vendor, or other special note about the item.

Default: As mentioned above, items with a cost MUST HAVE a default vendor. There can
only be 1 "default" vendor for each item. If you set the Default flag for a vendor, the system
removes the Default flag from all other vendors for the item. The default vendor flag is used
by the system when working with inventory, such as orders generated by the system.

Unit Cost: The Unit cost field is the calculated cost per unit based on the information entered
above. You cannot edit this field directly, and appears as a confirmation.

Cost Break Section

The Cost break section allows you to enter additional cost information from the vendor,
notably the quantity purchase breaks offered by the vendor. Many vendors offer dollar or
percent discounts when certain purchase quantities are reached. Each vendor for an item
can have many Cost break entries. For example, if a vendor offers several cost break levels,
they can all be entered, so that when purchasing items in the Entry module's Order option,
the system can alert you that there may be a better cost if you order more.

Note: Each Cost break record MUST HAVE both start and end dates to be valid. If both
dates have not been selected, the system will prompt you before leaving the record.

To add a cost break for an item's vendor, enter the purchasing quantity specified by the
vendor in the "Quantity break" field. You will be prompted with a calendar to enter the start
date for the cost break.
To add additional cost breaks for the same vendor, use the "+" button within the Cost break
section, or hold down the [Ctrl] key and press [A].

If there is more than one vendor for an item, and they all have cost break information, use
the black left and right black arrow buttons at the top of the Regular Cost section to move to
the next or previous vendor. The Cost break information changes to reflect that vendor's
cost breaks. Then, use the black left and right black arrow buttons at the top of the Cost
break section to move to the next or previous cost break for the selected vendor. 
To remove a cost break from an item, select the appropriate vendor from the Regular cost
section, then select the cost break information to remove and press the scissor button at
the top of the Cost break section. Accept the prompt that appears asking if the cost break
information should be removed from this vendor for this item.

Quantity Break: The quantity break field is used to enter the case quantities (or units if
purchased that way) that must be purchased from this vendor to obtain the cost break.
Remember that you can have different levels of Cost breaks from each vendor. For example
if you purchase between 10 and 20 cases, the vendor offers a certain cost, but between 20
and 30 cases, there is a better cost. Each cost break level is programmed to reflect the
purchasing information.

From / To: Both the from and to fields must contain valid dates for the cost break offer.
Double click the date fields to open a calendar utility, making date selection easy. You can
also enter the dates manually, keeping in mind that the date format for these fields follows the
Windows "Regional settings" setup for date formats on the host computer.
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$ Discount: Enter the discount amount in dollars, if the vendor offers a dollar based discount
for this cost break.

% Discount: Enter the discount amount as a percentage, if the vendor offers a percentage
based discount for this cost break.

Unit Cost: The Unit cost field is the calculated cost per unit based on the information entered
above. You cannot edit this field directly, and appears as a confirmation. This field is handy to
quickly see the difference between the Regular Cost unit price, and the Cost break unit cost.

2.2.4.7.1.8  Inventory Tab

Item (PLU) Maintenance: Inventory Tab

Using the inventory feature

The system can track inventory levels to assist the ordering and receiving process. The first
step is to define whether stock on hand and reordering is being used on the item. These
settings are available in the PLU maintenance. The inventory settings are located in the same
column as the regular retail price on level 1. Note that changing to another level does not
affect the inventory settings you make. All price levels share the same stock on hand.

The table below shows the fields that can be defined in regards to the inventory tracking for
each item. There are four fields to define.
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This example shows the Item table's "Inventory" tab.

Store number is needed when you are working on a multi-store inventory system because
stock levels may not be the same at all stores.

Inv. (Inventory tracking) Select this field to allow the stock to be tracked on this item. If you
place your cursor near this field an information field will appear that displays the number of
items on hand.

Ord (Reorder item) Select this field if this is an item that is reordered using the L-BOSS
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ordering system.

Min (Minimum on hand) Enter the minimum quantity in selling units that should be kept on
hand for this item.

ROQ (Reorder quantity) Enter the quantity that should be ordered (in multiples of the
purchase size.)
This table does not require any entry for items that do not use inventory tracking. For
example, if you are using an item code for miscellaneous sales you will most likely not need
to order the item. It is a non-stock item. No entry is required in the inventory table. The same
would be true if you purchased an end of line or some discontinued products.

Once the inventory flags for a re-order item have been defined it will be possible to set up a
link to a vendor (s) that supplies the item. The vendor link is required to be able to define a
cost and a purchase format for the item. For example, if you sell jars of mustard you probably
order the mustard by the case. In the cost link table you will define the purchase format for
the item. In the inventory information on the item maintenance you will define the minimum
number of jars of mustard to keep on hand. In the reorder quantity you will enter the number
of cases you want the system to suggest as an order when the minimum is reached.

The Parent / child fields are used to link items together for inventory tracking. For example,
you purchase cartons of 200 cigarettes, packaged as 8 packs of 25 cigarettes each. The
cigarettes are sold by both the carton and by the package. You therefore need to create 2
items with separate UPC codes so that they both affect a common inventory level. Here is an
example for parent - child set-up.

Create item 1111111111 (the UPC code for a carton of 8 packs of 25 cigarettes of
Brand A). 
Set this item 1111111111 to track inventory in the inventory tab. Set the minimum and
reorder quantity to the desired level. 
In the cost tab select the vendor and set the quantity per case as 1 with a case cost of
$24 (for our example of course you can set your real cost here...) Enter the vendor
item code if required on your system. This is the warehouse number for the product.
Set the default vendor flag if not already selected. 
In the Price tab, set the price of item 1111111111 to sell as a carton. For example, 1
quantity for $32. 
Now create item 2222222222 to be able to sell a package of cigarettes of Brand A. 

Price the item 2222222222 to sell for $4.25 for one pack. 

Item 2222222222 would not be set to track inventory. 

Item 2222222222 will have Parent - child set to Active. 

Below the active you will enter the item number of the parent product. In this case that
field will be set to item 1111111111 which is the code for the carton of Brand A. 
The parent item would be set to 1111111111 (UPC code of carton Brand A.) 

The quantity in the parent-child window will be set to .125 because when you sell a
pack of brand A you want to reduce the stock level of the carton by one package or
1/8th of a carton. 

Now you will able to sell both packages or cartons and reduce inventory for the same item.
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NOTE: You can also decide that you want to maintain the inventory in packages, not in
cartons of cigarettes. In that case you would program the cost on the package of cigarettes
(item 2222222222) as follows: Vendor xxx, units per case would show 8, cost per case would
show $24 (as above) and the vendor item code would be the same as before. Then you would
set the inventory to be tracked on this item. The "parent - child" relationship would be set to
active on the carton (item 1111111111) with a quantity of 8. This means that when a carton of
cigarettes is sold, it will remove a quantity of 8 packages from stock on hand. So you are still
purchasing cartons of 8 packs of cigarettes and both the carton UPC and the package UPC
will be reducing the same inventory.

NOTE 2: You can determine the behavior of the inventory tracking for items tracked by
quantity and for items tracked by weight. This change is made in the L-BOSS configuration,
Advanced settings. When this option is set, the on-hand quantity of scalable and price type I
(weight-tracking) products will be based on weight. The system will also default to the weight
field for those products during inventory transactions in the Entry program.

2.2.4.7.1.9  Sales Tab

Item (PLU) Maintenance: Sales Tab

The Sales tab is available to view sales of this item for previous periods. You can view sales
data for any 31 day period, or the last 7 weeks. Right click in the grid and a pop-up window
will appear. You can select the period end date, and view a weekly graph, or daily graphs for
the 14 days preceding the ending date or the 31 days preceding the end date you choose.
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If there is no weekly closing for the last weeks, the Maintenance application shows a warning
message asking if you have run the MAKEWEEK command. Normally, the daily,  weekly and
monthly closing commands are configured as events in the Events / Tasks manager at
installation to run automatically at appropriate times.
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This example shows the PLU week ly "Sales" tab.

The sales figures (quantity and amount) are displayed in graphic format to give the viewer a
quick overview of recent sales for the item selected. 

2.2.4.7.1.10  ECL tab

Creating Electronic Coupon links

Situations arise where mix and match or other price models do not work for the type of deal
you may want to run. L-POS has the ability to trigger a discount when specific criteria have
been met in a transaction.

The "ECL" tab allows the user to create items as electronic coupons linked with a set of rules
that establish when the coupon is issued. The ECL tab displays the records created as the
coupon rules. It is possible to have multiple records programmed with different conditions that
must be met to trigger the coupon. For example, you may want the POS to issue a coupon
when a customer purchases a specific quantity of items ("buy 6, get one free"), or
combination of types of items marked with a "Promo ID". The ECL tab records can be used
to maintain simple or compound promotional rules.

The ECL tab table is dynamic, meaning that depending on the "Type" field for each rule
record, the fields in the rule record contain values for the related type. 

To use the ECL tab you must first create a new unique item code with a description,
subdepartment and value (price) fields. In the POS tab of this item set the flag store coupon
to yes. The coupon's value in the price field is positive, but because it is marked as a "store
coupon" in the POS tab, the front end will subtract the coupon's value from the transaction it
is applied to. Once the coupon item has been created, you can determine the set of
conditions in the Promo tab that will issue the coupon during the sale.
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Example automatic discount by electronic coupon: Imagine the case when you want to
sell a coffee and a croissant for a total of $1.99 even though the normal price is 2.48
combined (coffee at .79 and croissant at 1.69). You cannot use a mix match group because
2 of either product would trigger the 1.99 price and you don't want to allow 2 croissant or 2
coffee to be sold at that deal price. So we move to the ECL table and create a new item that
will give a .49 discount when a coffee and croissant are sold together. 

Set-up: 
1-Create a new PLU item called Coffee & Croissant promo.
2-Set the sub-department for this new item to where the discount will be reduced.
3- Set the Store Coupon flag on this item (it will make the price negative so this PLU acts like
a coupon).
4-Set the price of this item to be the price reduction price for this item combination.
5-Add a first qualifying record in the ECL tab of the new Coffee & Croissant promo item. Set
this to type ITM and enter the PLU number for the Coffee.
7-Add another record to the ECL table of the Coffee & Croissant promo item. Set this to ITM
and enter the PLU number of the Croissant.
 (You have now instructed L-POS to sell the Coffee & Croissant promo item automatically
when the 2 products on the ECL tab are entered in the transaction.)
8-Deploy all changes to the POS.

This example shows the "Promo" tab set-up for
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an in store electronic coupon. The coupon PLU
named Coffee & Croissant promo will be
triggered by the POS once the Large coffee and
the Chocolate Croissant items are entered into
the transaction.

Meal deal or Combo pricing

Another scenario exists that occurs when you want to run a  combo deal on different
products for a total price where the base price of the items included in the deal is not
necessarily the same. Imagine a combo where any pastry and a small coffee can be
purchased for a total of 1.99 even though different pastries combined with the coffee give
different totals. To use the ECL coupons as mentioned above would require a new coupon
item for each different price combination. But you can create an item that will replace the
individual prices with the price of the combo deal.

Example of Combo deal (Pick 5 deal): This makes the POS act on meal deal items as
follows: when the ECL table criteria are met the Price of each qualifying item becomes ZERO
and the MEAL DEAL item is triggered and the Meal deal price is used. Purchase any Pastry
(pastries may have several different prices) and a coffee for 1.99 no matter what the total
price would have been.

Set-up: 
1-On each of the qualifying pastry items set the Promo ID (POS Tab F383) to a common id
number.
2-Create a new PLU item called Pastry-coffee duo.
3-Set the sub-department for this new item to where the revenue for the sale of the deal will
be tracked.
   (This item is not set as Store Coupon or Vendor Coupon because we want to replace the
individual price of each qualifying item to the price of the Pastry-coffee duo)
4-Set the price type of this item to D (package price)
5-Set the price of this item to be the meal-deal price for this combo.
6-Add a first qualifying record in the ECL tab of the new MEAL DEAL item. Set this to type PID
(promo id) and enter the promo id number you set on the pastry items in step 1.
7-Add another record to the ECL table of the MEAL DEAL item. Set this to ITM and entre the
PLU number of the small coffee.
 (You have now instructed L-POS to sell the MEAL DEAL item automatically when the
products on the ECL tab are entered in the transaction.)
8-Deploy all changes to the POS.

Hint: This can also be useful when you want to sell many UPC2 items (read price from label)
for a total price rather than the scanned price of each package of meat or cheese... Such as
on Friday evening when the meat counter is full and you would like to sell any 5 items in it for
19.99. All the qualifying items found in the counter would be given a common promo ID.
Create a "PICK 5 ITEMS" PLU would be set as Price type D with a price of 19.99. The ECL
tab of this PICK 5 ITEMS PLU needs one record. The record must have the PID number that
was given to each of the individual meat items and the QTY field must be set to 5. This
means that when 5 of the qualifying items are sold the system will trigger the PICK 5 ITEMS
PLU and replace the unit price of each item with the package price of 19.99
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NOTE: Remember that although the Promo tab is displayed for all items, it is only used in
conjunction with items marked as "Store Coupons" in the POS tab.
NOTE 2: You cannot Error correct an item using Price method D (as the meal deal items
explained above.)

ECL qualifying record Type

To create the promo rules for the store coupon, select the promo tab, and double click the
"type" field. A list of promo types appears, allowing you to choose the promo type. NOTE:
Depending on the type of promo, some of the fields may not apply, or the type of values each
field contains may vary.

ITM - Item: Select the ITM type to use an item code and quantity or amount sold as the type
of promo. Once the quantity entered in the "Qty" field is reached during the period established
in the "Method" field, the POS will issue the coupon. In a "buy 6 get one free" example, make
the coupon's value the same as the product's value; when the cashier scans the 6th item, the
POS diminishes the amount of the transaction by the value of the coupon. NOTE: When ITM
is the selected type, the "Code" field contains the item code.

PID - Promo ID: The Promo ID is used in connection with the Promo ID field on the POS tab.
The list of Promo IDs is user defined, selectable from a drop down list after they have been
created. Once a promo ID record exists, different products can be tagged with the ID. For
example, a coupon can be created and be issued when a customer purchases any three
items marked with that promo ID number, like a bag of chips, a soda, and candy bar. NOTE:
When PID is the selected type, the "Code" field contains the user defined Promo ID number.

SUB - Subdepartment: This coupon rule checks for items in a specified subdepartment.
The coupon can be set to issue when a pre-determined quantity or amount is purchased. 
NOTE: When SUB is the selected type, the "Code" field contains the subdepartment
number.

DPT - Department: Like the subdepartment coupon type, this coupon rule checks for items
in a specified department. The coupon can be set to issue when a pre-determined quantity or
amount is purchased. NOTE: When DPT is the selected type, the "Code" field contains the
department number. 

PTS - Points: If the POS is set to issue points for items purchased, this coupon rule
determines the amount of points required before the coupon is issued.(not implemented as of
Nov 2007)

CLF - Client Level: This coupon rule will limit the use of the coupon to customers assigned
to the customer level (determined in the Customer table) programmed here. This can only be
used in situations where the Accounts Receivable module is registered for the installation. 
(not implemented as of Nov 2007)

TTL - Total sale: Use this "type" of coupon to establish the total amount of the transaction
required before the POS will issue the coupon. Enter the total amount required in the
"Amount" field. (not implemented as of Nov 2007)
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Cumulative Purchases

The "Cum" field is used in conjunction with the Customer Accounts ONLY. It is used to
establish the tracking period for the coupon rule. It can be set to issue the coupon every time
the rules are met by transaction, or over a set period of time. In other words, the POS will
access the customer account to find the total purchase over the period determined by the
"Cum" field. (not implemented as of Nov 2007).

Method Qualifier

The Method determines the amount of times the coupon can be issued during a transaction.
If no Method is set, the default is "Unlimited".

Once Only: The coupon will only be issued once during any transaction.

Unlimited Repeat: The coupon will be issued as many times during a transaction as the
coupon's conditions are met.
"Biggest Only" or "Smallest Only" are used to limit the coupon to one item when more
than one of the item are sold during the same transaction. For example, a discount is
offered on turkey sold by weight, but the store only wants to discount the largest turkey
purchased if there are more than one entered in the transaction.
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2.2.4.7.1.11  ECommerce Tab

Use this tab for items that can be sold on the L-BOSS eCommerce application.

Main description: L-BOSS allows you to define a longer description of products that can be
purchased on the web. Use Shift-Enter in the edit box to force a Carriage return.

Alternate description: Enter second language description for the ecommerce application.

Main promotion description and Alternate promotion description:  Enter description to
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add when product is on promotion on the ecommerce platform.

Price: Enter the price to sell this item on the web store.

Sale price, Sale start, Sale end: Enter the web store sale price, start and end dates.

Active: Set this flag for items that should be available for sale on the web store.

Coupon: This button was added so that there is an easy way to copy the item number of the
current item to the item number field of the Web Coupon you are editing.

Width: Enter product width in same unit of measure as your shipping application uses.*

Height: Enter product height in same unit of measure as your shipping application uses.*

Depth: Enter product depth in same unit of measure as your shipping application uses.*

Weight: Enter product weight in same unit of measure as your shipping application uses.*

* Click the unit of measurement (in. or cm.) to switch between Metric and Imperial
measurement types.

2.2.4.7.1.12  Kit tab

Creating kits

Some stores need to create kits to sell package deals. Examples of kits: aquarium, filter,
pebbles, etc in a pet shop. In a sport store it could be the golf clubs, bag and lessons that
make up a specially priced deal or kit.

A kit is used to sell the kit contents automatically by entering the kit PLU number. To create a
kit you need to start by defining the number that will be entered to sell the kit. When you have
chosen the PLU number add it to the database as you would for a normal PLU item, setting
its price, subdepartment and other information that you normally define. To define the item as
a kit, select the kit flag on the Object tab. 

Please note that kit items only use the base price field. You cannot set kit items with package
price, limited quantity discount or any other fields in the price tab. Older versions of L-BOSS
allowed you to enter package price, discounts and other extended price features available
fopr normal items. Even if that information is present in the file it will be ignored by the POS.

The kit items have many flags that are not used by the POS. The status for tax is not read
from the kit item. The POS uses the tax flags of each individual item included in the kit. A kit
can be set as price required or as visual verify. But items in the kit will not use those flags
even if they are set. 

Keep in mind that if customer entry is required it must be made before kit items are entered in
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the POS transaction.

This will toggle the cost tab to become the kit tab. Access the kit tab to select the items that
should be deducted from inventory when the kit PLU is  sold. 
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Building the kits

The PLU items that make up the kit need to be added to the grid showing on the Kit tab. To 
add an item to the Kit list, double-click in the PLU number column and select the PLU you
want to include. To remove an item from the kit list, right-click on the PLU to remove and
press delete. The description of the PLU appears automatically. A default quantity of 1 will
be set. You can modify the quantity to be used when the kit is sold by accessing the quantity
column and entering the correct quantity. The price and amount fields display the unit price
and extended amount of the individual PLU's according to the quantity you selected and using
the current price level and price target. These fields cannot be edited here. If you want to
change the price of an individual PLU use the normal price change feature in PLU
maintenance for that item. The ratio column displays the revenue that will be attribued to each
PLU based on the price of the kit. This column cannot be edited. The system assigns the
revenue to each of the PLU's on a pro-rata basis. The last column called No represents No
void. This flag is used to determine whether the item can be removed from the kit by the
operator on the POS terminal. This may be required if you want to remove an item and sell
another item in its place. Note that the item is removed at the ratio price. The new item will be
entered at it's regualr price.

The bottom of the kit tab  displays the total price and cost of all components. The kit profit and
profit percentage are displayed for your convenience.
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Note: The kit tracking feature is not available with all POS systems. It is functional with L-
POS front end terminals. Please inquire with your dealer to verify that kits are available with
your front-end terminals.

2.2.4.7.1.13  Condiments - Modif iers

L-BOSS and L-POS allow adding a remote printer, often used to send orders to a preparation
area. It may be necessary to all condiment or modifiers when an item is ordered. Here is how
you can set up items that will be used as condiments when a product is ordered. 

Let's say you are preparing a hamburger and want to tell the cook it is all dressed, or mustard
and onions. You will need to press a button to sell the hamburger and then you would like a
form with the different condiments or modifications that can be made to the hamburger.

L-BOSS uses the PLU link to tie multiple items to a main menu item. 

1. Set the flag Allow multiple alias.  This allows entering the same PLU code as an alias on
many different items.
2. Create an item called All dressed to be used as a condiment for hamburgers. If it is a free
item use Price type M. On the Object tab of this item assign the alias 000000000000C1. This
is a 14 digit number with 12 leading zeroes. We chose C1 to link all the condimenst to the
Hamburger menu section.
3. Create an item called Mustard to be used as a condiment for hamburgers. If it is a free
item use Price type M. On the Object tab of this item assign the alias 000000000000C1. 
4. Create an item called Onions to be used as a condiment for hamburgers. If it is a free item
use Price type M. On the Object tab of this item assign the alias 000000000000C1. 

Now locate each of the items that you need to link condiments to automatically.
1. Assign the item code 000000000000C1 in the POS_TAB field called Link to.
2. Repeat for each item that requires a condiment selection.

After you have deployed all changes and you select the Hamburger the POS will display a list
of condiments that you can select for the hamburger. This type of list is not very conducive
and actually closes once the first condiment is selected. Rather than use a list you need to
set an advanced flag in PosSetup. Open the PosSetup>System>Advanced list.
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Set the Use condiment form when Alias used on PLU Link to True. Now L-POS will
display the condiments automatically on a form rather than on a list. The use of the form
requires that you supply a bitmap image for each condiment item. These images should be
selected using L-BOSS the same way any other item is assigned an image. if there are no
images the condiments will not appear on the form.

If you have other menu sections that require different condiments you can create them using
condiment group 2, all linked by item number C2 for example. When a specific condiment
needs to apar in 2 different condiment groups assign a second alias to that condiment. So for
example mustard can be part of condiment group C1 and condiment group C2. You would
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assign alias 000000000000C1 and 000000000000C2 to the item Mustard.

2.2.4.7.2  Working With Items

Working with Items Overview 

In this help section you will find information about:

Filtering and Global Modifications: L-BOSS utility that allows you to work with groups of
items by setting a "filter" to extract the items from the database. This means that changes
can be applied to items with similar pricing or other common programming attributes.

Add / Copy / Delete Items: The correct procedure to follow to create new items, either by
manually entering all the information, or copying information from an existing item (except the
item code), and how to remove items from the database.

Deploying Modified Items: Once you've made changes to items or other information that
affects the system, the modifications (or additions) must be "deployed" or activated in all
existing stations.

Rental Items: L-POS and L-BOSS can deal with items that are for rent, including multiples of
the original code. Rental items can be controlled with in / out dates.

Printing Labels: Items can be set to trigger the system to produce labels when there is a
price change.

2.2.4.7.2.1  Filtering and Global Modif ications

Extracting Items Using Filters

The Maintenance application includes a "Filtering" option used to select multiple records
based on common criteria, often used in combination with the "Global Modification" feature.
For example, it may be necessary to find all items in a specific sub-department with a price
greater than $1.79 AND taxable 3 flag selected. The following explains how to set up and use
filters.

Setting a Filter

Start be clicking the filter icon  from the icons area of the PLU maintenance screen. You
can also select the filter option from the Global Modification menu. Once filter mode is active,
the additional filtering will appear on the screen.

Press  to select the fields you want to use to filter the item file to extract records. Next,
right-click on the field to be filtered. If you right click an alpha field (like item description), a
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new window appears allowing you to select the "Criteria" used to filter the description. The
choices are available by using the pull-down menu in the Alpha-numeric window as shown
below.

Filtering with an Alphanumeric Field

This example shows the Filter setting tool.

Equal to  will list only the items that match exactly with the data you enter in the search field.
Begins with  will list all items that begin with the same data you enter in the search field.
Ends with  will list all items that end with the same data you enter in the search field.
Includes will list all items that include the same data you enter in the search field.
Not equal to  will list all items that do not match the data you enter in the search field.

Filtering with a Currency Field

When you set a filter in a currency field, the search criteria is different as shown below. Right
click in a currency field such as price to obtain the filter window.

This example shows the Filter setting tool.

Equal to  will list only the items that match exactly with the data you enter in the search field.
Greater than  will list only the items whose price is greater than the data you enter in the
search field.
Smaller than  will list only the items whose price is less than the data you enter in the search
field. 
Different than  will list the items whose data is different that the data entered in the filter field.
Between  will list the items that are between the 2 amounts entered.
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Filtering with a Logical Field

A "Logical Field" is a field that has only two (2) possible values, for example, On or OFF, True
or False, selected or not selected. When you set a filter by right clicking on a logical field such
as taxable, the window appears like the example below:

This example shows the Filter setting tool.

In a logical field, if you mark the selection box, the filter will list the items that have the field
selected as well. If you leave the selection empty, only the items that do not have the field
selected will be listed.
 

Filters may be set on several fields to pinpoint exactly the items you are searching for. When
a filter is activated, the field being filtered becomes yellow. 

To view the fields that are currently filtered press the  icon. The system will display the list
of fields currently being filtered.

To activate the search on the filtered items, press the  icon. The system will create a table
and list the items which respond to the search. 

When you need to clear the filter, press the  icon.

While the filter is active, the next record icon and the previous record icon will move ahead to
the next record that responds to the active filter. 

Combining Filters and Global Modifications

It is also possible to perform Global Modifications  on the item file. To use global
modifications, you must first establish a filter, explained above. Several tools are provided to
set the modification. 

Press the  to enter the Modification mode. Right click each field to modify.

When you have completed the modifications it is possible to view the modifications that are

about to be applied by clicking the  icon.
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To apply the modifications to the list of filtered items, press the  icon. 

To clear the modifications at any time, press the  icon.

You can perform global modifications on logical fields by either selecting or clearing the flag
set in that field. A global modification in an alphanumeric field such as the description will
replace all descriptions with the one you entered. A global modification performed on a
currency field such as the price allows you to replace and increase or decrease by amount or
by percentage. When you make a global modification on a currency field based on a
percentage increase or decrease you also have the option to set the last digit the price will be
rounded up to. If you want all the prices to end with a 7, enter it in the ending with  column.
All prices will be calculated and then rounded up to numbers ending with 7, such as 1.37,
1.47, 1.57, etc.

2.2.4.7.2.2  Add / Copy / Delete Items

Creating and Removing Items

Adding New Items

There are several options to create new items, depending on the circumstances. Sometimes
it is easier to create a new item and fill in all the required information manually. To create a
new, blank PLU code in the system, use the "+" toolbar button. Clicking the plus tool opens a
"New PLU" window that prompts you for the new code. After entering the new code, the
standard PLU edit screen appears, allowing you to enter the complete item information.

Adding New Items by Copying

Often, new items contain much of the same information as an existing item. For example, a
manufacturer decides to distribute a new flavour of an existing product. This means that the
new item's format, vendor and price are probably identical as existing items, with the only
difference being the UPC (item code) and descriptor. In these cases, it is much easier to
create the item by copying the information from an existing PLU. To create a new item by 
copying* from an existing one:

Instead of pressing the "+", enter the new code directly in the "Item Number" field, just as you
would to extract an existing PLU from the database. Because the Maintenance application
doesn't find the new code, it opens a QueryForm panel with the following options: 
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This example shows the item creation options.

Options

Cancel to abandon the operation if you have entered a non-existing item code in error.

New creates the new item and blank all the existing data fields, following the same procedure
as described above for creating items with the "+" toolbar button.

Always New creates the new item and blanks all the existing data fields, and continues
using the same process for every new item code entered. The QueryForm panel will not be
presented again until the Maintenance application is restarted. This will save time by reducing
the operator prompting.

Copy uses the item on the screen as a template for the new item being added. Most of the
data fields will be copied to the new item. This is time saving when creating items that have
common information. You can control how the system copies multiple targets. In the L-BOSS
configuration advanced settings select the way you want your system to behave. You can
choose to always copy multiple target items to the new item, never copy the multiple targets,
oir to prompt the user. So if you are working with a multi-store system with fifferent price
zones, or different cost targets this should help you save time when copyingin new records.

Always copy uses the item on the screen as a template for all new items being added. All
data fields will be copied to the new items. The QueryForm panel will not be presented again
until the Maintenance application is restarted. 

Modify existing actually replaces the item number (UPC) for the item on the screen. Once
deployed, the old code will no longer exist in the database. Please read the warning below
before using the Modify option.

Always modify replaces the UPC for all subsequent items being modified. The QueryForm
panel will not be presented until the Maintenance application is restarted. Please read the
warning below before using the Modify option.

WARNING!: Be extremely careful when using this option. This option is normally used in
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situations where an error has been made while creating a new item code. The new item has
been created and programmed, but with the wrong code. Since the new item has not been
sold in the system, there are no serious effects.

Before using this action, you should consider these factors:
Although occasionally necessary because manufacturers sometimes change their
product's UPC, the repercussions of this action are serious. In such cases, you should use
the Copy option, creating a new code with the same information as the old code. In this
way, you can continue to sell the old code.
The item's sales history is linked to the old code. The Modify option actually deletes the old
code from the database, so when you view item sales reports that contain the old code, the
code will appear without a description.

* WARNING!:The copy function does not copy all data from the existing product to the new
one you create with the copy function. The inventory records are not copied. The system only
copies the price information for the price target and level you are on to the new item. The
system only copies the default vendor for the cost target you select to the new item. The
same is true for the POS targets.

Removing Items

When you are sure that you will no longer sell an item (or the item is never used), you can
remove it from the database. When items that have sales are removed from the database,
they will still show up in the item sales reports, but the deleted items will have no descriptor.
To remove items from the database:

Locate the item, then use the  delete tool on the toolbar to remove it.

NOTE: Your system may be programmed to prohibit deleting items that have a stock count
different than zero. This flag is set in the Advanced flag settings of L-BOSS configuration.

2.2.4.7.2.3  Deploying Modif ied Items

Sending Changes to Targets

Modified records need to be transferred to the L-POS terminals. The toolbar's  icon

changes from gray to green  to advise the operator that changes have been programmed
on this record but they have not been transferred to the front end database(s). Using the
instant deploy tool from the item programming window will send any modifications to the
target terminals (or stores in a multi-store situation). When you click the satellite you will be
prompted to send this item or all modified items.

By default, the L-BOSS task scheduler is set up to automatically send all modifications
(including items) to targets at a pre-set time. This means you can also force all changes to
be sent by manually executing the "Deploy All Changes" event from the "Events / Tasks"
main menu option.
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NOTE: When you first create items, some of the option check boxes will appear to be
"grayed out" or selected but gray. You do not have to select and unselect them. The grayed
out check boxes indicate that the database has no value for these fields (neither yes, nor no.)

2.2.4.7.2.4  Item Label Setup

Linking Items with Labels 

L-BOSS can also generate item or shelf labels if the Label printing utility is registered for use.
To modify or create label templates you must also register the Form Manager. Please consult
your Logivision  dealer if you require more information concerning labels.

The label format(s) for the item are programmed within the item, using the Maintenance
application's desktop "PLU" icon to access the item tables. Once an item has been
associated with a printable label, the Report application's Selection utility provides label
printing choices. This means that there are two steps to complete to be able to print labels.

Items must be programmed with an associated label type. To link items to use a specific
label template, access the item table programming in the Maintenance application. At the
bottom right of the "POS" tab, there is a section titled "Label", which includes a label type
selection tool. Double click in the "Type" box to open the label selection tool. Logivision
delivers a few default label types. Type A uses labels sized 4" by 1.5" (Avery 5159). Types B
& C use labels sized 2.625" by 1" (Avery 5160). Label type D prints a ½ page label as a
sample shelf sign. It also does a conversion of the retail price from kilogram to pound in the
case of scalable items. The price descriptor is taken from the object table size description
field unless the fields is blank. Then we use the word each as size description. Your dealer
can modify labels for you so consult him for further assistance.

The available label types appear in the list within the label selection utility. Each type of label in
the list has a selection box beside it. To associate a label type with the current item, place a
check mark in one or more of the label types. This associates a label type with the item.

To enable the item to be selected at label printing time, the item must also be set to "Print".
Clicking the "Print" box in the label section of the POS table sets the item as selectable at
label printing time. L-BOSS automatically selects the "Print" box when a price is modified for
the item.

To print labels, access the "Report" application from the L-BOSS desktop. For help on
printing labels, refer to the Printing Labels help page under the Report System section in this
manual.
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2.2.4.7.2.5  Navigation Menu

Memorizing the Item Table's "Tabbing Order"

When programming items in the Item table, you probably use the same fields most of the
time. To help simplify the item editing process, the Maintenance application has a special
utility. The "Navigation" menu contains options that allow you to control the cursor's position in
the table (which field) when editing items. This means you can establish what needs to be
done, and program the cursor to go to those fields one after the other, using only the [Enter]
key.

In some cases, all the information to edit is on the same Item table tab, for example the
"Quick" tab. Sometimes, several Item table tabs must be accessed to complete the editing
for each item, for example, if you must enter a new cost, then a new price. The cursor's
editing order can also jump from one tab to another within the Item table tabs. 

Setting a new navigation: To set a new cursor edit order, open the Item table from the PLU
menu, or click the PLU icon on the desktop. 

Place the cursor in the first field to edit. 

Press and hold down the [Ctrl] key and press [Enter]. 

Move the cursor to the next field to edit, and repeat the [Ctrl] and [Enter] key strokes. 

Continue adding the fields to edit, in the order that you feel will be most efficient. 

Memorizing a new navigation: Once you've established all the fields following the steps
above, you will probably want to save the cursor's editing order. To save the memorized
cursor order:

Open the "Navigation" menu.

Select the "Save current navigation" option. A "Save new navigation" panel opens:

Enter a meaningful name for this navigation, for example "Cost and Price edit"

NOTE: Once a navigation has been memorized, it will be used until you select a different
navigation, even if you leave the Item table, or close the Maintenance application.

Selecting a different navigation: If you have saved several navigation patterns, they are
available for selection at the bottom of the "Navigation" menu. The navigation pattern currently
in use has a check mark beside it. To return to the Maintenance applications default
navigation pattern (all fields) use the "Reset navigation" option in the "Navigation" menu.

Deleting a saved navigation: If you have saved navigations that you no longer use, or wish
to remove existing navigation orders: 

Select the saved navigation that you want to delete

Once selected, use the "Delete navigation" option

N.B. To define a new navigation sequence immediately you either exit the Maintenance
application and follow the procedure above, or you follow these steps:

Select "reset navigation" from the navigation menu.
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Press Ctrl+Enter twice in the first field you want to navigate to.
Press Ctrl+Enter in each other field you want to use with this navigation sequence.
Once you've established all the fields following the steps above, you save the cursor's editing
order:

Open the "Navigation" menu.

Select the "Save current navigation" option. A "Save new navigation" panel opens
where you enter the tabbing sequnce name.

Note: Although it is referred to as a tabbing order, the "Enter" button is used to change fields
within the defined navigation sequence. You can access other fields with the mouse or by
using the Tab button.

2.2.4.7.3  Sub-department Table

Sub-department Overview

L-POS requires the linking of an item to a sub-department for several reasons. Rather than
taking a daily list of each product sold which be very lengthy for certain types of stores, a sub-
department report is used as an overview of what each area in the store is doing. Sub-
departments are in-turn linked to departments to provide a more consolidated view overall.
Examples of departments may be Grocery, services, etc. The Grocery department could in
turn be broken down to many more sub-departments: grocery, taxable grocery, meat, diary,
etc. 

Sub-departments all have individual flags for taxability, scale, etc. Once programmed, item
programming time can be reduced by associating the item with a sub-department using the
"Follow sub-department" option available in the item's "Quick" or "POS" tab. This way you
only need to manage the exceptions within a sub-department.

When you edit the sub-department table the file menu includes the send to host option.

Send to host: The Send to host option of the "File" menu options is only available when the
Host active option is selected to return data to a headquarter system. The "send to host"
option will allow output of the changes made on the local L-BOSS machine back to a host
system. This means that changes can be made at a store and sent back up to the host
system. Select this option for the tables that may be edited locally in a store.  Please consider
as well that changes sent back up to the headquarter system will be deployed to all terminals
that are part of the same target group for that file type. This means that if a price is changed
at store 3 and all stores share the information on that product, the change will make it to the
other stores in the next communication cycle. To force a change to make its way back up to
the head office you must press the Satellite from the menu for that record. Using the deploy
all changes option will not return any information to the host system. It is an item by item
decision that can only be activated one item at a time with the satellite icon.
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2.2.4.7.3.1  Sub-department Programming

Sub-Department Table Settings

This example shows a Sub-department table record.

Sub-Department is used to enter the record number this sub-department will use.

Department is a compulsory link that associates the product to a larger group for reporting
purposes.

Main Description is used to set a main item descriptor used on the report system.

POS Description field allows you to enter 2 descriptions that are used to give a description
which will appear on register receipts if the sub-department is used for manual sale entry.

POS target: Use this filed to select the target for this sub-department when you are working
on a headquarters system. For example, when you need to send different tax programming to
different target zones this will be how you do it.

FSA: : Set the correct status flag for manual subdepartment entries that can be paid using
the FSA card (Flexible spending account) against an available FSA RX or non RX account
balance.. Setting an FSA flag will disable the food stamp flag for the same item. Non FSA
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items cannot be paid with an FSA account. Normally FSA is only assigned to the item file to
ensure proper control.

Taxable 1: Select this flag if tax rate 1 should be applied when this item is used.
Taxable 2:Select this flag if tax rate 2 should be applied when this item is used.
Taxable 3:Select this flag if tax rate 3 should be applied when this item is used.
Taxable 4:Select this flag if tax rate 4 should be applied when this item is used.

Food stamp: Select the food stamp flag if this item can be paid for with Food stamps and
you are in a jurisdiction that accepts food stamps.

WIC: Select the WIC flag if this item can be paid for by WIC check.

Prohibit discount: Select this flag to stop the operator from applying a discount to this item.
The item will also be excluded from the running discountable total or from the account
discount subtotal.

No refund: Select this flag to prohibit refund of this product code. The point of sale will
prevent the cashier from entering the item's code and pressing the refund function.

No return: Select this flag to prohibit return or exchange of this product code. The point of
sale will prevent the cashier from entering the item's code and pressing the return function.

Scalable: This flag defines that the product is sold by weight read from the POS scale. This
flag should not to be selected for prepackaged and pre-priced items or those weighed and
labeled for scanning at the POS.

Manual weight: Select this flag to allow a manual weight entry for this product.

Not in gross: This flag is used to exclude the sales of this sub-department from the Net
sales of the store. This is sometimes the case for sub-departments used for bottle sales,
lottery returns, etc.

No pts redemption: Select this flag to prohibit payment of this item with customer points.
For example, you may not want to allow customers to pay for tobacco products with their
accumulated loyalty points.

MPF4: Multi-purpose flag 4.

MPF6:  Multi-purpose flag 6.

Validation req'd: set this flag if compulsory printer validation is required for sales to this sub-
department.

Prohibit Trans. Dsc: Select this flag to stop the POS from including this item in the
qualifying amount that must accumulate before the transaction discount will be triggered. The
item will also be excluded from the running DISCOUNT total or from the account discount
subtotal for accounts that use a client level with Discount type 2 assigned.
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General ledger: Enter the associated general ledger account number.

D or C (Debit / Credit): Is this a debit or a credit entry to the GL system. Most
subdepartment sales should be selected as credits or the letter C. 

Restrictor code allows the user to decide whether on not sales into this department should
be restricted at certain times. This could be the case, for example, of alcoholic beverages
that cannot be sold after 11:00PM. The restrictor number is used with this sub-department is
assigned here. The restrictor table is maintained in the PosSetup under System, Restrictors.

Customer age: This flag is available to restrict the sale of age-sensitive products such as
tobacco or alcohol. When this flag is set, the first item entered will prompt for customer age.

Operator age: This flag is available to restrict the sale of age-sensitive products such as
tobacco or alcohol. When this flag is set, the POS will verify the age declared in the set-up of
the operator signed on.

Max amount is used to set the maximum dollar value that can be keyed into the sub-
department during a register transaction.

Min amount is used to set the lowest amount that can be keyed into the sub-department
during a register transaction.

Max void will control the highest void amount that can be used without manager approval.
Note that the approval warning will flash and manager approval will be required before
tendering can begin, not to continue entering or scanning items. To prohibit a cashier from
using the void function entirely, change the function authorization rights in function setup.

Max refund will control the highest refund amount that can be used without manager
approval. Note that the approval warning will flash and manager approval will be required
before tendering can begin, not to continue entering or scanning items. To prohibit a cashier
from using the refund function entirely, change the function authorization rights in function
setup.

Points: Assign the percentage of points to issue based on the item price related to items in
this sub-department. For items that have individual points assigned, they will over-ride the
points assigned here. For items with no points assigned, or for any manual  entry made to the
sub-department, the percentage assigned here will be used to issue points to the customer.
Note that when item points or sub-department points are assigned, the rounding on points
issued occurs on each entry, not at the end of the transaction. 

As with Item programming, the toolbar's  Modified icon is used to advise the operator that
changes have been programmed on this sub-department but they have not been transferred

to the front end database. Using the  instant deploy tool will send any modification that
was made to the sub-department.
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2.2.4.7.4  Department Table

Department Table Overview

L-BOSS requires that a sub-department be linked to a department. This is used only for the
reporting hierarchy within the system. Because the Sub-departments often provide more
detail than a certain level of management may require, you can create a more general level to
which item movement and Sub-department keyboard entries are reported. Because sales
can be recorded into departments directly (department key on the POS), they have flags for
taxability, amount entry limits, etc.

When you edit the department table the file menu includes the send to host option.

Send to host: The Send to host option of the "File" menu options is only available when the
Host active option is selected to return data to a headquarter system. The "send to host"
option will allow output of the changes made on the local L-BOSS machine back to a host
system. This means that changes can be made at a store and sent back up to the host
system. Select this option for the tables that may be edited locally in a store.  Please consider
as well that changes sent back up to the headquarter system will be deployed to all terminals
that are part of the same target group for that file type. This means that if a price is changed
at store 3 and all stores share the information on that product, the change will make it to the
other stores in the next communication cycle. To force a change to make its way back up to
the head office you must press the Satellite from the menu for that record. Using the deploy
all changes option will not return any information to the host system. It is an item by item
decision that can only be activated one item at a time with the satellite icon.

2.2.4.7.4.1  Department Programming

Department Table Settings
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This example shows a Department table record.

Department is the number that will be used to identify this department.

Group is a optional link that associates the product to a larger group, used for filtering and
reporting purposes.

Main Description is used to set a main item descriptor used on the report system.

POS Description field allows you to enter 2 descriptions that are used to give a description
which will appear on register receipts if the department is used for manual sale entry.

POS target: Use this filed to select the target for this department when you are working on a
headquarters system. For example, when you need to send different tax programming to
different target zones this will be how you do it.

FSA: : Set the correct status flag for manual department entries that can be paid using the
FSA card (Flexible spending account) against an available FSA RX or non RX account
balance.. Setting an FSA flag will disable the food stamp flag for the same item. Non FSA
items cannot be paid with an FSA account. Normally FSA is only assigned to the item file to
ensure proper control.

Taxable 1: Select this flag if tax rate 1 should be applied when this item is used.
Taxable 2:Select this flag if tax rate 2 should be applied when this item is used.
Taxable 3:Select this flag if tax rate 3 should be applied when this item is used.
Taxable 4:Select this flag if tax rate 4 should be applied when this item is used.
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Food stamp: Select the food stamp flag if this item can be paid for with Food stamps and
you are in a jurisdiction that accepts food stamps.

WIC: Select the WIC flag if this item can be paid for by WIC check.

Prohibit discount: Select this flag to stop the operator from applying a discount to this item.
The item will also be excluded from the running discountable total or from the account
discount subtotal.

Override allowed: Select this flag to allow price overrides on this department.

No refund: Select this flag to prohibit refund into this department. 

Scalable: This flag defines that the department is sold by weight read from the POS scale.

Manual weight: Select this flag to allow a manual weight entry for this department.

Not in gross: This flag is used to exclude the sales of this department from the Net sales
and Total sales of the store. This is sometimes the case for departments used for bottle
sales, lottery returns, etc.

No pts redemption: Select this flag to prohibit payment of this item with customer points.
For example, you may not want to allow customers to pay for tobacco products with their
accumulated loyalty points.

Validation req'd: set this flag if compulsory printer validation is required for sales to this sub-
department.

Prohibit Trans. Dsc: Select this flag to stop the POS from including this item in the
qualifying amount that must accumulate before the transaction discount will be triggered. The
item will also be excluded from the running DISCOUNT total or from the account discount
subtotal for accounts that use a client level with Discount type 2 assigned.

Restrictor code allows the user to decide whether on not sales into this department should
be restricted at certain times. This could be the case, for example, of alcoholic beverages
that cannot be sold after 11:00PM. The restrictor number used with the department is
assigned here. The restrictor table is maintained in the PosSetup under System,
Restrictors.

Customer age: This flag is available to restrict the sale of age-sensitive products such as
tobacco or alcohol. When this flag is set, the first item entered will prompt for customer age.

Operator age: This flag is available to restrict the sale of age-sensitive products such as
tobacco or alcohol. When this flag is set, the POS will verify the age declared in the set-up of
the operator signed on.

Max amount is used to set the maximum dollar value that can be keyed into the department
during a register transaction.
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Min amount is used to set the lowest amount that can be keyed into the department during a
register transaction.

Max void will control the highest void amount that can be used without manager approval.
Note that the approval warning will flash and manager approval will be required before
tendering can begin, not to continue entering or scanning items. To prohibit a cashier from
using the void function entirely, change the function authorization rights in function setup.

Max refund will control the highest refund amount that can be used without manager
approval. Note that the approval warning will flash and manager approval will be required
before tendering can begin, not to continue entering or scanning items. To prohibit a cashier
from using the refund function entirely, change the function authorization rights in function
setup.

Points: Assign the percentage of points to issue based on manual entries to this department.
Item points follow the points assigned to the sub-department records, not the department
records. Note that the rounding on points issued occurs on each entry, not at the end of the
transaction. 

Modified is used to advise the operator that changes have been programmed on this
department but they have not been transferred to the front end database. Using the instant

deploy  tool will send any modifications that were made to the department.

2.2.4.7.5  Bottle Link Table

Bottle Link Programming 

Certain regions require that products sold in glass, plastic or other types of containers be
levied with a deposit or an environmental fee amount to encourage the return / recycling of
empty containers.
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This example shows a Bottle Link  table record.

Link # is the number you wish to assign to the value being programmed.

Link to is used to assign the current bottle link # to a specific PLU, rather than assigning a
value to the bottle link #. This can be useful if the store wants to account for the bottle sales
as department revenue. By using a PLU to sell the bottle deposits, the sales will be part of the
sub-department and department the PLU is linked to. (Note that the internal advanced flags
bottle follows WIC status, bottle follows FS status, and bottle follows TAX status is only
functional with bottle link records from the bottle link table. If you use a PLU number in the 
Link to field, the WIC, FS and tax status of the deposit PLU will take the settings of the bottle
deposit PLU, not the PLU that it is linked to. Also note that scanning empty containers after
pressing a bottle refund button does not function with PLU linking.)

Description: Enter the description you want to use for this bottle link. This description will not
be used on the POS, it is only a reference on the back-end system. The description used for
the bottle deposit is taken from the totalizer 510, unless a different totalizer is specified in the
set-up on an individual record in this table.

Amount: Enter the amount to be assigned to this bottle link. 

Totalizer number: If you do not want to use the default bottle deposit number for all deposit
amounts, enter the totalizer number to use here. The related totalizer must be created with
the proper values in the Totalizer set-up. If you add a totalizer in the bottle link table set-up, it
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will override the totalizer you set in L-POS Posetup, System, Totalizer tab. 

Environmental fee

In some areas, non-returnable bottles (no deposit) carry an additional fee to help pay for the
handling (re-cycling).

Description: Enter the description you want to use for this fee. This description will not be
used on the POS, it is only a reference on the back-end system. The description used for the
Environment Fee is taken from the totalizer you assign to this record.

Totalizer number: Set the totalizer you want to use for this fee. It will be both printed on the
register receipt and used on all reports for this fee.

Tax flags: Set the taxes required on this item.

When you edit the bottle-link table the file menu includes the send to host option.

Send to host: The Send to host option of the "File" menu options is only available when the
Host active option is selected to return data to a headquarter system. The "send to host"
option will allow output of the changes made on the local L-BOSS machine back to a host
system. This means that changes can be made at a store and sent back up to the host
system. Select this option for the tables that may be edited locally in a store.  Please consider
as well that changes sent back up to the headquarter system will be deployed to all terminals
that are part of the same target group for that file type. This means that if a price is changed
at store 3 and all stores share the information on that product, the change will make it to the
other stores in the next communication cycle. To force a change to make its way back up to
the head office you must press the Satellite from the menu for that record. Using the deploy
all changes option will not return any information to the host system. It is an item by item
decision that can only be activated one item at a time with the satellite icon.

Related settings: Several settings must be made to use automatic bottle deposits.

L-BOSS>Maintenance>Register>Function 510 must be linked to Totalizer 2.

PosSetup>System>Totalizers>Bottle sale task must be assigned to Totalizer 39: bottle
sales
PosSetup>System>Advanced flags: Function to use for automatic bottle deposits must
be set to function 510.

2.2.4.7.6  Tare Table

Tare Table Programming

Some products sold by weight (scalable) are sold in empty containers or other wrapping that
may add to the weight of the product when scaled. This does not include pre-packed
products that have a label with the weight and price in the code. The Tare table allows you to
create a record for each weight amount that must be deducted form the total weight when the
product is sold.
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This example shows a Tare table record.

Enter the tare number, description and weight for each record.

When you edit the tare table the file menu includes the send to host option.

Send to host: The Send to host option of the "File" menu options is only available when the
Host active option is selected to return data to a headquarter system. The "send to host"
option will allow output of the changes made on the local L-BOSS machine back to a host
system. This means that changes can be made at a store and sent back up to the host
system. Select this option for the tables that may be edited locally in a store.  Please consider
as well that changes sent back up to the headquarter system will be deployed to all terminals
that are part of the same target group for that file type. This means that if a price is changed
at store 3 and all stores share the information on that product, the change will make it to the
other stores in the next communication cycle. To force a change to make its way back up to
the head office you must press the Satellite from the menu for that record. Using the deploy
all changes option will not return any information to the host system. It is an item by item
decision that can only be activated one item at a time with the satellite icon.

2.2.4.7.7  Price Level Table

Price Level Table Programming

Price levels allow you to store different prices for the same item. You may create as many
price levels as required. Price levels are often associated with the notion of discount cards
given to frequent shoppers. Other reasons for price levels may be to allow selling different
quantities for different prices.
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This example shows a Price Level table record.

NOTE: You must create price level one (1) when importing data into L-BOSS from external
sources.

When you edit the price level table table the file menu includes the send to host option.

Send to host: The Send to host option of the "File" menu options is only available when the
Host active option is selected to return data to a headquarter system. The "send to host"
option will allow output of the changes made on the local L-BOSS machine back to a host
system. This means that changes can be made at a store and sent back up to the host
system. Select this option for the tables that may be edited locally in a store.  Please consider
as well that changes sent back up to the headquarter system will be deployed to all terminals
that are part of the same target group for that file type. This means that if a price is changed
at store 3 and all stores share the information on that product, the change will make it to the
other stores in the next communication cycle. To force a change to make its way back up to
the head office you must press the Satellite from the menu for that record. Using the deploy
all changes option will not return any information to the host system. It is an item by item
decision that can only be activated one item at a time with the satellite icon.

2.2.4.7.8  Category Table

Category Table Programming

Categories are used to create associations for sales tracking / reporting purposes. If you
want to measure the performance of specific items against other similar items you could
create a category. Normally the category is a more detailed grouping than are sub-
departments or departments. For example, you may want to monitor performance of one
style of cookies against all other cookies. Create a category called cookies and associate all
the cookie PLU's with that category.
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This example shows a Category table record.

NOTE: Category is not a required value in the PLU setup.

When you edit the category table the file menu includes the send to host option.

Send to host: The Send to host option of the "File" menu options is only available when the
Host active option is selected to return data to a headquarter system. The "send to host"
option will allow output of the changes made on the local L-BOSS machine back to a host
system. This means that changes can be made at a store and sent back up to the host
system. Select this option for the tables that may be edited locally in a store.  Please consider
as well that changes sent back up to the headquarter system will be deployed to all terminals
that are part of the same target group for that file type. This means that if a price is changed
at store 3 and all stores share the information on that product, the change will make it to the
other stores in the next communication cycle. To force a change to make its way back up to
the head office you must press the Satellite from the menu for that record. Using the deploy
all changes option will not return any information to the host system. It is an item by item
decision that can only be activated one item at a time with the satellite icon.

2.2.4.7.9  Mix & Match Table

Mix & Match Table Programming

Mix and match should be used when you need to associate items for pricing deals. For
example, if you want to price packages of Jello at $0.50 each and 3 for $1.39 you would use
the package price feature. To take it further, you can associate similar UPC codes by mix and
match number. L-POS will accumulate the quantity of all items in a common mix match
group to give the quantity discount. So associating the strawberry, orange and lemon Jello
into the same mix match group means the consumer could buy one of each flavor to get the
deal.
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This example shows a Mix & Match table record.

NOTE: The price is entered into the PLU table. The description of the Mix Match is only used
as a reference field, it does not print on the register receipt.

When you edit the mix-match table the file menu includes the send to host option.

Send to host: The Send to host option of the "File" menu options is only available when the
Host active option is selected to return data to a headquarter system. The "send to host"
option will allow output of the changes made on the local L-BOSS machine back to a host
system. This means that changes can be made at a store and sent back up to the host
system. Select this option for the tables that may be edited locally in a store.  Please consider
as well that changes sent back up to the headquarter system will be deployed to all terminals
that are part of the same target group for that file type. This means that if a price is changed
at store 3 and all stores share the information on that product, the change will make it to the
other stores in the next communication cycle. To force a change to make its way back up to
the head office you must press the Satellite from the menu for that record. Using the deploy
all changes option will not return any information to the host system. It is an item by item
decision that can only be activated one item at a time with the satellite icon.

2.2.4.7.10  Batches

Creating and Using Batches

A "Batch" is a group of items that have been selected for modification, often a temporary
price reduction. The L-BOSS basic maintenance program allows you to enter a regular price
and a sale price for an item, but you cannot enter 2 future sale prices for the same item
without creating a batch. You also need the batch option to schedule permanent price
changes ahead of time. This way you can avoid the need to be at the store the morning a
price change comes into effect. The batch module is used to enter the changes and stamp
the batch with an effective date. The batch is a licensed option.Contact your reseller for
more information or to purchase the batch option.
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This example shows a promotion batch in the Batch editor.

The batch window shows the batch list on the left and the contents of the selected batch
on the right. The batch types determine how they are used by L-BOSS. 

A promotion batch is a temporary price activation with a start date/time and an end
date/time.
A basket batch is a batch that was moved to the basket for future reference. Moving
batches to the basket helps speed up the price evaluation. Remember that L-BOSS
always selects the lowest price of all items with the exception of the prices in the
basket. The basket prices are never sent to the POS or considered for activation.
When a price change batch is activated by the POS the contents are then moved to
the basket for tracking and future use if required. You can delete batches from the
basket as required. The only effect is that the batch will no longer be accessible to
copy or add back to the other batch types.
A price change batch is used to set up a new price that will be activated at a future
date. The price change batch has a start time. The price change batch is a
permanent change.
Executing the Deploy all changes task/event in L-BOSS will perform the price
evaluation among all items in promotion batches, sale batches and compare with the
regular price. L-BOSS finds the lowest price and activates it. The Deploy all
changes does not look at the batches in the basket.

The Price change batches are processed during the deploy all change event. When
required a new regular price will be implemented. This does not always become the
active price. For example you change the price to 2.99 on Dec 15. But the same item
is on sale at 2.19 from Dec 1 to Dec 31. The new price of 2.99 will begin Jan 01.
In a multi-store environment you may want to deploy batches stored in the basket to
other stores. This may be the case when the remote store needs to label shelves or
is not ready to implement the batch yet. Select the Batch that you want to send from
the basket list and click the Satellite dish. This will transfer that batch from the local
batch basket to the remote stores price basket. The items will not be sent to any
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POS terminals. It will be sent to the basket in each remote store.
There is a flag to send a message to remote stores when a batch has been modified
and sent to remote stores. L-BOSS configuration, advanced settings.

Best Price Option

L-BOSS allows you to create as many batches ahead of time as required. Items can be
included in many batches, and these batches can overlap in dates. For example, an item
can be on "everyday low price" sale for 3 months from Jan 1 to Mar 31 and also on weekly
special from Feb.1 to Feb 8th. If the item price for the weekly special is lower than the 3
month long term promo price, L-BOSS will automatically select the lower price and send
to the registers at the correct date and time. When the lowest price is activated, the next
price will be automatically updated by the next sale or promo batch. So in the case of a
weekly special that is run during a 3 month long term low price, L-BOSS will implement
the Long term price at the correct date, then implement the weekly ad, then revert back to
the long term special after the weekly deal. Finally, when the long term price ends the
regular price will be re-activated.

Note that the "Best price" calculation only works for the base price of the item. The
system cannot resolve a situation where the price of an item is $1.00 each with package
deal 3 / $2.75 in batch 1 and $1.00 each but 3/ $2.50 in batch 2 with competing dates.
The best price method will resolve the difference between a split price if it is entered into
the base price field. For example, Item 1 is 3 / $2.50 (.8333 each) in batch 1 and $1.50
each in batch 2. Batch 1 will win the best price calculation in the period with competing
dates.

N.B. The "Best price" calculation is based on all price types for all items. If the REG
price is lowest the REG price will be the active price. If Promo 1 is lowest price it will
be the active price. Only the base prices are divided by the price divisor and then
compared. The system will activate the batch price for items with a price lower or
equal to the REG price, after dividing the price by the quantity. So an item in SALE33
batch priced at 1.99/1 will take precedence over the REG price at 1.99/1. This way
you can assign a discount, or a BOGO price using the same base price.

INSTORE price type

There may be situations where you want to force the system to use a specific price
even though batches exist for the item with a lower price. In this case create a batch
called INSTORE. All items that use the INSTORE type batch will remain active during
the date range assigned.

N.B. INSTORE prices cannot be imported into L-BOSS from a file transfer (such as
wholesaler import) and cannot be sent from a head office to stores. They must be
created at the store that wants to use them.

Modifying the layout of the batch entry form
Before you start editing batches you may want to personalize the screen layout. The
order and width of the fields can be modified. For example, if you want to see the
batch window like this sample you will need to make some changes.
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Modify column width:To modify the width of a field place the cursor on the vertical
bar separating the fields and resize tro the desired width.
Modify column name: To modify a column name right-click on the column header
and select modify title. L-BOSS displays the default name of each field for your
convenience and to help in troubleshooting. Enter the decription you want for that
column.
Modify column order: To change the order of the columns open a batch. When a
batch is open return to the Maintenance application File menu. Select Move column.
Click on the column to move and slide to the position you would like to use for that
column. Repeat the column move for each column you want to reposition. This way
you can add the columns you work with the most and bring them to the left-most
positions. When you have finished moving the columns return to the File menu and
click on Move column to remove this special status flag. You will return to normal
editing mode.

The batch toolbar

This toolbar is part of the batch editor form.
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Use the + to add a batch.
Use the Scissors to delete the selected batch.
Use the Satellite to send the batch changes to the database.
Use the Portable device button to select data from a file created with a portable unit
(wireless handheld).
Use the < to hide the toolbar and batch list. This will provide more room to view additional
columns.
If you have hidden the toolbar and batch list section a new icon will appear. Press the >
icon to return to normal view of the batch editor form.

Note: When you edit the batch table the file menu includes the send to host option.

Send to host: The Send to host option of the "File" menu options is only available when the
Host active option is selected to return data to a headquarter system. The "send to host"
option will allow output of the changes made on the local L-BOSS machine back to a host
system. This means that changes can be made at a store and sent back up to the host
system. Select this option for the tables that may be edited locally in a store.  Please consider
as well that changes sent back up to the headquarter system will be deployed to all terminals
that are part of the same target group for that file type. This means that if a price is changed
at store 3 and all stores share the information on that product, the change will make it to the
other stores in the next communication cycle. To force a change to make its way back up to
the head office you must press the Satellite from the menu for that record. Using the deploy
all changes option will not return any information to the host system. It is an item by item
decision that can only be activated one item at a time with the satellite icon.

2.2.4.7.10.1  Add new  batch

Adding new Batches

Batches are created by accessing the Batch form found on the PLU menu option in
the Maintenance application. Select the batch type (Promotion, basket or price
change.) Select the price target to use for the batch such as PAL. Now you can press

the  toolbar icon or right click on the price target to add a batch. You will be
prompted to enter a batch identifier that will be used for report purposes at a later
date. Enter any 10 character descriptor as batch identifier. You can also enter a
longer description that is used to make the batch name more meaningful.
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Now you can start adding items to the batch. This can be done by using the  icon
and entering the PLU code. You can also add the item by entering the vendor's item
code for this item. Upon entering the first item L-BOSS will prompt you to enter the
staring and ending dates and times for this batch. A batch usually has the same start
date / end date for all items in the batch. With L-BOSS you can set exceptions on
individual items.

Once you have entered the date and time on the first item L-BOSS will assign the
same date range to additional items added to that batch. Each of the fields from the
price table is available when adding items to a batch. Use the scroll bar or extend the
batch edit form to view the fields hidden to the right.

2.2.4.7.10.2  Delete a batch

Deleting Batches

You can delete a batch by selecting the batch and using the  delete tool. If you right click
on a Batch name in the list the context menu also allows you to delete that batch.

2.2.4.7.10.3  Move a batch

Batches can be moved from Promotion to Basket or to Price change. Batches can likewise
be moved from Basket to Promotion or Price change. Finally batches in Price change can be
moved to Promotion or Basket.

You may want to move the contents of a batch from one type to another. When you move a 
promotion batch to the basket batches, the batch will remain in the system. But it will not
be evaluated to see if prices contained need to be activated. Remember, L-BOSS reads
promotion batches and price change batches to locate the best price. The less records it
evaluates the faster the system will run.
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Select the batch to be moved and slide it to the appropriate batch type by holding the mouse
left button. For example, click a batch in your promotions list and move it to the top of Basket.
L-BOSS will ask for confirmation to move the selected batch to the basket. 

You can also move a batch from the promotion to price change, or from basket to promotion,
etc. Take care when moving batches that you modify the dates accordingly. For example, if
you move a batch from basket to price change and that batch has a starting date of last week
it will be activated the next time L-BOSS runs the deploy all changes event.

When a batch is moved manually using the drag and drop method first highlight the batch
name, then slide it to the batch area you prefer to have it in. For example in the image below
you can click on either PROMO124 or PROMO123 and slide the selected batch to either
Basket or to Price change.

2.2.4.7.10.4  Rename batch

Right click the batch to rename. A prompt will appear where you can modify the batch
identifiers. You cannot rename a batch to a name that is already being used.

2.2.4.7.10.5  Other actions

You may want to copy contents of an existing batch to a new batch, or merge the contents of
an existing batch into another existing batch.

 Right click the batch and select "Other actions".

This form will appear after you select Other actions:



L-BOSS Menus 215

© 2001-2014 ... Logivision

1. When this form opens the system you must choose to move or copy the selected batch.
2. Now decide whether this batch will be merged (merge means modify existing records and

add new records to the contents of an existing batch or whether it will overwrite the existing
batch by erasing all existing batch content.

3. Use the Choose destination pull-down to select a batch type and target.
4. Use the Batch name section to assign a new name when copying to a new batch.

2.2.4.7.10.6  Adding items to a batch

Adding records (items) to the batches

Items can be added several ways into a batch. 

1-From the batch entry screen, click the [+] icon or press [F6] to open an entry window
and enter the product code. 
When the input window appears, press Alt-Enter or double click to select from the
browser list. Select the item from the PLU list by pressing the "Add" button. Use the [F7]
button to search by Vendor code. Whenever the input form is open you can switch
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between PLU or vendor code search. As in PLU maintenance use the [F12] key to
expand a 6 digit UPCE code to a full UPCA code.

2-You can also add an item into the batch directly from the PLU item maintenance
screen. When the item you want to add to the batch is displayed in the item maintenance,
press F6 to add that item to the current batch.

3-You may also select a group of items from the PLU maintenance using the filter
option to locate the products to be added to a promotional batch. If you want to add all
chocolate bars currently selling for $0.95, you could set a filter on the sub-department for
chocolate bars and where the price is equal to $0.75. 

Make sure the batch is open in the batch viewer, then from the item table, 

press the Apply filter button to view the list of available items. If the filtered items
should be added to the open batch, 
close the list of filtered items, then,

select "Add filtered items to batch" from the Maintenance application's "Edit"
menu. 

All the items that responded to the filter will now be included in the current batch. The
system copies the information from type REG to the batch. 

Note: Items that use Like code do not need to be sent in the batch. Only the Like code
itself should be in the batch.

2.2.4.7.10.7  Adding items from a portable batch

Populating Batches using a Portable Device

In the batch editor, open a batch. Press the Portable button to import items from a batch
created with the hand-held unit. Your PDT or Wireless HTML help should tell you where to
find the item list created with the hand held.

The default location for the file should be L-BOSS\Office\Portable on the L-BOSS server.
Select the file and the contents will be added to your batch.

2.2.4.7.10.8  Working w ith batch data

Working with batch data
The batch editor has several features to help you edit your prices. You can select a
column and copy the same modification to each row. You can also work with simple
formulas to speed up mass changes. 

Assign the same start / end dates to all items in the batch
Click the title of the column called Start date. At the calendar prompt select the start
date to use for this batch. If this is a promotion bach set the end date by clicking the
column header for ending date.

Assign a calculated price reduction to the regular price in the batch
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Let's say you want the promotion price to a special offer where the customer is
offered the product for the same base price, but where he can buy 2 of that product
for 150% of the regular price. This means the second product would be half price if
he buys 2. But if he only buys one product he pays the regular price. L-BOSS uses
the price type called package price to do this. The regular price is already correct
because it was copied when you created the batch. The package price needs to be
computed.

Click the title of the package price column. At the prompt enter the formula to
compute this price. The formula for the package price amoun is "F30*1.5"  without
the quotes. This tells L-BOSS to compute the regular price (field F30) times 150%.
Now click the title of the package price quantity field. At the prompt enter 2. This will
set the value 2 for all rows in the batch.

Note: You can use certain fields from  the price table in this type of calculation. That
means F30, F31, etc. Right-click

2.2.4.7.10.9  AddBatch utility

L-BOSS includes a utility called AddBatch.exe. This program is to help you setting up
advertising for your batches. Addbatch will search for active batches to help you set up
advertising files for the batch. You will need to create an event to run ADDBAtch or open the
program from the L-BOSS folder. L-BOSS must be running to use ADDBAtch. If Addbatch
finds active promotions it will open the batches in a list on the left hand side of the window.
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The window above shows batch number 2 which will be added to the advertising images and
batch 3 which has not been selected. There are 6 items in the batch 2 called Coke batch. 5 of
these items have pictures associated with them and will be added to the Advertising file. The
other item 7763 will not be added to the advertisement unless a picture is associated to the
item.

File menu > Select primary image folder: Select the folder where your advertising images
are placed. If you want AddBatch to associate an image to a PLU automatically you need to
name the image file with the same PLU number as the item in the batch. Take care that a 14
digit plu number will search for a 14 digit image file. the images can be BMP, JPG, GIF, etc. If
no corresponding image is found in the Primary image folder AddBatch will search for a
corresponding image in L-BOSS\Office\Images. Take note that these images will usually be
too small to use for the advertising module.

View menu: The view menu allows you to choose between several different layouts for the
item list.
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When no image is found for a PLU in the batch the item will not be advertised. Items that
have no image display a red X rather than the image on the item list. To assign an image to
the item you need to follow this procedure.

1-Double-click the item number.
2-Browse to the folder where your picture is located.
3-Press the open button after selecting the image. The image will then be copied to the ADD
folder and renamed to the item number.JPG.
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Batches will not be added to the ads unless yiou select them.
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To view the items in a batch highlight that batch in the left hand portion of the window. The
items in the batch will appear ion the right.

You may want to execute the batch program automatically to delete images associated with
expired batches. Create an event to run AddBatch automatically.

2.2.4.7.11  Vendor Table

Vendor Table Programming 

In order to track the stock level or cost of each item, you will need to create the vendor from
whom it is purchased. From the Maintenance menu, access the Item option and open the
Vendor table to add the information required for each vendor. You may add as many vendors
as you require. Item cost records must have a default vendor.
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This example shows a vendor table record.

When you edit the vendor table the file menu includes the send to host option.

Send to host: The Send to host option of the "File" menu options is only available when the
Host active option is selected to return data to a headquarter system. The "send to host"
option will allow output of the changes made on the local L-BOSS machine back to a host
system. This means that changes can be made at a store and sent back up to the host
system. Select this option for the tables that may be edited locally in a store.  Please consider
as well that changes sent back up to the headquarter system will be deployed to all terminals
that are part of the same target group for that file type. This means that if a price is changed
at store 3 and all stores share the information on that product, the change will make it to the
other stores in the next communication cycle. To force a change to make its way back up to
the head office you must press the Satellite from the menu for that record. Using the deploy
all changes option will not return any information to the host system. It is an item by item
decision that can only be activated one item at a time with the satellite icon.

2.2.4.7.12  Scale Table

Scalable Item Table Programming
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NOTE: The Maintenance application does not include native drivers for electronic scale
devices. Electronic scales interfaced with the Maintenance application must have their own
communication "drivers". There must also be a proprietary conversion utility to determine the
electronic scale data format. To configure communications requires customization not
included with the standard L-BOSS program. Please contact your Logivision  dealer if you
want to be able to communicate with an electronic scale.

There are several types of electronic scales commonly used in retail sales. Some scales are
directly attached to the front end terminal, used to weigh produce at check out time. Scales
used by the front end terminal rely on the standard Maintenance application item
table programming, and do not use the scale table programming.

Some scales are used to produce scannable item labels for pre-packed bulk goods. In this
situation, the items must be programmed in the Scale table. Combined with programming
from the Item table for L-POS terminals (price, cost, etc.) the scale table programming can
be sent to the electronic scale at "deploy" time.

This example shows a Scale table record.

Scale Table Fields

NOTE: Remember that the scale table only contains the specialized fields for scalable items.
The scale table data for items is combined with standard item programming form other item
tables, such as the price, cost sub-department etc.
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Item code: The scalable item's code is normally the same code as in the item table.

Target: To establish communication with an electronic scanner, the device must be a target,
and be part of a target group. Because the Maintenance application does not include
communication drivers for electronic scales, the target record programming must include a
reference to the proprietary device driver.

Product Description: This is often a list of ingredients used by the electronic scale to
produce a label when weighed.

Shelf Life: Is the number of days before this product must be removed from the shelf, no
longer fit for sale.

Product Life: The number of days before the product should be consumed.

PLU Type: This tells the system whether the item is "random", "fixed weight", or "fluid
ounces".

Class:

Serving Size: FDA nutri-facts label field.

Price Modifier:

Net Weight:

Blank Fields: This allows you to send no information for the field type selected, blanking out
the data in the electronic scale.

When you edit the scale related tables the file menu includes the send to host option.

Send to host: The Send to host option of the "File" menu options is only available when the
Host active option is selected to return data to a headquarter system. The "send to host"
option will allow output of the changes made on the local L-BOSS machine back to a host
system. This means that changes can be made at a store and sent back up to the host
system. Select this option for the tables that may be edited locally in a store.  Please consider
as well that changes sent back up to the headquarter system will be deployed to all terminals
that are part of the same target group for that file type. This means that if a price is changed
at store 3 and all stores share the information on that product, the change will make it to the
other stores in the next communication cycle. To force a change to make its way back up to
the head office you must press the Satellite from the menu for that record. Using the deploy
all changes option will not return any information to the host system. It is an item by item
decision that can only be activated one item at a time with the satellite icon.
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2.2.4.7.13  Statistics

Using the Statistics Data Test

The statistics menu entry is available to clean up errors and unused records from database
tables. There are several tabs to select from, each will allow you to get some feedback on
number of records, invalid and obsolete records in different areas of the database.

General Tab
The PLU (or Item) file is actually composed of several database tables. The Statistics option
allows you to verify the validity of the item tables and the links that join them, called cross-
references. It is possible that the record cross-referencing becomes corrupt, or that items
exist that do not have the normal cross-references. This can happen if you have created
items in the main Object table, but have not linked the item to either a sub-department
(required) or given the item a price. The unlinked items are not necessarily harmful to the
system, but should be dealt with to prevent possible item management problems such as
report inconsistencies.

The Statistics option allows you to test the cross-references, and delete the invalid records
from the database. In some cases, you may want to complete further tests by accessing the
Maintenance application's "File" menu with the appropriate data table selected. To find out
more about testing tables using the dynamic File menu options, please see the "Dynamic File
Menu Options" help page under this manual's "Working with Items" help section.

Once the Statistics utility is open on screen:

Execute Button: Press the "Execute" button at the bottom left of the panel to test the data
tables, "Cancel" to close the utility without testing the data.

NOTE: The information collected using the Statistics utility always refers to the data tables for
the "Item Target" selected at the bottom of the screen above the "Execute" button. In single
store situations this is normally PAL. In Multi-store situations, be sure to select the correct
target for the operation. For help about targets, see the Terminal Table programming help in
this manual.
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This example shows the Statistics Data testing panel.

Number of Items (OBJ): This indicates the number of items that exist in the selected
target's Object table. The Object table is the main item table, used to store the item's core
information, accessed in the Maintenance application's "PLU" menu, "Item" option, "Object"
tab. (help page reference: Object Tab, under Item Tables topic)
Price records: This indicates the number of total price records in the system. This number
may be quite a bit larger than the number of OBJ records because of price levels and multiple
price targets.
Cost records: This indicates the number of total cost records in the system. This number
may be quite a bit larger than the number of OBJ records because of multiple vendors per
item and multiple cost targets.

Non-referenced POS: The front end terminals keep their own data tables for items, so that
if the network fails, the store can continue to sell. When you "deploy" data is sent from the L-
BOSS POS table, accessed in the Maintenance application's "PLU" menu, "Item" option,
"POS" tab. (help page reference: POS tab, under Item Tables topic). It is possible to have
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items in the POS data tables that do not exist in the L-BOSS Object table. The number here
indicates how many items exist in POS table that do not have matching records in the Object
table. You can press the "Delete" button to the right to remove these items from the POS
table. NOTE: If you double click the number field, a list of the non-referenced POS records
appears.

Non-referenced PRICE: Items in the Object table have links to the Price table to keep track
of their price. It is possible to have prices in the Price table that do not have a link to any item
in the Object table. The Price table is programmed in the Maintenance application's "PLU"
menu, "Item" option, "Price" tab. (help page reference: Price Tab, under Item Tables topic)
The number here indicates how many items exist in target Price table that do not have linked
records in the Object table. You can press the "Delete" button to the right to remove these
items from the Price table. NOTE: If you double click the number field, a list of the non-
referenced Price records appears.

Non-referenced Cost: Items in the Object table have links to the Cost table to keep track of
their cost. It is possible to have costs in the cost table that do not have a link to any item in the
Object table. The Cost table is programmed in the Maintenance application's "PLU" menu,
"Item" option, "Cost" tab. (help page reference: Cost Tab, under Item Tables topic) The
number here indicates how many items exist in target Cost table that do not have linked
records in the Object table. You can press the "Delete" button to the right to remove these
items from the Price table. NOTE: If you double click the number field, a list of the non-
referenced Price records appears.

Non-referenced SCT: Items in the Object table have links to the SCT table to keep track of
their inventory status. It is possible to have values in the SCT table that do not have a link to
any item in the Object table. The SCT table is programmed in the Maintenance application's
"PLU" menu, "Item" option, "Inventory" tab. The number here indicates how many items exist
in target SCT table that do not have linked records in the Object table. You can press the
"Delete" button to the right to remove these items from the SCT table. NOTE: If you double
click the number field, a list of the non-referenced SCTrecords appears.

Non-referenced ECL: Items in the Object table have links to the ECL table to keep track of
their advanced promo settings. It is possible to have records in the ECL table that do not have
a link to any item in the Object table. The number here indicates how many items exist in
target ECL table that do not have linked records in the Object table. You can press the
"Delete" button to the right to remove these items from the ECLtable. NOTE: If you double
click the number field, a list of the non-referenced ECL records appears.

Missing POS: This is the opposite of "Non-referenced POS" above. In other words, items
that have information in the L-BOSS Object table, but have no associated record in the POS
table used to program the front end terminals. Remember that this may include items that
have been created but not yet sent to the POS table. NOTE: If you double click the number
field, a list of the items not in the POS table appears.

Missing Price: This is the opposite of "Non-referenced Price" above. In other words, items
that have information in the L-BOSS Object table, but have no associated record in the Price
table. NOTE: If you double click the number field, a list of the items without a Price table
record appears.
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PLU # too short: This is the number of items that have an invalid PLU number because it is
too short.

PLU # too long: This is the number of items that have an invalid PLU number because it is
too long.

Deleted Items: L-BOSS keeps track of items that have been deleted from the Object table,
but not yet removed from the POS table used to program the front end terminals.

Records not Deployed: These are items in the current Object table that have been modified
but not yet deployed to the target front end terminals.

Sub-departments: This is the number of Sub-departments programmed in the Sub-
department table.

Departments: This is the number of Departments programmed in the Department table.

Batches: If you are using batches, this shows the batches that exist in the system, including
their status; Promo, Price or Not Active. For more about Batches in L-BOSS, see the 
"Batches" help topic in this manual.

Items in Batch: Shows the number of items in the batch type above.

Item Target: The target data that is being tested for the results that show in the Statistics
panel. This determines which Object table is being used for the statistics.

Price Target: The target data that is being tested for the results that show in the Statistics
panel. This determines which Price table is being used for the statistics.

NOTE: For help about targets, see the Terminal Table programming help in this manual.

Customer tab
This tab allows you to view statistics related to the customer file.

Total records: This is the total number of records in the customer report database
(RPT_CLT).

Weekly records: This is the total number of weekly sales records in the customer report
database (RPT_CLT).

Old weekly: This is the total number of old weekly records in the customer report database
(RPT_CLT).

Monthly: This is the total number of montly records in the customer report database
(RPT_CLT).

Old Monthly: This is the total number of old monthly records in the customer report
database (RPT_CLT).
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[Delete] Use this button to purge the old data from the file. This will eliminate unused data
and may speed up processing.

RPT_ITM_D tab
This tab shows statistics in the daily item movement file.

Number of records: Total number of rows in the daily item movement table.

Number of INV records: Total number of inventory related records in the daily item
movement table.

Physical count records: Total number of inventory count records in the daily item
movement table.

Adjustment records: Total number of inventory adjustment records in the daily item
movement table.

Receiving records: Total number of inventory receiving records in the daily item movement
table.

Transfer records: Total number of inventory transfer ecords in the daily item movement
table.

Order records: Total number of inventory order records in the daily item movement table.

Price levels: Total number of records for sales by price level in the daily item movement
table.

Inventory before cleanup: Total number of inventory related records prior to the last
cleanup date in the daily item movement table. [Delete]: This will remove any inventory
records from the file that are dated prior to the most recent cleanup performed. This will
speed up system.  Executing this file means that you will no longer be able to review
inventory transactions prior to the last cleanup date. There are no other negative effects.

COUNT before cleanup: Total number of inventory count records prior to the last cleanup
date in the daily item movement table.
[Delete]: This will remove any count records from the file that are dated prior to the most
recent ccleanup performed. This will speed up system.  Executing this file means that you
will no longer be able to view inventory counts prior to the last cleanup date. In reality

Reports tab

This tab displays the number of records for each report table on the system.

2.2.4.7.14  Transaction completion deals

Transaction completion deals (TCD) allow you to set up advanced promotion features. For
example you want to give 10% off bakery items if a customer spends $50.00. Or you want to
discount wine by 10% if a customer buys 12 bottles or more. This section explains how to set
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up the deals.

There are a few basic issues to consider before you start creating deals. The Preferred
shopper option must be licensed or the TCD feature will not work on the POS.

The system will not give a percent discount on items or subdepartments set as non
discountable.  
The lowest deal number is executed first.

The deal will show on screen only after a tender is done. 

A deal can have multiple records or conditions set. As soon as any single condition is met
the trigger and reward is executed and the rest of that specific deal is ignored. For example
you want to discount wine items differently depending how many item are bought.
Purchase 12 items to save 10%, 6 items saves only 5%. You MUST enter the higher
quantity of as the first condiftion in the wine deal. Otherwise the system will give the deal for
the 6 bottles first and ignore the remaining conditions that may have been set. If the first
condition entered is a quantity of 12, but only 8 items are purchased the system will not
execute the first condition. If the next condition on the wine deal says purchase 6 items to
save the deal would execute because you bought 8. Once the first deal is executed the
POS will evaluate the conditions of the next deal. The deals are always executed started
with the smallest number. We recommend that you leave some space between the deal
numbers when you are creating them.
The same items can be used in multiple deals. For example, save 3% on sub-dept 10
when spending $200.00 is deal 1. And deal 2 says save 3% on sub-dept 20 when you
spend $100.00. If both deals exist, and the $200.00 is purchased both deals will execute.
So the customer will get 3% on sub-dept 10 and 4% on sub-dept 20.

The images below show deal 101. Once deal 101 is executed the system will look for the
next lowest deal to execute. When the conditions are met it will execute and the next deal
will be considered. If a deal is not executed because no conditions were met the POS will
still evaluate the next deal.
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Adding a transaction completion deal.
This form explains how to add a TCD deal to the system. Remember that the deals will not
work without the preferred shopper option on the license key. To add a new deal use the +
icon at the top of the form. To add another condition to a deal use  + icon above the condition
tabs.
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A. Target: Assign the target (zone) that this deal applies to.

B. Deal #: This is the deal number. When creating deals please remember that the lowest
deal number will be verified for execution first and so on. This is important when you are
using discounts. If an item is discounted with a percentage off in deal 101 it will not be
discounted with a percentage off again in the same transaction, even with a second deal.
This is the same when a discount is given manually or triggered by a customer level. Since
the lowest deal number is executed first you should carefully plan the promotion set-up. We
recommend starting off with Deal 100, this will leave many lower deals in case they are ever
needed. Then the next deal leave some space, for eample use deal 150 or 200 as the second
deal.

C. Deal descriptor: Enter the descriptor to print on receipt for this deal. 20 characters
maximum. When the deal is apercentage off the percentage will be added to the descriptor.
Our example shows Buy 12 item to save. The "10%"  will be added automatically by the
POS when 12 items are accumulated.

D. Alt deal descriptor: Enter the alternate language descriptor.

Trigger conditions

Now you need to define the conditions that must be met to give the deal. You need to set a
trigger quantity in items or dollars. You need to determine which total is part of the condition.
The choices are on the Total sale, by sub-department, or by PromoID.
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1. Trigger quantity. Enter the quantity of items or the dollar amount that must be purchased
to meet the condition.
2. Items or dollars: This field allows you to choose between giving a reward for the purchase
of a quantity of items or an amount.
3. In: This field requires a selection to define whether the items or dollars are required from a
specific sub-department, PID (Promo ID) group or part of the Total sale. 

PID
This type uses the Promo ID (PID) flag from the POS table on PLU items to accumulate
amounts or quantities from those items. For example, you want to create a deal on
canned soups. You could assign a common PID number to each of the soups that
qualifies as part of the deal.
SUBDEPT
This type uses the Subdepartment counters to accumulate amounts or quantities from
items in that sub-department. For example, you want to create a deal on fast food items
where a $10.00 purchase of any fast-food product executes a deal. You would assign
SUBDEPT to this field.
TOTAL
This type uses the total counters of the transaction to accumulate amounts or quantities
of all items. For example, you want to create a deal where a $50.00 purchase  executes
a deal. You would assign TOTAL to this field.

4. Non discountable included: Set this flag to accumulate non discountable items in the
qualifying quantities and amounts. For exampleyou may want a product to accumulate toward
the trigger quantity even though it is non discountable. The product will not be discounted but
will add into the qualifying count or amount.

Action

Use this section to enter the discount.



L-BOSS User Manual 4.1.3234

© 2001-2014 ... Logivision

5- Give: Enter the percentage rate or discount amount you want to remove when the
qualifying amount or quantity is met.

%/Amt: Choose whether you are giving a percentage off or an amount off. Remember that
when a percentage is given that item will be excluded from any further TCD deals. When an
amount off is specified items in subsequent TCD deals may still be discounted of the
conditions are met.

6- On: If you selected to discount by percentage this is where you determine what will be
discounted. Select PID to discount a specific product or group of products with a common
Promo ID code. Select SUB to discount all items from the specified subdepartment. Select
TOTAL to discount all items in the transaction. In both cases only discountable items will be
discounted.

8- Exclude from trigger quantity: Use this flag to excluse the reward items from the
discountable total required. For example if you give 10% off PromoID items 100 for spending
$25.00, you may not want them to accumulate toward the $25 total.

9-Client level: Enter the client level required to trigger this deal. Client level 0 can be used to
set the deal for all customers.

2.2.4.8 Account Related Maintenance

Account (Customer Related Tables)

NOTE: The accounts receivable module and the preferred shopper module use the same
customer information from the database. Accounts receivable is required to post house
charges. Preferred shopper is required to use Points or to access the Discount table.

L-BOSS allows you to create customer records for check cashing, store charges and
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customer demographics. The customer maintenance is accessed using the Maintenance
application's "Account" menu, "Customer" option, or the "Clients" desktop icon. Each account
created must have a link to a customer risk level table, and to customer level table record. It
is good practice to define the related customer tables before adding customers. Note that the
terms "customer" and "client" are interchangeable.

Account view  is a quick way of opening the 3 tables related to account set-up. The system
will remember the last screen layout that was used.

Account Reports
L-BOSS provides account statements, customer details, account activity and account aging
(30-60-90 day) reports, found in the Report Selection "Clients" section.

NOTE: Client reports may include item tracking by customer. This option requires the
preferred shopper module. You must turn on the related flag in the cleanup tab of the L-
BOSS configuration menu.
Deleting and Modifying Account Numbers
L-BOSS will not allow you to modify an account number, or delete that account if there is an
account balance. Before trying to delete or modify account numbers, set the balance to zero.
(see the "balance" option in the client table). If an account number is modified or the account
is deleted, past transactions will still appear on reports for that period. If you create a new
account with a previously used (then deleted) account number, past transactions viewed in
reports for the re-used number will show as if they belong new account.

NOTE: Payments made to accounts do not target specific transactions. Amounts received
on accounts apply to the outstanding balance. 

If you are setting up a multi-store system please make sure you understand how multi-store
account balances function. There is a flag on the COMM tab in system configuration that
controls the behavior. Refer to the L-Remote setup help here.

2.2.4.8.1  Customer

Managing the Customer File

L-BOSS allows you to create an unlimited number of records within the Client (or customer)
table. Each customer account can have multiple sub-accounts or "Contacts" (account
users), but must have a "main" user. Accounts must be linked to both a risk level and a
customer level.
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Client number: This field is used to enter the number that will be used to retrieve the
customer record in both the L-POS lanes and L-BOSS stations.

 Use the icon as a shortcut to the Account alias table.

Modified: The L-POS stations can be configured to allow the creation of customers "on the
fly". The POS will prompt for the minimum information required to create the account, then
send the new account to the back end. When a customer is created from the front end and
sent to the back end, the dot beside "Modified" will be red, to identify accounts that were
created in the front end, and probably need to be edited to complete the information.

1. Detail: This option is available if your system is licensed to use the L-Tracker option.
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When you press the Detail button a new window will open and L-BOSS will begin processing
the electronic sales journal files for the last 5 weeks. This will in turn create a list of all the
transactions involving the account over that period. You can view details for previous periods
by selecting the appropriate start date on the calendar.

The History and the Promo buttons in the image above are custom queries like the buttons
you can add to the PLU screen. They allow you to create a custom selection according to
your requirements. When an account file is open the Maintenance > Edit menu includes an
option called Custom queries: L-BOSS allows you to list data records in certain fields such
as the account name, etc. You can create an sql request made to the database engine and
display the results in the search window. Certain database knowledge is required and
changing the standard requests may inhibit the normal searches you perform. Please refer to
the section on custom queries in the PLU help file.

PAL: The pull-down field to the right will probably show PAL as the target group. The target
allows you to soecify, in multi-store environments, which programming zones this data will be
sent to. In single store applications this will show PAL for all accounts. If you only want
customer X to be sent to store 5, you would create a program target for store 5 and put that
target on client record 5.

Company: Enter the company this account is for.

Address, City, Prov/State, Code and Country entered here will be displayed on account
statements or other customer based reports. L-BOSS also provides a statement report that
prints the address so that it can be folded and sent in a standard "windowed" envelope.

Expiry is the date until which this account remains active.

Phone and fax are used to enter the telecommunications data for the customer.

Info 1 and Info 2: Use these fields to record addityional customer information. This
information is  only provided as reference, not used by the system automatically. 

Tax 1 Exempt and Tax 2 Exempt should be entered if you want the L-POS front end to
exempt taxes that would have applied. These are individual flags. You do not need to exempt
one tax for the other tax to be exempted.

Note: L-POS can use up to 4 tax rates. You may enter a Tax 3 Exempt by clicking on the
descriptor for Tax 1 Exempt. A window will open where you can record the tax 3 exempt
number. You may enter a Tax 4 Exempt by clicking on the descriptor for Tax 2 Exempt. A
window will open where you can record the tax 4 exempt number.

Group is used by the report system to filter the customer file and only produce a report for
the category selected. It is not a compulsory field.

Balance is the current online charge balance for this customer. It can be adjusted manually
by double-clicking the field or by pressing the [F4] key and entering the appropriate
adjustment to the account balance. You can increase or decrease the customer balance.

Points is the customer points amount that have accumulated. It can be adjusted manually by
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double-clicking the field or by pressing the [F4] key and entering the appropriate adjustment to
the points balance. You can increase or decrease the customer points balance.

Risk Level: Select the proper risk level assigned to this account. The risk level controls both
store charge and check cashing privileges. The risk levels are created in the Client risk table
programming.

Client level: Select the proper customer level used by this account. The customer level may
offer a discount or a price level other than the default price. This is set up in the Client level
programming under the Account menu.

NOTE: The Risk and Customer level tables should be programmed before creating accounts
in the system, making it easy to select both Risk and Customer levels from a pop-up list.

PO # required: This flag will force the entry of a purchase order number whenever this
account tries to make a charge.

Contact Required: Set this option to on if L-POS should require the contact number to be
entered along with the account number. Account statements and other account reports will
show information from all contacts for the account as a single account. To be able to track
each contact's transaction information, the contact number must be included when entering
the account number at L-POS lanes. L-POS lanes can be set to require the contact number
by setting the "Contact Required" flag on.

Send by email: Set this flag to allow the Statement by email report to be emailed to this
customer's email address.

ECommerce: Set this flag to allow this customer to appear in the Ecommerce website.

PO# Digits Min/Max: Set the minimum and maximum number of digits allowed for PO #
entry for accounts with a PO# required.

Contact information fields

Each account must have a "main" contact. Additional account users (contacts) can be added
using the "+" button, or removed using the scissor button from the tool bar in the contact
section. The left and right arrow buttons are used to move to the next / previous contact.
Although you can create many contacts for each account the standard contact list will not
show more than 30 contacts for any single accounts. For accounts with more than 30
contacts you must assign a search function rather than the normal contact list.

Number: This field contains the contact's number, assigned to a contact when it is created.
A contact number may be required along with the account number at the POS to use the
account if the "Contact Required" flag is set to on. (see above). If no contact number is
entered, the transaction will be linked to the "Main" contact. The "main" contact always
appears as the first contact.

 Use this icon as a shortcut to the account contact alias table.
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First name: Enter the contact's first name.

Last name: Enter the contact's last name.

Language: This field allows you to set the default language the system will display for this
customer, English or French. L-POS will print receipts based on the customer's default
language. Account statements will also print using the default language.

Extension: Is the contact's office telephone extension.

Birth: Enter the contact's birth date. If entered it will be used to validate age restricted items.

Home: This field can contain the contact's main telephone number, pager, or other number.
The title to the left of the field is in red, and can be modified by clicking the title and entering
the phone type. (In the example shown above, the title is "Pager"). Note: This field can be
used to store additional checking account number for this customer. On check transactions
the POS will verify the main account number, and all contacts of that account home phone
number field for a matching check account number. So if you get a bad check from the
customer you can refuse checks from all his accounts this way without creating more
account records. You only need to add contacts and place the check account number in the
home ohone number field.

Cellular: This is an alternate number for the contact.

Email: This is the contact's email address, entered here for office reference only.

Remark: This is a per contact message that can be programmed to appear on the POS
display when this account is used.

Then icon opens a window where you can add contact specific information into 5 text
fields. Use these fields to build reports as required. The fields can contain information such
as driver's license, favorite wine, or anything else you may need to track for your accounts.
The field titles are info field 1 to info field 5 by default. These screen labels can be changed by
opening the L-BOSS configuration menu and accessing the Advanced flag settings. Here is
the contact table extra info fields window.
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Note: : if the current cashier's phone number matches the account phone number or the
account contact phone or cell number the transaction will not be allowed. This is to prohibit
cashiers from using their own account to sell to themselves or to others with their own
account discount.

Associating a Photo with a Customer

L-BOSS and L-POS can also be configured to display a photo of the customer, ideal for
visual confirmation. The photo can be for office use only, or also sent to the front end. The
POS screen must be programmed to display the photo when the account number (and
contact number) is entered at the POS.

To associate a picture with the customer's record in the client table:

With the client table open on the Maintenance desktop,

Click the "View" menu from the Maintenance top bar menus,

Select the "Picture" option.

The client table window expands to display a picture box, with "Browse" and "Delete"
buttons.
In the "Contact" portion of the customer window, select the contact to associate with a
picture.
 Use the "Browse" option to locate the contact's photo file.

 Deploy the changes to all L-POS terminals if they are programmed to display customer
photos

Use the "Delete" button to remove the associated photo from the contact's record.

NOTE: When the customer table is being edited the Menu bar is modified to include a View
option. This is where you can toggle on or off the displaying of the customer photo on the
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maintenance screen.

Note: When you edit the customer account table the file menu includes the send to host
option.

Send to host: The Send to host option of the "File" menu options is only available when the
Host active option is selected to return data to a headquarter system. The "send to host"
option will allow output of the changes made on the local L-BOSS machine back to a host
system. This means that changes can be made at a store and sent back up to the host
system. Select this option for the tables that may be edited locally in a store.  Please consider
as well that changes sent back up to the headquarter system will be deployed to all terminals
that are part of the same target group for that file type. This means that if a price is changed
at store 3 and all stores share the information on that product, the change will make it to the
other stores in the next communication cycle. To force a change to make its way back up to
the head office you must press the Satellite from the menu for that record. Using the deploy
all changes option will not return any information to the host system. It is an item by item
decision that can only be activated one item at a time with the satellite icon.

2.2.4.8.2  Deleting accounts

Sometimes you may need to remove accounts from your system. Follow this procedure:

1. Ensure the account balance is zero. You cannot delete an account that has a charge
balance. 

2. Account balance is normally increased by making a house charge transaction on the POS.
It is reduced by making a Received on account entry through the POS. Any other manual
adjustment to the account balance is entered in the Maintenance application. Open the
customer and press the F4 button. Enter the adjustment amount (positive to increase the
account balance or use the negative symbol for a negative adjustment.) Enter the points
adjustment the same way.

3. Press the  Scissors icon to delete the customer account.

4. There are a few ways to send the deleted records. You can locate any other account and
press the Satellite in the account toolbar. This will send that account and any deleted
records. You can also use the L-BOSS task menu to execute the Deploy all changes
command. This will send all changes and the deleted records to the POS terminals.

5. If you are using L-BOSS Central for multi-store systems, the records will be deleted from
the store back-office terminals after the next communication from each store to L-BOSS
Central. The records will be deleted from the POS terminals after the next deploy all
change event executed on each store's L-BOSS.

6. Deleting the customer account will also remove the contacts associated with that account.

Deleting account contacts.
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1. Locate the contact to delete.

2. Press the  scissors icon to delete the contact.

3. There are a few ways to send the deleted records. You can locate any other account and
press the Satellite in the account toolbar. This will send that account, the account contacts
and any deleted account or contact records. You can also use the L-BOSS task menu to
execute the Deploy all changes command. This will send all changes and the deleted
records to the POS terminals.

4. If you are using L-BOSS Central for multi-store systems, the records will be deleted from
the store back-office terminals after the next communication from each store to L-BOSS
Central. The records will be deleted from the POS terminals after the next deploy all
change event executed on each store's L-BOSS.

Note: When an account is deleted the record is only hidden in the L-BOSS database. This is
mandatory to allow you to re-print a statement for an account that was deleted. You will not
be able to When you create a new account using a number that was previously deleted
please take note of this behavior: the purchase history of the previous account holder will be
assigned to the new account.

2.2.4.8.3  Account / Contact alias table

You can add alternate lookup numbers (alias) for accounts or account contacts. This allows
you to assign additional numbers to the account, for example a customer lost his card. This
way you can issue a new card without losing any account details or history.

Start by opening the customer's main account. Now from the Edit menu select Account alias
or contact alias.

You can also access the account alias table by clicking the small  icon beside the client
number field.

To open the client contact alias table press the  icon beside the customer contact
number.

Note that the account alias is a lookup reference only. All statistics and transaction
information is recorded using the main account number or the original contact number.
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2.2.4.8.4  Account mask

The account mask creates default values supplied in certain fields when a customer is
created on the fly in the POS. The system uses 9999999 as the account number for the
mask account.

Open any account and open the Edit menu to select Mask account. Enter the default values
that will be assigned to new accounts created on the POS.

 The account mask set-up screen

The account mask account can contain the default values that will be assigned to a new
account created on the POS. So if most customers are from the same city and province you
can enter those values into the account 9999999. If you want new customer to be assigned a
specific risk or client level enter them.

If you assign an account expiration date to new accounts the default is entered as a number
of days in the account name field. On the mask account this field is labeled as "# of days."
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Don't forget to deploy these changes to the POS.

2.2.4.8.5  Adjusting the account balances

Account balance is normally increased by making a house charge transaction on the POS. It
is reduced by making a Received on account entry through the POS.

Any other manual adjustment to the account balance is entered in the Maintenance
application. Open the customer and press the F4 button. Enter the adjustment amount
(positive to increase the account balance or use the negative symbol for a negative
adjustment.) 

Enter the points adjustment the same way.

NOTE: The Points Avail field is only used on systems that are working with the special
points programs. Adjustments made to this field affect the Spending available amount as
defined in the special points application you are using.

2.2.4.8.6  Customer Level Table

Customer Level Table Programming

Customer levels are used to assign accounts to a "level" for pricing or discounting. Up to 999
customer levels can be created,
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This example shows a Customer Level table record.

Level Number:  Enter the level number to be programmed.

Description:  Enter a brief description of this customer shopper level (Regular, gold card,
super-saver, etc.)

Price level:  Enter the price level that members of this customer group will receive.

Discount:  Enter the discount that members of this customer level will receive on
discountable products.

Discount level: Enter the internal discount level that is executed when an customer discount
is triggered. This allows you to control the behavior of how the account discount works in
relation to other discounts.

Assign level 0 to use the discount level assigned under the PosSetup>System>Account
tab
Assign level 1 to 4 to specify that the account discounts will work against discount type
1 to 4.

 Here is an example of how the discount levels can be used.
You have customers who receive discounts using Level 1 discount type.
You have a manual sub-total discount button that also gives discounts on the total of
the discountable items.

1. If you want the customer to receive a discount on top of the discount already
offered with the button you should assign the button to use Discount level 1 (in the
button parameters). Then assign the customer level to use Discount level type 2.

2. If you do not want the customer to receive a discount on a discount you should
assign the customer discount level type to the same level as the button is set at.

Do not give points: Set this flag to suppress points that would be issued to customers
assigned to this shopper level.



L-BOSS User Manual 4.1.3246

© 2001-2014 ... Logivision

Note: When you edit the client level table the file menu includes the send to host option.

Send to host: The Send to host option of the "File" menu options is only available when the
Host active option is selected to return data to a headquarter system. The "send to host"
option will allow output of the changes made on the local L-BOSS machine back to a host
system. This means that changes can be made at a store and sent back up to the host
system. Select this option for the tables that may be edited locally in a store.  Please consider
as well that changes sent back up to the headquarter system will be deployed to all terminals
that are part of the same target group for that file type. This means that if a price is changed
at store 3 and all stores share the information on that product, the change will make it to the
other stores in the next communication cycle. To force a change to make its way back up to
the head office you must press the Satellite from the menu for that record. Using the deploy
all changes option will not return any information to the host system. It is an item by item
decision that can only be activated one item at a time with the satellite icon.

2.2.4.8.7  Risk Level Table

Risk level Table Programming

Risk levels are required to establish credit parameters and check cashing privileges. An
unlimited number of Risk levels can be created. An unlimited number of customer records
can be assigned to each risk level.

This example shows a Customer Risk  Level table record.

Risk level #: Enter the number to be used for this risk level.

Description: Enter the description to use for this risk level.
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Max credit: Enter the maximum credit that customers associated with this level will be
allowed to reach before further charges are refused.

Check limit is the maximum check amount that is to be accepted from any customer
assigned this Risk level.

Check change limit is the maximum change amount (after a check tender) that should be
returned to any customer assigned to this Risk level.

Check week limit is the maximum number of checks and the maximum amount that can be
accepted per week for any customer assigned to this risk level.

Accept check is used to define the check acceptance level for any customer assigned to
this risk level. The options are: "1" allow check payment, "2" request manager authorization
and "3" refuse check payment.

Interest Rate: L-BOSS can be programmed to apply interest charges on overdue amounts.
The interest fees are based on unpaid store charges that are over 30 days. For example, if a
customer purchases goods on account in the month of May and the amount charged during
May is left unpaid, no interest fees are calculated during June. When the "Generate Interest"
event runs on the 1st of July, the system uses the interest rate from the Risk Level table to
calculate the interest on unpaid charges from before June.

Enter the YEARLY interest rate without the percent sign "%". For example, a 2% monthly rate
is entered as 24.

NOTE: The interest calculation is a scheduled task called "Generate Interest" found in the L-
BOSS "Events / Tasks" menu, but can also be triggered manually.

Max PBAL new rental: You cannot rent items to customer with a charge balance above this
amount.

Note: When you edit the client risk table the file menu includes the send to host option.

Send to host: The Send to host option of the "File" menu options is only available when the
Host active option is selected to return data to a headquarter system. The "send to host"
option will allow output of the changes made on the local L-BOSS machine back to a host
system. This means that changes can be made at a store and sent back up to the host
system. Select this option for the tables that may be edited locally in a store.  Please consider
as well that changes sent back up to the headquarter system will be deployed to all terminals
that are part of the same target group for that file type. This means that if a price is changed
at store 3 and all stores share the information on that product, the change will make it to the
other stores in the next communication cycle. To force a change to make its way back up to
the head office you must press the Satellite from the menu for that record. Using the deploy
all changes option will not return any information to the host system. It is an item by item
decision that can only be activated one item at a time with the satellite icon.
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2.2.4.8.8  Account view

The account view option is an easy method to open the account tables simultaneously. It is
designed to simplify the operation but is really no different than opening the customer, the
risk, and the client level tables individually.

2.2.4.8.9  Discount

The discount table is used to control discount rates offered to preferred shoppers. The
discount table functions as part of the preferred shopper module. Contact your dealer to order
the option if it is not licensed.

Understanding the discount table: The discount table is used to control discounts by
customer type and by sub-department. By now you understand the relationship between
PLU's and sub-departments. You should also understand what a client level is before
proceeding. Assuming that you have a grasp on the above, here is how the discount table
works.

As an example, let's suppose that customers assigned to client level 1should get a 5%
discount off the price of items linked to sub-department 1. But the same customers assigned
to client level 1 receive 15% off items linked to sub-department 2. By adding records to
control these discounts, the L-POS can automatically handle the price control for you. 

Now let's add into the equation that customers assigned to Client level 2 receive 10% off the
price of items in sub-department 1 and 20% off the price of items linked to sub-department 2.
Getting more complex, but still a way of life in some retail stores.
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To go a step further, imagine a scenario where employees are assigned as Client level 3 and
they receive 40% off the price of items linked to sub-department 1, and they purchase at your
cost plus 5 % on items linked to sub-department 2.

Are you confused yet? We understand that the ideas here may seem complicated at first.
However, when required the programming you do in this table will really improve your price
control on the L-POS terminals.

We have explained the major functionality of the discount table by giving a few examples.
There is more: for each of the examples given above what would happen in you were in the
middle of a big sale where much of your merchadise had already been marked down? Would
you still give the same discount rates to the customers? 

Look closely at the example above. There are 4 rows where 4 different discount rates can be
entered. The different discount rates will be triggered by L-POS depending on which of the 4
conditions (NO-NO, NO-YES, YES-NO, YES-YES) are met. Look to the left of the dfirst
discount row in the table above. The MPF field shows NO and the Sale column shows NO.
This means that the customer will receive 10% off the price when the MPF flag is not
selected, and when the item is NOT on sale (or not included in a currently active sale batch.)
But he will only receive 5% discount off of the same items when they are already on sale.

The MPF flag is located on the POS tab in the PLU maintenance. It is a rarely used flag that
allows you to decide a different discount rate for items in the same sub-department. Note that
some import routines created to accept data from wholesaler's system may be using the
MPF flag internally. If you are using an import routine to accept data that way it would be a
good precaution to verify with your dealer before modifying the setting of your MPF flags on
PLU's on your system. 

The same logic applies to the YES-NO combination between MPF and Sale conditions on
PLU's. You can set a rate when MPF is YES and Sale is NO and a different rate for items that
have the MPF flag set and when the item is on sale. (Small note: the MPF flag is often used in
a pharmacy type  system where the retail operator may not be allowed to discount the DIN
registered products but does want to discount the non-DIN products. In that situation you
could use the MPF as the DIN flag.

The final setting in each discount table record is to decide whether you will function at a
discount from the current active price, or whether you will function at Cost plus the rate
entered for each condition. To use Cost plus, place a check mark in the Cost column for the
specific condition that should activate cost plus.

Adding records to the discount table: The discount table operates a bit differently from
other tables because the entries are required before L-BOSS can create the record. Enter a
sub-department number, a client level and the discount rates offered for each of the
conditions (NO-NO, NO-YES, etc). If you need cost plus, place a check mark in the cost-plus
box.

Modifying records in the discount table: Locate the record to be changed and enter the
new values.
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Removing records from the discount table: Locate the record to be removed and press

the Delete tool  from the menu. 

To locate an existing record, double click in the sub-department field. A list of the sub-
departments currently assigned to the table will appear.

N.B. The discount table does not over-ride the prohibit discount status of individual PLU's. If
you need to give a discount to customers on some PLU's even when the item is set to
prohibit discount you must add any value in the item discount %  for the specified price level.
Access item maintenance and the price tab. Enter any value in the item % discount field
(Price.F112). This discount will not be given to the customer. The customer will receive the
discount from the related sub-department as programmed in the customer discount table.
The value in F112 only means that the prohibit dicount flag should be ignored if there is a
discount rate in the discount table.

Note: When you edit the discount table the file menu includes the send to host option.

Send to host: The Send to host option of the "File" menu options is only available when the
Host active option is selected to return data to a headquarter system. The "send to host"
option will allow output of the changes made on the local L-BOSS machine back to a host
system. This means that changes can be made at a store and sent back up to the host
system. Select this option for the tables that may be edited locally in a store.  Please consider
as well that changes sent back up to the headquarter system will be deployed to all terminals
that are part of the same target group for that file type. This means that if a price is changed
at store 3 and all stores share the information on that product, the change will make it to the
other stores in the next communication cycle. To force a change to make its way back up to
the head office you must press the Satellite from the menu for that record. Using the deploy
all changes option will not return any information to the host system. It is an item by item
decision that can only be activated one item at a time with the satellite icon.

2.2.4.8.10  Product rew ard program (PRP)

The Product reward program (PRP) feature is used to track cumulative purchases by a
customer. When a defined accumulation point is reached the L-POS will automatically sell a
discounted or free item. A short report can be issued by the POS to show the dates and
transaction number of original purchase. This may be required in cases where the free items
are reimbursed by a supplier.
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Promo ID #:  This number is used to associate products to the free item promotion. The
promo ID number is assigned to the product (or products) in PLU maintenance. 

For example, every 10 purchases of a 10 pound bag of dog food entitles the customer to the
next bag for free. If the purchase is only applicable on one specific item you will assign a
unique Promo ID code to that item. Then you create the Free item record here by entering the
same Promo ID code you assigned to the dog food product. (The Promo ID setting is entered
in PLU maintenance, on the POS tab.)

If you want to allow different flavors of the dog food to accumulate together you would enter
the same Promo ID code to each of the different flavors of dog food. Then you create the
Free item record here by entering the same Promo ID code you assigned to the qualifying
dog food products. (The Promo ID setting is entered in PLU maintenance, on the POS tab.)

Description: This is a reference field only. The system will print information on the customer
receipt telling him how many more items are required to achieve his discount. When many
items are in the same product reward promotion (for example different flavors of dog food)
you would want the receipt to show something generic to the customer like "Your next 
Science Diet 20KG will be free." There is a flag in the PosSetup > System > General >
Advanced settings that allow you to choose between using the word "item" in that message
or the descriptor associated with the PRP record.

Trigger quantity: This is the number of items that must be purchased before a free item is
triggered by the POS system.

Discount rate: Set the discount rate that will be applied to the reward product.

Client level: Set the customer level required for this reward to be issued.

Other settings to consider: 

1- You must create totalizers to track the PRP items sold and the PRP items redeeemed.
Open the totalizers menu and add totalizers 3535 and 3536. Deploy these totalizers or deploy
all changes.
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2- You must assign these totalizers in PosSetup > System > Totalizers:

Select totalizer 3536 for the PRP given and 3535 for PRP sold.

3- If you need the transaction report to provide proof of purchase when a reward items is
issued you need to set the flag in PosSetup > System > General > Advanced settings.
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4- If you want to print "Item" rather than the PRP program descptor you need to set the value
in PosSetup > System > General > Advanced settings:
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WARNING: The free items cannot be issued if L-BOSS in not operating. Transactions that
are entered in off-line mode will update the free items sold when the system goes back on-
line.
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2.2.4.8.11  Custom messages

Use this option to modify the messages that are printed on account statements issued from
the L-BOSS reporting system. Several different messages can be programmed by changing
the number showing in the Custom message number area. The language setting is available
for areas where statements need to be sent in different languages to different customers.

2.2.4.8.12  Recalculate customer balances

Use this option to re-calculate customer account charge balance or points balance at a
specific date. This option can be useful if you need to re-process days.

2.2.4.8.13  Points rew ards

The Points Rewards table is used to set up conversion of customer points to rewards. It is
possible to create up to 10 records that each issue a specific reward in exchange for a pre-
programmed number of points. The reward list will display on the POS screen. The form
below shows the points reward programming entry screen.



L-BOSS User Manual 4.1.3256

© 2001-2014 ... Logivision

Points reward table

1. Enter a Point rewards record number
2. Enter the description and alternate description that will be used for this point reward.
3. Enter the Reward type. You can issue a gift card, give an amount discount, or issue an in-

store coupon that will print a voucher after a transaction.
4. Enter the number of points that are needed to obtain this reward.
5. Enter the value of the reward. Depending on the Reward type this will be the amount of

either the Gift card, the dollar discount or the percentage amount.

Note: If you select Printed coupon as the reward type a new field appears:

Coupon trigger PLU: When using the reward to Print a coupon voucher you will enter the
PLU number that is linked to an in-store coupon. The system will record that PLU and
trigger the in-store coupon to print. This reward type should not have a reward value
entered.
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You must set a flag in PosSetup>System>General>Ad. Set the flag "Type M items Count"
to True.
The PLU you program to use as a trigger to issue the coupon should be set as Price
method M, no price.

Notes:
The points reward system requires these settings:

Functions:
8078: Points to Gift Card. Link to Totalizer 160 Points converted.
8079: Points to Discount. Link to Totalizer 2 Total Sales and Link to Totalizer 14 Points
converted discounts
8080: Points to Printed coupon. Link to totalizer 3508 Points to Coupon Print
8081: Points Rewards.

Totalizers: 
14: Points converted to discounts. Use totalizer 8 as a model to copy from.
160 Points converted to Gift Card. Use totalizer 101 as a model to copy from. Please ensure
that 1060, 1160, 1260, 1360, 1460, 2060, 2160, 2260, 2360, 2460 and 2560 also exist and are
set up to report properly.
3513 Points converted to in-store coupons. This totalizer may exist in your system as
Information 18.

When points are converted to a discount by dollar amount the system will always discount
taxable items before discounting non taxable items. For example you convert points to offer a
5.00 dollar discount in a 10.00 transaction where 5.00 was taxable and 5.00 was non taxable.
No tax will be collected because the 5.00 discount is applied to the taxable items first.

To use a printed coupon you need to set up the in-store coupon before creating the reward.
When this reward type is used the POS will trigger the sale of a PLU if points are converted.
That PLU would normally be set as a Zero price item (Price method M).

Create a PLU that should be triggered when the points are converted. This is set up using
PosSetup>System>Coupons>Instore coupons:
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Create an in-store coupon that will print when that PLU is triggered. Do not create a SALE
coupon, create an Item coupon using the PLU created for that purpose.

PosSetup>Button setup
Add a button to issue a gift card in exchange of points.
Function type 123 Gift certificate +. You may want to modify the name of function 123 to call it
Gift Card Issued.
Here are the button parameters:

You must set the gift card function 123 properties:
Pre-programmed = Yes
Request Amount = Yes

Now you need to verify the button's database record number: Right-click on the Key-top
image:
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When you right click a new form appears with the button properties. The top of the window
shows the database record number of the button. Take note of the number.

PosSetup>System>General tab "Ad" Advanced flags:

There are 2 advanced settings that control the POS behavior. 
The reward grid can be displayed automatically whenever a customer has accumulated
enough points to obtain a reward. To use this method modify the Advanced flag: Pop up
Points Reward on entering customer.

Otherwise you need to configure a Point reward button using function 8081 and when it
is pressed the grid will appear if the customer has enough points to obtain a reward.
You also need to assign the GIFT CARD button number that is used to call the gift card to
be allocated in exchange for points. Search for the advanced flag called: Gift card button
number. You need to assign the database record number for the button cofigured to issue
the gift card in exchange for points. In our example it is button ID 6224.

2.2.4.9 Register Menu

Register Menu Options

The Register menu contains several less frequently used options that access system tables
normally configured at installation. Use the "Register" menu to access the following tables to
create or modify entries:

Operator Table: All system users must have a record in the operator table, even if they are
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not cashiers.

Function Table: The front end terminals use functions to define the keyboard keys or touch-
screen buttons.

Totalizer Table: Functions used on the front end terminals must collect quantities and / or
amounts during normal operation, used for the reporting aspects of the system software.

Terminals and Terminal Groups: Every terminal or back end station that accesses the
system must have a record in the Terminal table, and terminals must exist in groups for
communication or database access.

Gift Certificates: If your store uses certificates as tender, they must exist as records in the
certificate table to show up in reports.

2.2.4.9.1  Operator Table

Operator Table Programming 

This example shows an Operator table record.
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As with all tables, the edit tools on the toolbar allow you work with the selected record.

Modified: As with other tables, the  icon will change to  when a record is modified. The
flag will be reset after the modified record is successfully transferred to the front-end.

Operator #:  Enter the number this operator will use to log on to the L-POS system.

Print name:  Enter the descriptor that will print on the cash register receipt when this cashier
is using an L-POS terminal.

Level: This field is used to associate the operator with a security level to restrict usage of
certain functions. An operator with level 4, for example, will have access to functions
designated as level 4 and less.

First and Last name: Enter the operator's first and last names here.

Target: Enter the target where this cashier will be active. This can be used to send certain
cashier records to certain stores only. A cashier cannot be part of more than one target. The
default value is PAL which sends to all lanes in all stores.

Drawer: L-POS supports dual physical cash drawers. Enter the drawer number that should
open when this cashier works on the register.

Language: This field is used to determine the language of the messages used on the
system when this operator is signed on. In the current release of L-POS, English and French
are valid language selections.

Address Fields

The other fields in the operator record are for address information.Special attention should be
taken to the phone number:  if the current cashier's phone number matches the account
phone number or the account contact phone or cell number the transaction will not be
allowed. This is to prohibit cashiers from using their own account to sell to themselves or to
others with their own account discount.

Note: When you edit the operator table the file menu includes the send to host option.

Send to host: The Send to host option of the "File" menu options is only available when the
Host active option is selected to return data to a headquarter system. The "send to host"
option will allow output of the changes made on the local L-BOSS machine back to a host
system. This means that changes can be made at a store and sent back up to the host
system. Select this option for the tables that may be edited locally in a store.  Please consider
as well that changes sent back up to the headquarter system will be deployed to all terminals
that are part of the same target group for that file type. This means that if a price is changed
at store 3 and all stores share the information on that product, the change will make it to the
other stores in the next communication cycle. To force a change to make its way back up to
the head office you must press the Satellite from the menu for that record. Using the deploy
all changes option will not return any information to the host system. It is an item by item
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decision that can only be activated one item at a time with the satellite icon.

Note 2: You cannot delete the last operator with a programmer level from the system.

Security tab

The security tab allows you to define password rules for each operator for back end
operations and for front end operations.

Back end:

User must change their password: Set this flag to require a password change at next
logon to the back end system.

Password never expires: Logivision recommends you do not set this flag. Setting this
flag will compromise the PCI DSS compliance level of your system. If you set this flag you
will be prompted to accept responsibility in the event of data security breaches.

User account is disabled: This flag will be set whenever the operator tries to log on
unsuccessfully more than 3 times in succession. To re-enable this operator immediately
remove this check and deploy the record with the satellite.

Days before password expires:  Logivision recommends you do not modify the 90 day
default setting. Changing this to a value greater than 90 days will compromise the PCI DSS
compliance level of your system. If you modify this flag you will be prompted to accept
responsibility in the event of data security breaches.

Password - Generate: Use this button to generate a new password for this operator.
NOTE: The operators level 6 and 7 must have an email address setup to receive their new
password. Levels 5 and under do not require an email, the generate button will show a
temporary password on screen. 

Note on passwords: Back end passwords must contain at least 1 uppercase letter,  1
lower case letter and one number. Passwords must be a minimum of 8 characters.
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Front end:

User must change their password: Set this flag to require a password change at next
logon to the back end system.

User account is disabled: This flag will be set whenever the operator tries to log on
unsuccessfully more than 3 times in succession. To re-enable this operator immediately
remove this check and deploy the record with the satellite.

Reset password: Use this button to clear the password for this operator.

Allow Managing Self-Checkout: Use this button to allow the user to login as a manager
on the self-checkout lanes. 

2.2.4.9.2  Functions Table

Function Table Programming

!!WARNING!! The Function table should only be modified by programmers. Tampering
with the Function table can create serious system failure, or inaccurate reports. We
suggest you consult your Logivision  dealer if you require new functions.

Functions are required in order to make entries on the L-POS system. Functions are
assigned parameters and then embedded within buttons that are placed on the POS
keyboard or on the POS touch-screen. The description of a function is printed on the register
receipt when a button containing the function is used. Functions are created and modified
using the L-BOSS Maintenance application. Buttons are created and modified using the POS
Set-up module (accessed from the L-BOSS "Modules" menu.

Functions also have a relation to data that appears on a sales report, such as functions that
collect amounts. To track the information entered using a function, it must be linked to a
totalizer. Functions that do not collect information do not have totalizer links. Totalizers are
created by selecting Totalizer from the Maintenance application's "Register" menu.

From the Maintenance application's "Register" menu, select "Functions".
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This example shows a Function table record.

Func#: This is a number used by the system to sort the function list. We suggest that you
leave the existing functions numbered as they are. If you cannot locate a function you need
for the register operations, you can add new functions. Remember that functions that collect
amounts must be linked to totalizers for reporting, so if you create a new function, you may
need a new totalizer to link to.

Host: This is a reference used to advise the back-end which functions should be sent to the
front-end.

Desc: This description field will be used to position this function in the function list
alphabetically. It will also be printed on register receipts when a button that contains this
function is used. So if you are using a touch screen and you have created a button for Error
correct, and this button prints Void last item, it is because the function attached to the Error
correct button is called Void last item. Furthermore, it could be printing Correction on the
sales report because the function was linked to a totalizer called Correction.

Alternate Desc. This is the second language descriptor for the function. It will be used on
customer receipts.

Access: This area is used to restrict access to certain functions by operator type. For
example, to allow access to a function for operators who use the Cashier security level, the
Cashier check-box must be marked. To restrict access to a function for operators who use
the Cashier security level, the Cashier check-box must not be marked. When you create a
new function, the access is given by default to all operators from cashier to programmer. If
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the access needs to be restricted for additional operator levels, remove the mark from the
check-box of that operator level. The operator No User is used to define if a function can be
used without logging on to the system. This might be the case for a price verify function used
without an operator present.

Alpha Parameters

The alpha parameters section only appears here to maintain compatibility with a third party
software used in early L-POS versions and is no longer used.

Totalizer Link List

The bottom portion of the Function table shows a list of all Totalizers associated with the
currently selected function. If the Totalizer window is open on the Maintenance desktop,
clicking on the Totalizer number in the list forces the totalizer table to display the totalizer's
information. The Operand field is used to change the sign of the totalizer information to match
the accounting status of the totalizer (usually + or -). If the operand is incorrect or is required
but missing, L-POS terminals will issue an "Out of balance" error warning.

NOTE: When you need to collect sales data by sub-department or by department per
cashier or per customer you need to adjust the properties of certain functions. You need to
decide whether you will store sub-department or department data in the cashier report
database and in the customer report database. You cannot store both. Once that decision is
made, here are the modifications you must make in the function table:

If you want to collect sub-department information you need to modify the PLU
function (710) and the sub-department function 715.
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On both function 710 and 715 we have added  totalizer 5000 in the bottom of the window and
assigned the operand S.
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If you want to collect department information you need to modify the PLU function
(710) and the Sub-department function 715 or the Department function 716. You would
modify the sub-department function 715 if you assigned open sub-department
buttons on the L-POS keyboard. You would modify the department function 716 if you
assigned open department buttons on the L-POS keyboard.
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Functions 710, 715 and 716 were modified to include  totalizer 5000 in the bottom of the
window. By assigning a D in the operand we are advising L-POS to generate department
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totals instead of generating sub-department data (as with the operand S.)

Note: When you edit the function table the file menu includes the send to host option.

Send to host: The Send to host option of the "File" menu options is only available when the
Host active option is selected to return data to a headquarter system. The "send to host"
option will allow output of the changes made on the local L-BOSS machine back to a host
system. This means that changes can be made at a store and sent back up to the host
system. Select this option for the tables that may be edited locally in a store.  Please consider
as well that changes sent back up to the headquarter system will be deployed to all terminals
that are part of the same target group for that file type. This means that if a price is changed
at store 3 and all stores share the information on that product, the change will make it to the
other stores in the next communication cycle. To force a change to make its way back up to
the head office you must press the Satellite from the menu for that record. Using the deploy
all changes option will not return any information to the host system. It is an item by item
decision that can only be activated one item at a time with the satellite icon.

2.2.4.9.3  Totalizer Table

Totalizer Table Programming

!!WARNING!! The totalizer table is normally programmed for you at installation time
and should not be modified unless you are certain of the consequences. Modifying the
totalizers can seriously affect the report results. Please consult your Logivision  dealer
if you require additional support.

Totalizers are used to collect the sales or transaction data that was entered using a function
on the system.
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This example shows a Totalizer table record.

The totalizer number determines the section and position of each total on the default report
system included with L-BOSS. 

The description is used by the report program to print the description of each total on the
report. 

Alternate descriptor is used on receipts and reports when the second language is called by
operator or by customer.

Files determines which report database will be updated when the totalizer is used. The file
names are internal to L-BOSS, and were programmed at installation time. We suggest that
you consult your Logivision  dealer if you require specialized reports.

Debit, credit and General Ledger are all used to output data for an accounting system.
This requires a special interface. If you wish to send report data to your accounting package,
please contact your Logivision  dealer.

Report Section: L-BOSS reports make use of "sections", for example, a portion of the report
may show the negative transactions that reduce net totals.

Tlzr sequence: This number is used to sort the report section. If more than one record has
the same sequence number, they will show up together, ordered by their totalizer numbers.

Report formula: L-BOSS uses this field internally to perform special calculations, or format
the font behaviour of this report line.

NOTE: In order to use the Client / Sub-department report, or to obtain sub-department or
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department totals on the Cashier sales report, you need to make some adjustments to the
function table and add records to the totalizer table. Totalizer 5000 plays a special role in
relation to those reports. It acts as a template in a sense. Data is captured whenever the PLU
function is used, or when the sub-department function is used, or when a department function
is used. In order to capture sub-department data in the Cashier report database you need to
instruct L-POS to generate that data. It does not occur automatically. Once you have
decided to collect either sub-department or department data by cashier you will need to add
a totalizer into the system for each sub-department or department that must be reported. The
new totalizers that you create will be numbered using the following convention: create a new
totalizer that is the sub-department number plus 5000. So if you want to see information for
sub-department 15 on the cashier report you will need to create totalizer 5015. If you want to
see information for sub-department 132 on the cashier sales report you will need to create
totalizer 5132. The same would be true if you decide to report department activity by cashier.
You would create the totalizer 5022 to report sales for department 22. Remember that you
can only report one or the other on the cashier or customer reports. Here is an example of
the correct programming for totalizer 5010. This will allow sales of sub-department 10
(GROCERY) to appear on both cashier and customer reports:

Notice that in the Files area we have inserted CLK; and CLT. CLK instructs L-POS to send
the data to the cashier report database and to use total 5010. CLT instructs L-POS to send
the data to the customer by sub-department report database. If you do not need to see a
totalizer in either of those reports you would remove the file type. For example, if you do need
to see all sub-department movement totals per customer, but only need to see lottery sales
per cashier, all of the 5xxx totalizers would have CLT and only the Lottery totalizer would have
CLT;CLK in the Files area of the totalizer set-up window.

NOTE 2: Don't forget to adjust function 710, 715 or 716 or L-POS will not output the
report data you want to see. Please refer to function set-up for more information.
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Note 3: When you edit the totalizer table the file menu includes the send to host option.

Send to host: The Send to host option of the "File" menu options is only available when the
Host active option is selected to return data to a headquarter system. The "send to host"
option will allow output of the changes made on the local L-BOSS machine back to a host
system. This means that changes can be made at a store and sent back up to the host
system. Select this option for the tables that may be edited locally in a store.  Please consider
as well that changes sent back up to the headquarter system will be deployed to all terminals
that are part of the same target group for that file type. This means that if a price is changed
at store 3 and all stores share the information on that product, the change will make it to the
other stores in the next communication cycle. To force a change to make its way back up to
the head office you must press the Satellite from the menu for that record. Using the deploy
all changes option will not return any information to the host system. It is an item by item
decision that can only be activated one item at a time with the satellite icon.

2.2.4.9.4  Terminal Table

Terminal Table Programming

!!WARNING!! The Terminal table setup should only be used by programmers.
Tampering with the terminals and their respective targets  may cause system
communication problems.  

Terminals and Targets

One of the key features of L-BOSS is the terminal and target set-up. A Terminal might be an
L-POS terminal, L-BOSS server or workstation, a wireless device used for price changes, a
gas pump, a scale or even an application. 

A Target is made up of one or more Terminals. There are 3 target types: Report, Program
and Exchange.

Report targets are used to separate sales report data among terminals. In a store with 3
L-POS lanes you may want to report individually on the sales from registers 1, 2 and 3. You
may also want to consolidate the data into a total for the 3 lanes. This means you would
create 4 report targets; one for each POS and one target with all 3 terminals included. The
default L-BOSS installation includes a report target for lane 001 and for the target RAL. The
RAL target should be programmed to include all lanes and terminals.  

Program targets are used to create program data specific to that target. By default the
system includes 2 program targets: 001 (includes L-POS terminal 1) and PAL which
includes all terminals. In the default installation there is only one terminal so PAL includes
only lane 1. The PAL target should be programmed to include all POS lanes. If you are
using the fuel interface the PAL target will also include the Gas Pump server. if you are
using a  3rd party scale interface or similar the PAL target will include the terminal created
for that application. At a head office the PAL target includes the 901 L-BOSS terminal of all
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remote stores.
Exchange target is used by the L-BOSS to create the polling list. There is only one
Exchange target called XAL. The exchange target should be programmed include all
lanes and terminals that must be polled by L-BOSS. Do not add the local L-BOSS server or
any workstations to the XAL target. XAL will include all L-POS terminals.   If you are using
the fuel interface the XAL target will also include the Gas Pump server. if you are using a 
3rd party scale interface or similar the XAL target will include the terminal created for that
application. At a head office the XAL will include all the L-BOSS 901 terminals of each store
in the chain.

A first step in setting up the software for use in a live environment is to create the terminal list
and assign the terminals to one or more target groups. Access the Register option from the
main maintenance application. The following menu and screen layout will appear, although
the number of terminals and targets may not be the same:

This example shows the Terminal and Target Group programming utility.

The screen is divided into 2 areas. The left hand side of the screen displays the targets, the
right hand side shows the terminals that have been created. Each L-BOSS workstation or L-
POS terminal in the store must be created as part of the terminal list.

Adding terminals manually:
To add a terminal, select the Terminal option from the menu and use the Add option. You
can also click on the blue bar at the top of the terminal list to activate that window. Then the
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toolbar in the main window can be used to add a terminal( the   tool). L-BOSS will prompt
for the Store number and the Terminal number. The next step is to assign a Description for
the terminal. Below the descriptor window you select the terminal type. The terminal type is
used to determine which type of data it will receive. For example, you can set the terminal
type to L-BOSS for each of the L-BOSS workstations being set up for the system. The
terminal type you select allows L-BOSS to distinguish which file types should be transmitted
to that terminal when changes are made and then deployed. The LPOS type will tell L-BOSS
server to deploy files required for L-POS terminals. The L-BOSS type is used when a central
system L-BOSS needs to send changes to an L-BOSS server in a remote location. NONE
means that no files will ever be sent to this terminal even though it may be in the exchange
target for data communication. This is the case for a portable terminal working on-line, a price
checker, etc. You can add a new terminal type if the existing choices do not correspond to
your needs. Right click on an existing terminal type and follow the prompts. Right clicking on
the terminal type opens the following window:

Use the window to set the exclusion files that are not sent to this terminal type. For example,
if the ECR model does not allow printer model definition, then you could scroll down the list
and move Printer.Ini to the right hand window. The file list shows all the database tables, then
the INI files, then the images, SFiles and advertising files. Define the exclusions and pres OK
to return to the terminal programming screen.

The terminals you create must be assigned to register targets. The targets serve 3
purposes: Programming, reporting and exchanging data. A program target is used to
associate programming data such as prices, accounts and register set-up with registers.
The report targets are used when the report program is executed. When you request a
report, the report program will allow you to access data by register target. If you need to
report sales for each terminal, or for all terminals, several report targets are needed. The 
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exchange flag must only be set to the target called XAL. An internal check in L-BOSS warns
if there is more than one target with the Exchange bit set.

In most situations within a single store the registers will belong to common program, report
and exchange targets. You will send the same program data to all registers. Reports will be
requested for all terminals. If you use a different POS set-up (different screen layout, different
printer model, etc.) in the same store, you will need to set up a separate program target for
each program type. L-BOSS identifies which terminals belong to each target. For example
the scanner is different on lane 1 which is the courtesy desk. You will create new target
groups to separate the scanner set-up.

To add a terminal to an existing register target, highlight the terminal. Then highlight the target

to which you want to add the selected terminal. Now click the  tool between the 2 window
areas to move the terminal into the selected target. To remove a terminal from a register

target, use the  tool. You may include the same terminal in as many different targets as
required by your installation.

Adding terminals automatically:
When the terminal window is opened, the Edit menu option in the main Maintenance
application can be used to set the total number of lanes in the store. This option will prompt
for the total number of lanes that are to be used in the store. If your store has 3 lanes enter 3
at the prompt for number of lanes. Even if you had 2, it will set the system to 3 lanes by
creating a terminal and target list for you. This option uses fixed computer names  (POS01,
POS02, POS03, etc.)

Terminals are numbered sequentially beginning at 001 and the store number entered
during the L-BOSS configuration. If you are in store 001 the terminals will be created as
001 001, 001 002, 001 003, etc.
The terminals will be created as LPOS terminal types

Each POS terminal will be added to the PAL, RAL and XAL targets.

Each POS terminal will be added to an individual REPORT target named 001, 002, 003,
etc. The target descriptions will be set to POS 01, POS 02, etc.

Note: In order to add more terminals to an existing terminal list, the existing terminals must
be numbered sequentially beginning with terminal 001. Otherwise you will need to add the
terminals manually. Also make sure that you have used the correct computer name when
installing Windows. This routine will use POS01, POS02, etc.

In a normal store operation, you will need to create, or modify the following targets:

PAL or Program All Lanes: This target target should include each register in the store. It will
be used as the default target for price changes, cashier changes, etc. This target will be
selected as a Program target only. By default it is also the Item, Price and Cost target.
NOTE: If you add another item, price or cost target, you need to decide whether or not the
PAL target will be used for pricing or other item related maintenance. If it is to be used, make
sure that the ITEM, PRICE and COST check boxes are selected within the PAL target target.

RAL or Report All Lanes. This target group should include each register in the store as well
as each back office unit. When reports are requested and you select the target RAL, the
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system will display or print the data for all the terminals. This target will be selected as a 
Report target only.

XAL or Exchange All Lanes is used to send data simultaneously to all terminals. This target
will be selected as a Exchange target only. This target will include all POS terminals. It will
not include local L-BOSS server or workstation.

001 including register 1 only. This target needs to be created so that reports can be taken
individually for one machine, or so that data can be programmed and transferred to one
machine only, or in case you need to define separate set-up options for different terminals
(such as printers, scanners, keyboards, etc). This target would be selected as Report and
Program.

002 including register 2 only. This target would be selected as Report and Program. 
etc. for all other registers as for target 001.

901 including the back office terminal number 901. This will be selected as a Report target.
Then a report can be taken for back office operations such as account payments performed
on this unit.

902 if terminal 902 exists same as above for 901.

Setting up terminals and target groups with remote data communications
Under normal circumstances, LRemote will be used to transfer data between L-BOSS
stations found in different locations. In order for this to occur, you need to set up parameters
at each side. Create an Outboxhost folder on the hard drive of the L-BOSS server in each
store. See the related programming on the L-BOSS File menu under Configuration and Host
tab.

Terminals required at Headquarters to transfer data to remote stores

The headquarter terminal list must include a terminal for the L-BOSS server in each store.
During set-up You have a choice as to whether report data is available per terminal for each
store, or whether the report data from each terminal in the store is merged into a common
total for the store. (Related flag in L-BOSS, File, Configuration menu under Host). If you do
not want merged data, then you need to create each terminal in each store at the head office.
If you decide to report consolidated per store, then you only need to create the back office
terminal as we have already explained. Most businesses will probably want to report
consolidated sales only, so they should not forget to set the Merge lane data flag in the Host
configuration tab. 

If you need to report on each lane individually at the head office, then you must create a
terminal for each register in every store at the head office. These terminals must not have
any inbox or outbox assigned. They are only included in Report targets.

Sample terminal list:

Terminal Description Path Inbox Path Outbox
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001 901 Backoffice store 1
002 901 Backoffice store 2
003 901 Backoffice store 3

NOTE: You will need to create all the folders before using the system.

Terminal targets at Headquarters

When L-BOSS is used in a multi-store environment using L-Remote, care must be taken in
the Target group set-up. For example, within each store there are unique data files that
cannot be sent to each store. An example of this could be the Receipt header and trailer
messages. If there are different addresses to print in each store it is important to structure
the targets properly. Otherwise the headquarters system will not be able to change the
receipt message for store 1 without changing the message in store 2, etc. This means that at
the head office you need to create a target for each store, for example S01, S02, S03, S04.
Place the L-BOSS 901 terminal of each remote store in those target groups. Then L-BOSS
will be able to transfer the correct data files to the correct store. You MUST NOT use target
numbers such as 001, 002, etc. This would create a conflict. Here is a sample list that may
be created at the HQ if you have 3 stores to communicate with:

S01 Terminal 001 901, created as Program, report
S02 Terminal 002 901, created as Program, report
S03 Terminal 003 901, created as Program, report
PAL Terminal 001 901, 002 901, 003 901 created as Program target
RAL Terminal 001 901, 002 901, 003 901 created as Report target
XAL Terminal 001 901, 002 901, 003 901 created as Exchange target

When you are using multi-zone pricing you need to define the Price settings for the
appropriate targets. In the 3 store example from above, if each store has separate prices,
then you would need to select Price on each of the S01, S02 and S03 targets. If different
items go to different stores, then you need to select Item in the same targets. Same for the
Cost records of items. If some of the prices are common to all stores, then make sure that
the PAL target has Item, Price and Cost selected.

When creating the store list at the central office you can decide which files are sent to
different stores. You may decide never to send the printer configuration files for example. You
decide what is sent to each store. Then L-BOSS will check which target is used to send the
correct data to each terminal.

Changing prices in a store to send to the host system:
The Send to host option of the "File" menu options is only available when the Host active
option is selected to return data to a headquarter system. The "send to host" option will allow
output of the changes made on the local L-BOSS machine back to a host system. This
means that changes to prices, accounts and other files can be made at a store and sent
back up to the host system. Select this option for the tables that may be edited locally in a
store.  Please consider as well that changes sent back up to the headquarter system will be
deployed to all terminals that are part of the same target group for that file type. This means
that if a price is changed at store 3 and all stores share the information on that product, the
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change will make it to the other stores in the next communication cycle. To force a change to
make its way back up to the head office you must press the Satellite from the menu for that
record. Using the deploy all changes option will not return any information to the host system.
It is an item by item decision that can only be activated one item at a time with the satellite
icon.

2.2.4.9.4.1  Multiple L-POS targets (different screens, etc.)

L-POS terminals do not all have to be identical in the same store. It is possible to set different
screens, printers scanners, etc. 
Setting multiple terminals in the same store with different attributes
Before starting you should check:
1. Each pos terminal (or we may call it a register) exists on the terminal list. 
2. Each register is (always) part of the programming group PAL. 
3. Each register is normally also part of a group numbered exactly the same as the register

ID number. For example, Target Group 001 includes only Terminal 001 and this type of
group is set up as Program, Report and Exchange. 

If all the lanes are created as per the normal steps explained in 1,2,3 above, any time a
change is made to the set-up of any other lane, the change is recorded for ALL terminals
whose programming is linked to group PAL. This is because the default L-POS setup has all
of the programming GROUP FILES linked to the target PAL.

With the setup illustrated above, a system is ready to have different attributes on any lane if
the GROUPS setting in PosSetup.Exe is modified properly. But with the set up illustrated
above, if you wanted one register in a store to have a different screen than other registers, the
setup for each register would need to be done individually. This is OK if there are few
registers in a store. But when there are 20 registers, with 3 registers sharing different
attributes than the other 17 registers, it would be easier to create a few additional target
groups in the L-BOSS Maintenance program. You would create a new target group with 3
registers and one with 17 registers.
When you want to be able to change a part of the register configuration that is normally
shared with other registers, you need to modify the GROUPS settings in PosSetup.Exe. This
can only be done by running PosSetup. If you access the register setup from the L-POS
transaction screen you do not have access to the group set-up. Start PosSetup and enter
Groups.
With 8 registers programmed as explained in steps 1,2,3 your screen should resemble this
one:
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The list on the left are the attribute types that can be changed per target. The list on the right
shows the targets available. When a target is selected on the right (as above for PAL-
Program All Lanes,) the list on the left shows which attribute files are assigned to that target
group of registers. The example above has all files shared with the exception of the bank
driver because it was not installed. By way of example, this means that every time the
advertising set-up is changed the same change will be sent to all terminals that are part of the
Target PAL-Program All Lanes.

In the setup above, if 2 terminals need screens to be different than all other terminals, the File
Type Functions needs to removed from the Target group PAL. If it is not removed from PAL,
any change made to any terminal's screen will be sent to all registers belonging to PAL. So
you must create 2 new target groups under L-BOSS Maintenance register programming
menu. Call the new Target group "KEB" AND "TOU" for example. Make this target a
PROGRAM target by selecting the check box for program. Add registers that share the
common screen setup into each target group. Our example below shows lanes 1-6 in the
TOU touch screen target and lanes 7 & 8 in the KEB keyboard style target. The back end
target s look like this:
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With this change you will now be able to separate the screen settings for each of the targets.
Open PosSetup Groups screen which should look like this if the new Target groups are
created:
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The next step is to separate the screen programming for the targets KEB and TOU. You
must associate the file type Functions (fom the left hand window pane) to the target group
KEB-Keyboard screens and to the target group TOU-Touchscreens.

The change is made by selecting the target KEB on the right hand side of the Groups set-up
screen. Then place a check mark into the box beside Functions on the left hand side of the
window. You will be prompted for a source group as follows:
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This prompt allows you to assign the same layout you have in the original group PAL.To do
this highlight Functions.PAL and click OK. Otherwise you could choose None and begin from
scratch with no screen layout data in the new target. It is advisable to copy from the source
group PAL. It is much easier to remove and resize the screens, buttons, functions that to
create everything from scratch. That is a large job.

When you use the source Functions.PAL L-BOSS executes a copy command that replicates
the data from functions.PAL to functions.KEB. L-BOSS will insert new records in all screen
related tables to create the screen information for the new target KEB.

Once you have added the file type Functions to target KEB, the same process needs to be
followed for target group TOU. In PosSetup Group screen select target TOU-TouchScreen in
the right hand window. Then place a check in the box beside Functions in the file list in the left
hand window. When prompted to select the source group, choose PAL. The system will then
copy "Functions.pal" to "Functions.TOU" and also insert the rows into the database screen
tables.

The final step is to remove the file type Functions from the target group PAL. This is
EXTREMELY important or else your screens will not work properly because records for KEB,
TOU and PAL will all exist. To remove the Functions from target PAL, select target PAL-
Program All Registers in the right had window and then remove the check mark from the file
Functions on the left hand side. 

Now you are set to create and maintain 2 different screen layouts. When you start L-POS
and then run PosSetup from within L-POS, the program verifies which target group the
current terminal belongs to and changes the files associated with that target group. When
you start PosSetup outside of L-POS, you are prompted for a terminal number to access the
setup screens. Selecting terminal 1 allows you to modify terminal 1 and all the other registers
part of target group that register one belongs to. In our example of target TOU, a change to
terminal 1 will also record changes for terminals 2,3,4,5,6. Any change will be sent to other
registers in that group when the Deploy Pos Changes is executed.

The same logic can be followed to set up different settings for any of the file types shown in
Possetup Groups programming screen.
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2.2.4.9.5  Store information

This is where you enter the store information for each location. 
Note: When you are working with the L-BOSS Central or L-BOSS Regional system the Store
information table has more fields. Refer to the L-Remote chapter and open the
Creating_the_store_list topic of this guide for more information.

Most information here is very straight-forward. The Internal number can be used to identify the
store if the 3 digit L-BOSS store number is insufficient.

Select the store manager by pressing the [Set] button and choosing the operator.

2.2.4.9.6  Gift Certif icates

Programming Gift Certificates 

Gift certificates can be sold several ways with L-POS. You can create a list of gift certificates
or sell gift certificates on the fly. If you are using certificates that are pre-printed with amounts
and you want to control each one, you must set up each certificate in the table. You may also
decide to only sell gift certificates generically as an amount and give up the extra control that
L-POS can offer.

To add a gift certificate to the system access the Maintenance application and select the Gift
certificate menu option.
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This example shows a Gift Certificate table record.

Enter the certificate number, amount and set the expiry date. The expiration date is extended
by the number of days defined under the configuration menu, miscellaneous tab.

Gift certificate expiration:  
1. If there is no date in the EXPIRATION field in the gift certificate maintenance, AND
there is no setting in L-BOSS for number of days for gift certificate expiration, the gift
certificate will never expire.
2. If the number of days for gift certificate (in the miscellaneous tab of the configuration of
L-
BOSS) is set to 0, the expiration of the gift card (if any) will not be modified when it is
sold. If there is a number in that field L-POS will set the expiration date to the date the
certificate is sold plus the number of days in the configuration field for gift card expiration
days.

The Status field indicates the current status of the gift certificate record you are editing.
A means that the gift certificate is available for sale on the system.
I means the the gift certificate has been issued.
R means the the gift certificate has been redeemed.
U means that the gift certificate is programmed, but unavailable for sale.

Note: When you edit the gift certificate table the file menu includes the send to host option.

Send to host: The Send to host option of the "File" menu options is only available when the
Host active option is selected to return data to a headquarter system. The "send to host"
option will allow output of the changes made on the local L-BOSS machine back to a host
system. This means that changes can be made at a store and sent back up to the host
system. Select this option for the tables that may be edited locally in a store.  Please consider
as well that changes sent back up to the headquarter system will be deployed to all terminals
that are part of the same target group for that file type. This means that if a price is changed
at store 3 and all stores share the information on that product, the change will make it to the
other stores in the next communication cycle. To force a change to make its way back up to
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the head office you must press the Satellite from the menu for that record. Using the deploy
all changes option will not return any information to the host system. It is an item by item
decision that can only be activated one item at a time with the satellite icon.

Note 2: Gift cards: The gift certificates can be used a Gift cards by making a few changes to
the settings. Gift cards work similar to an account with a credit balance. Here are the steps
required to set-up the system to use gift cards rather than gift certificates.

1. In PosSetup>System>General>Advanced you need to set the Gift card server IP
addess.

2. Create a button that uses function 117 named Gift card tender. Set Gift number to
True. Set Credit note to True.

3. Create a button that uses function 123 named Gift card redeem. Set Pre-programmed
true. Set request amount true if you want to be able to override the amount the card
was programmed for originally.

Note 3: Scanning gift cards:  
1. Create a button and call it "Sell Gift Cert." add function "load form" in there and map it on

the keyboard.
2. In the properties of that function, click on "Advanced" and type in /VAR01=1. (This button

will need to be pressed before scanning to sell the gift cert.)
3. In the properties of the "CLEAR" button, click on "Advanced" and type in /VAR01=0 (this

is going to remove the variable from memory when "clear is pressed")
4. Create another button, this one called "Gift Cert.", and add 2 functions in there: Gift

Certificate (+) #123 and Gift Certificate (-) #117. (no need to map that one to the
keyboard as it's only going to be used in the definition table)

5. In that button, go in the Advanced properties for function Gift Certificate (+) #123, and in
there type in /IEQ01=1 /VAR01=0 (this will execute the function only if var01 is equal to 1
and set back the var01 to get out of selling mode)

6. Still in the same button, but on the 2nd function Gift Certificate (-)
#117==>properties==>advanced, type in /INE01=1 (this will execute the function only if
var01 is NOT equal to 1)

7. Your def. table needs to have an entry for that: set your [8 - Undef] function to use the
"Gift Cert" button that you created at step 4 (you need a "key" on the barcode to be able to
recognize that it is a gift certificate).  

8. To sell a new gift certificate, you push "Sell Gift Cert" (created at step #1) and scan
your gift card. To redeem it, you just scan the card without pressing that button.

2.2.4.9.7  Web coupon

Use this table to create coupons applicable on the web store.
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Coupon code: Enter the coupon item number

Description: Enter coupon description

Alternate description: Enter language 2 description

PLU: Enter the item number this coupon applies to. No PLU number is required when the
coupon type is 1 (transaction coupon)

Start date: Enter the start date for the availability of this coupon.

End date: Enter the end date for the availability of this coupon.

Discount $: Enter the discount amount for this coupon

Discount %: Enter the discount percentage for this coupon

Coupon type: 
0= Item coupon
1=Transaction coupon

Coupon limit: 
0= No limit
1= Once per customer
2= Once per system

Comment: Enter a comment related to this coupon.
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2.2.4.10 Windows Menu

Controlling the Maintenance Desktop

Like many Windows based programs, the Maintenance application allows you to have more
than one window (table) open at the same time. The Window menu contains options that
allow you to control how the windows or tables appear on the desktop. 

Cascade: This aligns the open windows in layers, with the corners and title bars of all open
windows visible, enabling you to find the window you a looking for.

Tile: This option tries to place all the open windows into the Maintenance application's
desktop by re-sizing them.

Close All: Closes all open windows at once.

Selecting open windows from a list: If you have multiple windows open on the desktop, you
can open the "Window" menu and select the window to "bring to front" from the list at the
bottom of the menu.

2.2.5 Loyalty features

2.2.5.1 Loyalty setup

L-BOSS and L-POS contain several features that can be used for loyalty tracking and
rewards.

Loyalty features with local processing inside L-BOSS and L-POS

The following features are available for use with L-BOSS and L-POS when the
preferred shopper module is purchased.

Price levels allow you to create different prices for items. The price level itself will either be
selected manually by the cashier or it can be triggered by a customer account number.
Look for more information on setting up price levels here.
Customer discounts: each customer is assigned to a Client Level in L-BOSS. The client
level table allows you to assign a general discount rate that will be applied to all
discountable items purchased by the customer. Click here to view the client level set-up.
Customer discount table: this table uses the same logic as customer discounts with more
discount rates available per customer type. You can assign a different rate of discount per
customer level, per sub-department and the rate can vary if the product is on sale or at
regular price. More information on the customer discount table.
Product reward program allows you to set up a reward system based on cumulative
purchases of items. For example, every 10 coffees earns the next coffee for free. Click
here for more information on the PRP.
Points accrual and redemption. L-POS allows you to set up points systems in several



L-BOSS User Manual 4.1.3288

© 2001-2014 ... Logivision

ways. Click here for further information on using points as a loyalty system.
Points rewards: This feature allows redeeming points accrued with the L-BOSS system by
converting them to gift cards, discounts or printed vouchers. Click here for more
information.
Transaction completion deal (TCD): This feature allows set-up of discounts that are based
on purchases made within a transaction. Read more about the TCD here.  

Loyalty features available with third party programs

L-BOSS and L-POS also interact with 3rd party reward systems.
Air Miles: sends batch data related to customer purchases based on the Loyalty One Air
Miles program. Merchants must be approved by Loyalty One to use this service.
Aeroplan: sends data related to customer purchases to the Aeroplan host. Merchants must
be an approved Aeroplan merchant to use this service.
CAA: sends data related to customer purchases to the CAA host. Merchants must be an
approved CAA merchant to use this service
Fanbox: interacts with the Fanbox host to process loyalty accrual and redemption
transactions. Contact Fanbox for information on program features.
Givex: interacts with the Givex host to process loyalty accrual and redemption transactions.
Contact Givex for information on program features.
Loyalty Lane: interacts with the Loyalty Lane host to process loyalty accrual and redemption
transactions. Contact Loyalty Lane for information on program features.

2.2.6 L-POS Points system

L-POS allows you to compute and issue points during a sale transaction. L-BOSS will

accumulate these points that can be used as a reward for the customer. There are different

ways to issue points. And there are different ways to redeem points. This is a generic

explanation of how to issue points and how points can be redeemed.

2.2.6.1 Issuing points

There are 3 methods to issue points:

Points attached to the PLU. These points can be set as a fixed amount for the PLU or

as a percentage of the item price.

Points attached to the sub-department. These points are ALWAYS a percentage of

the price.

Points attached to the tender buttons. These points are ALWAYS a percentage of the

tender amount.

Points on a TENDER will ADD to points on the PLU or points on the Sub-department

Points on a PLU override the points set on the sub-department it belongs to.

1-Points attached to the PLU

You can issue points on items by setting a points value or a percentage in the price table for

each price type (SALE, PROMO, REG,ETC) and for each price level (Base, Silver, Gold,

ETC). There is a flag in the Possetup|system|PLU tab: Points as percentage. This is a

system wide flag that affects all PLU items. You cannot issue  points as a percentage of item

price on some items and points as a fixed value on other items. When set to True the system
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computes the points attached to a PLU as a percentage of the price of the item that has

points attached.  

So to give 145 points on an item that is $1.45 set the points field in the price tab of that item to

100. 
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There are also flags in PosSetup|System|General|Advanced related to how points are
rounded. A sale with 2 items priced at 1.45  and 1% points produces a different result if points
are rounded per item or rounded at the end of the transaction. Points rounded per item would
give 2 points whereas  points rounded at finalize would issue 3 points. Those flags are
located in the Preferred shopper points section.
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To exclude specific items from the calculation of points given on the total or on the related sub-
department enter a negative percentage in the points field.

The system will suppress points on items that are discounted if you set the Advanced flag: 
Suppress PLU  a tta ched points w hen item  discount is used. This means that if an item is affected
by an ITEM DISCOUNT no PLU attached points will be calculated.

1-Points attached to the Sub-Department

It is also possible to set points on the sub-departments rather than on the item. In this case
the system will check if points were assigned to the item. If not it will take the points assigned
to the Sub-department it belongs to. This was you can decide to double points on some items
when you need to by setting the value on an individual item to double the rate used on the
sub-department. Let's say you want points on all items in the grocery department except
when the item is on sale. Set the points value to zero in the sale batch you create for those
items. It will override the points value on its sub-department. After the batch the item will start
issuing points again. If you are using Sub-department buttons for manual entry and want
points on the manual entries made on the POS you must attach points to the sub-
department:
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1-Points attached to the Tenders

The other way to issue points on a transaction is on the tender buttons. 
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There is an advanced flag in the Preferred shopper points section related to this that allows
you to decide whether tax is included in the points calculation or not. But this is only valid if
points are issued on the tender keys. Take note that this flag only affects the behavior of
systems using add-on tax. Points calculated on total sale on systems that use VAT tax will
always be inclusive of the tax.
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Points issued display factor: This flag in the Advanced settings Preferred shopper points
section controls how the points issued are displayed. If for a specific reason you want 400
points issued to display as 4 points issued you could set the value to .01
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2.2.6.2 Printing points

L-POS can print the points earned in a transaction on the customer receipt. Open the
Advanced settings under PosSetup|System|General tab.
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Print points will show the points on the customer receipt. This flag overrides the "Print points
only if customer".
Print points only if customer will print points only when a customer account is opened in
the transaction. If the flag "Print points" is set to true the system will always print points
whether a customer account number is used or not. So you need to turn off the "Print points"
flag and turn this flag on if you want to print points messages only when a customer account
was opened.
Print points as a dollar value will transform the points into currency value.
Points value will multiply the points in dollar amount by this value. So if an item for 1.00 set
to issue 100% is sold and this points value flag is set to 2 the system would show $200.00 in
the point issued this transaction. This value would normally be set to .01 if using points as a
dollar value. NB: The Points Value is ignored unless the Print points as dollar value is set
as True.

Sample receipt where each penny sold earns 1 point.

1/13/2011 12:49:21 PM        L-BOSS Peter

OREO COOKIES                pR  5.00    
PREMIUM PLUS SODA BISCUITS    p 0.15    
UNCLE BEN'S RICE              p 0.10    
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----------------------------------------
TOTAL          5.25 
Cash                            5.25    
Points in this transaction: $5.25       
Item count: 3                           
Trans:6622     Terminal:030202034-003001

Sample receipt where each penny sold earns 1 point but the Print points as dollar value is
set to True.

1/13/2011 1:03:31 PM         L-BOSS Peter

IDEAL CREAM CORN              p 0.25    
IGA SALAD DRESSING            p 0.20    
OREO COOKIES                pR  5.00    
----------------------------------------
TOTAL          5.45 
Cash                            5.45    
Points in this transaction: $5.45       
Item count: 3                           
Trans:6628     Terminal:030202034-003001

Sample receipt where each penny sold earns 1 point but the Print points as dollar value is
set to True and a customer account is used..

1/13/2011 1:05:27 PM         L-BOSS Peter

John Smith                      0.00    
4                                       
IDEAL CREAM CORN
 2 @ 0.25ea.                  p 0.50    
IGA SALAD DRESSING
 2 @ 0.20ea.                  p 0.40    
OREO COOKIES                pR  5.00    
----------------------------------------
TOTAL          5.90 
Cash                            5.90    
Points in this transaction: $5.90       
Points balance            : $97.55      
Item count: 5                           
Trans:6629     Terminal:030202034-003001

N.B. L-POS will never print points if you select or modify any of the following advanced flags
in PosSetup|System|General tab.
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The setting for Print points must be TRUE.
All other settings must be set to their default to allow prints to point.

The fields listed above can be used with L-POS as part of a special points application and is
explained in the Special points program set-up topic.

2.2.6.3 Redeeming points with a points tender function

The first thing is to decide if points can e used to pay for a product. By default all items are

included in the transaction amount  that can be paid, or discounted by points.

To change this behavior set the PosSetup>System>Advanced flag called: The point Tender

function is used to pay the total amount. When this flag is set things like bottle deposits, taxes

and other sundry amounts cannot be paid for with points.

You can restrict paying specific items by setting the "No Pts redemption" flag on those items

or sub-departments.  Note that the follow sub-department flag controls whether this needs to

be set per item or if the value is set at the sub-department level.
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In the Buttons you will need a Points Tender to use the points as money.

Create a button using function 140 type Points tender.
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Block Size is the minimum number of points that can be used. For example if you want to

force customers to purchase at least $10.00 of merchandise to spend any points set this

value to 1000. They will be able to use 1000, 2000, 3000, etc. They will not be able to spend

1250 because the blocks are accepted only in multiples of 1000. The normal value is 1 so

that they can use as low as 1 point in a transaction.

There are related flag in the in the Advanced settings under PosSetup|System|General tab

in the Preferred shopper points section:

The point Tender function is used to pay the total amount: Set this flag to allow points to

pay the entire transaction including taxes and other purchases such as bottles. If this flag is

not set TRUE only items that are not set to No Pts Redemption will be payable by the point

tender function.

Point redeemed conversion rate: This setting controls the value of each point as a

currency value. Set the rate by dividing the amount reduction by the quantity of points required

 for that reduction. Here are a few examples:

If you want to redeem points at the rate of one point for one dollar set the value to 1. (1 /

1 = 1)

If you want to redeem at the rate of one point for one cent set the value to .01. (.01 / 1

= .01)

If you want to redeem at the rate of 1000 points gives .50 cents reduction set the value

to .0005 (.5 / 1000 = .0005)

NOTE: L-POS internal gift cards cannot be paid using Point Tender. Use the Point Reward

system.

Sample receipt showing a Points tender. In this example the customer paid $1.00 by using

100 points.

1/13/2011 1:16:35 PM         L-BOSS Peter

John Smith                      0.00    

4                                       

Taxable                        1.00 Tx1

----------------------------------------

SUB TOTAL                       1.00    

Taxable 1           1.00                

Tax 1                           0.05    

----------------------------------------

TOTAL          1.05 

Point Tender  100               1.00    
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SUB TOTAL                       0.05    

Cash                            0.05    

Points redeemed           : 100         

Points balance            : 9130        

Item count: 1                           

Trans:6633     Terminal:030202034-003001

2.2.6.4 Point system examples

EXAMPLE  1:

Points are issued based on transaction total before tax. Tenders issue points at rate of 1% of the sale
amount. Points are redeemed as a payment type. Any minimum payment amount is allowed using
points.  200 redeemed points (accumulated purchase of $200.00) gives a $1.00 payment.

In each tender function assign the Points(%) value as 1.
Set the Point Tender using function 140 Block size to .01
In System>Advanced flags> Set the Point Redeemed Conversion Rate  to .005

Assuming the customer has enough points you can tender up to the exact amount of points that will pay
the entire sale balance. In this example, if a sale is made for 3.99 the customer would need to enter 798
Points to pay the total. If you direct tender it will use as many points as possible. You cannot over
tender. An error will occur if you try to tender more points than available on the account.
Note: to exclude taxes and bottle deposits from the amount payable set the Advanced System flag:

The point Tender function is used to pay the total amount. to false.

EXAMPLE  2:

Points are issued based on transaction total including tax. Tenders issue points at a rate of 100% of the
sale amount.

In each tender function assign the Points(%) value as 100.
In System>Advanced flags> Set the flag The calculation of the points will be based on the total
including tax to True

Points are redeemed as a payment type.  You must redeem points in blocks of 10,000 at a time. Each
10,000 points is worth one dollar. 

Set the Point Tender function 140 to a block size of 10,000.00
In System>Advanced flags> Set the Point Redeemed Conversion Rate  to .0001

Assuming the customer has enough points you can tender up to the exact amount of points that will pay
the entire sale balance. But you MUST tender in multiples of 10,000 points. Each 10,000 points will give
1.00 reduction in amount owed. In this example, if a sale is made for 3.99 the customer would be able to
enter 30,000 Points. The remainder must be paid with an alternate method of payment. If you direct
tender it will use as many points as possible. You cannot over tender. An error will occur if you try to
tender more points than available on the account.

EXAMPLE  3:

Points are issued as a dollar amount based on the 1% of the sale total excluding tax. Points cannot be
used to pay for items in sub-department 10.

In each tender function assign the Points(%) value as 1.
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Set the advanced flag: The calculation of the points giving on the tenders will be based on the
total sale including tax to False.

Set the advanced flag: Print the points issued a s a  dolla r va lue to True
Set the advanced flag: Points redeemed conversion rate to .01
Set the flag No Pts redemption on sub-department 10 and on all items associated to sub-
department 10.
Set the Points tender key Block size to 1.00

NOTE: You must make sure that these Advanced flags are set to default value for the system to issue
points. These flags MUST be set to use an alternate method for issuing and redeeming points. Refer to
the section on Special Points program set-up on how to use the system with the alternate method.

Special Account identifier

Custom  CU RREN T PO IN T m essa g e
Custom  A CCU M U LA TED PO IN T m essa g e
Custom  REDEEM ED PO IN T m essa g e
SPEN DIN G A V A ILA BLE custom  m essa g e: 

2.2.6.5 Converting Points to rewards

The Points Rewards table is used to set up conversion of customer points to rewards. It is
possible to create up to 10 records that each issue a specific reward in exchange for a pre-
programmed number of points. The reward list will display on the POS screen.

Points reward table

Enter a Point rewards record number.

Select a Target where this point reward can be used.

Enter the description and alternate description that will be used for this point reward.

Enter the Reward type. You can issue a gift card, give an amount or percentage discount,
or issue an in-store coupon that will print a voucher after a transaction.
Enter the number of points that are needed to obtain this reward.

Enter the value of the reward. Depending on the Reward type this will be the amount of
either the Gift card, the dollar discount or the percentage amount.
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Note: If you select Printed coupon as the reward type a new field appears:

Coupon trigger PLU: When using the reward to Print a coupon voucher you will enter the
PLU number that is linked to an in-store coupon. The system will record that PLU and
trigger the in-store coupon to print. This reward type should not have a reward value
entered.
You must set a flag in PosSetup>System>General>Ad. Set the flag "Type M items Count"
to True.
The PLU you program to use as a trigger to issue the coupon should be set as Price
method M, no price.

Notes:
The points reward system requires these settings:

Functions:
8078: Points to Gift Card. Link to Totalizer 160 Points converted.
8079: Points to Discount. Link to Totalizer 2 Total Sales and Link to Totalizer 14 Points
converted discounts
8080: Points to Printed coupon. Link to totalizer 3508 Points to Coupon Print
8081: Points Rewards.

Totalizers: 
14: Points converted to discounts. Use totalizer 8 as a model to copy from.
160 Points converted to Gift Card. Use totalizer 101 as a model to copy from. Please ensure
that 1060, 1160, 1260, 1360, 1460, 2060, 2160, 2260, 2360, 2460 and 2560 also exist and are
set up to report properly.
3508 Points converted to in-store coupons. This totalizer may exist in your system as
Information 18.
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When points are converted to a discount by dollar amount the system will always discount
taxable items before discounting non taxable items. For example you convert points to offer a
5.00 dollar discount in a 10.00 transaction where 5.00 was taxable and 5.00 was non taxable.
No tax will be collected because the 5.00 discount is applied to the taxable items first.

When points are converted to a percentage discount the system will pro-rate the discount
between taxable items and non taxable items. In the example above the tax would be
computed on 2.50 because thee discount would apply equally to taxable and non taxable
items.

To use a printed coupon you need to set up the in-store coupon before creating the reward.
When this reward type is used the POS will trigger the sale of a PLU if points are converted.
That PLU would normally be set as a Zero price item (Price method M).

Create a PLU that should be triggered when the points are converted

Create an in-store coupon that will print when that PLU is triggered. Do not create a SALE
coupon, create an Item coupon using the PLU created for that purpose.

2.2.6.6 Manual points

The manual points function can be used to add or subtract points to a customer account.

No minus will make sure the customer cannot reach a negative points balance. For example
if you set the flag Negative the system will redcue the customer points balance when the
button is used. If you set No minus you will not be allowed to accept more points than the
customer has.
Negative is used to create a button that reduces the points by the amount entered.
Current points works when the Negative flag is set to create a redeem button. This flag
allows you to use points earned in the current transaction as part of a point redemption.
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2.2.6.7 Special points program set-up

Here are 2 examples of how to set up the L-POS points system to allow spendable dollars

using the points balance. 

EXAMPLE 1- Pharmacy with a cosmetics deal.
Customer buys 100.00 of cosmetics and earns 10.00 to spend on more cosmetics. If they

buy 12.00 it accumulates to the 100.00 minimum before the reward is available. Every 100.00

earns 10.00 to spend.

This system requires changes in PosSetup:

PosSetup > System menu> Advanced flags list:

Preferred shopper section

Points rounding factor: 0.005

On total points rounding factor: 0.5

Point identifier symbol used on receipt to identify product: p

Point tender function is used to pay total: No

Apply point rounding at finalization: Yes

Print points issued as a Dollar value: Yes

Points value: .01

Spending block size: 10000

Spending value: .1

Points redeemed conversion rate: .01

Point Issued Display Factor: 1

Custom CURRENT POINT message: CURRENT POINTS (you must set a description)

Custom ACCUMULATED POINTS message: ACCUMULATED POINTS (you must set a

description)

Custom REDEEMED POINTS message: REDEEMTED POINTS (you must set a

description)

Spending available custom message: Available to Spend (you must set a description)

Vendor specific section

Special Account Identifier MUST be set to a value, not blank. If you enter a Z here you must

set up your accounts to start with Z. Accounts that do not begin with the Special Account

Identifier will not receive points. To issue points with this method to ALL accounts set the

identifier to * (astersisk). The flag on customer level 

ISSUING POINTS

Set the points field to 100 to issue on the price tab of all cosmetics items that will issue

points.

Make sure you set the Flag "Points in percentage" on the PLU tab of PosSetup>System

settings page

If you are using Subdepts to issue points they must be set at 100%

if you issue points on the tender buttons:

You can exclude items from calculation by entering a -1% on the item.

You can exclude a subdept from issuing points by entering a -1%

Items with no points defined will follow the points entered on the related sub-department.
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TENDERING POINTS

Create a Point tender button using function 140.

Set the Block size to 1.00

Set the flag "No Pts Redemption" on all items or Sub-departments that cannot be paid for

with reward dollars.

EXAMPLE 2: Grocery store reward program

Customers must buy 2000.00 of productsto earn 10.00 of rewards to spend. For example, if
they buy something for 12.00 it accumulates to the 2000.00 minimum spending before the
first reward block of 10.00 is available to spend. Every 2000.00 of qualified spending earns
10.00 to spend. The points are issued in whole dollars, always rounded down. So 1.79 will
issue 1.00 of points. 

When they spend points they must spend minimum 1.00 at a time. Any over tender will be
sent to the OverTender fee. But they cannot overtender by more than .99. So a 2.15 item paid
with points will use 3.00 of points and .85 goes to overtender fee. If they try to enter 5.00
points it will give error. 

This system requires changes in PosSetup:

PosSetup > System menu> Advanced flags list:

Preferred shopper section
Points rounding: 0
On total points rounding: 0.5
The calculation of points on the total includes tax: True
Point tender is used to pay total: Yes
Apply point rounding at finalization: Yes
Print points issued as a Dollar value: Yes
Points value: 1
Spending block size: 2000
Spending value: .5
Points redeemed conversion rate: .01
Point Issued Display Factor: 100
Custom CURRENT POINT message: CURRENT POINTS (you must set a description)
Custom ACCUMULATED POINTS message: ACCUMULATED POINTS (you must set a
description)
Custom REDEEMED POINTS message: REDEEMTED POINTS (you must set a
description)
Spending available custom message: Available to Spend (you must set a description)
Vendor specific section
Special Account Identifier MUST be set to a value, not blank. If you enter a Z here you must
set up your accounts to start with Z. Accounts that do not begin with the Special Account
Identifier will not receive points. To issue points with this method to ALL accounts set the
identifier to * (astersisk). The flag on customer level 
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ISSUING POINTS
Tender buttons must be set to issue 1% points. Set this in the function properties of each
payment button.

If you are using Items or Subdepts to issue points they must be set at 1%

if you issue points on the tender buttons:
You can exclude items from calculation by entering a -1% on the item.
Make sure you set the Flag "Points in percentage" on the PLU tab of PosSetup>System
settings page
You can exclude a subdept from issuing points by entering a -1%
Items with no points defineed will follow the points entered on the related sub-department.

TENDERING POINTS
Create a Point tender button using function 140.
Open Advanced settings for function 140 in the point tender button
/OTF=-1 /MIN=1.00
Note: The /OTF=-1 is a special flag that controls overtender on Points. When you set this flag
the system will force tendering in whole dollar amounts. The system will allow you to under
tender. The system will prohibit over tender above the next higher dollar amount. The change
normally due on the over tender will be sent to thee Overtender fee totalizer. For example:
Sale is 3.47 total. Press the Point Tender button and the system will use 4.00 points and
send .53 to overtender fee.

2.2.6.8 Redeem points & print a voucher

OBSOLETE: We added the Points Reward function to improve the control over issuing in-store

coupons for customer points. Please refer to the section on "points to rewards".

To redeem a points value and print an in-store coupon you can do this. Our example redeems

2000 points and prints a $20.00 voucher

Set the Possetup>System>General>Advanced flag : Allow zero priced PLU to TRUE.

Create a PLU called 2000 points redeemed. Our example uses PLU 2000. Price this item at 0.00

Create an in-store coupon (PosSetup>system>Coupons>In store coupons)

Press NEW and add coupon for item 2000 that you created. Access the Properties window:
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Now access the Modify tab to enter the text that will print on the coupon.
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Now create a button to use the points and print the voucher (in-store coupon)
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This button will execute 3 functions if you want to use it in a separate transaction. To use it in a

normal transaction just remove the CASH function not to finalize a zero sale.

The MANUAL POINTS function should be set like this:
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The PLU function should be set like this:
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The CASH function has no special parameters to assign.

To use the button place it on the keyboard and press during the transaction to redeem 2000 points

and print the in-store coupon attached to PLU 2000. A customer who doesn’t have 2000 points

available will not get the coupon.

Here is the redeem using manual points:

1/19/2011 7:06:16 PM         L-BOSS Peter

                               $0.00    

Customer Level 1                        

4                                       

Manual Points  -2000           $0.00    

2000 Points redeem             $0.00    

----------------------------------------

TOTAL                          $0.00    

Cash                           $0.00    

Points redeemed        : 2000           

Item count: 1                           

Trans:432      Terminal:040000007-039001
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You can become a Preferred Shopper today!

     Please ask for information at

          our courtesy booth.

         THANK YOU & COME BACK

 

Here is the voucher sample:

     L-POS

 POS SOFTWARE THAT UNDERSTANDS YOU...

    ...FROM PEOPLE WHO UNDERSTAND POS

1/19/2011 7:06:16 PM         L-BOSS Peter

****************************************

  $20.00 GAP CASH

You have redeemed 2000 GAP shopper

reward points for a $20.00 gift

voucher redeemable at all participating

stores.

****************************************

Trans:432      Terminal:040000007-039001

You can become a Preferred Shopper today!

     Please ask for information at

          our courtesy booth.

         THANK YOU & COME BACK

2.2.7 Report System

Report System Overview

Viewing reports for all store activity is perhaps the ultimate reason for having a retail control
system. Without reports, it is impossible to make important management decisions based on
accumulated data. With L-BOSS reports, quick, simple, up to date information is only several
clicks away. Report formats must also fit the store's needs, containing only the information
required. L-BOSS provides flexible reporting, including content and format.

Information security is a must as well. Not all users should be able to access financial reports
for example, but might still need to view item quantities, or department lists. L-BOSS reports
are security configurable, actually hiding reports, not just barring access. If they do not have
the required security level to access a report, users do not even see that the report exists.
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Because L-BOSS compiles front end transactions by date as they occur, the back-end
system is constantly updated with sales data from L-POS terminals. This means that "on-
the-fly" reporting is always available, allowing the manager to make decisions based on
current information.

Report headers display the data selection such as terminal group, cashier number,
department range, or whatever is pertinent to the current report. But it is possible that a
terminal is working in off-line mode. For example, a network cable has been unplugged, or a
terminal is being used for an outdoor flower sale. It is good practice to use the View logs
menu option to verify the status of the store's POS terminals. When all terminals are on-line
and their mailboxes are empty you know that all data has been retreived and processed by L-
BOSS.

Grand total information:
Financial and end of day reports may display a grand total value. The grand total (Totalizer
4003)is the total of all positive sales. This is the Total Sales (Tlzr: 2) of every SIL file (taxes
included) that has a positive total. The grand total range is 0.00 to 9,999,999,999.99

Negative GT before L-POS version 2.1.5.9: 
Totalizer 4002 is the total of all positive sales plus the absolute value of all negative sales.
This is the Total Sales (Tlzr: 2) of every SIL file (taxes included). Its range is 0.00 to
19,999,999,999.98
 
Negative GT with L-POS version 2.1.5.9 and up, and with L-BOSS only: 
Totalizer 4002 is the total of all negative sales. This is the Total sales (Tlzr: 2) of every SIL file
(taxes included) where the transaction total is negative. Its range is -9,999,999,999.99 to 0.00 

The grand totals do not represent the sales information. They are provided as a simple
verification method to insure that no report has been misplaced. To verify data continuity,
subtract the previous day totals from today's total.

2.2.7.1 Report Types

Default L-BOSS Reports

L-BOSS ships with a default selection of reports. Generally, the default reports meet the
needs of the average retail operation. If you have special reporting needs that are not covered
by the default reports, consult your Logivision  dealer to find out about customized reports.

List of Default Reports
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NOTE: Some of the report types relate to specific modules and will not produce reports
unless the module is registered for your installation.

Batches - Reports associated with price and promo batch set-up information as well as
sales movement for specific batches.
Cashiers - For balancing cashiers and viewing cashier statistics.

Clients - If you use the accounts receivables or preferred customer module, these reports
include account statements, account aging and other statistical reports. Some of the
reports require the preferred shopper option, others require the accounts receivable option.
Department - sales reports summarized by department totals.

ECL Programming - Displays items that have been associated with the ECL tab in PLU
maintenance.
EWIC - Use the EWIC reports to verify products contained in the APL download.

Financial - reports for store balancing, periodic financials for accounting

Inventory - includes several types of product lists useful for justfying inventory levels,on
hand amounts, and stock evaluation totals.
Labels - allows printing different label types with various product information. Labels are
often customized by the reseller to fit specific needs. The existing label templates were
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designed to print on standard label stock such as Avery 5160, 5260, 5159, etc.
List - for example: system operators, or PLUs by vendor. These reports are lists only, and
do not show amounts.
Others - Contains a few reports for tracking various information such as gift certificate
status, hourly movement, layaway status and rental tracking.
PLU sales - Item movement totals with various sort and selection criteria.

Product reward Program - These reports allow you to track the product reward program
items.
Sub-Department - sales reports summarized by sub-department totals.

System - displays system set-up information

End of day (report)- This is the report most businesses use to print daily or periodic sales
totals containing department, sub-department and financial information.

Controlling Reports

When a report has been selected but not launched from the list, there is a special right click
menu that controls the report properties, such as security level required to access it or if is it
visible or hidden. 

Right Click Menu

Hide: Select this option to hide the report from the list of reports. This hides the report but
does not remove it from the list.
View Hidden: Used to locate hidden reports, showing the entire list accessible according to
the user security level programmed.
Property: Opens the report's properties panel, (see the Report Properties help page below)
New: Create a new report list entry, and its associated report.
Delete: Remove the report from the list, and delete it.

2.2.7.2 Report Selection

Report Selection Utility

The L-BOSS reports are accessed by clicking the Reports icon found on the L-BOSS
desktop. Depending on how the security levels are programmed, you may be required to
login. The Report utility will open, displaying the reports available according to the logged
user.
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This example shows the Report Selection Utility.

The Report Selection utility functions much as a Window's style browser, with "folders" for
each report type. More frequently used reports appear as icons in the "root" of the report list.
Remember that reports are linked to security levels, and that if you don't have access to a
report, it will not appear in the Report Selection utility.

NOTE: The reports that appear in the Report Selection tool vary depending on your
installation, the installed modules, and specialized reports. Also, your Logivision  dealer may
have re-named reports to suit your needs. The list shown above is an example only; you
may not see the same reports in your setup.
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Selecting a Report

If a report appears as an icon, click once to select it and press either the "Preview" or "Print"
button on the bottom of the report selection utility, or double click the icon.

If the report is in a category along with other reports of the same type, click the "+" beside the
folder to open the list of associated reports, then proceed as above. You can also press the 
Right arrow to expand the folder or the Left arrow to collapse the folder.

Bottom bar Buttons

Use the "Preview" button if you want to view the report on screen before printing. Like any
"print preview" option, you will still be able to send the report to the printer after viewing on
screen.

The "Print" button will send the report to the printer without viewing on screen first. Use the
"Print" button if you are sure that the report contains the information you wish to view.

"Cancel" to close the report selection utility and return to the L-BOSS desktop.

2.2.7.3 Opening Reports

Using Reports

Once a report has been selected using the Report Selection utility, there are still several
steps before opening the report to view on screen or send to the printer. 

After selecting a report, press the "Preview" button. 

Reports Without Dates

Some reports do not require dates, such as item lists, department or cashier lists. When you
select a list type report, the Report Selection utility opens a list panel to determine what
should be included in the list report. In some cases you will need to determine the source 
target for the list, or perhaps a range for the list (for example from operator 10 to operator
20). In the case of a range, the selection tool offers to use all, starting with the "<First>"
element, to the "<Last>" element. Elements are the "records" from the table you have
selected to view. After selecting the range for the list report, press "Preview" to show the list
on screen, "Print" to send the list to the default printer.
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This example shows the Report Target Selection utility.

NOTE: L-BOSS is designed to be customized according to your needs. This means the
prompts displayed for a report vary depending on the way the report was programmed. The
panel above is an example only.

Reports That Require Dates

Some reports will require that you select the date(s) for the report. When you select a report
that requires a date, the selection tool opens a calendar panel. 

This example shows the Report Start and End Date Selection tool.
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By default, the Report Selection utility selects today's date. If you want to view today's report,
you need only choose to view on screen or send to the printer without viewing.

If the default report date does not correspond with the desired report date, click on the correct
date, then Preview or Print. If the desired report date is in a different month, use the left or
right arrow buttons above the date portion of the calendar to navigate to the correct month or
year.

Report Periods

Because the L-BOSS reports can cover different types of periods, you must determine a
"Start" date and an "End" date for each report. L-BOSS uses these dates to retrieve the
appropriate data and generate a report. Selecting a report period from the calendar's "Period
type" box changes the way the calendar behaves when changing the date. For example,
selecting "Monthly" in the Period type will cause the calendar to move ahead or back by
monthly periods.

N.B. The period type totals are stored as separate records in the database. As sales are
received from the POS terminals the data is posted into the daily report summaries. Other
period totals are not generated immediately as data is received. 

Weekly totals are available after the last day of the week has been processed. In most
cases this occurs between Saturday night and Sunday morning.
Monthly and yearly totals are are available after the last day of the month or year have
been processed.
The report database contains daily movement data for a specified amount of time. L-
BOSS is designed to automatically purge the daily movement files. The default system
removes daily product movement history after 92 days. This setting can be changed by a
system administrator. The system stores weekly, monthly and yearly movement history
indefinitely.

NOTE: If you select a starting date that is greater than the ending date for a report, the
calendar utility will automatically change the ending date to a date that is past the start date,
according to the Period type. This is also true if you select an ending date that is before the
starting date.

2.2.7.4 Report Viewer

Viewing Reports

Once a report is selected to view on screen (Preview), L-BOSS opens it in the Report
Viewer. By default, reports are set to open using the "full screen". 

NOTE: To have reports not open full screen, you can change the default setting using the L-
BOSS, "File" menu, "Configuration" option, "System" tab. De-select the "Preview Maximized"
option. For help using the Configuration panel, see the System tab help page under the L-
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BOSS help section in this manual.

This example shows the Report Viewer with the Cashier report loaded.

Report viewer Menu

Files
View as PDF: Select this option to open the report in a pdf viewer
Save as PDF: Select this option to save the report to a PDF file
Save as Text: Select this option to save the report as a text file.

Send
Select Client: Send the report by email to the selected client
Select operator: Send the report by email to the selected operator
Select vendor: Send the report by email to the selected vendor
Select store manager: Send the report by email to the store manager
Other recipient:Send the report by email to a specific email account

Edit
Search: Find specified text in document
Next Search: Find next occurrence of the text.

Window
Close current window: If a report is opened on the screen and you open a new report L-
BOSS will create a second display tab in the same report window. Use this menu option
to close the tab that is open.
Detach current window: Use this menu option to detach the tab that is open from the
current report window. This will create a new report window form with the single report
that was detached.
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Report Viewer Options

Close: Closes the Report Viewer, and returns to the Report selection utility.

Print: Sends the report to the default printer. If the report's properties have the "Printer
Dialog" option selected, the printer driver's option panel will open allowing you to select printer
settings.

Search Utility: You can search through a report preview for specific text or numbers.

Hold down the [Ctrl] key and press the [F] key to open the search tool. 

Enter the text to search for. 

If the search finds the requested characters the report line containing the matched
text is highlighted. 
Press the [F3] function key to continue searching for the same text or,

Hold down the [Ctrl] key and press the [F] key to enter a new search.

NOTE: The search only finds the exact match. For example, if you are searching for "sales",
the search will not find "sale". For a more global search, enter only a portion of the text to
match. Following the example above, entering "sal" will find all report lines with "sal" anywhere
in the line.

(+ / - ) Zoom: To zoom the report view in or out.

Page Selection Tool: Used to navigate multi-page reports. The single arrows move 1 page
up or down. The double arrows are use to go directly to the first or last report page.

NOTE 2: When a report has nothing to print, the message will auto-clear after 15 seconds.
This will help in situations where reports are scheduled to run automatically.

2.2.7.5 Report printing

Default report printer

Reports are normally printed to the default printer as defined in Windows printer settings.
There are several ways to overcome this default behaviour. In the report properties selection
window you can select the Printer dialogue option. This will open the printer menu so you can
select a printer when it is time to print the specified report. Available printers and options will
be available through the printer dialogue window.

Setting a default printer for reports

Reports are normally printed to the default printer as defined in Windows printer settings. You
can set a different printer to use with L-BOSS if you cannot redefine the default windows
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printer. You will need to make a few changes to the system settings. Refer to this help guide
under the L-BOSS > File > Configuration > Misc.

Setting a different printer for specific reports

Refer to report properties for information on choosing a specific printer for each report's data
output.

2.2.7.6 Printing Labels

Generating Item or Shelf Labels

NOTE: The Label utility must be registered for use. Although L-BOSS ships with several
default label templates, your Logivision  dealer may have provided other label formats for
your installation. ALSO: Items must be associated with a label type and set to "print" before
they are selectable during the label printing process. For help on setting up the item to be
able to print labels, see the "Item Label Setup" help page, under the "Working with items"
Maintenance application help section.

The Label printing process follows the same general steps as printing other reports. From the
Report selection utility, select the type of labels to print, then click the "Preview" button.

Depending on how the label generating report is programmed, you will be prompted to
choose a selection process to determine the labels to print. As with other L-BOSS reports,
this panel varies depending on the way the report is programmed. In the example above, you
can choose a single item. If you do not specify values for these, the Report application will



L-BOSS Menus 325

© 2001-2014 ... Logivision

select all labels marked with the label type being produced. The pre-selection setting allows
you to specify whether you will print for all items or only items that were modified since you
last printed. After choosing how the items are selected, press the "Preview" to see the label
page on screen, or "Print" button to send the labels to the printer.

Selection prompt window

In some cases, you may not want to print all items that need a label or you may need to print
several labels for certain items. Certain label queries use a "selection box", allowing the user
to determine which items, and the quantity to print.

NOTE: The item list is generated by the label's SQL code file; the sort order, and selection
method vary depending on how the SQL file is programmed. Please consult your Logivision 
dealer if you need to customize the sort process.  

To use the selection box:

If you want to print one label for each product on the list click the "set all to" button and enter
a 1 in the quantity field.
You can also select and row and set a different quantity for that row.

Once the quantity is established, press the OK to continue. 

First Label Selection
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To reduce label waste (ink jet and laser printers), the selection process also includes a step
that requires you to determine which label to start printing from. 

This example shows the Select First Label process for type "B" Labels.

If you have used several labels on one page, but have some unprinted labels left on that page,
you can select the label position to start printing from. The First Label Selection panel
displays the label page layout for the type of labels you are printing. This panel is based on
the label template's page configuration set in the Form Manager, under the "File" menu,
"Label" option.

To select the label position to start printing from, count from the top left, going down the first
column, as displayed by the numbering in the image above. To select the label to start
printing from:

Left click the correct position with the mouse, or

Use the left, right, up and down arrow keys to locate the starting position and press
the [Enter] key.

The Report application will start printing labels from the position you have selected.

Other Label Printing Options

It is also possible to print labels from an item "batch", or from a receiving order. The options
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also depends on how your Logivision  dealer has configured your installation. You should
contact your Logivision  dealer if you have specialized label print options and require help.

2.2.7.7 Report Properties

Report Properties Panel

When you select the "Property" option from the report's right click menu, the properties panel
opens.

!!WARNING!! Some of the options available in the report properties allow the user to
change the content or look of the report and should only be used by programmers.
Tampering with the default report properties or editing the SQL code within may
damage them, causing system errors when launched. Consult your Logivision  dealer
if you have special reporting needs.

NOTE: Report files are stored in the L-BOSS\OFFICE\RPT folder. There are three (3) basic
file types, .FRP, .LRP and .SQL. NOTE THAT these files should ONLY BE EDITED AND
SAVED using the FORM MANAGER report editor. DO NOT EDIT, COPY, RENAME,
SAVE or otherwise manipulate the report files manually from other installations. File
names, extensions and contents follow internal L-BOSS conventions that MUST be
respected for the report system to function properly.
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This example shows the Report Properties editor - the Cashier report.

Report Properties Panel Options

The report's property file name and extension (.lrp) appears at the top left of the panel to
identify the report file being edited.

The Report Title is the name that appears at the top of the report on screen or in printed
format.

Language allows you to set the default language for the report.

Minimum user level is the security feature for this report. The security level must be set for
each report individually. The security levels follow the standard L-BOSS security levels. (to
read about security levels in L-BOSS, see the "Security" help page under the L-BOSS "File"
menu "Configuration" section)  If a user does not have that security level, the report does not
appear in the report list, and therefore is not selectable.

SQL File is the file that contains the L-BOSS proprietary commands and the SQL used to
extract the information from the database for this report. The "Ed" button to the right of the
name opens the report SQL editor described below. The "..." button allows you to select the
report .sql file from a browser.

Template File (.frp) is the Form Manager file for the report. The template file contains the
visual layout and presentation aspects of the report. The template file can only be edited
using the Form Manager. If you wish to edit template files to create your own report layouts,
contact your Logivision  dealer to register the Form Manger module for your installation.

Category is used to place the report in a folder with other associated reports. Click the "..."
button to use the Report selection tool to select the correct Category for the report.

The Report prompts pull-down option can be used to set the titles and values in the prompt
windows associated with this report.

Setting the Preview to on (check marked) forces the print preview mode. If this is not
selected, the report selection process skips the print preview mode.

The Hidden option here is the same as the Hide option when a report is selected and right
clicked. This prevents the report from appearing in the list, but does not remove it.

Use Group forces the report to use group totalizers.

Check mark the Debug box if you want L-BOSS to "step through" the report generation
process, stopping after each SQL and L-BOSS command to display the command's code.
This is very helpful if the report generation is causing errors, allowing you to determine at
what step the code is producing errors. It also shows the resulting report's template fields,
allowing for template debugging.
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In the Printer area select the Dialogue option to open the printer options panel before
actually sending the report to printer, allowing the user to set printer options for the print job.
Otherwise choosing Print from the report menu sends the data directly to the printer.

Black and white sends the data to the printer in monochrome thus reducing memory
requirements quite significantly.

Main should be selected for all reports that will print to the system printer defined in the L-
BOSS configuration under the miscellaneous tab. This is either the default system printer or
the main report printer defined under L-BOSS configuration. If you do not select the main
printer option you need to define a printer that will be used. Press the Select printer button to
define a different printer for this report.

Change Icon is used to open the L-BOSS icon library, allowing you to select from the
available report icons.

Report Sections

The left bottom portion of the Properties panel contains the Report Section used to control
the output for reports that repeat certain details depending on a certain table. For example, a
list of sales details per cashier; each cashier has the same information, such as cash in
drawer, total sales etc. The report must display the same details for each cashier, breaking
the report into "sections".

Trigger Fields are fields that force the report to be broken into "bands" (sections), or details
for each record. For example, if the report deals with cashier details, there should be a report
section for each cashier's details. The cashier number field would be the "Trigger Field" that
would separate the report, with each cashier record repeating the same details. 

Title Fields are associated with the Trigger Field; they are the title for the report sections
established by the trigger field. Following the cashier example above, the cashier number field
is the actual trigger, but in the report section the title should be the cashier name, not the
number. Field On Form is the report template field that contains the Title fields. 

Total fields lists fields that should be added (sum) together in the report. Fields in a report
template file can also contain formulas that calculate elements to generate totals.

New page is also linked with the Trigger field; when selected, it forces the report to print a
new page for every time the Trigger field changes value. To continue with the cashier
example, each time the process generates details for another cashier, it forces the report to
start a new printed page. Page 1 forces the page number for that report section to be
numbered starting at one. 

2.2.7.8 Report SQL Editor

Modifying L-BOSS Report SQL Code
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The L-BOSS reports use a combination of proprietary commands and SQL code to generate
the queries that extract information from the database tables for reporting. The report
properties include a .sql file and combines it with a report template file that controls how the
report will actually appear. 

NOTE: This help document explains the Report SQL Editor tool, not how to program report
queries or other L-BOSS or SQL related commands.

!!WARNING!! The SQL editor should only be used by programmers. Tampering with or
editing the SQL code within report files may damage them, causing system errors
when launched. Consult your Logivision  dealer if you have special reporting needs.

Once a report file has been selected from the Report Selection tool, right clicking it opens a
menu. The Property option opens a panel that contains the report's configuration. The name
of the command file for the report is entered in the "Sql file"  properties field. To the right of the
sql file name, the "Ed" button opens the Report Editor, displaying the L-BOSS proprietary
commands along with the SQL code required to extract the data for the report.

This example shows the cashier report in the Report SQL Editor.

Report SQL Editor Window

The SQL editor window is divided into four (4) parts: 
The SQL editor is the top left portion of the screen, and contains the commands for
the report.
The tool bar.

The upper right of the window shows the prompts used in the Report SQL file to
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collect the language, start and end dates, period type, store number and cashier
number from the user. The editor reads the code at load time and displays all prompts
it finds in the report file when you open the Editor.
The bottom portion of the editor window is empty when first opened. It is used to view
the results of the SQL commands in table format with the field numbers as column
headers (not as a formatted report) after pressing the "Test" toolbar button.

Tool Bar Tools

Test: tests the currently loaded query and displays the results in table format. Use this to test
changes to the query and get immediate results.

View Qry: Opens a panel displaying the current version of the loaded report query. The panel
also contains an "execute" option that runs the query displaying the results in table format
(like the test option).

Re-Read: If you make changes to the report file, for example adding new prompts, this
forces the editor to re-read the code and refresh the upper right pane that shows the prompts
used in the code.

Save: The save button is "greyed out" until you actually change the loaded query. This saves
the modifications in the .sql file.

Close: Closes the Report SQL Editor window. If changes were made to the query, the close
process will prompt to save the modifications.

NOTE: The editor has a "SIL field decoder" feature (field numbers like F1024). While editing
the code, if the cursor is anywhere in a field number, the field's description is displayed in the
Editor window's top bar beside the report file name. Click any "F" field in the query to see
which field is referenced.

This example shows the Editor's SIL field decode feature. The cursor is on the first field in the query -
(F1185)
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2.2.8 PosSetup

Please refer to the L-POS help file located in the POSWIN folder on the L-POS terminals.
POSHLP.CHM and POSHLP.PDF are available for assistance with set up and use of the
POS application.

2.2.9 Entry Module

About the ENTRY program

The Entry module is used for all inventory transactions, except for the sale or return of items
on the POS terminals.
The menu options for entry are structured as follows:

File menu accesses the following options.
Login (to enter your operator ID)
Language selection
Compute on hand inventory (This will force the system to re-calculate on hand values.
This may be required if you have re-processed transactions from past days.)
View log
Exit

Modules provide access to the different applications included in the entry system.
Receiving
Adjustment
Orders
Count
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Pickup
Transfer

View is used to access past transactions made on the Entry system.
Receiving
Orders
Adjustment
Count
Transfers

Help provides access to the help file and version information.
Contents

Function keys and menu options available in the Entry transaction screens

Within the receiving, purchase order, transfer, adjustment and count screens there are both
menu options and shortcut buttons. Here is an explanation for each function.

File
Review (F8)

This function allows you to select an inventory transaction that has been posted to the
database. When you review a transaction it may be possible to print, print labels, print
shelf labels or delete the transaction. Not all functions are available for all transaction
types. 

Delete
This function can be used to delete an open purchase order that has not been
received yet.

Print (or Print worksheet if an order is in progress)
Use this option to print the transaction in report form as required.

Print shelf labels
This function will generate one shelf label for each different product in the transaction
(assuming the label option was purchased and the product set-up is complete.)

Print item labels
This function will generate an item price label for each product in the transaction
(assuming the label option was purchased and the product set-up is complete.)

Save (F11)
This function will save the transaction you have opened without posting it to the
database.

Post (F12)
This function records the transaction to the database. This function cannot be
undone.

Exit

Edit
Cost edit (F4)

This function opens the cost table so you can modify the cost of an item permanently,
rather than changing the line cost within the current transaction only.

Add item (F2)
This function posts the current item into the transaction.

Delete item (F3)
This function deletes the current item from the transaction.
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Reset all items to zero
This is used with the count function.

Reset "on order" to zero
This will reset the on order quantity for this item back to zero.

Description search F7
This opens the search window based on product description.

View
Day info

This window will display movement on this product for today and is most useful during
the count function.
Extended day info

This displays the contents of custom sql statements.
Order by

This option allows you to determine the display order of items added to the
transaction grid. Select Entered to view as the items were added to the
transaction or imported from the portable device. If you are entering receiving off a
supplier invoice this may assist in matching the 2 documents.

The transaction will print and re-print in the same the order that was displayed on
screen when you post the transaction.

Entered (will appear as entered into the transaction)
PLU # 
Vendor item code
Description
Store #
Case
Unit

Note: The order is saved "as entered" by default.

Note 2: The entry menus and some buttons are dynamic, meaning they can change
depending on what you are doing. For example, when you are working on an open order the
[Print-F5] buttons becomes [Worksheet]. Some buttons or menu options may appear grayed
out at some points in transactions. This is normal because they are not available at that point.
For example, the Delete option is not available for an order you are working on. It is available if
you recall an order that was posted, but not yet received.

The Entry module is used for transaction entries that affect stock control as well as some
cashier balancing operations. Inventory control has a prerequisite: each item must be created
in the L-BOSS item maintenance. You must assign the purchase format and the cost for
each vendor that supplies the product, in the "Cost" PLU table tab. In the "Inventory" tab, you 
must assign the Inv flag to activate Inventory tracking if you want to receive the item and
maintain the stock on hand. To use the suggested re-order option, the Ord flag must be set
to on. 

NOTE: Items should have a "Count" before L-BOSS can accurately report on hand
inventory. When you manually set an item to be tracked (in the "Inventory" tab), L-BOSS
sets the starting count to 0. However, if you use a "global change" to set the inventory
tracking on all items at once, you must perform a count. Before trying to maintain inventory
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on items, make sure that all items to track have a starting count (before receiving or
adjusting stock).

For detailed help on item maintenance, please refer to the Item Table help section in this
manual. You can use the Entry module to create purchase orders or receive stock without
placing an order. The following help pages explain how to perform inventory operations.

2.2.9.1 Inventory tracking

Several procedures must be followed to use the inventory system. You need to create the
products. You will also need to create the vendors who sell you those products. It is
necessary to set up the cost information, minimum stock levels and re-order information for
your products. Once the product information has been entered you will be ready to start
ordering and receiving from your vendors. This manual does not detail the entire process of
creating the PLU file for the registers. It does explain the fields necessary to use the Inventory
control option available with L-BOSS. It also covers the use of the Entry module to create the
inventory transactions such as ordering, receiving, and stock counts.

Steps to complete to use the Inventory option

Assuming your software is licensed to use the inventory module, you will need to:

1-Create the vendors
2-Create the product file
3-Assign minimum and re-order quantities
4-Create purchase order
5-Receive stock
6-Perform stock adjustments
7-Perform stock counts

L-BOSS general set-up options related to inventory control

There are a few options in L-BOSS that control behavior of the inventory options on a
system-wide level. For example, certain items may be controlled by weight, rather than by
unit. Such as walnuts sold in bulk. When receiving is done you would probably prefer
receiving walnuts and other weight-controlled items by weight rather than by quantity.

Open the L-BOSS configuration and access the Advanced flags on the Company tab. Set the
option "Use weight field instead of the quantity field for weight items" to true.

2.2.9.1.1  Inventory item maintenance

This section explains what you need to do with a product before being able to use the Entry
program to order, receive, make adjustments, and so on.
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2.2.9.1.1.1  Create vendor f ile

Creating the vendor file

The first step to complete is to create the vendors from whom you order and receive stock.
Each product you buy will be associated with one or many vendors. Open the L-
BOSS>Maintenance>PLU>Vendor menu to add, modify or delete a vendor. Here is the
vendor creation form:
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2.2.9.1.1.2  Assign vendor and cost to each product

Assign a vendor and the cost for each item

Now you are ready to modify the product file. You will need to begin by assigning a vendor to
each item and entering the cost of the product when it is purchased from that vendor.
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2.2.9.1.1.3  Create inventory record for products

Create the inventory records for each product

At this point you will need to define the inventory status fields for each item. Access the
Inventory tab as shown here:
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Store number: Select the store.

Inv: Select this flag to use the L-BOSS to track inventory for this product in this store. 

Ord: Set this flag to use the ordering system for this product. You must set this flag to have
this product added to an an automatic purchase order requested for the vendor who supplies
this product.

Min: Enter the minimum stock level in selling units.

ROQ: Set the re-order quantity in case pack size.

2.2.9.1.1.4  Using the parent-child function

Child / parent relationship

Some products are ordered in one format such as a case, but can be sold in more than one
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selling unti. Cigarettes may follow this rule. Here is an example on how to use the parent child
relationship to control different UPC codes that affect the same vendor product. Let's work
with a carton of Camel cigarettes. This item would normally be purchased from the supplier
in a carton of 10 packs of 20 cigarettes each. The retailer may sell either cartons or single
packages. We will assign fictitious codes to demonstrate.

Item 1234 is the PLU number to sell a carton of Camel. This item will be given a retail price of
$45.00 per carton and a cost of $37.00 for the carton. 
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You decide that you need a minimum of 20 cartons on hand. Once below 20 cartons you will
reorder 1 carton until above minimum.

The carton has 10 packages of Camel. Item 5678 is the PLU number to sell a single package
of Camel. This item will be given a retail price of $4.75 and a cost of 10 for $37.00. 

This item is attached to the PLU 1234 for inventory control. Each time one pack 5678 is sold

the system will remove 1/10th of the carton item 1234. This is because the inventory tab was
set to use the child / parent relationship as follows:
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Once you select the "active" mark in the child / parent window the "Inv." Flag is no longer
available. The inventory will be tracked on the Parent PLU, item 1234. Orders, receiving,
counts will be performed on the parent item, even if the child item is entered in an inventory
transaction.

2.2.9.1.1.5  Lot prices and inventory control

Lot pricing

L-BOSS includes a special price type useful when different sizes of the same product are
sold. For example, coke can be sold as a single item or as a six-pack. If you want to use the
UPC from coke single can to sell different number of cans you should consider lot pricing
(Method P.)

The example shown below is for wine that can be sold by the bottle, wrapped in a pack of 3, 6
or as a case of 12. A price has been assigned to each different quantity. When the item is
scanned, a table will appear and the operator will select the quantity being purchased.

If one of the rows is selected as default, the system will sell that quantity automatically. To
override the default quantity the operator must press the Price modify button BEFORE
scanning the item. Then the table will appear as if no default quantity had been programmed. 
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This method allows using a single PLU code to track all different package sizes of the
product. 

Note: Items using price type P cannot be placed in a batch for sale or price change.

Now the items exist in the database and you are ready to use the inventory transaction
module.

2.2.9.1.2  Inventory transactions

Entry module
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The Entry module is used for all inventory transactions, except for the sale or return of items
on the POS terminals.
The menu options for entry are structured as follows:

File menu accesses the following options.
Login (to enter your operator ID)
Language selection
Compute on hand inventory (This will force the system to re-calculate on hand values.
This may be required if you have re-processed transactions from past days.)
View log
Exit

Modules provide access to the different applications included in the entry system.
Receiving
Adjustment
Orders
Count
Pickup
Transfer

View is used to access past transactions made on the Entry system.
Receiving
Orders
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Adjustment
Count
Transfers

Help provides access to the help file and version information.
Contents

Function keys and menu options available in the Entry transaction screens

Within the receiving, purchase order, transfer, adjustment and count screens there are both
menu options and shortcut buttons. Here is an explanation for each function.

File
Review (F8)

This function allows you to select an inventory transaction that has been posted to the
database. When you review a transaction it may be possible to print, print labels, print
shelf labels or delete the transaction. Not all functions are available for all transaction
types. 

Delete
This function can be used to delete an open purchase order that has not been
received yet.

Print (or Print worksheet if an order is in progress)
Use this option to print the transaction in report form as required.

Print shelf labels
This function will generate one shelf label for each different product in the transaction
(assuming the label option was purchased and the product set-up is complete.)

Print item labels
This function will generate an item price label for each product in the transaction
(assuming the label option was purchased and the product set-up is complete.)

Save (F11)
This function will save the transaction you have opened without posting it to the
database.

Post (F12)
This function records the transaction to the database. This function cannot be
undone.

Exit

Edit
Cost edit (F4)

This function opens the cost table so you can modify the cost of an item permanently,
rather than changing the line cost within the current transaction only.

Add item (F2)
This function posts the current item into the transaction.

Delete item (F3)
This function deletes the current item from the transaction.

Reset all items to zero
This is used with the count function.

Reset "on order" to zero
This will reset the on order quantity for this item back to zero.

Description search F7
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This opens the search window based on product description.
View

Day info
This window will display movement on this product for today and is most useful during

the count function.
Extended day info

This displays the contents of custom sql statements.
Order by

This option allows you to determine the display order of items added to the
transaction grid. Select Entered to view as the items were added to the
transaction or imported from the portable device. If you are entering receiving off a
supplier invoice this may assist in matching the 2 documents.

The transaction will print and re-print in the same the order that was displayed on
screen when you post the transaction.

Entered (will appear as entered into the transaction)
PLU # 
Vendor item code
Description
Store #
Case
Unit

Note: The order is saved "as entered" by default.

Note 2: The entry menus and some buttons are dynamic, meaning they can change
depending on what you are doing. For example, when you are working on an open order the
[Print-F5] buttons becomes [Worksheet]. Some buttons or menu options may appear grayed
out at some points in transactions. This is normal because they are not available at that point.
For example, the Delete option is not available for an order you are working on. It is available if
you recall an order that was posted, but not yet received.

2.2.9.1.2.1  Purchase Orders

Purchase orders

L-BOSS includes a module to create purchase orders based on minimum and current stock
levels. Open the order module by clicking the Orders short cut.
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You are prompted to choose between Continue an order, Modify an order, Manual, Auto-
generate order, or to use data that was recorded with a Portable device. The next step in
the purchase order process is to complete the header information.

Continue an order can be selected to terminate a order that was created in a previous
session and saved without being posted to the database. When this option is grayed out
there are no orders to continue.

Modify an order is available when a orders have been placed and posted but not received.
This means you can change the order before receiving it if your supplier cannot fulfill or has
changed information for items in the order.

Manual order:

You need to provide the information required to store the transaction for future reference. 
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Vendor number is a compulsory field.
The date field can be used to modify the date the transaction will be saved for.
Inv # can be used to enter an invoice number if known. 
PO # is the number you are assigning to this purchase order. The Generate button will
assign the next available order number.
Inventory store number is used to determine which store you are ordering for.
Cost target allows you to choose the cost you are ordering at,
Remark is a compulsory field to store with the transaction.
The Load all items can be selected if you want L-BOSS to select all items that belong to the
vendor, saving time entering all the item numbers manually. You will still be required to modify
the quantity for each item before posting the order transaction.

The inventory module allows you to generate an order sheet for items controlled by the
inventory tables. The products require a few flags set before they can be ordered with L-POS.
In the Maintenance application you must set the Inv. and the Ord. flags for each item. Refer to
the item maintenance help for further explanation on setting items for inventory tracking. 

Auto-generate order:

You need to provide the information required to store the transaction for future reference. 
Vendor number is a compulsory field.
The date field can be used to modify the date the transaction will be saved for.
Inv # can be used to enter an invoice number if known. 
PO # is the number you are assigning to this purchase order. The Generate button will
assign the next available order number.
Inventory store number is used to determine which store you are ordering for.
Cost target allows you to choose the cost you are ordering at,
Remark is a compulsory field to store with the transaction.

The BaseOnSale can be selected if you want to place the order as a factor of sales for a
previous period.

Based On Sales:

Use this flag when you want to base the order on sales for a previous period. The system will
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calculate the sales for the period you select, then multiply by the factor you input. After taking
into account the stock on hand and on order the system will populate the order grid with the
correct order amounts for each item sold in the period you selected.

If you select the BaseOnSales flag a form will appear where you decide how to use the sales
data accumulated on the system.

Record type Daily or Weekly:
Keep in mind that daily item sales history is deleted from the system to save database space.
The default cleanup routine is every 90 days. So if you want to use data from more than 3
months ago you may need to select the weekly sales totals to compute order quantity. Also
note that the current weeks sales totals are not computed until the last day of the week.

Factor:
Enter the multiplication factor to use. For example, if the system looks at the sales data and
sees item 1 was sold 24 times during the selection period it will order 24 by default factor 1. If
you foresee a big sale on item 1 you could set the factor to 2.5 and order 24 * 2.5 = 60 of that
product.

Sale period:
Enter the date range to use for the order. Keep in mind that daily records may have been
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purged if you go back too far. Consider using the weekly totals, they are not purged
automatically from the system. Let's say you are June 15th 2008. You want to order stock for
the upcoming July 4th weekend. You could return to the weekly records for the period
containing the July 4th weekend in 2007 and base your order on sales for that period. If
business is way up this year use the factor and multiply by 1.5 or 2 to increase your order
quantities.

It's also possible to build an order using a hand held portable device. When you complete a
session file it can be imported using the Portable device button on the Purchase order
menu of the Entry program. Press Portable device  the following screen will appear:

Find the file you created with the portable device. By default the file will be saved to the L-
BOSS server in the Office\Portable folder. All orders use the default extension ORD and will
include the session file number you used when creating the order with the portable device. In
the following example the file is called RF00010.Ord.

Now you will press OK in the Select vendor information window to import the file saved
with the portable terminal.
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The system will process the file, display the number of rows it processed and prompt you if
you are ready to delete the file. 

It is possible that  you have scanned some items with the hand held that cannot be
processed by Entry. The following window will appear if this situation occurs. It is up to you to
take the required action to correct the problem.

Press Yes to view a list of the items that will not be processed as part of the order. If the
items are not set up properly in the database you need to correct them and assign the
inventory status to each item as explained previously. Once you have viewed the skipped
items list, all other items that were processed will be sent to the order screen for you to
process the order. 

The skipped items are saved in an exception file that be processed after the corrections are
made to the product set-up. This file will be named RF0013_Except.Ord if the original file was
named RF0013.Ord. L-BOSS appends _Except to the filename to distinguish from other files.

Orders to multiple suppliers with Hand Held device.

When you place an order with either the Worthington RF or the Unitech RS232 model hand
held devices you need to segregate your orders manually for each vendor. The system will
not automatically split an order from multiple vendors when the orders are made with the
Worthington RF or the Unitech RS232 type 
device.
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If you are working with a device the uses the HTML wireless device monitor application the L-
BOSS will split the file you collect into orders for the different suppliers of the products you
scanned and ordered. L-BOSS uses the default vendor flag to locate the vendor during this
split. This split will create several session files for you when you finish the entries. L-BOSS
normally creates a file named RF0014.Ord when you save session file 14 on the wireless
hand-held connected to the HTML Wireless Monitor application. If multiple vendors are found
in the session file 14, L-BOSS will name the files by appending "_VENDOR#" to the file. So in
the case of session 14, the files created for vendor 101 and vendor 103 would be
RF0014_101.Ord and RF0014_103.Ord.

When the header data is complete you must press Ok to start entering products into the
Purchase order. Now the system will display the screen used to add item information to the
purchase order. It is divided into sections as shown in the following screen capture.
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The screen is divided into 4 sections to improve data entry.

· 1-Header information displays the general information you entered related to this order.
· 2-Products on order shows a list of the items that have been placed on order.
· 3-Item detailed information displays the information available from the database that

may assist in establishing the order quantity, including cost, minimum stock level, on
hand, etc.

· 4-Operator input fields are used to enter the items and modify order quantity.

When you request a manual order the form will appear blank as shown above. Now you are
ready to begin entering the items that you want to place on order.

For each item you want to add to the PO:
· Select the item
· Confirm a quantity
· Confirm the cost
· Post the record into the order

You can select an item by entering its item number. If you leave the PLU # blank and press
Enter, the cursor will jump to the Vendor code field so you can select an item by Vendor
code. To display a list of items by PLU number or vendor code, double-click in either field and
the list will appear. When you double-click in the PLU number field and the list opens you will
have a column for PLU number and a column for the description. You can click the title bar
where it says "Select item" to re-sort the list in alphabetical order by description.
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Once you select an item from the list or type in a product number associated with this
vendor, the cursor will move to the Cases field. Now you must enter the number of cases you
wish to order. If you leave the field blank and press Enter the cursor will jump to the Units
field. You may also enter the quantity in the units field to place the order. Whether you enter
the quantity in cases or in units, L-BOSS will display both in the grid above.

After you input an order quantity, the cursor will move to the Amount field and display the
extended cost for the quantity being ordered. You can modify the cost to be recorded for the
order directly in this field. For example, your supplier is offering you a $2.00 rebate on a
product normally purchased for $10.00 a case. If you buy 10 cases the extended cost would
show $100.00. You can change that cost in the Amount field by entering $80.00. When you
modify the cost in the Amount field it will be saved with the order. It will not be saved
permanently.

The weight column is used to order items that are sold or tracked by weight. Products like
tomatoes, fish, and ground beef can all be ordered by weight with L-BOSS. There is a flag
setting that can be used to simplify the inventory transactions with weight items. This flag is
found in the configuration menu of L-BOSS under the company tab, Advanced settings. Set
the flag as required. If used, each time you enter a weight type item the cursor will jump to the
Weight field rather than the case field in the Entry transaction modules. You can still use the
weight even though you did not select the advanced flag.

When you have entered the item, quantity, and cost and press Enter, the cursor will move to
the [F2-Add] button. Press Enter again and the row of date you just input will move to the grid
above to display the results. Now you repeat the process for each item.

Speeding up the order process

In most situations once you select the item and you enter the quantity you are ready to select
the next item because the cost is correct on file and there is no deal available fro this order. In
that case you can save time by pressing the [F2-Add] button immediately. And you do not
need to actually click the screen image. You can press the F2 function button on your
keyboard. Restricting the use of the mouse should speed up the process considerably.

Posting the order to the database

You must "Post" the order before it can be printed in final purchase order form. So if you are
sure that the order information is correct press the [F12-Post] button. Now L-BOSS will
actually record the order and save it to the database. At this point a confirmation prompt
appears. Answer yes to continue.
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Printing an order worksheet

You may need to print a worksheet before finalizing the order. Whenever an order is begun
the [Worksheet] button can be used to print an order worksheet. This form can be used to
verify the suggested order list in the stock room or on the sales floor. Any adjustments can be
noted on the worksheet and entered back into the order before it is posted. Once an order is
posted it cannot be modified. You can receive against it, or delete it, but you cannot modify it.

Saving the order

If you are interrupted while you are creating an order it may be necessary to save the order to
complete it later. L-BOSS allows you to "Save" the order without posting it to the database.
Whenever you need to, press the [F11-Save] function to terminate the order you are working
on without losing it or without actually recording it as a Purchase order. This process will
save the data entered into a temporary working file that can be continued later.
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NOTE: Items entered into an inventory transaction can be sorted several ways to improve
reconciliation with supplier invoices or for any other reason. Open the View menu and select
the "Order By"  option. By default, items are sorted in the order they are entered into the
transaction. To sort in any other order use the View menu option. The sort order on the
screen cannot be changed once a transaction has been posted to the database. The printed
copies of inventory transactions are always made in the order that was visible on the screen
when the transaction was posted.

When you save an order to a temporary file the Order type selection window includes another
choice. Press Continue an order to recall an order that you saved with the F11 button.
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Review an order already posted

An order that has been posted to the database can be reviewed for reprint or can also be
deleted up until the time it is received. Once it is received the order is turned into the received
invoice. It is no longer available for review.
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2.2.9.1.2.2  Receiving Stock

Once stock has been purchased it needs to be received. The receiving module allows you to
receive items from an open purchase order, or manually without a purchase order. Data can
be entered manually, or imported from a portable terminal.

Select the receiving option from the Entry program.
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Access the receiving module and select Manual. When you select manual, you need to
supply information for L-BOSS to track the incoming stock. 

This example shows a Manual Receiving screen.
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Enter the vendor number (double click or press [Alt-Enter] to obtain a list of your
vendors) 
You may enter an invoice number if required 

Enter the order number you are receiving against. 

Enter the date of this transaction. You may want to select a previous date (for
example you were on holidays and this entry needs to be done as of 3 days ago). 
You may not have access to the Inventory store number if you are controlling
inventory in a single store. 
The Cost target is normally used in multi-store environments. It allows you to select a
different cost zone for your products being received. 
It is compulsory to enter a remark for tracking purposes. 

The Load all items flag can be used when you want to view all items that can be
received for the vendor you have selected. 

When you select the Manual option the system requires header information to begin the
transaction.

You need to provide the information required to store the transaction for future reference. 
Vendor number is a compulsory field. Enter the vendor you are receiving products from.
The date field can be used to modify the date the transaction will be saved for.
Inv # can be used to enter an invoice number if known. 
PO # is the purchase order number you are assigned to this transaction. 
Inventory store number is used to determine which store you are receiving for.
Cost target allows you to choose the cost you are receiving at.
Remark is a compulsory information field stored with the transaction.
The Load all items can be selected if you want L-BOSS to select all items that belong to the
vendor, saving time entering all the item numbers manually. You will be able to modify the
quantity for each item before posting the transaction.
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When the header data is complete press Ok to start entering products into the receiving
transaction. Now the system will display the screen used to add item information to
transaction. It is divided into sections as shown in the following screen capture. When you
select a manual receive the item grid will be blank.

The screen is divided into 4 sections to allow data entry. For help on the different menu
options and function buttons please refer to the Entry module introduction.

1. Header information displays the general information you entered related to this
transaction..

2. Products received in the transaction shows a grid of the items that have been entered
into the transaction.

3. Item detailed information displays the information available from the database.
4. Operator input fields are used to enter the items and modify order quantity.

If you have not selected the Load all items flag, L-BOSS will display a blank form. The
cursor will position itself in the PLU # field. If you know the product code enter it. If not
press [Alt-Enter] for a list of items associated with this vendor. You may also press
[Enter] to position the cursor in the vendor code field where you can find the item
using the vendor's code. 
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Once you locate the item, the cursor will move to the Cases field to allow you to
receive by case. Press [Enter] to switch to the Units field if you want to receive by unit
count. 
Confirm the cost for the line entry and press [F2-Add] to accept this line. You may
also press [Enter] when the [F2-Add] button is highlighted. 
At any time in the receiving you can modify a previous line entry by entering that
product code. 
You can delete a line entry with the [F3-Delete] function. 

You can modify the current cost record by pressing [F4-Cost]. This will change the
cost on file on a permanent basis. If you change the cost of line items using the
amount field that change will only affect the current transaction. You will be given an
option to save the cost changes when the transaction is posted. You will not be able
to save a new cost for specific items only when the amount was edited manually. If
you want to save the new cost for specific products only you must use the F4 function
to update the file for each of those items.
During the entry you can use a built-in calculator that allows simple math operations in
the unit, case, amount and weight fields.
To view movement information on this product for today's date press the [F6-Info]
button. Select the Auto refresh flag if you want this window to update each time you
enter a new product code onto your order. 
Once the items have been received you save the transaction by pressing [F12-Post].
You will have the option to print the transaction. The print option window will display
even once the transaction has been printed. This way, if another copy is required or if
you want to print labels you can still make the selection before the transaction is
archived.
If you need to save the receiving data without posting it definitely to the system use the
[F11-Save] option. The system will prompt you to enter a file name. The enrty
ransaction will then be saved so that you can finish working on it later.

Receiving Stock from a Purchase Order

When the receiving module is accessed, select the option to receive from an order. If you are
using a multi-store system you need to select the store. Once the store is selected a grid will
appear with the open orders listed for that store.

Select the order you want to receive and you will see a grid with the items that were ordered.
You may correct any of the data or post it immediately if all was received as ordered. To
modify the contents of the received items list follow these steps.

Locate the item to modify on the list. The cursor will move to the Cases field to allow
you to modify the number of cases. Press [Tab] to switch to the Units field if you want
to receive by unit count. 
Confirm the cost for the line entry and press [Enter] to move the cursor to the [Add]
button. Press [Enter] to accept this line. 
At any time in the receiving you can modify a previous line entry by entering that
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product code. 
You can delete a line entry with the [F3-Delete] function. 

You can modify the current cost record by pressing [F4-Cost]. This will change the
cost on file on a permanent basis. If you change the cost of line items using the
amount field that change will only affect the current transaction. You will be given an
option to save the cost changes when the transaction is posted. You will not be able
to save a new cost for specific items only when the amount was edited manually. If
you want to save the new cost for specific products only you must use the F4 function
to update the file for each of those items.
During the entry you can use a built-in calculator that allows simple math operations in
the unit, case, amount and weight fields.
To view movement information on this product for today's date press the [F6-Info]
button. Select the Auto refresh flag if you want this window to update each time you
enter a new product code onto your order. 
Press [F4-Cost] to post the received products list into the database. You will have the
option to print the transaction. 

Printing your stock transaction.

Once the transaction has been posted you will be prompted with the following window. You
can use any of the printing options as many times as required. Once you are satsified with
the printed contents of your transaction press close to continue other operations.

NOTE: Items entered into an inventory transaction can be sorted several ways to improve
reconciliation with supplier invoices or for any other reason. Open the View menu and select
the "Order By"  option. By default, items are sorted in the order they are entered into the
transaction. To sort in any other order use the View menu option. The sort order on the
screen cannot be changed once a transaction has been posted to the database. The printed
copies of inventory transactions are always made in the order that was visible on the screen
when the transaction was posted.
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Receiving Stock using a Portable Device

The L-BOSS portable interface includes a receiving option that allows users to collect
reception information by scanning the products and entering received quantities. Select 
Portable device from the receiving menu to open the Select vendor information window.

Select the vendor to use for this receiving transaction. Enter a remark and select the portable
device session file that was saved to the system.

The receiving application files are located in the L-BOSS\Office\Portable folder. The files will
have the .REC extension and include the session number used when creating the file with the
wireless device. When the file is selected press the Ok to open the file.

Now you will press OK in the Select vendor information window to import the file saved
with the portable terminal.
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The system will process the file, display the number of rows it processed and prompt you if
you are ready to delete the file. 

It is possible that  you have scanned some items with the hand held that cannot be
processed by Entry. The following window will appear if this situation occurs. It is up to you to
take the required action to correct the problem.

Press Yes to view a list of the items that will not be processed as part of the receiving. If the
items are not set up properly in the database you need to correct them and assign the
inventory status to each item as explained previously. Once you have viewed the skipped
items list, all other items that were processed will be sent to the receiving screen for you to
process the transaction. The skipped items are saved in a file that will have the same name,
appended with _Except.Rec. This means that you will be able to process the remaining items
after correcting the item set-up for each skipped item.

You may receive less that the quantity ordered when you receive against an open purchase
order. When this occurs the system will prompt you to keep the back-ordered items open on
the purchase order. Answer yes to retain the order for the remaining items, or no to destroy
the order. If you never save back order items the prompt can be answered automatically.
Access L-BOSS>Configuration>Advanced flags and set the "Prompt for backorders in Entry
" as required in your business.
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When you request a manual receiving the form will appear blank as shown above. Now
you are ready to begin entering the items that you want to receive.

For each item you want to add to the transaction:
Select the item
Confirm a quantity. The cursor may jump to the weight column if this is a scalable or
weight-tracking item.
Confirm the cost
Post the record into the transaction

You can select an item by entering its item number. If you leave the PLU # blank and
press Enter, the cursor will jump to the Vendor code field so you can select an item by
Vendor code. To display a list of items by PLU number or vendor code, double-click in
either field and the list will appear. When you double-click in the PLU number field and
the list opens you will have a column for PLU number and a column for the description.
You can click the title bar where it says "Select item" to re-sort the list in alphabetical
order by description.

Once you select an item from the list or type in a product number associated with this
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vendor, the cursor will move to the Cases field. Now you must enter the number of cases
you have received. If you leave the field blank and press Enter the cursor will jump to the
Units field. You may also enter the quantity in the units field to receive. Whether you
enter the quantity in cases or in units, L-BOSS will display both in the grid above. When
you work with scale items the system will display cases and weight.

Speeding up the entry process

In most situations once you select the item and you enter the quantity you are ready to select
the next item because the cost is correct on file and there is no deal available for this
transaction. In that case you can save time by pressing the [F2-Add] button immediately. You
do not need to actually click the button. You can press the F2 function button on your
keyboard. Restricting the use of the mouse should speed up the process considerably.

Posting the Receiving to the database

You must "Post" the transaction before it can be printed in final invoice form to match the
supplier invoice. So if you are sure that the information is correct press the [F12-Post] button.
Now L-BOSS will actually record the transaction and save it to the database. At this point a
confirmation prompt appears. Answer yes to continue.

Review a receive transaction already posted

A transaction that has been posted to the database can be reviewed for reprint or to be
deleted up until the time it is received.
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Importing transaction data from the Portable device

You may own a portable device and receive stock with it by scanning the product codes directly from
shipping pallets. If this is the case you will need to transfer the data files from the PDT to the L-BOSS
machine. When this operation is complete you will be able to access the file and create a receiving
transaction with the data file. Access the receiving type window after filling in the transaction header
data:
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Once the data has been processed onto the entry screen you continue with the transaction as if it had
been made any other way. Any errors that occur during the import will be saved to an error text file and
can be displayed (items that do not belong to this supplier, items not in system, items that are not
tracked by the inventory module, etc.) You will be prompted to delete the portable terminal data file once
it is imported into the transaction.

Inventory adjustments

Stock adjustments may be required from time to time. Damaged goods, returns, credits, free items are
all examples of stock level change. You may add or remove items using the adjustment feature. Access
the Adjustment menu: in a multi-store environment the system will prompt for store number. Select the
store and the entry grid appears for the transaction:

The screen is similar to the order and receive screen. There are a few differences: 
No prompt for header information: you are adding or subtracting items from stock, irregardless of the
different suppliers you may have for the product.
Adjustments on a unit level only.
The remark field is compulsory.
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Make the necessary adjustments. Use the [-] minus button to enter a negative quantity (to remove a
damaged piece for example.) Post or save the transaction as you would for an order or receiving.

Stock Counts

The count function is used when you want to confirm current inventory levels and freeze them at this
point as the starting reference level for a new period. There is no exact time a count transaction must be
executed on L-BOSS. Typically people may execute a count once a month, or once a year. You may
count the inventory by sections; it does not need to all be counted at the same moment.

Every time a count transaction is performed the transactions dated previous to the count date are no
longer considered in the calculation of the on-hand values. This sounds complex but it isn't:

Imagine that we are June 1. 

You verify Kleenex and you have 50 boxes in stock.
June 2 you receive 25 boxes and now have 75 boxes.
June 3 at 8:00 am you open the store, verify Kleenex and find 72 boxes because 3 were sold last
night.
You decide to Post the count at 72 boxes on June 3rd.

Then your shipper says he was sleeping on May 30th and forgot to open a pallet that contained 100
boxes of Kleenex.
He shows you the receive slip and you tell him to post the transaction on May 30, the day it was really
received.

He posts the receiving transaction of 100 boxes of Kleenex on inventory date May 30, prior to the
most recent count.
This transaction will be added to the inventory on hand then, and will add to the inventory on hand
now. But as soon as the internal inventory calculation procedure is invoked the system will return to
the 72 boxes of Kleenex that you declared on June 3rd.

The current stock level is computed by taking the last count found, removing sales, adding receives, and
adjusting for transfers and adjustments according to the movement in those transactions. Since the last
count date found for Kleenex was June 3rd, everything done prior to that date is ignored. To correct the
error that your received caused you would need to post the receiving on June 3rd after the count was
done.

 Other things that needs to be taken into account before using the count function:

No matter when it is actually done, a count is reputed as performed at the stroke of midnight on that
transaction date. This means that sales or receives done the same date will be removed or added to
the count, no matter when the count is actually input.
This means that if you come in at 10:00 and count 5 boxes of Kleenex and post that count the
system should show 5 in the on-hand field for Kleenex.
If you had sold 2 boxes of Kleenex that morning the system will show 3 boxes on-hand for Kleenex
because the Count transaction is reputed as performed at midnight to start the day.
So you need to make sure that the counts are made first thing in the morning before other
transactions that affect the inventory.
Or you can count your stock after close today and make the count entry tomorrow morning. No
matter what else you do it will still be accurate because what you had last night will be input as
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what you started with the next morning.

2.2.9.1.2.3  Physical count

Stock Counts

The count function is used when you want to confirm current inventory levels and freeze
them at this point as the starting reference level for a new period. There is no exact time a
count transaction must be executed on L-BOSS. Typically people may execute a count once
a month, or once a year. You may count the inventory by sections; it does not need to all be
counted at the same moment.

Every time a count transaction is performed the transactions dated previous to the count date
are no longer considered in the calculation of the on-hand values. This sounds complex but it
isn't:

Imagine that we are June 1. 

· You verify Kleenex and you have 50 boxes in stock.
· June 2 you receive 25 boxes and now have 75 boxes.
· June 3 at 8:00 am you open the store, verify Kleenex and find 72 boxes because 3 were

sold last night.

· You decide to Post the count at 72 boxes on June 3rd.

Then your shipper says he was sleeping on May 30th and forgot to open a pallet that
contained 100 boxes of Kleenex.
He shows you the receive slip and you tell him to post the transaction on May 30, the day it
was really received.

· He posts the receiving transaction of 100 boxes of Kleenex on inventory date May 30,
prior to the most recent count.

· This transaction will be added to the inventory on hand then, and will add to the inventory
on hand now. But as soon as the internal inventory calculation procedure is invoked the

system will return to the 72 boxes of Kleenex that you declared on June 3rd.

The current stock level is computed by taking the last count found, removing sales, adding
receives, and adjusting for transfers and adjustments according to the movement in those

transactions. Since the last count date found for Kleenex was June 3rd, everything done prior
to that date is ignored. To correct the error that your received caused you would need to post

the receiving on June 3rd after the count was done.

Other things that needs to be taken into account before using the count function: you can
either COUNT NOW or COUNT AS OF MIDNIGHT.

Normally the COUNT NOW would be to allow input during the day while sales are being
made. So if its noon and you need to count and input the onhand quantity of an item use the
COUNT NOW option.
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But in some situations you will have counted your stock after closing and then may not have
time to actually post the numbers until the next day or later. In that case you would use
COUNT as of MIDNIGHT and choose the day AFTER you made that count. So the values you
enter will be inserted into the database at the start of a new day.

· No matter when it is actually done, a count is reputed as performed at the stroke of
midnight on that transaction date. This means that sales or receives done the same date
will be removed or added to the count, no matter when the count is actually input.

· The difference with the count now option is that it will adjust the actually count value by
adding or subtracting the variations in stock level since midnight.

Count transaction:

Select Count from the Entry main screen. The following window will appear:

Select to count as of midnight (you are entering the stock count from a sheet counted on a
previous date) or select count as of now when you are entering a stock count for an item
you counted during the day while sales are being made. With this method there is a risk that
a shopper basket contains items that have not been sold yet and that were not on the shelf
when you counted your items.

If you have finished the sales for today in the store it is safe to use the count as of now option
because there are no more shopping carts in your store that took items from shelves but
have not paid for them yet.

You can use the count as of midnight for a past date. In a situation where you asked your
clerk to count stock on Saturday night after hours when the store was closed. You come in
Monday and he gives you the work sheet with the counts. You should open the count, select
as of midnight, then select the Sunday (yesterday). Then post the items in the count. They
will be counted as if the count had been made Sunday morning before the store opened. That
is exactly the same as if you had posted with the count as of now on the Saturday night.
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For a count transaction you must enter the item using the PLU number, you cannot enter the
item using the vendor code. You may use an alias to find the main PLU programmed in the
system. Count can only be entered as units; weight may be used for scale items. Proceed to
save, post or use the other functions the same way they are used for orders, receiving, etc.

Counting Inventory

NOTE: Items must have a "Count" before L-BOSS can accurately report on hand
inventory. When you manually set an item to be tracked (in the "Inventory" tab), L-BOSS
sets the starting count to 0. However, if you use a "global change" to set the inventory
tracking on all items at once, you must perform a count. Before trying to maintain inventory
on items, make sure that all items to track have a starting count (before receiving or
adjusting stock).

Physical inventory counting is required to reset the inventory levels to actual on hand
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amounts.

Access the "Count" option and enter the store number and other header information to
store with the count data. Choose the date this count was made on. Note that the
count for a given date is added to other transactions done the same day. For
example, if you receive 10 pieces and you sell 5 pieces the stock on-hand would
show 5 pieces. If you also make a count for that day of 10 items, the total on-hand
stock would show 15 pieces for the item.
The pre-selection window allows you to select a Load on hand option. This will
display a list with current on hand of the selected items. This way you can change the
items that are different and post the values that are correct without modification.
When you select Load on hand several new fields are available to filter the list of
items to count. The filter includes all fields from the OBJ_TAB of PLU maintenance.
By default not all fields will appear on the list. The fields are added under the File
menu by selecting Count filter configuration. Select the menu option, choose a field
to add to the filter, assign a name and press Add. Use the delete button to remove an
existing filter. If you filter by description or other string fields the system will use the
From - To values like this: If you enter From A to N, all items beginning with A in
description up to all items beginning with N in description will show on list.
Count transactions are always considered as the first entry made to the inventory
system on the date selected for the count. So a normal count procedure would be to
count the stock after close of business day. The report system allows you to print
physical count  sheets to note the on hand values. Once you have completed the
actual counting use the Entry program to post the count. But post the count for the
following business day. If you post the count for that same day it will be done as of
12:00am, before any sales or other inventory transactions occured. So the on hand
will display the wrong totals. You need to select the following day as the count date.
The count transaction in Entry can be made any time the following day because it is
always considered as the first transaction of the day.
You can select the Load on hand option to create a list of all inventory items. When
this option is selected you also have the option to reset all current stock on hand
values to Zero to facilitate the count procedure. This way you will not need to worry
about stock on hand values for items you no longer carry, they will be reset and if they
are not counted they will remain at zero. Use the Menu, select Edit and the select
the Reset all items to 0 option. 
When you add an item that was already counted for the day you are prompted for
user decision: should the system add the new count to the existing count for the day,
or should the system replace the previous entry with this new count. This will allow
you to count stock found in more than one physical location. By definition, multiple
counts performed on the same item using a portable data terminal are added to each
other, not replaced.
At any time in the count you can edit a previous line entry by entering the product
code. 
You can delete a line entry with the [F3-Delete] function. 

When you have finished the count press [F12-Post].You will have the option to print
the transaction. 
If you need to save the count without posting it definitely to the system use the [F11-
Save] option. The system will prompt you to enter a file name. The count will then be
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saved so that you can finish working on it later. 

2.2.9.1.2.4  Adjustments

Inventory adjustments

Stock adjustments may be required from time to time. Damaged goods, returns, credits, free
items are all examples of stock level change. You may add or remove items using the
adjustment feature. Access the Adjustment menu: in a multi-store environment the system
will prompt for store number. Select the store and the entry grid appears for the transaction:

The screen is similar to the order and receive screen. There are a few differences: 
· No prompt for header information: you are adding or subtracting items from stock,

irregardless of the different suppliers you may have for the product.
· Adjustments on a unit level only.
· The remark field is compulsory.

Make the necessary adjustments. Use the [-] minus button to enter a negative quantity (to
remove a damaged piece for example.) Post or save the transaction as you would for an
order or receiving.
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NOTE: Items entered into an inventory transaction can be sorted several ways to improve
reconciliation with supplier invoices or for any other reason. Open the View menu and select
the "Order By"  option. By default, items are sorted in the order they are entered into the
transaction. To sort in any other order use the View menu option. The sort order on the
screen cannot be changed once a transaction has been posted to the database. The printed
copies of inventory transactions are always made in the order that was visible on the screen
when the transaction was posted.

2.2.9.1.2.5  Transfer

In a multi-store inventory system you may want to move stock out of one location and add it
to another. Access the transfer module to use this function. Note that the items need to be
assigned to each inventory store in PLU maintenance under the inventory tab. When an item
is transferred from store 1 to store 2, L-BOSS actually creates an order for store 2 to use as
a receiving slip. This will be transferred to store 2 during a subsequent communication
among the stores.

Now you will open the transaction entry screen. The system is similar to other entry module
screens. You will select an item, the quantity and store to send the item into. This procedure
will repeat for each item for each store to send to.
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When you complete the transfer transaction and post the data the system will allow you to
print the transfer sheet for each store that items are being sent to. This transaction data will
be available at the receiving store after communication among the stores has sent the data.

The store receiving the transfer will use the Receiving and select from an order as receiving
type. The remark field will show the store that sent and the store that is receiving as the last
characters of the remark field.

NOTE: Although the Transfer option affects the inventory report information, such as item
movement, on hand, cost and retail stock values, it does not affect accounting information,
such as billing or invoices. For example, you can transfer inventory out of a store, reducing
inventory values but there is no trace of how that inventory was paid for as with sales,
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potentially causing accounting problems. You should consider this before using the Transfer
option.

NOTE 2: Items entered into an inventory transaction can be sorted several ways to improve
reconciliation with supplier invoices or for any other reason. Open the View menu and select
the "Order By"  option. By default, items are sorted in the order they are entered into the
transaction. To sort in any other order use the View menu option. The sort order on the
screen cannot be changed once a transaction has been posted to the database. The printed
copies of inventory transactions are always made in the order that was visible on the screen
when the transaction was posted.

2.2.9.1.2.6  Inventory reports

Inventory reports

The inventory system can produce many different reports to assist your store operations. Reports can be
printed to display stock on hand, inventory value, stock below minimum, etc. The following pages display
report samples and explain the reports intended use. Most reports include totals that are not displayed
here to save space.

Order report: This report is used as a purchase order to send to or call a supplier to order stock.

Receiving report: This report displays a receiving entry once the transaction has been posted. It can be
used to confirm that stock was received and to match with items on a supplier invoice. When a match
occurs invoice payment will proceed.
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Adjustment report: This report shows the items that were entered into the adjustment
transaction. Items can be added or removed using the adjustment entry transaction.

Count report: This report shows the stock quantity or weight counted at the count date (the result of a
count.)

Inventory transfer: This report displays the items being transferred out of the store. The
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remark field shows the items are leaving store 3 and are being transferred to store 1.

Count sheet: Use this report to enter stock counts or variations

Entry tracking: This report shows all items ordered or received from the supplier over
the period of time requested.
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Items below minimum: This report displays a list of items below minimum stock level.

Items on order: This report shows all items on order from a specific vendor.
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Inventory movement: This report shows inventory movement between dates.
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On hand inventory: This report lists the quantity or weight on hand for each product.

PLU inventory tracking: This report shows the transactions that affect the movement of a
product over the selected period.

Receiving summary: This report displays all receiving transactions for the period and
vendors you select.
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Stock value: This reports displays the value of the stock at current cost and retail.
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2.2.9.1.2.7  Other Entry Options

Compute Option

Use the compute selection to recalculate the current stock levels anytime you want to be
sure that all transactions are being considered, especially important if you are making
inventory counts. For example, you have done a count for today, and then you realize that
their are sales that were not processed. After you have processed the sales data, use the 
Compute option to recalculate the stock levels.

View or reprint previous transactions

Use the View menu option to recall any transaction including your orders, received goods,
adjustments and counts that have been entered on the system. Once the transaction is
recalled you may revise it, print it, or even delete it. If any change is made to an order that had
already been posted you need to use the Compute option to recalculate the stock levels. A
warning will appear to this effect.

Purging Old Inventory Records
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The View option allows you to see entries made in previous transactions. To remove received
transaction data from the list use the Purge option. You cannot purge orders. Select the date
before which you want the transaction data to be removed. Note that this does not in any way
affect stock levels.

2.2.9.2 Pickups and Loans

Working with Cashier Pickups, Loans and Declarations

Please access the chapter on Cashier pickups and loans.

2.2.10 Events / Tasks

Events / Tasks Utility

The L-BOSS system includes both fully automated procedures and a "Task Manager" that
provides access to run other events upon demand. When the Events / Tasks icon is
accessed, L-BOSS displays a list of currently assigned tasks or events. The task list shows
all events programmed on the system. The events set to run automatically appear with a date
in the "next event" column.

One of the most common uses of the Events / Tasks option is to execute commands
manually, and can be used to force the system to execute automated commands that failed,
or did not execute automatically as programmed.
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This example shows the Events / Task utility.

The "Description" column displays the command's name.
The "Scheduled" column displays the command's execution status: manual, manual and
automatic, Auto only.
The "Load" column shows which Tasks or Events are set to run when L-BOSS is launched.
The "Next Event" list the next time / date for automated commands.

The Task Manager's option buttons are positioned below the list of system commands.

Execute: After selecting the appropriate command, press this to force the system command
to run.
Edit: Use this button to modify the programming for the selected command.
Add: Use this option to add new commands to the Task Manager list.
Close: Closes the Task Manager. This does not stop the automated commands from
executing.

Navigating Command Directories

Some Tasks in the list are found within "Directories", or event categories. In other words, if
more than one command exists for a specific task, the tasks may be grouped together under
one heading. In the example above, the "PT600" is a goup of commands that deal with the L-
BOSS  / PT600 interface. Directories have the term <DIR> under the "Scheduled" column.

To access the commands in a directory:
Select the command directory to open and double click with the left mouse button,

Select the command to run in the directory and press the "Execute" button.

To return to the main task list, press the [BackSpace] key, or

Double click the ".." directory at the top of the list.

By convention, the ".." symbol always represents the parent directory. 

NOTE: Most of the events required for normal system operation have been predefined on the
list. If you are unsure of how to make modifications to the event list, you should consult your
qualified Logivision  agent.

2.2.10.1 Programming Events

Modifying / Adding / Automating Tasks

The Task Editor

The "Task Editor" utility opens when you press the Task Manager's "Edit" button. As with
other tables, the table edit tools appear as toolbar icons at the top of the editor. If you are
unfamiliar with the table editing tools, refer to the Common Data Edit Toolbar help page in this
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manual.

To modify an existing event, selecting the event from the Task Manager's list and press the
Edit button.

This example shows the Task Editor programming.

Description: Enter a meaningful descriptor that allows the user to recognize the command's
function. This is not necessarily the command's actual name, and does not affect the actual
command that is run.

Command: This is a combination of the L-BOSS programming and the actual command file
to execute manually or at the specified time. Since some commands can overwrite or
otherwise change existing data, we suggest you consult your Logivision  dealer before
making changes or adding new Events / Tasks.

Directory: The Task list can be configured to use command sections. Similar to "Report
Categories" found in the Report selection panel, the "Directory" Task List entries do not
execute anything. They are used to group tasks into categories or sections. Selecting the
"Directory" flag sets this task as a section heading, with the related tasks listed below this
heading.

Select Allow manual to be able to force this event from the Task Manager when required.

Allow scheduled: Select this option to force L-BOSS to run this event at the selected date
and time. The event cannot execute if L-BOSS is not running at the date and time
programmed.
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NOTE: You can set tasks to be both manual AND automatically executed. You can unselect
both "Allow" options to disable the command.

Next event will occur on: This shows the next time this command should run, and is used
along with the repeating cycle setup to determine the dates and times of execution.

Execute one past event: Select this option if you want L-BOSS to execute a command that
did not execute when it should have, usually because the system was "down" or L-BOSS
was not running when the command should have last run. For example, if the system is set
to perform the daily maintenance at 11:59 pm, but the system is not functioning because L-
BOSS was inadvertently closed. When L-BOSS is launched the next morning, it will realize
that it should have executed the commands (set to execute one past event) at the previous
date / time, and will execute them. If this option is not set, L-BOSS will wait until the next
scheduled time for the execution.

Execute at loading time: Is used to tell L-BOSS that this command should be run when L-
BOSS is launched. Tasks that are flagged to execute at load time will run when L-BOSS
starts. Note that it may take up to 30 seconds before L-BOSS can read the Task list and
execute tasks set to run at startup. Also, the "scheduled" flag does not have to be set to on
for the command to run at startup.

View on all terminals: Set to on by default, this flag determines which terminals can see and
execute this task. When not selected, L-BOSS needs to know which terminal the task is for.
You can only enter one (1) special terminal.

Executed on controller: Set to on by default, this flag specifies that the selected task runs
on the L-BOSS host terminal (usually 901). If the flag is removed, L-BOSS needs to know
which terminal the selected task should run. This can be convenient for certain tasks that can
be run on other terminals, and helps to remove some of the workload from the controller. You
can only enter one (1) special terminal.

If filename exists: Set this option when the task you are scheduling should be executed only
when the file named exists.

Repeating Cycle

The repeating cycle determines the interval that the selected command should run, used
along with the "Next event" entry above.

Hours: Enter the number of hours that determine the cycle. You can also enter a decimal
number to have a command execute every set number of minutes. ( .5 hours = 30 minutes ).
If you enter a number of minutes and press F2 the value will be converted to hours for you.

Days: Enter the number of days (often 1) to execute this command. You can also use days to
execute once a week or once a year.

Months: Enter the number of months to execute this command. Calendar months are used,
not 30 days
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NOTE: You can only enter one (1) type of cycle. 

Adding / Removing Tasks

Use the "Add" button to create a new task. L-BOSS will automatically select an available task
number. Unless you have modified the default task numbers, you should leave the suggested
task number. Follow the information above about each option in the task editor.

NOTE: When adding a new task both "Allow" options appear selected, but "Grayed out"
because the system sees them as neither selected or not selected. Click once to clear the
grayed check mark, then click again to select.

To remove a task from the list, select the command to remove, then right click with the
mouse. The right click menu includes a delete option. Care must be exercised when
removing tasks from the list; be sure you do not remove required tasks from the list.

Changing the Events / Tasks List Order

You can change the order of the Events / Tasks list, placing the most used commands at the
top of the list for easy access. Changing the list order does not affect the way in which
automated jobs execute. To modify the order:

Select the event to move,

Press and hold down the [Alt] key,

Use the up arrow key to move the event up on the list,

Use the down arrow key to move the event down the list,

Release the [Alt] key, then select another task to move another event in the list.

Using Command directories

Tasks can also be moved to a command "Directory" by selecting the command to move with
the mouse. To move a command so that it will appear in a directory:

Select the task with the left mouse button,

Hold down the left mouse button, and "Drag and Drop" the command on top of the
directory.
Once the command directory is highlighted, release the mouse button.

A prompt appears asking if the command should be moved to a directory.

Accept the move by clicking the "Yes" button. Clicking the "No" button will place the
command beside the directory where it was dropped.

To move a command from a directory back to the main task list:
From within the directory, select the command to move.

Hold down the left mouse button, and "Drag and Drop" the command to the top of the
directory. (The top line of the directory displays two dots ".." under the description column,
and <DIR> under the schedule column).
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Once the ".." directory is highlighted, release the mouse button.

NOTE: "Directories" can be moved up and down the list the same way as individual Tasks,
that is by selecting the directory, holding down the [Alt] key and using the up and down arrow
keys to move the directory.

2.2.11 View Log

View Log Utility

L-BOSS includes a utility to review the status of data transfers and messages to and from all
terminals and stations set up in the system.  The View Log utility allows you to see the
functional "in" and "out" boxes, unprocessed commands or data, and urgent messages.

This example shows the Urgent message Log viewer.

Used as a "trouble shooting" tool, the viewer provides a complete system report tool. The
View Log information is also "color coded" making it simple to distinguish between normal
functionality and error situations. When opened, the View Log utility displays any urgent
messages that are present in the system. 
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2.2.11.1 Logs and Messages

Viewing Logs and Messages

View Log allows you to view urgent messages, terminal status and mailboxes, normal
system messages and the system log tables. 

The  printer icon is used to print the contents of thee view log window.

The  icon is used for a print preview.

The  delete icon is used to delete an error message or an error log.

The  OK icon saves any changes and exits the active screen.

The  (urgent message) icon displays any urgent messages available on the system.
Right-click this icon to obtain a history of the urgent messages that you have deleted recently.
You can also view error messages that occurred in remote stores using this option.

The  (status information) icon will show the different folders that this L-BOSS must
monitor for the remote stores or POS terminals and display the contents of those folders. In
normal situations the folders should be empty. When they are empty the arrow highlighting
the folder will be white.

Files in the Local Inbox means that those files were received but L-BOSS cannot process
them. This is extremely unlikely. If there are files in the Local Inbox that do not get processed
it may be due to a network communication error. You should contact your dealer for
assistance. 

Files in the Local Outbox is possible if one of your POS terminals is not online. The data for
that terminal is stored on the local terminal outbox folder until communication with the POS is
restored. Then the data will be moved from the Local Outbox to the POS terminal's inbox.
You can recognize which terminal a file was sent to by the filename. The last 3 characters
before the extension represent the store number. The lst 3 digits represent the terminal
number. So the file D1222300121027.501 was sent to terminal 501 of store 027.

If there are files in the Unprocessed folder, L-BOSS was unable to import the data contained
in those files. Your first remedy should be to try and reprocess the files. Place the cursor on
the Unprocessed folder and right click. Select Reprocess files. If the files return to the
Unprocessed folder you will need to verify the file contents to correct the situation. You should
contact your dealer for assistance.  

If there are files in the register inbox it is probably because the register is connected to the
network but is not operating the POS application. If the POS is operating and there are still
files in the register Inbox, action is required to determine the problem. You should contact
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your dealer for assistance. 

If there are files located in the register outbox you have not collected all the sales. This is
not a normal situation and should be addressed immediately.

The  normal messages icon displays the normal priority messages recorded by the
system.

The  icon lists messages sent to this terminal using the internal L-POS  to L-BOSS inter-
station messages.

The   (check) icon can be used to validate the data that has been collected and posted to
the report database by L-BOSS. This option shows the number of transactions and the total
that the system processed and compares the numbers with data stored on the registers. The
total in the difference column should amount to zero. If there is a difference in the amounts it
is very important to reprocess the data collected for that day. A difference in the quantity is
less alarming. It means your system has functions that do not involve dollar amounts which
do not have a counter programmed in the report totals. Correct this in the totalizer setup of L-
BOSS or in the System settings under totalizer in Pos-Setup.

The  logs icons display the tables containing
information that is recorded when files are exchanged between terminals. There are 3
different views available. they are accessed by pressing the appropriate log icon.. The "All
logs" view shows a log of all the files transferred to the lanes. The "Outstanding" view lists
information on files that L-BOSS sent  but is still awaiting confirmation that they were
received. The "Unsuccessful" view shows information on files that were received and not
processed properly by a POS terminal. 

The  icons display the logs for emails sent from the L-BOSS
system.

2.2.11.2 Urgent Messages

Viewing Urgent Messages

Urgent Message will flash on the L-BOSS Desktop whenever a new urgent message has
been received by the back-end controller. Clicking on the flashing Urgent message will
access the view log page and open the urgent message immediately. If you do not delete the
urgent message the system will continue flashing the warning. 

Delete any urgent message from the list by selecting it and pressing the  (delete) icon on
the View log toolbar.
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2.2.11.3 Unprocessed Files

Viewing Unprocessed Files

Unprocessed will flash on the main L-BOSS menu whenever a file is sent to the L-BOSS
"unprocessed" folder. This is not a normal situation and it should be addressed immediately.
Access the unprocessed folder by pressing the flashing Unprocessed message. The
screen will switch to the Status view of all terminal folders and you will have access to the list
of unprocessed files. Right click on the unprocessed files to reprocess them. If they cannot
be reprocessed successfully contact your dealer for assistance in determining the contents
of the file.

NOTE The L-BOSS stops all further processing when file(s) are present in the unprocessed
folder. It is imperative that the files are processed before the system can resume normal
operation. If you decide to manually delete the file from the L-
BOSS\OFFICE\UNPROCESSED folder L-BOSS will still refuse to start processing because
it remembers that a file was deleted. When this must be done and you accept the
consequence proceed as follows:

Delete the file from the L-BOSS\Office\Unprocessed folder. This will cause an urgent
message related to the file you deleted.

Open the L-BOSS>File menu: use the option Bypass file processing order security.
Typing accept is your acknowledgement that the normal data processing routine has been
aborted and you accept the risk of information being processed out of sequence.
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2.2.12 Monitoring Utility

Watching the Front End

L-BOSS includes a monitoring utility that allows you to view the current transactions from any
L-POS lane in the installation. To launch the Monitoring utility, open the Windows "Start"
menu, "Programs", "L-BOSS" and select the "Monitoring" option. The Monitoring utility is
useful in watching cashiers' activity during transactions.

Note: Monitoring is also used to output transaction data to security systems. Consider
placing a shortcut to the Monitor.exe application in the system startup folder. Users should be
trained to leave the application open at all times.

2.2.12.1 Monitor menu

These selections are available on the File menu:

New: This will clear the current monitor session so yo can start over.
Open: Use this selection to manually open a POS lane to monitor. Enter the store number
and lane number of the terminal you want to see. Note that terminals should be in the same
workgroup to facilitate monitoring.

Note: You can also use the  button to select the terminals to monitor. Place a check mark
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beside the terminals you want to view, then click the check mark button above the list. You
can open multiple monitor windows simultaneously, and arrange the open windows within the
Monitor utility.

Beep on red: You can set the Monitoring utility to alert you with a "BEEP" when certain
functions are used, notably functions that are set to be "red", meaning negative functions that
subtract amounts from the current transaction. To activate the warning beep, select the
terminal to track, then from the Monitoring utility's "File" menu, select "Beep on red". If a
negative function is used during the transaction, the Monitoring utility will issue a warning
"beep".

Monitoring Statistics

The utility also provides totals for all activity tracked during the monitoring process. The "File"
menu contains a "Statistics" option that opens a window showing the statistics for the
selected terminal.

This example shows a sample of Monitor Statistics.

Redirect output: Use this option to set up a data output for a 3rd party security system. This
data will be sent to the designated TCP/IP or RS232C port for display on another system,
such as video surveillance cameras. The Prefix field may be required by some systems
when more than one POS terminal is sending data to a common port. This prefix on lane one
could say "POS01", the prefix on lane 2 could say "POS02", etc. This way we will differentiate
the data from lane 1, 2 and 3, even though all data from each lane is being received at the
sameport/address. All rows of data arriving from lane 1 will be "prefixed" by POS01, etc.

2.2.12.2 Monitor toolbar

The Folder is used to open a specific L-POS terminal manually.

Use the  tool if you have highlighted text and want to copy to another application.
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The red arrow down diminishes the number of characters, narrowing the space used. The
red arrow up widens the column used in each monitor window. 

Use the "A" button to change the font.

The  tool will display a list of all active terminals.

The  tool exits the application. Monitoring stores the settings and will reopen all terminals
that were being viewed the last time it ran.

2.2.13 Electronic Journal

Electronic Journal Utility

This example shows the Electronic Journal - Basic version.

The electronic journal allows reviewing sales transactions made on the L-POS system. The
program is executed by running the EJ.EXE executable in the POSWIN or L-BOSS folder.
You can also use the EJ menu option from the L-BOSS software. Two program versions are
available, Basic and Professional version. The basic version is included with L-POS on
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each lane while the Professional EJ version is an optional purchase. Call your L-POS dealer
to purchase the Professional version if it has not been enabled. 

The first window shown here is the normal EJ layout. This view of the EJ is used to review
transactions. The File menu allows rebuilding the pointer files and exiting from the software.

2.2.13.1 Using the Electronic Journal

EJ Viewer Menu Options

File menu options:
Missing transactions will list any transactions that are mising in the EJ file sequence.
Rebuild pointers will create files that assist L-BOSS in positioning start tranaction position
for a given day.
Set printer font is used to define the font that will be used when print options are selected
with the EJ utility.
Set journal directory is used to define the location where your journal files are stored.

Edit menu options:
The top menu section displays the search commands that have been defined on your
system.
The bottom menu section is used to record a search for repeat use or to delete an entry
from the top section of the Edit menu options wndow.

View menu options:
View transactions with / without visible PLU number
Extended to view the search input area
Animation option to highlight results of searches

Print menu options:
Print the current transaction only
Print each transaction with data that responds to the current search criteria
Print the entire transaction file for the current day.

Help displays version information.

The EJ program can be operated without the mouse by using the function buttons to execute
the required command. It is also possible to use the mouse if preferred.

Press "F2-Date" to select the date you want to review. You can also select the date from the
date pull-down window above the receipt area. When the calendar is open, the [Home] key
will select today's date automatically. You can also scroll to the previous or next date using
Ctrl-PageUp or Ctrl-PageDown keyboard combinations.

The receipt area shows the transaction data. Use the scroll bar within the receipt area to
move up or down the transaction.

From anywhere within the transaction file for a given day, the [Home] key returns to the top of
the file and the [End] key advances to the end of the transaction file.
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"PgUp-Prv" moves back to the previous transaction in the same day. Although it is not
shown, [Ctrl] - [Pgup] moves one date backward.

"PgDn-Nxt" moves ahead to the next transaction in the same day. [Ctrl] - [PgDn] moves
ahead one full date.

Use the track-bar to the right of the scroll bar to move up and down the transaction list for the
date you selected. The track-bar moves proportionally to the size of the file (indicated below
the Store and Terminal numbers.)

Press "Esc-Exit" to close the EJ program.

Press "F3-Search" to extend the EJ window to the following layout:

This example shows the Electronic Journal - Professional version.

The EJ program includes search functions. The search tool allows you to set a maximum of
eight criteria to find the data you need. For example, you could search for all customers who
purchased a particular product or spent an amount equal to, greater than, etc. Cashier review
tools such as finding voids, refunds or other negatives are also easily performed. 

The pull-down windows in the search columns can be accessed by clicking the small arrow
button or the function button above the search fields. The headers in each of the columns are
explained below.

F4 - Field is used to set filters to use within your search. The fields include: Transaction, text,
cashier, amount, PLU number, customer, date, time, store, terminal, sub-department,
department, function, and totalizer. 
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F5 is adjusted dynamically to reflect the filter type you selected in the F4 column. For
example, if you select PLU number, the header for the F5 column becomes PLU #.

F6 - Operand is used to set an argument such as = (equal to), > (greater than), < (lesser
than), etc.

F7 - also changes according to the filter field set in the F4 column. For example, set the F4
column to PLU number, and you will see the F7 column becomes Amount. 

F8 - Condition is used to determine whether or not an additional search line should be added
to the current entries. As you add multiple lines to the search you may realize that one of the
entries is invalid. Use the "F11-Delete line" button to remove a search line. 

Use "F12-Insert line" to add a search line into the current search data. The first step is to
select a field to search by, in order to display only data that is required. For example, if you
need to see all transactions between 10:00AM and 2:00PM that included manual amount
entries into the subdepartment 5, you would set the following:

Initiating a search with incomplete data will display an error telling you which search line is
incomplete. The cursor will be positioned automatically in the field where the data must be
added to assist you. Note that in the interest of simplifying the data entry, we have enabled
use of the [Enter] key to change fields within the search data entry forms. So if you have
entered Time in the F4 column, press Enter to move to the F5 field, enter to move to the F6
column, etc. If the last column is left blank, L-POS assumes that the search criteria is
complete and pressing Enter will execute the search. If an additional entry is required to
funnel toward the data you are searching for, press the down arrow key to add a condition to
create another search entry line.
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The EJ search executes all OR conditions before executing the AND conditions. All
conditions must be true for a search result to be available.

When you have created a search that you may need to use repeatedly it can be added to the 
Edit menu. With the search active, open the edit menu and select Remember actual search.

NOTE: In order to open a prompt window for user input use the question mark in the
appropriate column. For example, to be prompted for the subdepartment number in the
example above, replace the "5" in the F7 column with a "?". The EJ program will prompt for
the subdepartment number instead of using 5. 

2.2.14 L-Tracker overview

Overview

This guide will assist you in using L-Tracker. L-Tracker is useful for locating data within
transactions that is not available with the normal L-BOSS reports program. The L-Tracker is
an optional module that may not be licensed on your system. Please contact your dealer to
inquire about licensing rights.

The L-Tracker search is performed on the same electronic journal files that can be reviewed
with the electronic journal search and review tool. The advantages to using the tracker
include advanced filtering options and multiple date spanning. The L-Tracker also provides an
integrated details review for the account maintenance module. This means that customer
transactions can be reviewed directly from the maintenance module.

2.2.14.1 Main screen

The L-Tracker main screen contains a menu, and several screen areas that remain constant
during operation.

The transaction detail information for the currently selected transaction is displayed on the left
hand portion of the L-Tracker window. The transaction header information is displayed
above the transaction details viewer.

The right hand side of the screen includes an area where pre-selection criteria are entered
to limit the transaction results list that shows as a grid once the Go function has been
executed. The customized search fields are used to locate specific data from the
transactions displayed as a result of the pre-selection.
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Several shortcuts have been added to simplify navigation:
F2 is used to access the details area of the screen.
F3 is used to perform a custom search
F4 accesses the Field input area of the custom search.
F5 accesses the Descriptor input area of the custom search.
F6 accesses the operand input area of the custom search.
F7 accesses the Value input area of the custom search.
F8 accesses the condition input area of the custom search.
F9 positions the cursor on the results list.
F10 is a shortcut to the transaction number field.
F11 deletes a line from the custom search.
F12 inserts a row into the custom search.
ALT-G executes the pre-selection to limit the results list to transactions that meet the
selected criteria.

2.2.14.2 L-Tracker menu options

The L-Tracker menu includes 5 main headers explained here in detail.

File menu

Rebuild pointers: This option is available to allow the user to rebuild file pointers
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manually. In order to speed up search commands, L-Tracker stores information from the
transaction files in smaller pointer files.Place the From date calendar selection on the
first date that you want to create or rebuild the pointers for. Only dates that need to be
rebuilt will be processed.
Set printer font: Set the font used by your printer when a print option is selected within
the L-Tracker menu.
Set receipt width: Set the width of the transaction details viewer to the left of the results
list.
Language: L-Tracker language of operation can be set manually using this option. The
program will run according to the language set-up of the current user. If no language was
defined for the user, L-Tracker will use the language defined in Windows regional
settings. This language setting over-rides any programmed or automatic use of
language.
Exit: Use this option to terminate the L-Tracker properly. You can also use the program
close icon (red-X) to terminate L-Tracker.

Edit menu: The edit menu is split into two sections. The top section (which may be empty on
your system) displays search queries that were saved from previous sessions. The bottom
section allows you to add serach queries to the top section of the menu or ro remove search
queries from the top section.

Remember actual search: Use this option to store the custom search statement you
are currently using. For example, you have set the Custom search window to find all
transactions containing the text "Marlboro light". If you select "Remember actual search"
from the Edit menu, L-Tracker will memorize the search and ask you to give it a
description. This description will then be placed on the top section of the Edit menu for
repeated use in future sessions. By memorizing your frequently used searches L-
Tracker will save you time when you need to locate specific data in the sales journal files.
Erase actual search: Use this option to remove the currently selected search option
from the top section of the Edit menu. To remove the search statement, first you need to
open it by accessing the Edit menu and clicking on that search statement. Then use the
Erase actual search option to delete it from the list.

View menu

PLU number: This option allows you to view the PLU number in the details area of the
transaction review screen.

Print menu: Several options can be used to obtain printed copies of the transaction results. 

Current transaction details will print the transaction displayed in the details window.

All transaction details will print the details for each transaction displayed on the results
list.
Summary transaction list will print a summary list of all the transactions that contain the
specific data defined in the custom search. The summary list will show the transaction
number, data searched for, and the amount. A total will be available at the end of the
report. The summary list is useful in situations where you want to see details because a
suspicious total appeared on a report. Example, the cashier report shows that an
operator did 17 Error Corrects. This report would list the items that were corrected and
the amounts with a total at the end
Search lines only: Use this option to print out the contents of the result list only.
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Help menu: Use this option to obtain version details or to open the help file.

2.2.14.3 Running L-Tracker

L-Tracker is a licensed program from Logivision. If your user license does not permit you to
use L-Tracker you will need to contact your authorized reseller to have the option enabled. If
you do not have a Tracker icon on the L-BOSS desktop, your system was not licensed to run
the Tracker option.

Click on the L-Tracker icon from the L-BOSS main menu. You may also start L-Tracker from
the operating system directly. Access the L-BOSS folder and double-click LTracker.Exe to
start the program. The following window appears.

2.2.14.4 Locating data

Finding transaction data with L-Tracker is executed by filtering through the transaction files.
Once the proper filters have been set, you should only be viewing the transactions that
respond to your search requirements.
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When the program is opened, the system positions the calendars on today's date. The
calendars are useful when you want to locate transactions that may span multiple dates. For
example, locating all the transactions with STORE COUPONS in the last 7 days.

So the first step in locating specific data is to select a date range. The calendars allow you to
set a Start/End date range.

Next you need to decide if the transactions including STORE COUPONS you want to locate
were entered on a specific terminal in a specific store. Use the Store and Terminal fields to
limit the data search to transactions from a specific terminal. Leaving the Store number blank
will search all stores. Leaving the Terminal number blank will search all terminals.

Now that we have the dates, stores and terminals you need to decide if the transactions are
for a specific customer or for a specific cashier. You can enter a customer number, or double
click in the customer number field. This will show a list of all customers who were found in
the transaction files within the dates selected. The same for cashier. Leaving eithe field blank
will ignore the filter and display the transaction files with STORE COUPONS for all
customers or for all cashiers.

Note: The Transaction field is used to enter a specific transaction number and will locate only
the transactions with that number within the selected date range.

Once the dates, terminal, store, customer, cashier and transaction fields have been set L-
Tracker is ready to begin the filtering process. The first time the program is used the
processing time will vary depending on several factors. Journal size and date range will
determine the time it takes for L-Tracker to build the database table it needs to perform the
further data searches available with the Tracker program.

To begin the processing press the Go icon. Each transaction in the date range you selected
will be read by the program and records will be inserted into a new system database table. As
explained in the previous paragraph, this may take some time so be prepared to wait for the
results list.

Once the process is complete the transactions that respond to your pre-selection criteria will
be displayed in a list below the selected criteria. As you scroll up and down this list you will be
able to view the details of each transaction to the left. Now it is time to add the search criteria
to locate transactions containing STORE COUPONS.

The area below the results list is used to enter custom search data. The 5 data fields allow
you to make custom searches within the transactions returned by the pre-selection filter. 

The F4-Field pull-down list allows you to select among different search types. To search for
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STORE COUPONS, choose Text and enter that descriptor in the F5-Description field. In this
case the fields F6-Operand, F7-Value and F8-Condition are not required. If a situation arises
where you needed to find, for example, all STORE COUPONS and SUB-DEPARTMENT 15,
you would use the F8-Condition pull down and select AND. A new row appears in the custom
search area. In this row you would modify the F4-Field window and select Sub-department on
the pull down list. When you do that, the F7 column is used to enter the Subdepartment
number.

Once you have finished defining the Custom search press the F3-Search button. L-Tracker
will once again filter the transactions and produce the list of transactions that respond to both
the pre-selection criteria and the Custom search filters you set.

2.2.14.5 Keyboard shortcuts

L-Tracker can be operated both with a mouse or using the keyboard shortcuts listed below.

Several shortcuts have been added to simplify navigation:
F2 is used to access the details area of the screen.
F3 is used to perform a custom search
F4 accesses the Field input area of the custom search.
F5 accesses the Descriptor input area of the custom search.
F6 accesses the operand input area of the custom search.
F7 accesses the Value input area of the custom search.
F8 accesses the condition input area of the custom search.
F9 positions the cursor on the results list.
F10 is a shortcut to the transaction number field.
F11 deletes a line from the custom search.
F12 inserts a row into the custom search.
ALT-G executes the pre-selection to limit the results list to transactions that meet the
selected criteria.

2.2.15 Time Clock System

L-BOSS includes a Time Clock function to record the hours worked by staff members. The
Time Clock is made up of 3 parts.

1. Time Clock Service
2. Time Clock (client to punch in/out) 
3. Time Clock Manager

The Time Clock system also includes programs required to set up the options and database
connections.

You will need to install and configure the Time Clock application before first time use.
1. L-BOSS will Install the Time Clock Service on L-BOSS station 901.
2. L-BOSS will install the Time Clock Manager on each L-BOSS terminal.
3. Time Clock punch in/out can be made on POS terminals. You need to configure a button to

use function 8082.
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4. To use the Time Clock punch in/out program on terminals that do not run the L-POS you
need to install from the Time Clock CLIENT installation file. This installs the Time Clock
entry pad as a standalone application. 

Important note: To use Time Clock, it must be activated in LBOSS configuration!

2.2.15.1 Time Clock Service

The Time Clock Service is a background application that runs on the L-BOSS server
(terminal 901) and responds to the Time Clock requests for punch in/out. The Time Clock
Service will accumulate punch in/out requests even when L-BOSS is not running. These
requests will be posted to the Database when the L-BOSS 901 terminal is started.

The Logivision Time Clock service will be installed with the application. It should be
automatically configured to start automatically with Windows restart.

2.2.15.1.1  Time Clock Service Settings

Open the L-BOSS Configuration panel, Misc tab to modify the settings used by the Time
Clock Service:
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File:
Select Language or Exit.

Period cycle: enter the pay period repeating cycle.
Period ending date: enter the end date of the current pay period.
Time Block size: Enter the number of minutes in each portion of an hour that is
remunerated. For example if you pay employees in 6 minute blocks enter 6.
Grace time: Enter the number of minutes that are allowed for a late punch in or an early
punch out without losing the entire time block.
Prohibit punch over: Enter the maximum number of consecutive hours that can be
accumulated for one punch in.
Ignore punch if less than: A punch that is less than this setting will not be posted by the
time clock system.
Send urgent message of one punch is more than: An urgent message will be sent to L-
BOSS any time a punch exceeds this number of hours.

Network settings
Service port: Enter the port number used by the Time Clock Service. System default is
8050.
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Manager port: Enter the port used by the Time Clock Manager. System default is 8052.

2.2.15.2 Time Clock Manager

Time Clock manager allows entries to the time clock database to make adjustments, such as
when an employee forgot to punch out.

The Time Clock Manager is started from the Modules menu:

2.2.15.2.1  Time Clock Manager

The Time Clock Manager screen:
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The Time Clock Manager Operators window displays a list of the operators created in your
system. When you select a date it highlights the payroll period your selection belongs to.
Select an operator to view the entries for that period.

When you select an operator the Working times window displays the activity for that
employee during the selected period.

Open the File menu option to switch languages.

Show only operators punched in: Set this to display only operators that are clocked in.
Number of operators present: Displays total number of operators clocked in now.

2.2.15.2.2  Time Clock adjustment entry

Press the Add entry or Edit button in the Time Clock Manager screen.
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The entry will be made for the operator that is selected in the Operators list.

Add entry to post a new record for the employee you selected.
Edit to modify the selected entry from the Details list.

Start/end Date: This is the date you are making an adjustment for. The system defaults to
the same date selected on the Time Clock calendar.
Start/end time: This is the start time when the operator should have punched in at. You can
also change the end time.
Total Time: Instead of changing the start and end time, you may enter the number of hours
to adjust. This will modify the end time by adding or subtracting from the start time.
Comments: Enter a comment to add to this entry. Comments are mandatory.
Use Time Block Size: This will change the Total Time field to use increments that match the
Block size configured in the settings.

Ok: Press this button to post the entry. There will be a delay of approximately 10 seconds for
the transaction to post.
Cancel: Press this button to abort the entry.

2.2.15.3 Time Clock (Entry form)

Time Clock can be used from within the L-POS application or as a separate application on a
PC connected to the L-BOSS server. The configuration of the POS button is explained in the
L-POS help file under the Function Parameters. 

The L-POS system includes a clock in clock out button to make employee timeclock entries.
The TimeClock client application is installed with L-BOSS. Use the TimeClockClientInstall.
exe to install this application on machines not running L-BOSS.

Running Time Clock as a standalone program:
The Time Clock.exe program is used to Clock in and Clock out. It also gives access to the 
client application set-up page where the network communication settings can be modified.
This window will appear when you start the Time Clock.
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This is the form used for employee Time Clock operations.
 
Entry: The first column is where operator information is entered.

Comments: Each clock in or clock out requires a comment

Actions: The icons represent shortcuts to different functions.

 opens the Time Clock settings menu.

 is used to preview the report of the worked hours.
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 is used to display the About window of Time Clock (version, etc).

 is used to PUNCH IN and start work shift

 is used to PUNCH OUT to end work shift

 Use this to cancel the current entry.

The top of the window displays current operator Time Clock status.

2.2.15.3.1  Time Clock (Entry Settings)

From the Time Clock Entry form Press the   button to access the Configuration
menu and set up the Time Clock application.  
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Store and IP Address: Press on the Discover button to force the client application to
search for the server.If only one server answers, the store and IP will be filled automatically. If
more than one server answers (meaning that there is more than one Time Clock Service
running on the network), Time Clock will display a list of all the available store numbers.

Server Port: Enter the port to be used between the Time Clock Client and the Server (the
service, probably running on the L-BOSS computer). Default port is 8050.
Local port: Enter the port to be used between the server and the Time Clock Client. Default
port is 8051.

Keep application open after punch: Set this flag to keep the Time Clock window open after
each punch in or out. Otherwise you will need to reload the client application for each usage.
Keep me logged in: Use this flag when you are the only user punching in/out at this
workstation.
Show Time Clock icon in system tray: When this option is selected and the Keep
application open after punch is not checked,  the application will stay open in the system tray.

Language: Enter the program display language.
Change password: Press on this button to change your password. This button will bring you
back to the main Time Clock screen and you will be prompted to enter the old password
before entering the new one. 
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2.2.15.3.2  Employee time report

 is used to preview the report of the worked hours for the employee who is logged in
to the Time Clock

2.2.15.3.3  Punch In / out

1. Use the keypad to enter your employee number. 
2. Use the Green Check-mark to accept your employee number or password. The system

uses the same front-end password used to login the POS application, not the back office
password. Press the Check-mark twice if you have no password.

3. You must supply a comment to Punch in or to Punch out. Click the appropriate
comment.

4. The actual buttons used to PUNCH IN or PUNCH OUT are unavailable until you sign in to

the Time Clock application. Press the  button to complete the Clock IN or
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press the  to complete the Clock OUT process.
 

Use the  to cancel the current entry.

Notes: 
1. The system will not let you clock in if you are already clocked in.
2. The system will not allow a punch to exceed the number of hours defined in the Time
Clock Service settings menu.

2.2.15.4 Time Clock Report

L-BOSS includes 2 reports to calculate the number of hours worked per employee per
period.

Open the Cashier report folder and select Employee Work Hours (detailed or summary)

The report allows you to select:
Period. This is the period that corresponds to the settings made in the Time Clock Service
Settings.
Year: Enter the year to use for the period you select.
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Single employee: Enter an employee number or leave blank to select all employees.

Use the Report group to decide which stores/terminals will be added to the report.

Use the Program target to decide which operators will be added to the report.

2.3 Special

Special Menu Options

What is it for?

The Back Office System Software allows advanced users to create menu options for
specialized utilities, or as a quick launch for custom applications, reports, etc.

Please consult your L-BOSS dealer for more information.

2.4 Help

L-BOSS Help

Logivision  provides user help in both electronic and printable format. Both the printable
manual and the electronic help describe all the options available in the Back Office System
Software at the time of release. 

NOTE: Designed as a "user manual", the help does not detail how to program L-BOSS
commands or SQL. Please consult your Logivision  dealer if you have specialized needs that
require programming.

The L-BOSS main "Help" menu "Contents" option is used to access the "electronic" help file,
an online version of the printable manual. The on screen help file can also be launched at any
time by pressing the [F1] function key. Designed in the standard Windows 98 / Me / NT help
style, the electronic help includes a navigational tree (table of contents), and a searchable
index to help quickly locate information. For help on how to use the help file, please read the
Windows help, accessed in the Windows "Start" menu.

If you wish to have a printed copy of the L-BOSS User Manual, please see the Printing help
as a Manual section above in this manual.

Version numbers

The "About" option opens a panel displaying the installed L-BOSS version number, useful for
obtaining technical support information. Since L-BOSS contains a number of separate utilities
with version numbers, the about also provides a quick list of all application version numbers.
With the "About" panel open on screen, click the L-BOSS icon. This opens a list of all the
version numbers for the L-BOSS programs. This also creates a text file that can be printed
and faxed, or emailed as an attachment to help the technical support process.
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You can customize the help / about page by adding the Logo.txt file to the L-BOSS folder that
contains text to be displayed in the help / about window. Create an ascii file with Notepad
containing the text you want to display. If the file L-BOSS\Logo.jpg or L-BOSS\Logo.Png exist
the Help / about window will display the image as well.

2.5 Other applications

Enter topic text here.

2.5.1 L-Remote

L-BOSS can be used in a multi-store chain to manage data centrally. L-Remote is the
module that is used to transfer data. Item and other data maintenance such as price changes
can be transferred from the head office out to stores. L-BOSS is designed to create and
maintain data from the central head office location and send it to stores, not to maintain data
at the store locations to send back up to the head office system.

Sales data from the stores is returned to the head office. The communication is designed for
high speed internet connection only. Data transfer over dial-up is not supported.

L-BOSS is available for store operation. L-BOSS Central is used at a head office to connect
with L-BOSS in each store. L-BOSS Regional is used in a company that needs to
consolidate data from several locations but also have that data move to L-BOSS Central.

The L-BOSS Central and L-BOSS Regional cannot connect directly to L-POS terminals.

2.5.1.1 L-BOSS configuration settings

L-BOSS Configuration menu
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1-In the Company tab make sure the Allow multi-store flag is set.
2-In the System tab at each store make sure each location has a unique store number.

2.5.1.1.1  Comm tab

Comm tab settings will vary depending on whether you are setting up a store or a head office.
You need a fixed IP or domain name at head office to connect from store. L-Remote needs to
be configured at both ends; meaning store and head office. In some situations you may
configure a regional office.

Comm tab set-up for a Store
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LRemote communication enabled must be set. Setting this will initiate install of thee
LRemote service.
The What am I will be selected when you did the installation and selected L-BOSS type
(store, regional, central).
Preserve report data per terminal: Select this option to enable reporting per POS
terminal at head office. Otherwise select Merge report data per store. If you select
Preserve report data per terminal you need to create each store's POS and Back
office terminals at Head office. If you select Merge report data per store you will only
create the back office terminal 901 for each store when defining the terminal list at head
office.  This way you will only have a global report per store, and not the possibility to see
each lane individually.

L-Remote server
Remote office server

IP or Domain name refer to the IP or domain name  of the Head office L-remote server.
(This may be the DNS of the L-Remote server or an IP address. It needs to match the
name used for the L-Remote certificate LogiRootCA.cer). L-Remote will use port 8080 by
default. To specify a different port address enter it after the IP address or domain, for
example Logivision.com:8025
Call every is used to set the repeating cycle for communications.
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Specify starting time is used to allow different connection times from different stores.
This means you could have 10 stores starting connection at 1:00, 10 more starting
connection at 1:10, etc. Leave this blank and communication will start immediately and
repeat as per the repeating cycle you entered.
Multi-store account balance: This option must be set at the head office only

L-Remote login: Name and Password need to match at both ends. 

Comm tab set-up for the Head office

Open the Comm tab of the L-BOSS configuration menu.

LRemote communication enabled must be set.

The Head office type was selected in the What am I form during the installation (store,
regional or Central).
Preserve report data per terminal: Select this option to enable reporting per POS
terminal at head office. Otherwise select Merge report data per store. If you select
Preserve report data per terminal you need to create each store's POS and Back
office terminals at Head office. If you select Merge report data per store you will only
create the back office terminal 901 for each store when defining the terminal list at head
office.
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LRemote Login : Name and password must match with the Stores

Name for communication over local network This is the host name to set if the L-
BOSS Stores are on the same network as your L-BOSS Central. This name should be
the IP address of connection or the server name on the network.  The port must match
the port used to create the certificates and must match the comm configuration of the
Stores.  You must do port forwarding on your computer to forward datas to the Central
computer
Name for communication over internetThis is the host name to set if the L-BOSS
Stores are remote to the L-BOSS Central. This name should be the remote IP address or
the domain name of the PC to access your network.  The port will be configured
automatically to the value following the local port.  You will need to set up port forwarding.
Unrestricted port to send certificate This is the port used to send certificates when
asked by the client. When active, it starts the service to distribute the certificates.  Once
each stores got the certificates, you can deactivate this option, since they will now use
the secured ports.
Port: The first port is the base port number. The two other ports are generated
automatically and cannot be modified. 
Re-generate the certificates: When clicked, it will indicate to the LRemote Server
service to re-generate the SSL certificates next time the service is “re-enabled”.  Use this
button to re-create the SSL certificates. This should not be used unless you change the
IP address or Ports used by the L-BOSS Central. The certificates are created and sent
automatically without pressing this button the first time L-Remote is executed.

Warning: If you chose not to open the ports for L-Remote to distribute the certificates
automatically you will need to proceed manually.  You must copy the certificates from the
LrCerts folder on the L-BOSS Central to the same location in each store. The certificates
are located in Program data under LBOSS\LrCerts. The certificates files use this naming
convention: LogiClient_###_Internet.CER and LogiClient_###_Local.CER where ### is
the store number of the L-BOSS Central. Once the files are copied to the remote stores
you must manually execute the SSLCertificatesManager.exe under the LBOSS\LrCerts
program folder. Upon execution a window will open. Enter the 3 digit store number of the
L-BOSS Central and press Next.

Call Timeout: Click on this to open a window that will allow you to define when the
system will prompt urgent message if the Store has not communicated to Central since
the specified time.
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Multi-store account balance:  It is important to make the correct setting for the account
balances to flow properly. When you decide NOT to select multi-store account balances
only the charges made at a local store will appear on the statements printed at that store.
The head office system cannot contain different balances for each store in its database.
So if you choose not to use the Multi-store account balance flag you must print
statements at each individual store and ignore the account balance at the head office.
See footnote for more information.

If the option is not checked, the customers balances will be maintained at each store
individually.  The statement reports will be available only in store.  Each store keeps its
own statements, so the same client can have a different balance at 2 different stores for
instance.

Please take note that if this option has not been set at the installation of the L-BOSS, this
can cause serious problems.  If the stores are not synchronized, the balances will be
erroneous when you'll check the option.  The first store that will communicate with Central
will send it its balances and those ones will be deployed to each store (overwriting the
previous balances)

Comm tab set-up for a Regional office

A regional office may be required to consolidate data from a few stores. A regional office
retains data for local reporting then sends its data to the head office as final destination.
Please contact Logivision if you plan to use the L-BOSS Regional version.

Heartbeat feature
Once all settings have been made you will be prompted to activate the L-Remote "heartbeat"
feature. The heartbeat allows the L-Remote server to keep track of the IP address of each
store. This allows the head office to send a request a store to call on demand by the head
office. This request will be sent to groups of stores in sequence to allow the incoming
connections enough time to terminate their connections and not overload the system.

Head office data communications

In some situations it is necessary to transfer files from the POS system in a store to a central
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location for further processing. The L-BOSS communication method and set-up is defined
under the Comm tab. By default no communication is defined. Refer to the L-Remote section
of this guide for further help on remote communications.

The Comm tab includes a flag related to Multi-store account balance. It is important that this
flag be set properly to reflect how you want to handle charge account balances. Most
customers should use this flag. 

Multi-store account balance
Multi-store account balance
flag IS selected

Multi-store account balance
flag is NOT selected

Can I make account
adjustments at Head office
using L-BOSS Maintenance

YES NO

Can I make account
adjustments at Stores using L-
BOSS Maintenance

NO YES

Can I print statements at Head
office

YES NO

Can I print statements at store NO Yes
Is my account balance
identical at Head office and all
stores

YES NO

Can I pay off my account
balance for all stores at any
store

YES NO

NOTE: It is important to make the correct setting for the account balances to flow properly.
When you decide NOT to select multi-store account balances only the charges made at a
local store will appear on the statements printed at that store. The head office system cannot
contain different balances for each store in its database. So if you choose not to use the
Multi-store account balance flag you must print statements at each individual store and ignore
the account balance at the head office. It cannot be used.

2.5.1.1.1.1  Update to version 4.1.1.x

If you are updating L-BOSS from a previous version and you are using L-Remote:

AT HEADQUARTERS

Restart L-BOSS after update to version 4.1.1.x 

Go to File -> Configuration -> Comm tab 

Enter the “network name” and “internet name”, thoses names will be used to create
the SSL certificates. 
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You need to modify the "port" used by the Local network. Subtract one from the
current value assigned. For example, if the port is set to 8080 you must change it to
8079. The "port" used for internet communication will be set automatically. 

Systems that are running both the Central and Store version of LBOSS in the same
local network at head office must change the "port" number in the Store L-BOSS. You
must set the same number that was assigned in the "Port" field of the L-BOSS
Central comm tab

2.5.1.1.2  Understanding L-Remote

Terminals and target groups setup with L-Remote communication

This section explains the terminals list you need to create when you work with L-Remote. The
setup is done within the Maintenance application, menu Register, option Terminals

Required terminals at Central to transfer data to remote stores

The terminals list of Central will include a terminal for each L-Boss server of each store.  You
have the choice to have reports available for each terminal individually for each store, or to
have the data of each terminal consolidated per store (this option is available under Comm
tab of LBOSS Central> File > Configuration).  
If you don't want to consolidate data, then you need to create each terminal of each store at
Central.  
If you want to consolidate reports per store, then you only need to create L-Boss terminals
like it was already explained.
Most of companies will probably want consolidated sales reports only, so they should not
forget to activate the correct flag in the configuration of the Central.

If at Central you request the reports of each individual lane, then you need to create a
Terminal for each lane of each store at Central.  Those terminals can't be flagged for
Exchange or Program.  They can only be set for Report.

Transmitting data with L-Remote

When a price is changed from Central, L-Boss copies a file to each target that must receive
the price.  If you have 3 stores that must receive the price change, L-Boss will want to send
the change to each target.  When L-Remote is used, the transfer occurs periodically, and not
immediately like in a store that deploys changes at lanes.  So instead to write the information
directly in the inbox of the store, the files are copied in the temporary folder on the L-BOSS
Central.  When L-Remote starts the connection between Store and Central, it seeks this
temporary folder assigned for this store.  The data are then transferred from Outbox001 to



L-BOSS User Manual 4.1.3426

© 2001-2014 ... Logivision

the Inbox901 of the store, and finally processed.
During the same communication, L-Remote Client will seek the folder OutboxHost of the
store. This folder contains all sales data that must be transferred to Central.  So during the
same call, the changes are sent from Central and data are sent from Store.

Central's terminals groups

When L-Boss is used in a multi-store environment (L-Remote communication), you must
proceed with caution in the groups configuration.  For instance, there are files of unique data
assigned at each store that cannot be sent to every store.  A good example are the headers
and footers of the receipts: if different addresses are printed for each store, it's important to
structure the groups correctly, otherwise the Central won't be able to change the header's
receipt of one store without affecting all the other stores.  
The mail servers of each store can also have different names.  This means at Central you
must create a group for each store (S01, S02, S03, etc)  In those groups you must enter the
L-Boss station controller of each remote store. After, L-Boss will be able to transfer the
correct data to the according stores.  You MUST NOT use group numbers like 001, 002, 003,
etc. This would create conflict.  Here is an example of a list that could be created at Central if
you need to communicate with 3 stores.

S01 Terminal 001 901, group for Program and Report.
S02 Terminal 002 901, group for Program and Report.
S03 Terminal 003 901, group for Program and Report..
PAL Terminal 001 901, 002 901, 003 901 group for Program
RAL Terminal 001 901, 002 901, 003 901 group for Report
XAL Terminal 001 901, 002 901, 003 901 group for Exchange.

When you use prices multi-zones, you must specify the parameters of item, price and cost
for the appropriate groups.  Following the example on top, if each store has different prices,
you must check Price for each group S01, S02, S03.  If the stores have different items, then
you need to check Item. Same thing for Cost of items.  If some prices are common to all
stores, make sure the target PAL has Price, Cost and Item selected

Store's terminals groups

The standard terminals and targets must be created into each store.  You must also create
the targets that will receive specific information for this store only.  If you have created a
target S02 at Central to send a receipt's header different than other stores, you must create a
S02 group at Store also.  On store's side, this target S02 would include all terminals that
require this header.  Normally it regroups all terminals of the store.  You will also have to
redefine the targets in PosSetup to assign the new header to S02 and not to PAL.

Updating prices from Store:

The option Send to Host in the file menu is only active when the L-Remote communication is
active.  This option allows to send to Central the changes done at the store. It means price



L-BOSS Menus 427

© 2001-2014 ... Logivision

changes, accounts and other data can be done in store and sent to Central to update Central.
  You need to understand that every changes deployed from a Store to a Central will then be
deployed to all Stores connected to Central (for all terminals that were part of the target group
- ie PAL or ST1)  This means if a price changes has been initiated to store 3 and all other
stores share this information, the change will reach all other stores on next communication. 
The only way to force a change to reach Central, is to hit satellite for this record only (it will
not work in you hit satellite and choose ALL). It will not work either if you use the task Deploy
all changes. This can only be done one item at time.

2.5.1.1.3  Store list at L-BOSS Central

The store list must be created to allow proper inventory control. Open L-BOSS Maintenance
application. From the Register menu select Store Information.

For each store in the chain you will decide here which data will be transferred from the
Central to the store. Enter the store names, addresses and phones numbers. Use the INI
files list and tables list to define which files are transferred to stores from the HQ. Place a
check mark on each file type that you wish to deploy. Once you define which tables are
deployed you also need to define the different programming groups in PosSetup and program
targets in the terminal list.

L-BOSS Central  
1. Create the list of all stores in your chain. If you want to send the same list of stores to a

store(s) place a check mark in the STD_TAB table. This is the store details table.

L-BOSS Regional  
1. Create the list of stores this regional office communicates with. Please take note that when
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the head office is set to deploy the STD_TAB to this regional office terminal this information
will be the same as the head office store list. 

L-BOSS Store

1. The store details tab in a store will not have the same information available as the store
details table in the Central or Regional offices. Create the stores you will receive stock
from or transfer stock to. Please take note that when the head office or regional office is
set to deploy the STD_TAB to this store the information will be the same as the head office
or regional office store list. 

2.5.1.1.4  Terminal list at Head off ice

Terminal list at head office

L-BOSS head office will send data to each remote store via the L-BOSS back-office 901
terminal. At head office you must define the back-office 901 terminal for each remote store. If
you want sales reports for individual terminals by store you must define each of the POS
terminals at the head office. You must set the flag to Preserve report data per terminal in
the Comm tab settings of each store.

Here is an example with 4 stores (35-38) that have 1 L-POS and 1 L-BOSS each and the
head office (store 39) with one L-BOSS terminal.
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The L-BOSS central will communicate with the L-BOSS 901 terminal at each store.
Include the 901 terminals from each store in the XAL group.

Program data can be sent to ALL terminals or to individual stores.
Create 4 targets 035, 036, 037 and 038.

Add L-BOSS terminal 035-901 into the 035 target.

Add L-BOSS terminal 036-901 into the 036 target.

Add L-BOSS terminal 037-901 into the 037 target.

Add L-BOSS terminal 038-901 into the 038 target.

Add terminals 035-901, 036-901, 037-901 and 038-901 to the PAL group.

Reports can be taken for the terminals defined in the Report targets.
To report on individual stores create 4 report targets, R35, R36, R37, R38.

Add L-BOSS terminal 035-901 into the R35 target.

Add L-BOSS terminal 036-901 into the R36 target.

Add L-BOSS terminal 037-901 into the R37 target.

Add L-BOSS terminal 038-901 into the R38 target.
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Add terminals 035-901, 036-901, 037-901 and 038-901 to the PAL group.

NOTE: To program register data such as Advertising, printers etc., you need to include an L-
POS terminal type in each different program group you created (such as PAL). Take care 
NOT to place an LPOS terminal type into the XAL target because that will cause the system
to stop polling any data. You cannot have an LPOS terminal type in the XAL target of the L-
BOSS Central or L-BOSS Regional systems.

2.5.1.1.5  Target set-up

This example includes a program group to send data to each store individually and a program
group PAL to send data to all stores simultaneously. The example also includes individual
report groups for each store (R01, R02 etc.) and the RAL group to report on all stores all
terminals.

Sample program type targets Sample report type targets
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In this configuration example only the remote stores L-BOSS terminals have inbox and
outbox defined. Even if there are several L-BOSS terminals at each store you must only
define the INBOX and OUTBOX of the main terminal 901. All other terminals at each store get
there data from terminal 901 in that store. This is because the data that leaves from L-BOSS
is sent to the back office in each store, not directly to the POS or to other back office
terminals. At each store the normal terminal list will have an inbox and outbox defined for
each POS terminal. As usual, stations 902, 903, etc. use the data directly from the 901 with a
network connection. When you define the L-BOSS terminals of each remote store it is very
important to set them as L-BOSS terminal type.

Terminal and target list in each store

There is nothing special about the terminal list at each store unless you are working with
different pricing or other program groups. If you have a different price target (for example P01)
at head office it is because you are sending different prices to different stores. If P01 was
created at head office to send prices to store 001, you will also need to create the P01 target
at store 001. This target will include the POS terminals in store 001. It will be selected as a
PRICE and PROGRAM group. If you do not create the P01 target group at the store the items
that are in the P01 price zone will not be sent to the POS terminals.

2.5.1.1.6  Different targets (like price zones)

Different price targets (price zones)

L-BOSS allows you to maintain different data for different stores. For example, if you want to
create different prices for store 1 and store 2 you will need to define new PRICE TARGETS at
the head office. For example, you may create targets P01 and P02 for price differentiation
between the 2 stores. The price targets are defined in L-BOSS >Maintenance >Register
>Terminals programming menu. You need to add a check mark in the "Program" and "Price"
fields of the selected Target.
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Selecting "Price" means that you will now be able to create a price for any item and assign
that price to the P01 group. 

Then you can create a second price for the item and assign the second price to the P02
group. 

It is VERY IMPORTANT to realize that whenever you create individual prices for an item you
must remove the price target PAL for that item. Since PAL gets sent to all stores, if it is still in
the file along with P01 and P02 you will be sending the PAL and P01 to store 001 and PAL
and P02 to store 002. There is no predictable result of which price will be active at the remote
stores. So you MUST DELETE the price from target PAL for items that have individual prices.

This system allows you to maintain only the exceptions that are different from one store to
another. For example:

· Items 1-200 are the same everywhere so they only have a PAL price and it is
deployed to everyone when it changes. These items will only have one price for the
PAL target.

· Items 201-210 are different at each target. So you create P01 and P02 prices for each
item in that range. The P01 prices will go to store 1 and P02 will go to store 2. If you
have several stores that use the same price put all those stores into a common price
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target when you are creating the target list.

NOTES: 
It is very important to remove items from the PAL target if they belong to
individual targets. This explanation was given for prices, the same holds true
for tax status (POS target) and for cost (COST Target).

It is also important to understand that price or other information does not go
from stores "UP" to head office. Price information goes down from head office
to stores.

You can send prices for individual items from store to head office by using the
"Send to host" option as explained in the L-BOSS user guide.

2.5.1.1.7  Deploying f iles

Deploying changes to the stores

Changes made at the head office need to be sent to the stores. This will occur automatically
whenever Deploy all changes is executed. Changes are also sent to all locations when the
satellite is used within a specific record on a table. This action only gets data to the L-BOSS
back-office in the remote stores. You will need to execute a command at the store to get the
files from the store's back office to the store's POS terminals.

Deploy files with different zones (price, item, cost, etc.)

L-BOSS includes a menu option to send individual files to target groups. You need to be
careful when using that option to Replace data at the targets. In most situations the same
data goes to all stores. When you are using Price zones different price data goes to different
stores. So price records for zone 1 may be part of the P01 group, prices for zone 2 will be in
the P02 group and prices common to both stores will be in the PAL group.

If you select deploy and replace the system will send the PAL price data to both stores and
replace the current data in the table with the PAL records in the price_tab. This means that
the store now only has the prices for items common to both stores. So you need to handle
the Deploy and replace command manually if it is ever required.

Using the example of price zone P01, P02 and PAL follow these steps if you ever need to
replace the price data in the stores.

L-BOSS>File>Deploy individual file

1. Select the price_tab and check Replace
2. Deploy this file and select the PAL group when prompted. Now the remote store L-BOSS

terminals will only have the PAL records.
3. Select the price_tab again but do NOT check Replace.
4. Deploy this file and select the P01 group when prompted. Now the first remote store 001

L-BOSS 901 terminal will have the P01 price records added to its price table
5. Repeat step 3 and 4 for the next store, etc.
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6. Repeat the steps 1 to 4 at each store to send the price data to the lanes.

Follow similar logic for any other files that may be different in your remote stores.

Sending changes from the store back to the head office

Normally all data is programmed at the head office and sent to the stores. L-BOSS was not
designed to maintain data at a store to send back up to head office.

Nonetheless you can send data manually one record at a time from a store back up to the
head office. Open a table for editing, such as the Sub-department table. When the sub-
department table is open for editing click on the File menu. The Send to host option is now
visible.  Select it if you want to have the choice to send changes made locally back to the
head office.

Every table that you edit has the option "Send to host". Changes you make to any of those
tables will be sent whenever you use the "satellite" option to send that record immediately.
Let's suppose you decide to "Send to host" the PLU changes. When you change the price of
an item in the store and use the satellite to send it to the lanes it will also be sent to the head
office. If you use "deploy all changes" in the store the changes are not sent to the host.

The "Send to host" option is designed to send infrequent local maintenance back up to the
head office and out to other stores in the same target group.

2.5.1.1.8  Installing certif icates

Introduction
L-Remote uses SSL certificates to ensure secure communications. These certificates are
installed automatically when L-Remote is executed the first time. If you do not allow L-
Remote to install the certificates automatically because of a particular network requirement
you will need to install the certificates manually.

Manual installation of SSL certificates 
NOTE: If you chose not to open the ports for L-Remote to distribute the certificates
automatically you will need to proceed manually. 

You must copy the certificates from the LrCerts folder on the L-BOSS Central to the same
location in each store. The certificates are located in Program data under LBOSS\LrCerts.
The certificates files use this naming convention: LogiClient_###_Internet.CER and
LogiClient_###_Local.CER where ### is the store number of the L-BOSS Central. 
Once the files are copied to the remote stores you must manually execute the
SSLCertificatesManager.exe under the LBOSS\LrCerts program folder. Upon execution a
window will open. Enter the 3 digit store number of the L-BOSS Central and press Next.

2.5.1.1.9  Open port in Window s Firew all

The communication port used by Lremote Server needs to be unblocked in your firewall policies.

This explains how to open the port for traffic in the Windows 7 Firewall:
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Open the Windows Firewall and select Advanced settings

In the Advanced windows select Inbound rules:
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In the Inbound rules select New rule
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In the rule type window select port and press Next:

The rule applies to TCP on port 8080. Press Next.

Select Allow the connection and press Next.
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Allow this rule as shown above and press Next.

Enter a name for the rule and press Finish.
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2.5.1.2 L-Remote operation

This section explains how to use L-Remote server and client.

2.5.1.2.1  Starting L-Remote server

L-Remote will launch automatically with the L-BOSS application at head office when the
system is configured for stores to call the head office. If you want to view the current

communication status double click the L-Remote Server tray icon . The  L-Remote server
will display a list of stores and the current status.

File menu:
View logs will bring you to the log files for detailed activity tracking.
Language allows to switch language.

View menu:
All stores will list all remote locations
In process stores will show only the locations communicating now.

Tools menu:
Options: Loads the LRemote Server service settings for modification. 

Operation viewer:
The L-Remote server displays a list of all the terminals configured for L-Remote
communication.

1- Use the small arrow at the right of each store to expand the view and display current
activity details for that store.

Closing the L-remote server window will not stop the communication with stores. 

Use the Tools menu to open the L-Remote settings menu:
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ServerSettings

Client  In error Timeout

Number of seconds without any calls from client before it change to In Error state while client

is connected.

Client Retrying Timeout

Number of seconds without any interaction before it changes to Retrying state while client is

connected.

Client Lost Connection Timeout

Number of seconds without any interaction before it changes to Retrying state while client is

connected.

Maximum Connections 

Number of maximum connections allowed on the server.

Client settings

Maximum Connection Block Time

Number of minutes of uploading files/downloading. 

Delay between retries

When LRemote Client did not have time to complete all the transfers and when it reaches the

maximum running time, it disconnect and wait this delay before retrying to transfer files. This

mechanism exists to let other store to transfer their data and balance the load across all

LRemote client machines . If not, only few stores will take and keep available connections

and stores would be processed sequentially.
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2.5.1.2.2  Starting L-Remote Client

L-Remote client at the store will connect automatically at the designated time according to
the schedule entered during L-Remote set-up.

Initiating L-Remote communication immediately

L-BOSS displays the time before the next scheduled communication on its main desktop
form. Double click the count-down to initiate communication immediately.

To display the L-Remote client window double click the L-Remote Client tray icon . The
following form will be displayed:
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File Menu

Force connection to server
Allows to start a file transfer run

Cancel current operation
Allows to stop the current file transfer run

Browse for logs
Open a Windows explorer window in today’s log folder for the current store

Language
Change language to “French” or “English”

Show activity
Show the log section in the window

Exit
Exit from LRClient

Help Menu

About
Displays information about LRClient
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2.5.1.2.3  L-Remote status icons

Image States Description

Closing,

WaitingForFileCache

When a store disconnect or when it is checked if

the downloaded files have been written to disk

Connecting

RetryingSinceNoRecentCall

s

Starting

When a store disconnect but did not have time to

transfer everything. Will reconnect later.

Idle When everything is up to date and waiting for the

next time to connect and to check if there’s new

file transfer

LostConnection When a store is connected and did not call a

transfer method for a certain amount of time.

Downloading When it is downloading files

Uploading When it is uploading files.

2.5.1.2.4  Trouble-shooting L-Remote

Q. There is no communication between server and client.

A. - Open the right ports on the LRemote Server Machine Firewall. Create inbound rule. 

- If you are communicating through a router, do port forwarding for the ports defined in

Configuration -> LRemote in L-BOSS “Server”.

Q. There is authentication error when the client tries to communicate with the server.

A. You do not have the right SSL Certificate installed on your LRemote Client Machine.

Usually it is downloaded automatically. If you have the “Unrestricted port to send

certificates” checked in Configuration -> LRemote in L-BOSS “Server”. If not then you

will have to install it “manually” with the help of SSLCertificate Manager.
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2.5.2 L-Register interface

WARNING:
It is assumed that the reader of this guide has a thorough knowledge of the L-BOSS
application. This guide only pertains to the added functionality obtained from installing the L-
Register option with L-BOSS.

L-Register controls communications with the TEC MA1595 ECR. Different configurations
are available with the ECR. Not all ECR configurations are supported by L-Register. Note for
example that L-Register version 2.0.0.2 only communicates properly with the MA1595 rom
version 7 or 8. You may need to reprogram the ROM in the ECR to use L-Register.
  

2.5.2.1 Preparing the ECR

MA-1595 Requirements

Supported Configurations
Master/Satellite
RAM Allocation

System Setting 2 (PLU Inquiry, Local Cashier)
System Setting 1&2 (PLU Inquiry, Floating Cashier*)
*Requires Expanded RAM

Standalone
RAM Allocation

System Setting 2 (PLU Inquiry, Local Cashier)

MA-1595 Setup
RAM Allocation
Note: New install of L-Register with an existing MA-1595. Go to PC Configuration (print
out RAM Allocation for LRegister Setup).

RAM Allocation information will be needed when LRegister is setup.
Print out sample of Submode 79:

Thank you Call again
Your receipt

10-07-04 THU #0
     PX 179
#1 0:S/A 1:M/S       1
#2 EX RAM            0
#3 SYSTEM            2
#4 CLERK            15
#5 PLU            5000
#6 C.T             500
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#7 TRAN              0
#8 NEG CARD          0
         001 07:00 TM

Mode Lock : Set Position
Enter : [179]
Press: [AT/TL]
A receipt will print out like the sample above, this example is for a Master/Satellite
System.
NOTE: CVS is not supported at this time.
Refer to the RAM Allocation section of the MA-1595 programming manual for
Standalone, and Master, Backup Master, Satellite System.

The following Submodes have to be set correctly in order for the TEC MA-1595 to
communicate with the PC.

1) Terminal ID Setting (Standalone, Master, Backup Master and all Satellites)
Mode Lock: Set Position
77 [@/for] 1 [ST]

A) Enter Terminal ID Number and depress [#]
1 = Master / Standalone
2 = Backup Master
3 -16 = Satellites

B) Enter 3 [ST] and enter the IP Address for that terminal.
(Standalone – Address 3 will be setup with Master settings)

Example: 192 168 000 001 [#] = Master /Standalone
192 168 000 002 [#] = Backup Master
192 168 000 003 ~ 016 [#] = Satellite

C) Enter 4 [ST] and enter the Master Terminals IP Address.
(Standalone – Address 4 will be setup with Master settings)

Example: 192 168 000 001 [#]
D) Press [AT/TL] (address 5 Subnet Mask and address 6 Default Gateway are left at
the default setting, as in the example below)

Thank you Cal l  agai n
   Your  r ecei pt
  10- 07- 04 THU #0

      PX 177
#1
#2                   0
#3       192. 168.  0.  1
#4       192. 168.  0.  1
#5      255. 255. 255.  0
#6          0.  0.  0.  0
          0008 12: 48TM
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Enter the Register Number and Depress [#]
Example: 1 [#] Master

2 [#] Backup Master

2) Terminal Connection Table (Master Only)
Mode Lock: Set Position - RTR ON
(SFKC Programming Submode 76 in the MA-1595 Programming Manual, SFKC for
RTR = 138)

69 [@/for]

A) Enter In-line ID Number (01 to 16) and depress [ST]
B) Enter Register Number and depress [#]
C) Enter IP Address and depress [#]
D) Repeat A through C until all terminals in the system have been set, up to 16.
E) Press [AT/TL]

Example: 1 [ST] 1 [#] 192 168 000 001 [#]
2 [ST] 2 [#] 192 168 000 002 [#]
3 [ST] 3 [#] 192 168 000 003 [#] [AT/TL]

Thank you Call again
Your receipt

10-07-04 THU #0
PX169
#01 #1 192. 168. 0. 1
#02 #2 192. 168. 0. 2
#03 #3 192. 168. 0. 3

0010 12:48TM

3) PC Transmission Information Setting
Mode Lock: Set Position
68 [@/for] 1 [ST]

A) Enter PC IP Address and depress [#]
Example: 192.168.000.100

B) Enter 2 [ST] and enter the port setting 49155 depress [#] (DO NOT CHANGE
THE PORT)
C) Press [AT/TL]

Thank you Call again
Your receipt
10-07-04 THU #0

PX168
#1 192. 168. 0. 100
#2      49155
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    0009 12:24TM

4) Hourly Range Table Setting (Submode 7) (For report purposes in L-BOSS, the
full range of hours have to be programmed as shown in the example)

7 [@/for] 0100 [#] 0200[#] 0300[#] 0400[#] 0500[#] 0600[#] 0700[#] (Continue
through) 2400 [#] [AT/TL]

Thank you Call again
Your receipt
10-10-04 THU #01
P07
1:00 TM
2:00 TM
3:00 TM
4:00 TM
5:00 TM
6:00 TM
7:00 TM
8:00 TM
9:00 TM
10:00 TM
11:00 TM
12:00 TM
13:00 TM
14:00 TM
15:00 TM
16:00 TM
17:00 TM
18:00 TM
19:00 TM
20:00 TM
21:00 TM
22:00 TM
23:00 TM
24:00 TM

Sample LAN Configuration
The TEC MA-1595 use a fixed IP address. If registers are added to an existing network,
check with stores network personnel for IP address, subnet mask, and gateway address
that can be used. If the register is in a standalone network (one PC using L-BOSS), any
IP address, subnet mask, and gateway address can be used – follow standard IP
address configuration. The following is an example that can be used with 1 PC and
three MA-1595.

PC IP address set in network settings
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TCP/IP: 192.168.0.100
Subnet mask: 255.255.255.0
Gateway: 0.0.0.0

Master MA-1595 # 1
IP Address: 192.168.0.1
Master IP: 192.168.0.1
Subnet Mask: 255.255.255.0
Gateway: 0.0.0.0

Backup Master MA-1595 # 2
IP Address: 192.168.0.2
Master IP: 192.168.0.1
Net Mask: 255.255.255.0
Gateway: 0.0.0.0

Satellite MA-1595 # 3
IP Address: 192.168.0.3
Master IP: 192.168.0.1
Net Mask: 255.255.255.0
Gateway: 0.0.0.0

2.5.2.2 Adding the L-Register option

Fro m the  L-BOSS scre e n o p e n the  File  me nu a nd  se le c t the  Co nfig ura tio n o p tio n.
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From the L-BOSS Configuration menu open the Load files tab.
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From the Load file menu press the From disk button. Locate the LRegister option file on the
CD or from your download location. Select the file and press the Open button. This will copy
the LBO data from the CD to your L-BOSS Available loads list (the lower portion of the
Load files tab window.)
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Once you see the file LRegister on the Available loads list press the Load selected files
button. This will install the option files needed to use L-Register.

PS: The Lregister version may differ from this screenshot.

2.5.2.3 Terminal set-up

L-BOSS Terminal Table Setup

Please refer to the L-BOSS guide's terminal set-up for a complete explanation of creating
terminals and targets with L-BOSS. This explains the difference when working with the TEC
ECR.

As with any terminal within L-BOSS, ECRs must be present as terminals for
communications to function normally. For example, when the "Deploy All Changes" event is
executed, L-BOSS relies on the Terminal Table to know which terminals should receive the
communication.

ECRs can only be reached through the "Master" ECR, which then conveys information to
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other ECRs in line. 

Terminal PC name: Name of the computer where the L-Register application is running.
Usually same as the L-BOSS 901 computer name. 

2.5.2.4 Events to communicate with the ECR

The LBO installation creates several new events to handle ECR communications. These
events are all contained in the ECR communication event after the LBO is installed.
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Refer to the Events set-up for more information on how to add, modify or remove events.

2.5.2.5 L-Register set-up event

Use the LRegister setup event to modify the settings L-BOSS uses with the ECR's. The
following windows appear:
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Clear report:

Don't send to register: This flag is available to stop sending data to the ECR. May be
required at some point to allow sending data to the Lregister database but not to the lanes.

Configure: Press this button and the following window will appear:

[GENERAL tab]
Store: Enter the store number.
Outbox: This is the folder where L-Register will save the data from the ECR. It must match



L-BOSS User Manual 4.1.3456

© 2001-2014 ... Logivision

the terminal's Outbox in the terminal set-up of L-BOSS.
Age 1 trigger: Enter the age 1 trigger value for the ECR's age verification feature (Sub-mode
41).
Age 2 trigger: Enter the age 2 trigger value for the ECR's age verification feature  (Sub-
mode 41).
Keep raw data backup: This will keep a copy of the data sent to the ECR in its native
format.
Days: Number of days to retain the raw data.
Number of cashiers: Enter number of cashier records in the ECR.
Number of PLU's: Enter number of PLU records in the ECR.
Number of customers: This feature is not supported.
Use second language: Select this option to send alternate language data to the ECR (such
as PLU descriptions.)

[COMMUNICATION tab]
Master's settings

IP Address: Enter the Master register IP address.
Port number: Enter 49155

System option settings
PLU local file: Make the selection that corresponds to your ECR settings
Cashier local file: Make the selection that corresponds to your ECR settings
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Time intervals
Merge(Msec): Enter 7000 unless instructed otherwise
Programming(Msec): Enter 15000 unless instructed otherwise
Comm timeout (Msec): Enter 30000 unless instructed otherwise

Register table: Select the number of registers used in the store.

[Report Definition]
Use this tab to modify the report settings if required.
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[EJ Definition]
This menu can be used to modify the EJ record interface. It is recommended to consult with
your TEC dealer before modifying the values on this page.

2.5.2.6 Recover data from existing ECR

The 1595 Utility AUTOBACK UP ROUTINE. DO NOT CLOSE once this event is
executed.

This utility allows you to retrieve your data and it will be saved to the "\L-
BOSS\LRegister\Utility\PGMFILE\" folder. Select the files which you would like to read from the ECR. 

To get the data into L-BOSS you must take the files that are saved to this folder and move them to the
"L-BOSS\Office\Inbox" folder. Once moved select the files and remove the Archive bit setting. L-BOSS
will import the files to your existing database. The data imported will replace your existing data.

2.5.2.7 Initial load to ECR

Initial Load to ECR
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Now that the database alias, L-BOSS terminal and communication setups are complete, the
last installation step is to send the current L-BOSS information to the register. The "Deploy
and Replace" Event / Task must be executed, with the register's terminal as the "Target".

 

After successfully programming the register with the PLU and Clerk tables, the basic
installation is complete. The last factors to consider have to do with testing operations on the
register, and reviewing sample reports to be sure that all register functions that collect
amounts or other values display correctly in L-BOSS reports. 

2.5.2.8 POS tabs new fields

POS Tab 

Item (PLU) Maintenance: POS  Tab 
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This example shows the Item table's "POS" tab. 

POS  Target:  This field is used in multi-store environments when the status flags for the
items are not the same in all stores. To understand the Terminal table programming, go to
the Terminal table help page in the L-BOSS help file. The default target for items is PAL. To
change the target for an item, double click the Target field of the POS table and select the
new target from the drop down list. Targets are only available if they have been programmed
as an Item target in the Maintenance application's "Register " menu "Terminals " option. 

Follow  Sub-dept:  This feature is not supported by the TEC ECR.

Taxable 1:  Select this flag if tax rate 1 should be applied when this item is used. 



L-BOSS Menus 461

© 2001-2014 ... Logivision

Taxable 2:  Select this flag if tax rate 2 should be applied when this item is used. 
Taxable 3:  Select this flag if tax rate 3 should be applied when this item is used. 
Taxable 4:  Select this flag if tax rate 4 should be applied when this item is used. 
NOTE: The tax rate must be programmed at the TEC ECR to apply tax.

Food  Stamp:  Select the food stamp flag if this item can be paid for with Food stamps and
you are in a jurisdiction that accepts food stamps. 

WIC1-2-3: These flags are not supported by the TEC ECR.

Prohibit discount:  This feature is not supported by the TEC ECR.

Prohibit  Quantity:  This feature is not supported by the TEC ECR.

Quantity  Required:  Select this flag if a quantity entry is required before the item can be
sold. This is often the case for items sold, for example, at 3/$1.00 and when the cashiers are
unsure whether scanning one item will ring 3 items for $1.00 or 1 item at 34 cents. 

Price  Required:  This item status creates an "open-priced " item. It means that the item will
behave like a sub-department, forcing the cashier to manually enter a price for the item. 

Visual  Verify:  This feature is not supported by the TEC ECR.

Not for  Sale:  Use this flag to restrict the sale of this item temporarily, as in the case of
seasonal items not available year-round. This allows you to leave the PLU in the Item table,
but not allow POS operators to inadvertently sell the item. 

Hash  Item:  This flag is used to exclude the sales of this product from the store's Net and
Total sales. This is sometimes the case for items or departments used for bottle sales,
lottery returns, etc. This feature is not supported by the TEC MA-1595 or MA-1650.

Gas PLU:  This feature is not supported by the TEC ECR.

Scalable:  This flag defines that the product is sold by weight read from the POS scale. This
flag should not be selected for pre-packaged and pre-priced items such as items weighed
and labeled for scanning at the POS. 

Manual  Weight:  This feature is not supported by the TEC ECR.

Override  Allowed:  This feature is not supported by the TEC ECR.

No  Repeat:  This feature is not supported by the TEC ECR.

No  Refund:  This feature is not supported by the TEC ECR.

No  Return:  This feature is not supported by the TEC ECR.

Bottle  Return:  This feature is not supported by the TEC ECR.
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Validation  Req'd: This feature is not supported by the TEC ECR.

MPF:  This feature is not supported by the TEC ECR.

SI-1: Selective Itemizer 1 - To allow discounts on selective items.

SI-2: Selective Itemizer 2 - To allow discounts on selective items.

Price Print Off: The price will not print on the reciept when this flag is used.

Manual Tare / SI-4: Forces the operator to enter a manual tare on this plu.

SI-3: Sets selecteive itemizer 3.

Vendor  Coupon:  This feature is not supported by the TEC ECR.

Store  Coupon:  This feature is not supported by the TEC ECR.

Divisor:  (Scalable items only) Double-click in this option window when you want to use a
different measure than the default pound or kilogram when this product is sold. The POS will
divide the weight by the divisor you select before calculating the price. Supported by the TEC
MA-1595 and the MA-1650.

Tare  Link:  This flag is used to define a weight (normally the packaging) to be deducted from
the total weight when the product is sold. To assign a tare value, double-click in the tare link
field and select the correct tare value for the item. The Tare table is programmed using the
Maintenance application's "PLU" menu "Tare Table" option. If the correct tare value does not
exist, you must open the tare table and add a new record or modify an existing record. Tare
Table programming on the TEC ECR.

Var  Tare:  (Variable tare). This flag should be selected whenever the tare value is a
percentage of the total weight of the item. Enter the percentage of the total weight to use for
tare removal. 

Bottle  Link:  This flag is available to automate the charge for bottle deposit in areas where
deposits are charged on items like soda, beer, etc. Select the link that is programmed with
the appropriate bottle deposit amount. 

Promo ID: This feature is not supported by the TEC ECR.

Restrictor:  This feature is not supported by the TEC ECR.

Client  Age:  This setting is available to restrict the sale of age-sensitive products such as
tobacco or alcohol.  The value of 18 or 21 is programmed in the LRegister, Setup
Configuration.

Oper  Age:  This feature is not supported by the TEC ECR.

Label:  The Print  flag is used internally by the system. It is selected when a price is changed
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so that a label will be printed for this item the next time you print labels. The Type window
allows you to select a label type that you want to use for this item. Double click to select from
the available labels you have on your system. 
NOTE: Label is an optional module availalable from your Authorized Toshiba TEC
America Dealer. If this module is not purchased in addition to the L-BOSS Software
the following options are not available. 

Link To: Links to other PLU Price

2.5.2.9 Sub-department programming

Sub-Department Table Settings 
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This example shows a Sub-department table record. 

Sub-Department: Is used to enter the record number this sub-department will use. The sub-
department is also the department number on the TEC ECR.

Department: Is a compulsory link that associates the product to a larger group for reporting
purposes.  This field is to program the Minor Groups at the TEC ECR, valid entry is 0-30. 

POS target: Use this filed to select the target for this sub-department when you are working
on a headquarters system. For example, when you need to send different tax programming to
different target zones this will be how you do it. 

Main Description: Is used to set a main item descriptor used on the report system.  The
TEC ECR will support 16 alphanumeric characters.  L-BOSS does not support double sized
characters. LRegister sends the first 16 alphanumeric characters to the ECR.

POS Description: Field allows you to enter 2 descriptions that are used to give a description
which will appear on register receipts if the sub-department is used for manual sale entry. 

Taxable 1: Select this flag if tax rate 1 should be applied when this item is used. 
Taxable 2: Select this flag if tax rate 2 should be applied when this item is used. 
Taxable 3: Select this flag if tax rate 3 should be applied when this item is used. 
Taxable 4: Select this flag if tax rate 4 should be applied when this item is used. 
NOTE: The tax rate must be programmed at the TEC ECR to apply tax.

Food stamp: Select the food stamp flag if this item can be paid for with Food stamps and
you are in a jurisdiction that accepts food stamps. 

WIC1-2-3: This feature is not supported by the TEC ECR. 

Prohibit discount: This feature is not supported by the TEC ECR. 

Override allowed: This feature is not supported by the TEC ECR. 

No refund: This feature is not supported by the TEC ECR. 

Scalable: This flag defines that the product is sold by weight read from the POS scale. This
flag should not to be selected for prepackaged and pre-priced items or those weighed and
labeled for scanning at the POS. 
NOTE: Scalable and Gas Cannot be set at the same time at the ECR, however L-BOSS can
set and send both settings and the ECR will accept it.

Manual weight: This feature is not supported by the TEC ECR. 

Not in gross(Hash Status): This flag is used to exclude the sales of this sub-department
from the Net sales and Total sales of the store. This is sometimes the case for sub-
departments used for bottle sales, lottery returns, etc. 

No pts redemption: This feature is not supported by the TEC ECR. 
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Si-3: Sets selective itemizer 3.

Validation req'd: This item will require validation on the ECR.

General ledger: Enter the GL to use for posting ssales with the GL interface option.

D or C 9Debit/Credit): Related to GL, is this account a debit or credit account.

Restrictor code: This feature is not supported by the TEC ECR. 

Customer age: This flag is available to restrict the sale of age-sensitive products such as
tobacco or alcohol. When this flag is set, the first item entered will prompt for customer age. 
The value of 18 or 21 is programmed in the LRegister, Setup Configuration.

Operator age: This feature is not supported by the TEC ECR. 

Max amount (High amount): Is used to set the maximum dollar value that can be keyed into
the sub-department during a register transaction. The TEC ECR will only support 7 digit 0.00
- 99,999.99. 100,000 or greater L-BOSS will send 99,999.99, the maximum value and a
message is reported.

Min amount (Low amount): Is used to set the lowest amount that can be keyed into the sub-
department during a register transaction. The TEC ECR will only support 7 digit 0.00 -
99,999.99. 100,000 or greater L-BOSS will send 99,999.99, the maximum value and a
message is reported.

Max void: This feature is not supported by the TEC ECR.

Max refund:  This feature is not supported by the TEC ECR.

[ECR's specific]
Preset Price : Preset price set to the ECR department. The TEC ECR will only support 6
digit 0.00 - 9999.99 or 999.999. 10,000 or greater L-BOSS will send 9,999.99, the maximum
value and a message is reported. Programmable address 3 in department programming on
the MA-1595. The field is a price field but does support 3 digits to the right of the decimal point
for gas.

EX; Gas Flag no set on L-BOSS
           Enter Data             Display                ECR

1.789 1.79 1.79
1.999 2.00 2.00
1.225 1.22 1.22
1.235 1.24 1.24

Sub-Link#: Forced Link in department programming at the TEC ECR.

Single Item: The entry sequence will immediately finalize the sale as cash sale when
operated outside a sale.
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Negative: Allows a department to have negative transactions.

Gas: Used to enter gasoline sales. Gasoline sales cannot be used as the preset type. The
sale amount of gasoline must be entered.
NOTE: Scalable and Gas Cannot be set at the same time at the ECR, however L-BOSS can
set and send both settings and the ECR will accept it.

Split Package:  This feature is only supported by the TEC MA-1595 and MA-1650.

Store Coupon: This feature is only supported by the TEC MA-1595 and MA-1650.

Compulsory (Manual) Tare: To allow a manual weight entry for this product.

SI-1: Selective Itemizer 1 - To allow discounts on selective items.

SI-2: Selective Itemizer 2 - To allow discounts on selective items.

Price Print off: TEC MA-1535 option only.

Gift card dept: Use this to set the item as a gift card sales department.

2.5.2.10 Operator programming

An extra tab related to the TEC ECR is added when the L-Register option is installed.
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Open the ECR Specific tab to set the  operator type for the TEC MA 1595. Operators can be
set to:

Cashier
Cashier for training
Supervisor

Refer to the L-BOSS operator guide section for further information on programkig operators.

NB: You must use sequential numbers when programming the operators. If the register was
set up for 20 operators you must create operators 01 to 20. Youy cannot use a number
higher that 99 when working with the TEC ECR. The user number must be 2 digit numeric.
The password must be 2 digit numeric.

2.5.2.11 ECR Reports

The LRegister option adds new reports to allow X or Z of the ECR.

You will see the ECR X report folder and the End of day (LRegister) reports to use with the
ECR's.
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2.5.2.12 Field numbers in system Error messages

Overview: 

Errors with Plu's, sub departments, cashier, operators

Field Numbers alert the operator of an 'out of limit entry' in the L-BOSS program. In the event
that this occurs from one of the following areas: PLU, Sub-Departments, Operators, etc. a
log is provided in Field Numbers to assist the operator. 
L-BOSS will display a window during communications with a Field Number ex: Field: F1007
out of limit. This number represents the option that was programmed incorrectly, or an
erroneous entry put in the field. By referencing this number from the Urgent Message window
to the Field Numbers description provides a quick reference to rectify the incorrect entry. If
the Field Number is not listed in the Urgent Message please contact your Authorized Toshiba
TEC America Dealer.

PLU Field Numbers and description

F04 = Sub-Dept., Department Link, Valid entry field 1 to 99. Address 1 on the TEC ECR. 

F06 = Tare Link, Tare Table Number, Valid entry 0 to 9. Address 11 on the TEC ECR.

F18 = Report Code, PLU Group Number, Valid entry 0 to 99. Address 9 on the TEC ECR.

F1007 = Package Price, Valid entry 0.01 to 9999.99, positive entry only.

F1126 = Cashier Number, Valid entry 1-99. If cashier number is set to 100 or greater, 99 is
sent to the TEC ECR. 100 or greater is for a L-BOSS Operator only.

F1138 = Var Tare, Tare 2 Rate, Valid entry 0.01 to 99.99, this is a percentage (%) field.
Address 14 on the TEC ECR.
 
F1203 = Base Price, Valid entry 0.00 to 9999.99, positive entry only.

F1204 = Package Qty, Max. 2 digit entry, Valid entry 0 to 99. Address 8 on the TEC ECR. 
NOTE: Package Quantity will not be sent unless Package Price has a price set other than
0.00
 
F1207 = M&M (Mix and Match), Mix and Match Group Number, M&M number will not be sent
unless base and package price and package quantity are set. Valid entry 0 to 255 . Address
13 on the TEC ECR.

F1225 = Dollar Discount, Valid entry 2 digits, 0 - 99. 100 or greater will send 99 to the TEC
ECR. Adress 15 on the TEC ECR

F1237 = Divisor, Unit Weight Code, Valid entry 0 to11. Address 12 on the TEC ECR. 

Subdepartment field numbers and description

F03 = Link Group, Valid entry field 0 to 30. Address 1 on the TEC ECR Department
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programming.

F05 = Bottle Link, Link Plu Table Number, Valid entry 0 to 99. Address 10 on the TEC ECR.

F30 = Preset Price, Valid entry 0.00 to 9,999.99 or 999.999. Address 3 on the TEC ECR
Department programming.

F239 = Max Amount, Valid entry 0.00 to 99,999.99. Address 7 on the TEC ECR Department
programming.

F240 = Min Amount, Valid entry 0.00 to 99,999.99. Address 8 on the TEC ECR Department
programming.

2.5.3 Form Manager

Form Manager Module Overview

NOTE: Although the Form Manager is included in your L-BOSS installation and is fully
functional, it must be registered before you can save L-BOSS report, L-POS form, or
item and shelf label templates.

The Form Manager is an L-BOSS module used to design the visual and content aspects of L-
BOSS reports (including item and shelf labels) and L-POS "form" layouts. Both L-BOSS and
L-POS ship with basic report and form templates that meet the needs of most retail
businesses. In some cases, your Logivision  dealer may have included specialized reports. If
the reports and forms that were included in your installation adequately display your
information, you do not need the Form Manager.

The Form Manager uses a visual programming interface that allows the user to "drag and
drop" fields and other design elements (objects) on a "template", making it simple to create
visually attractive reports. The Form Manager provides a complete set of tools to configure
report and form templates as well as item or shelf labels. The tools are designed to work with
data fields, graphic elements (including line and rectangle drawing tools), and formulas for
report time calculations.

L-BOSS Report Template Files

Each L-BOSS report file (.sql) has an associated template file (.frp) that controls the report's
on screen and printed format, along with special formulas that allow data manipulation within
the template. The report template uses fields that are linked with the fields in the report's SQL
file to report the SQL query results. 

L-POS Form Template Files
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Front end L-POS terminals can also print reports by requesting information from the L-BOSS
controller. Because the L-POS reports are often printed on the receipt printer, they cannot
use the same template as the L-BOSS reports. L-POS templates are called "Form"
templates to help distinguish them from back office "report" templates.  

Shelf and Item Labels

The Form Manager is also used to create templates for item or shelf labels, allowing you to
configure the label page layout (columns and rows), label contents, such as bar code,
description, price, and other common label type information.

2.5.3.1 Template Editor

Form and Report Template Editor

Opening an Existing Template

The Form Manager can be launched as a "stand alone" application from the L-POS Windows
application menu. It is also possible to select a report file using the Report Selection tool, right
clicking it opens a menu. The "Property" option opens a panel that contains the report's
configuration. The name of the template file for the report is entered in the "Template File"
properties field. 

To the right of the Template's .frp file name, the  button opens the Form Manager's
template editor.
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This example shows the cashier report template in the Form Manager's Editor

Template Objects

Anything that appears in the template is called an "object". When selected, objects display
"nodes" that are used to re-size the object.

When a corner node is selected, the cursor changes to a double ended oblique arrow,
used to re-size both horizontally and vertically at the same time. Hold the cursor over
the corner node. Click and hold down the left mouse button and drag the corner node
to re-size the object. 

The center nodes (between the corners) re-size either horizontally or vertically,
depending on the node selected. When a center node is selected, the cursor changes
to either a horizontal or vertical double ended arrow. Hold the cursor over the center
node. Click and hold down the left mouse button and drag the center node to increase
either the height or width of the object.

Once an object is selected, (showing its nodes) you can move it by pointing the
cursor over the object, anywhere within the nodes. Click and hold down the left mouse
button, dragging the object to its new template location.

The template page uses color to distinguish between "Label", "Field" and "Prompt" objects:
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Label objects are yellow, and contain titles that describe the type of information, often
column titles.
Field objects are green, and contain fields associated with the SQL file's SIL fields
that their data comes from.
Prompt objects are blue, and are the variables used in the report's SQL file to collect
information from the user.
Graphic objects (lines and rectangles) are black.

Image objects are not assigned any color, they appear as graphic images. (.bmp
only)

NOTE: If you enter more than one field in an object box, it will also appear blue.

Object Right Click Menu

Once an object is selected, right clicking over the object opens a special menu containing
object controls and options. The options available depend on the type of object selected.

New Description: (Label objects only) Modify the label's text.

Justify: Used to position the field value or text within the object. It does not affect the object's
template position. The justify utility also has special "Currency" and "Amount" options for
monetary fields.

Center on Page: Places the selected object in the center of the template. It does not affect
the label text or field value's position within the object.

Copy: Used to copy the object to the Form editor's clip board for pasting elsewhere in the
template.

Font: Opens the font panel, allowing you to override the default template font set using the
"Configuration" menu's "Set default font" option. Changes the font for the selected object only

Delete: Remove the selected object from the template.

Condition: This option is used to determine how the object behaves in multi-page reports,
and if it should display zero values.

All Pages: Use this condition if the object should appear in all report pages.

Last Page Only: If the object should appear on the last page only.

First Page Only: If the object appears on the first page only.

Zero Suppress: If this object should not appear in the report if it has a value of zero
(0.00).

Formula: (Field and Prompt objects only) Opens the formula entry box to use a calculation
for the field's value.

NOTE: If a field is not wide enough for the text that appears in it, the text will be cut off at the
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field limit. However, if the field's height will accept a second line (depends on font size) the
Form Manager will extend the text to the second line, known as "text wrapping".

2.5.3.2 Tools

Top Bar Tools and Options

NOTE: Because the Form Manager edits both L-POS Form templates and L-BOSS report
templates, some options or tools may only apply to forms and some only to reports. In this
help, if an option or tool does not specify which type of template the option or tool is used for,
it is available for both template types.

The Form Manager's top bar show's the template's title assigned when it was created. To
change an existing title, use the "File" menu's "Save As" option. This will open a panel asking
for a new description for the template file. After entering the new description, select the same
file name, overwriting the previous version.

Ln: (Forms only) LINE For L-POS form templates, if you have defined columns, select this
option to have column lines appear on the printed output.

Detail Count: (Forms only) Determines how many details appear on the L-POS printed
output. 

Add Label: This button creates a new Label object for the template. Clicking it opens a Label
editor, where you can edit the text that the label will display in the report. The "Justify" option is
used to position the field value or text within the object. It does not affect the object's template
position. After clicking the "OK" button, point the mouse cursor anywhere in the template and
click to have the new label object appear. You can then determine its final template position
and size using the "nodes". NOTE: You can also change the label's justification after it has
been created by selecting the object and right clicking it to open the object menu and
selecting the "Justify" option.

Select Field: is used to create a new template field object. Field objects are normally
associated with the report's .sql file. When the report is generated, the field object value is
determined by the query.

Line Tool: Use this tool to create horizontal or vertical lines to graphically define special
report or form areas in the template. The line is a graphic object only, it cannot have any
values.

Rectangle Tool: Use this tool to create rectangles to graphically define special report or
form areas in the template. The rectangle is a graphic object only, it cannot have any values.
The rectangle tool is also used to define a "frame" for a graphic object (.bmp file format only).
After drawing a rectangle, right click the object and select the "Image" option. A file browser
opens the default L-BOSS image folder. If required, navigate to the image's source folder,
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and select the image object. Once the image object is contained in the rectangle frame, it
takes on the frame's dimensions. You can re-size the frame to display the image properly.

Cursor X / Y Position: The X and Y boxes show the current cursor position if you have the
"Configuration" menu's "Show position ruler" option set to on.

Object Dimensions: W is the selected object's width, H is the selected object's height. The
object's measurements are in inches unless the "Configuration" menu's "metric" option is set
to on (changing the rulers), then it is measured in centimeters. NOTE: If you change the ruler
with an object selected, the measurement values will not change until you unselect and re-
select the object.

Grid Size: The Form editor uses an invisible "grid" to place objects in the template. When
placing objects in the template, they will "snap to" the invisible grid lines. Grid lines help you
align objects in the template. The grid spacing can be adjusted using the grid size setting.

Language: You can temporarily change the language setting for the report to allow for
differences in label or field text that must be resolved to ensure that the report prints correctly
in either language. The language setting is not saved with the template. The default
language for a report is defined in its properties.

Rulers: The Form Manager displays horizontal and vertical rulers along side and above the
template to assist in aligning objects. Click and drag the red arrow (top left corner of the
rulers) along the top ruler to use a line to help align objects vertically.

2.5.3.3 Menus

Form Manager Main Menus

File Menu

The "File" menu contains typical file operations and configuration tools for several options.

New: Open a new Report or Form template.

Open: Open an existing Report or Form. This opens a typical Windows file browser,
displaying the files in the default L-BOSS\Office\Rpt folder. Use the "Files of type" option to
choose between Form or Report templates. 

NOTE:The Form Manager can open text type files, for example L-BOSS .sql command
files. When a text type file is selected for editing, the Form Manager "locks" or greys out
certain options and tools that are for graphic use only.

Save: To save the open template, keeping the same name.

Save As: Used to save a template under a new name.
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Print Test Page: Opens the Windows printer options panel, allowing you to send a "test"
layout page. The template appears in a "print pre-view before being sent to the printer. The
test page doesn't contain data, but is handy to view what the page will look like, and verify the
fields used.

Labels: This option controls the label page setup in terms of columns and rows, spacing
between the labels (both horizontally and vertically). Also the label page margins. Based on
the information you enter here, and the "Page Setting" option (determines the page size), the
bottom portion of the label setup tool shows the number of labels per column and row.

This example shows the Form Manager's label page setup 

The measure used (inches or centimeters), depends on the template's rulers, set using the
"Configuration" menu's "Metric" option. Enter the correct values for label width, height, the
gaps and margins. You can either click the field and enter the number, or with the cursor in
the field to modify, use the up and down arrow keys to increase or decrease the value.

Rotation:
Rotation can be set on each individual labels and/or on each individual descriptor. Use the
descriptor rotation only when you are required to have different orientation on the same label.
Otherwise, the label rotation is much easier to use.

The rotation of a descriptor (and field) is done directly in the form manager under the Justify
menu of each descriptor and field. You may only rotate them by 180 degrees (upside down).

The rotation of the complete label is done in the LRP file of the report. Rotation can be set to
0, 90, 180 or 270 degrees. You can only use the 0 and 180 together, or 90 and 270 together
(within the same form). ie. you cannot have labels set to 0 and 90 within the same label.

To use this rotation, you must create a section ROTATE in the lrp file. Then the orientation of
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the first label is Label0 and the second label is Label1 and so on...

Example:

[ROTATE]
Label0=0
Label1=180
Label2=180
Label3=0

Page Setting: This option is used to establish the size of the page being produced by the
current template. The measure used (inches or centimeters), depends on the template's
rulers, set using the "Configuration" menu's "Metric" option.

This example shows the Form Manager's page setup

Records

Some reports contain repeating lines of the same information, based on a changing field, for
example item or PLU sales. Each line is a report "record" that includes the same information
for each line. The "Records" menu allows you to define a repeating report line's contents.

Create the item record: Select this option to create a repeating line "box" (area) to define
the individual item fields that will appear in each line. Once selected, you must point and click
somewhere within the template. After the record box is created, you can move it or re-size it
to suit the report needs.

Create a new tender record: Tender records are used to define the template area that will
display tender amounts by type. Similar to the item record, the tender record will repeat for
every tender type with an amount in the report.

Use SQL Mask: This option controls which fields appear in the "Field" selection drop down
list tool. Selecting this option opens a file browser, allowing you to select the .sql command
file to use. The "Select field" list will contain only the SIL fields found within that command file.
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Configuration

Set default font: Opens the font option panel, allowing you to establish the default font for
the form or template. Label objects and field results will be displayed with the default font
unless you specifically change the object's font using the right click menu "font" option. In
other words, you can set the default font, then use variations where required.

Show position ruler: The position ruler displays a position marker above the horizontal and
vertical page rulers. It also causes the Form Manager to track the cursor's X / Y position
displayed at the top of the Form Manager. Setting the "Show position" option to on uses more
system resources, and may slow down the system.

Auto load last file: The Form Manager is a stand alone application. It can be launched from
a report's "properties" box, or from the L-POS Windows menu. Set this option to on if you
want the Form Manager to re-load the most recently used template at start up.

Auto repaint: Some screen displays seem to have difficulty re-drawing the template when
objects are moved or modified. Set this option to on if you notice that objects in the template
disappear, forcing the Form Manager to re-paint the screen more often.

Metric: The Form Manager can be set to use either metric or inch measures. When
selected, this option forces the rulers and page settings to metric measures. The Form
Manager uses inches by default, the metric setting must be re-set each time you launch the
application.

Object Inspector: Is used to display all information about the selected object, including
object dimensions, page position and other object attributes. The Object Inspector can be
placed anywhere on the Form Manager desktop, or made to "Dock" on the right side of the
window.
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This example shows the Form Manager's Object Inspector

NOTE: To dock the Object Inspector, click its top bar and drag the inspector to the right side
of the Form Manager. When the Object Inspector is being moved, the Form Manager shows
the Inspector's outline. When the Object Inspector reaches the right side, the outline will
"snap" to the side of the window. Releasing the Object Inspector at this point "docks" the
Inspector. It can only be docked on the right side of the Form Manager window.

Re-snap to grid: The Form Manager uses a hidden "grid" to help position objects on the
form or report template. This option forces all objects to "snap to" the closest invisible grid
line.

2.5.4 LogiLicence

LogiLicence is used for L-POS and L-BOSS license control. LogiLicence captures a
hardware snapshot and sends unique information about that hardware to our licence servers.
The licence server generates licence data for that hardware and transmits the licence
information back to the store.  LogiLicence validates licence information periodically by
connecting to our licence servers. This is done over a secure internet connection.
LogiLicence sends a request and the licence server responds. This is transparent to the
user. LogiLicence requires use of secured port 443 for exiting messages.

The help in this file explains how to use and install Logilicence in this version. Please refer to
the file LogiLicence.PDF for information on how to use and install LogiLicence for older
versions, or how to update from KeyReader and a hardware dongle to Logilicence. The file
will be found in the L-BOSS program files folder with the other help filles.

2.5.4.1 Ordering a licence file

Until recently we shipped hardware keys to control the software. We are now shipping licence
files by email. The cost of the licence file is the same as the hardware key. We recommend
that you should have blank licence files available for a last minute installation to avoid delays
with ordering and preparing the licence file for that store. Preparation of the licence file
requires registration, database entries and accounting. We require a few days lead time to
send the licence files. You can order blank licence files and store them somewhere safe.
They will be invoiced the same way the blank keys were invoiced. The licence file has no
options when sent to you. When you connect your system with our Licence server your
hardware information is exchanged. At that point the options ordered for the store will be
enabled in the licence file. 

2.5.4.2 Requirements

To use LogiLicence with L-POS / L-BOSS make sure you have:
1. LogiLicence Service Install.exe This file is installed with L-BOSS to the L-BOSS program files

folder..
2. A Licence.temp file from Logivision that contains the software serial number. This file will be

emailed to you rather than a hardware dongle.
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3. Your computer must connect to the internet and port 443 must be open for exiting requests.

2.5.4.3 Installation

1. Run LogiLicence Service Install.exe
2. Follow the prompts to install the application.

3. A new icon  will be added to the system tray to allow easy access to the LogiLicence
application.

4. Once the program is installed the service will start automatically and it will search for the
Licence.temp file. The LogiLicence program window will ask you if you want to browse
computer to find your licence

5. Select the licence.temp file (DO NOT rename this file, ever!)
6. If the licence.temp file was valid the Read licence file button will be replaced by an Update

licence file from host button.
7. Press the Update licence file from host button to activate the store's options.(there will be a

first communication with our server, and the server will send back the key options to the
store)

8. Once the first communication done with success, the licence.temp will become a licence.
lic. We recommend you keep copies of the licence files after they have been activated or
whenever a new option is added. If a hard drive crashes over a weekend you will need that
licence file to activate the software licence on a new machine. 

9. Attach a USB drive to the PC that runs the LogiLicence application to save the activated
licence file.

10.Open LogiLicence > Operations option menu, Select Save licence file to USB.

Note: Since all licenses are named Licence.lic, it's better to zip your file and rename the
document to the name of the store. A good way to keep a copy would be to host the file, like if
you send it to a email, this way you can access the file without requiring a USB on you.

2.5.4.4 Moving a Licence file

If you need to repair a hard drive or replace a computer running LogiLicence you will need to
move the licence to the new hardware:
1- Open the LogiLicence Viewer.
2- Press the Move the licence to another computer button. You will be warned about the

number of times the licence can be moved before you need authorization to move again.
This is designed to allow you to perform hardware updates without contacting Logivision.

3- Select Yes. This prompt will appear:
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4- Now you need to save the Licence.lic file that you are moving to a new machine. Open the
Operations menu from the LogiLicence Viewer screen.
a. If you have a USB stick that was plugged in and functional you can select the option

Save licence to USB. This option will save the Licence.lic file to the root of the USB
device.

b. If you want to copy the file manually use the Operations menu from the LogiLicence
Viewer screen and select Browse Licence Folder.

5- To copy the Licence.lic file to the new machine open the Operations menu from the
LogiLicence Viewer screen.
a. If you saved the file to a USB stick plug it in and wait until it is ready for use. Select the

option Get licence from USB. This option will retrieve the Licence.lic file from the USB
device.

b. If you want to copy the file manually use the Operations menu from the LogiLicence
Viewer screen and select Browse Licence Folder.

2.5.4.5 Retain a backup copy of the licence file

We recommend you keep copies of the licence files after they have been activated or
whenever a new option is added. If a hard drive crashes over a weekend you will need that
licence file to activate the software licence on a new machine. We are working on our on-line
database query to allow you to retrieve the licence file yourself. But until that’s ready our
advice is to keep a copy of each licence.lic file. Once the software has been activated follow
this procedure to save a copy of the licence.lic file:

Save the activated licence file to a USB drive
1. Attach a USB drive to the PC that runs the LogiLicence application.
2. Open LogiLicence.
3. Open the Operations option from the top menu.
4. Select Save Licence To USB.
5. The file will be copied to the USB drive.

Browse the folder to save the activated licence file to another location
1. Open the LogiLicence Viewer.
2. Open the Operations option from the top menu.
3. Open the Browse licence folder option.
4. Select the Licence.Lic file and copy to the location that you want to save to.
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2.5.4.6 LogiLicence viewer window

Logilicence Viewer 1

1- Licence number assigned to this location by Logivision
2- Licence file status
3- Licence server status
4- Last startup of the Logilicence service
5- Local L-BOSS store number : allows you to set the store number to be used with the

LogiLicence file. This way your demo can be set up with different store numbers for
different applications.

6- Licensee name
7- Next scheduled re-validation date where the Logilicence will connect with the Logivision

licence server
8- Software compiled up until this date can be installed
9- Logilicence service software version
10-L-BOSS software version
11-Language of the viewer
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12-Quantity of L-POS terminal that can operate from this licence
13-Quantity of L-BOSS terminals (901, 902, etc.) that can operate from this licence
14-LBOSS Type that can be installed with the key (Store, Regional, or Central)
15-Quantity of ECR’s that can operate from this licence
16-Quantity of fuel pumps that can operate from this licence
17-Number of emails that can be sent by month
18-L-POS option form one displays modules that can be used by the licensee.
19-L-POS option form two displays modules that can be used by the licensee.
20-L-POS bank option displays card authorization interfaces that can be used by the

licensee.
21-This button will display READ LICENCE FILE when you have not yet used the option to

read the Licence.lic file or when it cannot be found. The button will display UPDATE
LICENCE FROM HOST when you need to connect with the Logivision servers to enable
the licensed options.

22-This option can be used when you know ahead of time that you need to move the licence
to a new computer.

2.5.4.7 Operations menu

These are the options under the Logilicence viewer Operations menu:
Connect to another service is only used when a local licence viewer needs to connect to a
service running on a different machine. This should not be used unless requested by
Logivision.
Restart the service will stop and restart the service running to supply licence information to
Logivision applications.
Read licence file will force the system to read the licence file.

Browse licence folder will open the browser to the location of the Licence server
application.
View service log displays a list of events recorded by the system.

Save licence to USB will save the Licence.lic file to a USB stick.

Get licence file from USB will search for a valid licence file on a functional USB memory
stick. 

2.5.4.8 Renewing software licence

Logilicence will perform the required connection to the Logivision licence servers
automatically as required. The normal cycle to validate that the licence is intact is every 30
days. Logilicence will actually attempt to connect a few days ahead of time to avoid errors.

2.5.4.9 No internet connection available

The LogiLicence system is used to validate software options that were purchased. When
stores do not have a permanent internet connection you must perform a periodic manual re-
activation. Note that Logivision is not responsible for continuous operation of the system. It is
up to you and your customer to ensure that the licence renewal is performed.
There are two ways to use LogiLicence without an internet connection at the store. You must
request one of these manual activation methods when activating the licence the first time.
More on-line systems will mean less manual intervention and higher profits for you. If you
need to add a new option to a system with no internet access you must use one of the
methods below to obtain an updated licence file that contains the new option.
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NOTE: To activate a new licence for the first time it is compulsory to connect that computer
to the internet for an on-line exchange with the LogiLicence host servers. 

Method 1: Requesting a renewal file from another PC with internet access (for example

the customer has internet at home)

This method can be used by either the customer or the dealer and must be performed before
the end of the usage period. The usage period ends on the date shown in the Licence is valid
until of the LogiLicence viewer window. If you do not renew before this date the 14 day grace
period will begin. At the end of 14 days the backoffice will stop working.

At the store that has no internet access:
1. Open Logilicence
2. Open the Operations menu. 
3. Save licence to USB. The file will be saved to your USB stick. 
4. Take the USB stick to a PC with internet and email access.
5. Send the licence.lic file via email attachment to:
licence@logivision.com 
Subject line must say RENEWAL
6. An updated licence.lic file will be returned almost immediatly. 
7. Save the new licence.lic to the USB stick. Take care to delete or overwrite the old licence.
lic.
8. At the store with no internet access open LogiLicence (operation > Get licence from USB). 
9. The licence will be valid for about 12 months. 
10. This procedure must be repeated each year.

Please note that if the hardware configuration has changed you must connect to the internet
to activate the licence on the new hardware. Consider using a cellular modem, or a standard
phone line and a modem. Otherwise the PC runnning LogiLicence must be taken to a
location with internet access.

Method 2: Email renewal through the dealer
This method sends a licence file to the dealer who registered the licence about 1 month
before the date shown in the Licence is valid until field of the LogiLicence viewer window. The
dealer must install the new licence.lic file received by email before the date shown in the
Licence is valid until field of the LogiLicence viewer window (operation > Get licence from
USB). If you do not renew before this date the 14 day grace period will begin. At the end of 14
days the backoffice will stop working.

Procedure:
1. Save the new licence.lic to a USB stick. 
2. At the store with no internet access open LogiLicence (operation > Get licence from USB). 
3. The licence will be valid for about 12 months. 
4. This procedure must be repeated each year.

Please note that if the hardware configuration has changed you must connect to the internet
to activate the licence on the new hardware. Consider using a cellular modem, or a standard
phone line and a modem. Otherwise the PC runnning LogiLicence must be taken to a
location with internet access.
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2.5.4.10 Licence detection errors

If a system is due for license renewal on Jan 15 it will try to communicate with the Logivision
Licence server starting about Jan 12. If no connection is made by the 15th an error will be
generated and the L-BOSS or the L-POS may report that no licence key was detected since
1 to 14 days depending on how long it has been since last successful connection.

There is a 14 day grace period during which the software operation will not be affected. It is
important that action steps be taken if the “no key was detected” message appears. The
message can be generated by a POS terminal or by the back office terminals. The urgent
message displayed in L-BOSS will include the terminal id of the POS or back office station
that did not receive the licence information. Here is an example:

From: 029001
To: 001901
Date: 16/09/2011 1:11:00 PM
Subject: L-POS: Warning (4.0.0.34)
X-PRIORITY: 1

The software license key has not been detected since 2 days.  Application performance will
degrade until you resolve this problem.
The message header includes a “From” field. In this example above the message was
generated by L-POS terminal 029001 (From: 029001). The terminal number is made up of 3
digit store number and 3 digit terminal number. This message was generated by terminal 01
in store 29.

If there is a licence detection error please try these steps before calling for assistance:

1. Open the LogiLicence Viewer window by double-clicking the  icon in the system tray
2. Press the “Update licence file from Host” button.
3. You should see a message at the bottom of the LogiLicence viewer window confirming that

the licence was updated successfully.
4. If the “Software license key has not been detected” message is generated from an L-

BOSS station open the L-BOSS  File menu at that station number.
5. Click on View internal process
6. Now press the Read Key button.
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7. You should see a message like the one highlighted in the window above. UDP received:
Key info from: 192.168.0.38. The IP address will be different. If you do not see the UDP
received: Key info from: xxx.xxx.xxx.xxx there is a problem with the messages being sent
between L-BOSS and the LogiLicence service. If you do not see the Key Info received
message when you press the Read key button please temporarily  disable any firewall and
antivirus programs that are running and try the Read key operation again as explained in
steps 4 to 7. If this resolves the issue please adjust your firewall or antivirus to allow
LogiLicence service as an exceptions and add UDP ports 8033 and 8043 to exceptions
list. 

8. If the error was generated from a POS terminal click on the L-POS license number in the
top left hand corner that POS terminal. A menu will appear:
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1. Open the Console and press the Key button.

2. You should see a Mailslot received: Key info message.
3. If you do not see the Key Info received message when you press the Read key button

please temporarily disable any firewall and antivirus programs that are running and try the
Read key operation again as explained in steps 9 to 11.
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2.5.4.11 Secure the service

Securing the licence service

We recommend that you set the properties on the service to restart if failures occur. 
1. Open the Services view from Control Panel, Adminstrative tools. Right-click on the Logivision

Licence service.

2. Open the Recovery tab. 
3. Set the value for First failure and second failure to “Restart the service”. 
4. Change the Reset fail count after to 1 days.  
5. If the system experiences more than 2 failures per day there is a serious issue that needs to

be addressed.
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2.5.4.12 Important message to resellers

Logivision sells dealer software licences to allow testing, debugging and demonstration of the
L-POS software. These licences include all the software features. They allow running the
POS application on 2 terminals simultaneously. You can also set up the L-BOSS server and
an L-BOSS workstation. Dealers have been using the licences on different terminals by using
the “moves”. We will release a new LogiLicence server on Wednesday, December 11th,
2013. This release of LogiLicence will permit use of a dealer licence on a maximum of 6
different hardware profiles. When you use the Logilicence option to “Update from Host” on a
PC that has not been registered you will be prompted to register this terminal profile. When
you accept the terminal profile is saved. Once the 6 profiles are registered no further changes
will be permitted. 

So this means that your licence purchase allows you to use the dealer system on up to 6
different sets of 2 machines. If they all have different store numbers and you adjust
LogiLicence on each system to serve the correct store number they can all run
simultaneously. So in reality we are giving you up to 6 dealer licences for the price of 1. The
dealer licence cannot be used for trade purposes in a live store. This will lead to software
copyright infringement and legal issues for the retailer and dealer. So please take care not to
register the dealer licence in a live merchant location.
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If you try to install the licence on a new hardware profile you will be warned before it is
activated. If you assign a licence to the wrong machine and need it changed there will be a
minimum one hour charge to correct the settings and remove the incorrect hardware profile
(s). This will also apply if your PC breaks, burns or whatever. Take note that the PC name is
part of the profile we save. We also know that some dealers use the dealer licence to stage
new installations. If you continue to do this your 6 hardware profiles will be registered and the
fee will be charged to remove any of the hardware profiles that were assigned to the dealer
licence. Please acquire the software licence you need for the new installation and stage your
installation with the actual store licence file. 

2.5.5 File Maintenance Utility

L-BOSS File and Database Maintenance Utility

!!WARNING!! The aspects covered by this utility are technical. Given the critical nature
of the L-BOSS system data and because it is possible to seriously damage the
information in the database, we suggest you do not attempt  any database
manipulation unless you are absolutely certain of the results of the operation. Please
contact your Logivision  dealer for technical support.

L-BOSS provides a utility to handle database tables, used to backup and restore information
from the tables, or re-index and pack tables. Some of the options controlled by the File
maintenance utility can be run from within L-BOSS as automated "Events". For example, the
backup operation. However, the File Maintenance utility is a "Stand alone" program, not linked
with the L-BOSS program or other module. To launch the File Maintenance utility, open the
Windows "Start" menu, "Programs", "L-BOSS", "File maintenance" option.

NOTE: Since the File Maintenance utility accesses the data tables, they must not be in use
during operations. To ensure the tables are not being accessed, you should close L-BOSS
before running this utility.
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This example shows the L-BOSS "stand alone" File and Data table Maintenance Utility.

About Data Table Backups

The L-BOSS utility can extract all data from the tables and store the information in text type
"SIL" (Standard Interchange Language) files. The backup files contain information about each
table, along with the data to re-populate the tables. It can completely re-build the database
from these files. When set as an automated task, the backup utility works as a "cyclical"
backup; it creates a series of folders named for each day of the week. After the first week, the
process replaces each day's existing backup from the week before. There is always at least
one week of data, going back day by day.
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2.5.5.1 File menu

File menu options

Login is used to sign in. You must have the rights as defined by the system adminstrator.
Logout is used to sign off.
Refresh: Use the refresh option to update the record count of each table. This may be
useful when you want to evaulate the time a completre backup or restore may take.
Alias: This option is not used in normal situations.
Merge: The merge function saves data and creates files that will add the source data to
the existing target data rather than deleting all existing data in the target system and
replacing with only the source data.
Backup: The backup function saves data and creates files that will replace existing data in
the same table when it is restored.
Re-Index: If you are using the default "Paradox" database type, there are situations that
may arise where the data table "indexes" become corrupt. This doesn't mean that the data
itself is corrupt, just the internal pointers used by the database to quickly locate records.
This can happen during a system "crash". For example: at the moment that L-BOSS is
writing data to a table, there is a power failure, or the computer "freezes" because of low
resources. When the system comes back online, and L-BOSS is re-started, it will open a
message box indicating that it was not properly shut down, and that this may have caused
damage to the data table indexes. In this case it is suggested that the tables be re-indexed
as a precaution.
NOTE: If your installation is using MSSQL rather than a Paradox style database you will
probably never need to run the re-index command because the MSSQL program handles
this type of situation internally.
Re-Indexing Operation: Close all L-BOSS programs and modules before running the re-
index command. If you re-index while there are tables open, the process will stop, indicating
that a table is busy. You must close all L-BOSS programs and re-start the re-index
process. Follow the selection process for the tables to re-index, or, in most cases, use the
"select all" option from the utility's "Edit" menu. Once the tables are selected, press the
"Re-index" button at the bottom of the utility window. The re-indexing process does not
affect the table data, or harm the database in any way.
Source: This option is used to define the source during a merge or backup.
Target: This option is used to define the target during a restore operation.
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Properties: The File Maintenance utility can also display specific information about a table
and its associated SIL file. With one table selected, click the right mouse button. A
properties panel opens, displaying the table information in the top portion of the panel. If you
did not select an associated backup from the "View" menu there is no associated backup
file. If you select a backup day from the view menu, then right click a table, the bottom
portion of the properties panel displays information about the backup file. You can also click
the "View" button below the backup file properties to open the SIL file in an editor to view the
actual contents.

This example shows the Data table and backup file properties.

Rebuild new only: After installing a partial update, this option allows you to restructure the
data in tables that have been modified since the previous software release.

Why and How to use the Pack Command

NOTE: The Pack command is only required if your installation is using the "Paradox" type
of database. MSSQL databases do not require "Packing". This process occurs on a
regular basis, run internally by L-BOSS. You should not normally have to run the Pack
command. It is described here to explain why it exists as a utility. You should take note
that although Paradox may appear as a database type, it will not support the full
range of features available with L-BOSS. Logivision does not offer support on
Paradox based L-BOSS systems. Please upgrade to the free desktop edition of SQL
Server provided with the L-BOSS installation.

When records are deleted from a Paradox data table, the record is really just emptied of
any values. The physical space the record occupied in the table remains. During normal
use, the data tables are added to and have records removed on a regular basis, taking
more space than actually required. The "Pack" operation seeks and removes these spaces
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from the Paradox table structure, diminishing the table to include only the records that
contain data. This process occurs on a regular basis, run internally by L-BOSS. You should
not normally have to run the Pack command.

2.5.5.1.1  Creating a backup f ile

L-BOSS uses data that is stored in a SQL database. This data is not easily accessible for the
normal user. The backup function extracts the data from each of the tables in L-BOSS.
Filemaint also ncludes a Restore option to replace existing data with a backup.

To back up data from an existing L-BOSS system you should first close the L-BOSS
program on all the L-BOSS 901 and L-BOSS workstaions. Open the Filemaint.exe program
from the L-BOSS program group or from the L-BOSS folder.

Select any individual file to back it up. 
Press and hold CTRL button and select several files to back up the highlighted files.
Use the Edit menu to select all files or groups of files.

When all files have been selected press the Backup button or access the File > Backup
function.

These files are saved to the L-BOSS\Office\Backup folder on the L-BOSS 901 terminal. Any
existing data files in the folder will be overwritten with the current backup.

Backing up to a specific folder
Use the VIEW menu to access the folder where you want to save your data. Select the
Custom folder to create a new storage location or to access a location you used previously.
Any existing data files in the folder will be overwritten with the current backup.

2.5.5.1.2  Automatic backups

Creating An Automated Backup

L-BOSS provides a utility to handle database tables, used to backup and restore information
from the tables, or re-index and pack tables. Some of the options controlled by the File
maintenance utility can be run from within L-BOSS as automated "Events". For example, the
backup operation.

If your installation does not already include an automated backup "Event" you can create one
by following several simple steps. First, open the "Events / Tasks" utility using the L-BOSS
desktop icon.

Click the "Add" button at the bottom of the Automated Tasks utility to open the "Task
Editor".
Enter a description for the task, such as "Daily Backup".

Place the cursor in the "Command" entry line, then click the "..." button to the right of
the Command box.
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A file browser opens. From the "Files of type" option at the bottom of the file browser,
select "Programs".
By default, the file browser shows the "Office" folder. Navigate to the \L-BOSS folder.

Find and select the "FileMaint.exe" file.

The Task Editor will automatically fill in the Command with the backup option.

Place a check mark beside both the "Allow manual" and "Allow scheduled" options.  

Set the time for the backup operation.

In the "Repeating cycle" box, enter 1 "days" to have the backup performed every day.

Press the check mark icon on the Task Editor top bar to save the new task and close
the editor.

This example shows the Event / Task editor - Daily Backup event.

The backup files are created in folders under the \L-BOSS\Office\Backup, with the day of the
week as the folder name.

Note that the default L-BOSs application does install an automated backup task. You may
use this task after setting the time to meet your requirements.

NOTE: The Filemaint program does NOT create a full backup of the L-BOSS user
maintained data. Filemaint automatic backups only extract the data from the SQL database
so that it can be easily included in your normal system backup routine. There are many other
files in the L-BOSS folder that contain user defined data that is not part of the original
installation. These include, but are not limited to images, INI files, custom SQL queries,
custom report files, check write and endrosement forms, invoice templates, etc. It is normal
practice to back up the L-BOSS folder on an incremental basis. Check with your dealer on
how to set up the cmplete system backup.
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2.5.5.1.3  Restoring data to the SQL database

These backups are only used if the data tables become corrupt, or if for some reason they do
not contain the correct data. If this situation should arise it may become necessary to replace
the data table, restoring it to a previous "last known as good" state. It is rare that all tables
become corrupt, so it is essential to know which table to restore. By default, the File
Maintenance utility displays all the tables (and their internal names) it finds in the current
database when it opens. 

To restore a file from a backup:

Open the File Maintenance "View" menu and select the folder to restore the table
from.
The table list now shows the table names, and the associated backup files.

Select the table to restore. (you can hold down the [Ctrl] key to select more than one
table)
Press the "Restore" button at the bottom of the File Maintenance utility.

NOTE: The "Edit" menu also has preset selection patterns that simplify the selection
process. For example, if you want to select all the report tables, use the "Edit" menu's "Select
Report files" option.

NOTE 2: The restore function must be treated with care. When you restore a backup file all
existing data in that file will be REPLACED.

2.5.5.1.4  Merging data f iles

You may need to get data from more than one system into a single file. This is what we refer
to as a Merge.

Let's say you have installed a system in a store and want to add the PLU data from that store
to an existing database. If you use the normal Backup command you will have a problem.
When a Backup is restored it OVERWRITES all existing data in the same files on the target
system. So rather than using he backup command to save the data from the new store you
will use the merge command.

Example: Store A has 5000 PLU records that we want to add into the data in store B which
has 17,000 PLU records. It is possible that some records exist in both stores. If that is the
case you need to decide which of the common PLU items you want to retain. The same item
does not exist twice in the database. Let's say you are sure that the Store B has the correct
information for all existing items, but you still want to add the missing PLU from STORE A's
database.

That means we will need to take the data from STORE B and import it over the data from
Store A. This way any existing items in store A will be changed by the data from Store B. But
of course we want to keep all unique items from both stores. To do this you need to run the
Merge command at store B.
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Create the merge data:
1. In store B open Filemaint. 
2. Use the edit menu to select the item related tables.
3. When the item tables are selected open the File menu and select the Merge command.
4. You will see the prompt:

5. Answer yes to save the files in the L-BOSS station 901 under the L-BOSS\Office\Merge
folder.

6. Copy the files from the L-BOSS\Office\Merge folder to the Store A L-BOSS\Office\Merge
folder. You may need to create the folder if you never did a merge in StoreA.

Restore the merge data:
1. In Store A open FileMaint.
2. Use the View menu to point to the Merge folder.
3. Use the Edit menu to select the item related files.
4. Press Restore.
5. The existing data from Store A will be updated by any changes to identical records from

Store B. All new items will be added to the Store A database.

2.5.5.1.5  Using the target command

You may need to work with different programming groups in some stores. For example, when
you have keyboards on some lanes and touch screen on other lanes. This requires you to
create target groups as explained in the Register menu, targets programming chapter.

Now let's say you are in Store A and you have some great screen set up for use with touch
screen terminals. Store B has keyboards but wants to run with touch on 1 lane. Using the
Merge and target commands you can get the data from Store A and bring it back to store B
without manually creating all the screens.

First you will need to create the screen groups in Store B as explained in the chapter on
creating different screen targets. You will also need to separate the Functions program
groups as explained in the same section. If you followed our example the screen targets in
store B  will be KEB and TOU. In store B you must separate the terminal with the touch
screen into the TOU target. The other terminals are in the KEB group to use keyboards.
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Now go to store A to get the touch screen data that you want to use in the new store B. We
assume the the touch screen data in store A is using the PAL target where all lanes are the
same.

1. Close L-BOSS.
2. Open Filemaint.
3. Sign in.
4. Open the Edit menu and select screen related files.
5. Open the File menu and select Target.
6. In the "Enter new target" prompt window enter TOU and press Enter.
7. Open the File Menu and select Merge.

This will save the 5 screen related files to the L-BOSS\Office\Merge folder. Take these 5 files
to Store B.

In Store B copy the 5 files to the L-BOSS\Office\Merge folder.

1. Close L-BOSS.
2. Open the Filemaint and sign in.
3. Use the View menu to point to the Merge folder.
4. Use the Edit menu to select the screen related files.
5. Press Restore.
6. The existing data from Store A will be added to the data already present. So if you have

followed the instructions you should now have different screens for touch terminals and
keyboard terminals.

Use the L-BOSS>Task> Deploy screens to send the files to the POS.

2.5.5.2 Edit menu

Edit menu options

Select all will select all tabkles on the list.
It is possible to select files manually with filemaint. For example, you can back up the
operator table by selecting CLK_TAB and pressing the backup button. The Edit menu
allows you to select groups of files that are predefined. To backup the files related to PLU
programming use the Select Item related files. Filemaint will select the ALIAS_TAB,
COST_TAB, OBJ_TAB, POS_TAB, PRICE_TAB and SCT_TAB
Select screen related files will select all tables related to the screen settings.
Select Item related files will select the files related to item in your system.
Select report files will select all the tables that contain report data.
Reverse selection will de-select the highlighted files and select the others.
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De-select all will remove selection mark from all files.

2.5.5.3 View menu

View menu options

Language Use this option to select the program operation language.
Merge directory Select this option to work with the files that were saved to the L-
BOSS\Office\Merge folder.
Default: Select this option to work with the files saved to the L-BOSS\office\Backup folder.
Sunday: Select this option to work with the files saved by the automatic backup the previous
Sunday to the L-BOSS\office\Backup\Sunday folder.

Monday: Select this option to work with the files saved by the automatic backup the previous
Monday to the L-BOSS\office\Backup\Monday folder.
...
Saturday: Select this option to work with the files saved by the automatic backup the
previous Saturday to the L-BOSS\office\Backup\Saturday folder.
Custom directory: Select this option to work with the files in a custom folder.
Update view: Select this option to refresh the list of files in the selected directory.

2.5.6 Exporting data

It is possible to export data from the L-BOSS report databases. Refer to the following
sections for an example on how to proceed.

2.5.6.1 Setting up an export

L-BOSS has the ability to export a report's data to CSV or text file. Here is an example based
on the Financial report.

1 - Find the report you want to export in the report selection window. Right-click and select
properties. Note the name of the .lrp file of the report.
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 2 - Next, you need to open the report's section in the Program data folder under
Logivision\Officexxx\Server.ini where xxx is the store number. All the report sections are
named [RPT_NameOfLRPfile], in this case [RPT_Financial]:

[Rpt_Financial]
Position=316,135,454,437
 
3 - You need to add a line to the [Rpt_Financial] section of the file. This will tell L-BOSS which
fields to export, the file name to create and the data format to use. That file will be created
every time you execute the report, whether it is viewed or printed.

[Rpt_Financial]
Position=316,135,454,437
CMD=@EXEC(OUTPUT=Financial.csv,STYLE=CSV,LRP=Financial,FIELDS=F1039;0;
F9996;0;F67;0;F64;0;F9998;0;F65)

where:

OUTPUT=  L-BOSS will use this filename to save the data. The file will always be created in
the REPORT directory of the requester's inbox. The location of the outbox is explained further
down this chapter.
STYLE= can be CSV (Straight Comma Separated Values with alpha fields between quotes
and numeric without quotes), CSVS (no quotes around any field) or TXT (as-is)
LRP= you need to specify the name of the .LRP file of the report you want to export without
the extension.
Fields= you need to specify which fields from the report you want to export and their desired
length (use 0 for no length limit) separated by semicolons (;). For example with the financial
report if you want to export ALL the fields in there: F1039;0;F9996;0;F67;0;F64;0;F9998;0;F65
(notice the ";0" after each fields...if you want the fields to have a max length of 15 characters
you would put ";15" after then instead and the system will truncate them if they are longer and
pad them with spaces if they are shorter. If you leave them to ";0" it will export the full length)
  
4 - So for our financial report example, the complete line would be 

CMD=@EXEC(OUTPUT=Financial.csv,STYLE=CSV,LRP=Financial,FIELDS=F1039;0;F9996;0;
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F67;0;F64;0;F9998;0;F65;0). 

This will export the result of all the fields of the financial report to C:\Temp\Financial.csv every
time you run the report from the L-BOSS report selection window. So now the [Rpt_Financial]
section in server.ini would look like this:
 
[Rpt_Financial]
Position=316,135,454,437
CMD=@EXEC(OUTPUT=C:\Temp\Financial.csv,STYLE=CSV,LRP=Financial,
FIELDS=F1039;0;F9996;0;F67;0;F64;0;F9998;0;F65)

Each time you run the financial report in L-BOSS the system will create the Financial.csv file
in the terminal's OFFICEsss\INBOXttt\Report folder.
sss= 3 digit store number. ttt= 3 digit terminal number of the machine that was used to run
the report.

****IMPORTANT NOTES ON EXPORTING:****

 
- The export is only the RESULT SET OF THE SQL QUERY behind the report so ANY
FORMATTING DONE IN THE FORM (.frp) will NOT be exported nor will ANYTHING that
comes from the form. 
 
- You can get the list of fields by going in the Form Manager and looking at what fields are on
the form. Only the GREEN fields can be exported (in the grey bar), the yellow labels and blue
results cannot:

The export can also be done by putting your export command in an .sql file in the office folder
and be run with a scheduled event, but if you do it that way, you NEED to fill in the prompts
inside the command. It is important to note that the STR and TRM fields are not part o fthe
SQL file but must be present to tell L-BOSS where to save the file. All reports are written to
the REPORT directory of the requester's inbox. In the case that you send the request via a
file, you must define a store number (STR=xxx) and a terminal number (TRM=xxx) with the
request.  This defines which folder the report will be written to.

@EXEC(OUTPUT=Financial.csv,STYLE=CSV,LRP=Financial,@DATE1=@DSSF,@DATE2=@DSSF,
@TARGET1=RAL,@PERIODTYPE=D,STR=001,TRM=901,FIELDS=F1039;0;F9996;0;F67;0;F64;0;
F9998;0;F65,fmt=,@ASIS) 

This way, the system will look at the terminal xxx to find the computer name, then will access
its OFFICEnnn shared directory to gain access to INBOX\REPORT.  So for the sample
report request shown above the file will be written to: 
\\ComputerName\OFFICE001\INBOX901\REPORT\plusales.txt.

If you are on the same machine, the physical path will depend on the operating system: 
For Windows 7 operating system:
C:\ProgramData\Logivision\Office001\Inbox901\Report\plusales.txt
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For Windows XP operating system:
C:\Documents and settings\All users\Application data\Logivision\Office001\Inbox901
\Report\plusales.txt

Please refer to L-BOSS\DateFmt.txt and L-BOSS\Rpt_Technotes.html for more
information on filling in prompts and their formats.

2.5.7 Troubleshooting

2.5.7.1 Communications are halted

This option is usually hidden from view when the system is operating properly.

It is possible that corrupted data is sent to L-BOSS. For example after a network failure or
when importing from 3rd party systems. If this occurs L-BOSS will interrupt operation until the
problem is resolved. Here is the first message displayed on the L-BOSS:

Whenever this occurs you should normally close L-BOSS and all workstations. This frees up
any database issues.Then re-open L-BOSS and try to reprocess the file that caused the
error. When you open L-BOSS the same red screen will appear. Press OK and the L-BOSS
will show a flashing UNPROCESSED icon. L-BOSS may also display an error message.
Close the error window and click the Unprocessed icon.
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When you click UNPROCESSED this form will appear:



L-BOSS Menus 503

© 2001-2014 ... Logivision

This form shows the mail folders for each terminal. The system selected the Unprocessed
folder and displays the name of the file that did not process. Right-click on the file name and
try to reprocess the file. If the red error screen saying a file has been moved to the
unprocessed folder occurs again there is a more serious issue with the data in the
unprocessed file.

If you make the decision to move this file manually from the unprocessed folder L-BOSS
adds a new menu entry to the File menu:

The Bypass file processing order security option is the only way you can return L-BOSS to its
normal processing activity. This option prompts you to confirm the file delete is voluntary by
typing the word ACCEPT, pressing OK then entering your name. Once these conditions are
satisfied the processing will restart.

2.5.8 Updates

The L-BOSS updates are executed by closing the application and running the
LBOSSINSTALL.EXE file. When you update take care to select UPDATE and to pint to the
correct program folder.

You can install the LPOSINSTALL.exe to update the POS terminal.

You can also execute an event to update all L-POS from  the L-BOSS as follows:

This is done by executing the Update Program task in L-BOSS. This command will
REPLACE the existing program files on the target terminal(s). You cannot update from a
version 3 to a version 4 using this process because of the difference in folder structure. But
you can update from version 4.0.0.x to version 4.1.x.x for example.
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This process explains how to send the program file update from an existing L-POS version 4
to a newer L-POS version 4. This command does not send user Data (you cannot send the
ProgramData folder for example).

WARNING: This function will interrupt the POS operation until it has finished. It is usually done
outside business hours but there is no restriction on using it during normal business hours.

Here are the steps you need to follow:

1 - Install the new L-POS to have the new files you need to send to each lane. This will create
the Poswin folder and a bunch of subfolders. If installing on 32 bit to default program location
the installation files will be in Program Files

2 - Copy the contents (or the files you need to update) of the Poswin folder you installed into
the OfficeSystemxxx\Programs folder of the L-BOSS server.

The OfficeSystemXXX folder is located under:

Windows 7:
C:\ProgramData\Logivision\OfficeSystemxxx\

Win XP Pro
C:\Documents and Settings\All Users\Application Data\Logivision\OfficeSystemxxx\ 

3 - Execute the Update Program task from L-BOSS. You will be prompted for a target. 
Select the target and you will prompted if you want to update the target with all the files. 
Select Yes to send all files. 
To replace a specific file select NO when prompted to update all files. 
Then select the file(s) you want to deploy to the targets. 
Hold the CTRL key and click on each file to select multiple files or folders.

If you need to update the Pos.exe only, you would copy the newest Pos.exe in the ..
\OfficeSystemXXXfolder\Programs folder. Then you would run the Update Programs task. 
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3 Glossary

Glossary of Terms

Back End: The office terminals or stations that run L-BOSS, used for the management
aspects of the store, controlling the data for the front end.

Category: A user defined key that items can link to for combining items either for reporting or
global modifications.

CID: Cash in Drawer, but often used to describe any tender type that accumulates in a POS
drawer.

Command File: Executable file that contains proprietary L-BOSS commands, along with
SQL code used to interact with the database. Command files in L-BOSS often use a ".sql"
file extension.

Compute: Calculate or re-calculate data to give a total, often required after entering inventory
quantities, in order to re-establish the correct number after sales.

Count: In terms of inventory, the physical counting of items. Inventory tracking must start with
a count to establish the real quantity for items in the sales process.

Declaration: The act of counting and entering the in drawer amounts for all tender types at
the end of a cashier's shift. The declaration is used to report Over / Short amounts by
cashier.

Deploy: Prepare to send; place information in an outbox, or in a target inbox.

Electronic Journal: In the front end terminal, an electronic version of a register tape, used to
store ALL transaction details tracked by a front end terminal.

Entry: Any process that involves manual data entry, for inventory operations or other
management related processes, such as cashier loans or pickups.

Event: A process or task set to run automatically at a pre-programmed time. Can also be
forced to run manually.

Execute: Run a command file, utility or program, perform a process.

Flag: An indicator or attribute, used by the system to identify a process or item status.

Front End: The portion of the store where sales transactions are performed. The points of
sale (POS). 

Grand total information: 

Financial and end of day reports may display a grand total value. The grand total
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(Totalizer 4003)is the total of all positive sales. This is the Total Sales (Tlzr: 2) of every
SIL file (taxes included) that has a positive total. The grand total range is 0.00 to
9,999,999,999.99
Negative GT before L-POS version 2.1.5.9: Totalizer 4002 is the total of all positive
sales plus the absolute value of all negative sales. This is the Total Sales (Tlzr: 2) of
every SIL file (taxes included). Its range is 0.00 to 19,999,999,999.98
Negative GT with L-POS version 2.1.5.9 and up, and with L-BOSS only: Totalizer
4002 is the total of all negative sales. This is the Total sales (Tlzr: 2) of every SIL file
(taxes included) where the transaction total is negative. Its range is -9,999,999,999.99 to
0.00 
The grand totals do not represent the sales information. They are provided as a simple
verification method to insure that no report has been misplaced. To verify data continuity,
subtract the previous day totals from today's total.

HALO: Highest Allowable Limit Override, function used to allow sales over the programmed
limit, often manager required security level protected.

Inbox: A physical disk location (folder) where information is received as a file when
"deployed"; a target.

Key Protection: A physical device used to protect from illegal use of the software, copies,
number of stations (lanes) etc. The key is installed on one system station and runs a special
program that allows access to registered modules.

Key Reader: The program that runs on the machine in the system that physically hosts the
software protection key.

Launch: Start a process, execute a command file.

Loans: The in drawer amounts used to begin a cashier's shift. 

LQD: Limited quantity discount, or the maximum number of an item a customer can
purchase and still get the discount. Often used to limit special deals.

MailSlot: The technology used to communicate information directly through the network.
Starting with version 1.8.x.x L-BOSS started using UDP

Margin: The profit an item generates, expressed as a percentage of the selling price.

Markup: A percentage of the cost added to the cost to obtain a selling price.

Operator: Any system user, including cashiers, clerks, managers, programmers. Operators
are linked with a security level to establish system access rights.

Outbox: A physical disk location (folder) where information is placed as a file when
"deployed", ready to be sent to a target.

Paradox: A common relational database format, normally used for smaller installations
where there is less data. Larger installations that require multiple user access and contain
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large amounts of data usually use MSSQL type databases.

PDT: Portable Data Terminal, a hand held device used to collect item information for
modification.

Pickups: The act of removing amounts from a cashier's drawer, normally when the in drawer
amounts exceed the highest allowable limits for that tender type.

PLU: Price Look Up, the same as "item" or UPC, a unique number used to identify a single
product.

Polling: The communication process between front and back end terminals, normally used
in relation with sales data collection.

POS: Point Of Sale, the front end terminal where sales transactions are performed.

Post: Save to the database only. Posting does not Deploy (send).

Relational Database: Any type of database where data is kept in tables, and linked with
other tables by a common key field or combination of key fields.

Risk Level: Associated with customer accounts, a table that contains information about
credit limit. Customers are then assigned a risk level that establishes their credit limit.

SIL: Standard Interchange Language. An extensive industry standard data dictionary and
established numbering system for data fields that relate to the retail business, used to
transport information in a common format. SIL files combine data and the SQL command
necessary to export or import data.

SQL: Standard Query Language, an industry standard database language used to
manipulate, extract and store data in relational tables.

Target: Any terminal or group of terminals that must be sent to, or received from. Including:
portable data terminals, back office stations, front end terminals. Targets have a specific
naming convention, explained in the terminal table programming help page in this manual.

Task: The actual job or process, usually associated with an event. Command files contain
the specific code for individual tasks.

Terminal: Any system station, front or back end computer or other data device. Normally part
of a target group.

UPC-A, UPC-E, EAN, Code39: Common types of industry standard bar codes used
throughout the retail sales market.

Vendor Code: Vendors or suppliers usually have a proprietary code they use to track items
they wholesale. Often used when ordering or returning items to vendors, linked to a cost.
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Compute Option     385
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Contact     235
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Controlling Rental Items     160

Controlling the Maintenance Desktop     287

Controlling the Viewer     30, 31

Copy item     190
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Cost Target     167
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Creating An Automated Backup     489
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Creating Promotional Coupons     176
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Customer Level Table Programming     244
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Daily Maintenance Process     19

data integrity     18
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Divisor     139
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Edit Menu Item Options     127

Editing tools     116

EJ Viewer Menu Options     398

Electronic coupon links     176

Electronic Coupons     176

Electronic Journal - Professional version     398

Electronic Journal Utility     397

Entry Module Overview     332

Establishing access levels     62

Events / Tasks Utility     386

exchange groups     272

exchanging information     28

Execute     34

command     34

command file     34

Execute at loading time     387
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Factor     144
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Combining Filters and Global Modifications     187
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First Label Selection     324

Follow Sub-dept     139
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Forcing Commands     34
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Form editor    

Main Menus     473

tools and menus     473

Form Manager Main Menus     474

Form Manager Module     469, 478

Freeze     30, 31

Func#     263

Function access security     263

Function Table Programming     263
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Gift Certificates     283

Global Modification     187

Glossary of Terms     505
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Grid Size     473

Groups     272
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Hash Item     139

Help     417

help manual     16

Hints     66

Host     55

active     55

data communications     55

path     55

Port     55

Tab Settings     55

How polling works     18
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icons     16

Ignore Un-posted changes     127

Image objects     470

instant deploy tool     192

Interest Rate     246

internal commands     34

internal exchange system     28

Internal process     31

Inv. (Inventory tracking)     171

Inventory Adjustments     371

Inventory application     332

IP or Domain name     55

Item (PLU) maintenance     131

Cost Tab     167

ECL Tab     176

Inventory Tab     171

Object Tab     136

POS Tab     139

Price Tab     144

Quick Tab     134

Sales Tab     174

item data integrity     121

Item Detail     136

Item flags     134
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Item Maintenance Utilities     122

Item Navigation Menu     194

Item number     134

Item Table Tabs and Fields     131

Item tables    

Bottle Link Programming     202

Category Table Programming     206

Mix & Match Table Programming     207

Price Level Table Programming     205

Tare Table Programming     204

Vendor Table Programming     221
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keystrokes     16



L-BOSS User Manual 4.1.3512

© 2001-2014 ... Logivision

- L -
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label type selection tool     193
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L-BOSS File Menu Options     25

LBoss main menu     23
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Line Tool     473
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Load Files Tab Settings     57
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Loans     386
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LQD     144

- M -
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PLU Menu Options     130

Maintenance Application Overview     113
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Markup     144
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Messages     47
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Misc Tab     52

Mix & Match Table Programming     207
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Modifying L-BOSS Report SQL Code     329

Modules     68
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Monitoring Utility     395

Monthly Maintenance Process     19

Move Filtered items to Batch     127

Moving an Object     470

multiple copies     160
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Navigating     16

network situations     47

New item     190
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Next number     52

No Refund     139

No Repeat     139

No Return     139

nodes     470

Non-referenced POS     225

Non-referenced PRICE     225

Not for Sale     139
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Object Dimensions     473

Object Inspector     474

Object nodes     470

Object Right Click Menu     470

Object table     136

Oper Age     139

operator     27
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Operator #     260

Operator Table Programming     260

Ord (Reorder item)     171

Other Dynamic Edit Menu Options     129

Other Dynamic File Menu Options     126

Over / Short     52, 386

Override Allowed     139

- P -

Pack     489

Package     144

PAL - target group     272

Parent / child     171

password programming     260

Pause     32

Physical Backup     20

Pick 5 deal     176

Pickups and Loans     386

PID     176

PLU fields     131

Points     144

Polling Process     18

Populating Batches using a Portable Device     208

POS descriptor     134

POS Target     139

Posting Batches     208

preferred language     28

prevent unwanted access     28

price level     154

Price Level Table Programming     205

price levels     144

Price Modify     144

Price Required     139

Price Target     144

price-look-up     134

Print     139

a single page     16

the entire manual     16

Print name     260

Printer section     52

Printing help pages     16

Printing Labels     324

Product Life     222

Programming Departments     199

Programming Events     387

programming items     131

Programming Sub-departments     196

Prohibit Quantity     139

Promo ID     139, 176

Promotion prices     208

Protecting Your Data     20

Purchase Order    

creating     346

manual     346
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Quantity Required     139

quick access to the Item table     130

Quit polling     32
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RAL - target group     272
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from a Purchase Order     358

using a Portable Device     358

without a Purchase Order     358

Rectangle Tool     473

Register Menu Options     259

Regular Cost     167

Re-indexing Tables     489

Re-Init Printer     52

Remark     167

remote data communications     272

Removing Items     190

Rental Items     144, 160

Replace     35

Reply     65

Report     315, 321

Category     327

Change Icon     327

controlling     315

date selection     319

Debug     327

Dialog     327

F3 Search Utility     321

Hidden     327

New page     327

period types     319

Preview     327

Preview Maximized     321
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Report     315, 321

Printer dialogue     327

Properties panel     327

range     319

right click menu     315

Section     327

Selection Utility     317

Template File     327

Title Fields     327

Total fields     327

Trigger Fields     327

Types     315

Use Group     327

Viewer     321

Report Code     136

Report formula     269

Report Section     269

Report SQL Editor     329

Report System Overview     314

Report Template Editor     469, 478

Report Viewer Options     321

Re-Read     329

Reset transaction counter     31

Resizing an object     470

Restoring from L-BOSS Archives     20

Restrictor     139

Return time     160

Risk Level     235

Risk level Table Programming     246

ROQ (Reorder quantity)     171

Rulers     473

- S -

S.R.P.     144

Sale Price     144

sample files     57

Scalable     139

Scalable Item Table Programming     222

Scheduled events     67

Scheduler     386

Searching Through Data Lists     117

Secure Information     18

Security level     27, 260

Security Tab Settings     62

Selecting a different navigation     194

Selecting Reports     317

Sending Changes to Targets     192

Sending Information After Editing     120

Sending Information From One Database Table     35

Server     47

main directory     47

office directory     47

Serving Size     222

set ALL item prices from their costs     127

Set default font     474

Setting the Language     28

Setting up terminals and target groups     272

Shelf Life     222

Short / Over     386

Show position ruler     474

Show tips     66

Sign in     27

Size Description     136

Special Menu     417

specialized utilities     417

SQL Command     121

Start All     32

Statistics     225

Stock control     332

Stop     30, 31

Stop All     32

Store Coupon     139

Store number     171

sub-department link     134

Sub-department overview     195

Sub-Department Settings     196

Sub-Dept     134

System date     47

System Tab     47

System Tab Settings     47

- T -

Tabbing order - item table editing     194

Tare Link     139

Tare Table Programming     204

Target groups     272

Task Editor     387

Task Manager     386

Taxable     139

Template Editor     470

Template Objects     470

Terminals     272

Terminal groups at Headquarters     272

Terminal list     272
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Terminals     272

Terminal Table Programming     272

Terminals and Groups     272

Test    

No sub-department     122

PLU at zero price in level 1     122

PLU price over 100.00     122

Show POS targets     122

Show Price targets     122

Unreferenced bottle link     122

Unreferenced sub-department     122

Unreferenced tare link     122

Testing Item tables     225

text wrapping     470

Tlzr sequence     269

To restore a file from a backup     489

totalizer "files"     269

Totalizer Link List     263

totalizer number     269

Totalizer Table Programming     269

tracking a process     28, 30, 31

Tracking cashier activity     395

transfer data to remote stores     272

Transfer Menu     120

trouble-shoot     28

Type     139
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Unit of Measure     136

Unprocessed Files     394

unwanted access     28

Urgent Messages     393

Use scanner     122

user     27

user level     62
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user preference     28
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Using the keyboard     16
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Vendor Table Programming     221
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View Log Utility     391
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Viewer     28
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Unprocessed Files     394
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Visual customer confirmation     235

Visual Verify     139
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Windows Menu     287
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